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  SAFETY and EMC INFORMATION 
 

Please read this section carefully before installation 
 

This controller is manufactured in the UK by Eurotherm Ltd. 
 

It is intended for industrial temperature and process control applications when it will meet the requirements of 
the European Directives on Safety and EMC.  Use in other applications, or failure to observe the installation 
instructions of this handbook may impair the safety or EMC protection provided by the controller.  It is the 
responsibility of the installer to ensure the safety and EMC of any particular installation. 

Safety 

This controller complies with the European Low Voltage Directive 2006/95/EC, by the application of the safety 
standard EN 61010. 

Electromagnetic compatibility 

This controller conforms with the essential protection requirements of the EMC Directive 2004/108/EC, by the 
application of a Technical Construction File. 
This instrument satisfies the general requirements of an industrial environment as described by EN 50081-2 and 
EN 50082-2.  For more information on product compliance refer to the Technical Construction File. 

Service and repair 

This controller has no user serviceable parts.  Contact your nearest Eurotherm Controls agent for repair. 
Some module terminal units may contain fuses and must be replaced by the correct type of fuse.  These are T 
type rated at 2 Amps to EN60127. 

Electrostatic discharge precautions 

When a module is removed from the base, any exposed electronic components are vulnerable to damage by 
electrostatic discharge from someone handling it .  To avoid this, before handling the unplugged module 
discharge yourself to ground. 
If removing a PCB from its sleeve, for example - to remove snubbers from the Relay Module, please use anti-
static precautions. 

Cleaning 

Do not use water or water based products to clean labels or they will become illegible.  Isopropyl alcohol may 
be used to clean labels.  A mild soap solution may be used to clean other exterior surfaces of the product. 
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Installation Safety Requirements 
Safety Symbols 

Various symbols are used on the instrument, they have the following meaning:  
 
 Caution, (refer to the   

accompanying documents) 
Functional earth  
(ground) terminal ! 

 
 

Personnel 

Installation must only be carried out by qualified personnel. 

Enclosure of live parts 

To prevent hands or metal tools touching parts that may be electrically live, the controller must be installed in an 
enclosure. 

Blank Terminal Unit 

Bases are supplied to hold 4, 8 or 16 modules.  In the event that a base is not fully populated a blank terminal 
unit, part number 026373, will be supplied with the system.  It is important that this is fitted into the position 
immediately to the right of the last module in order to maintain IP20 rating.  See Chapter 3 ‘Terminal Units’ for 
installation details. 

Caution:  Live sensors 

The controller is designed to operate with the temperature sensor connected directly to an electrical heating 
element .  However you must ensure  that service personnel do not touch connections to these inputs while they 
are live.  With a live sensor, all cables, connectors and switches for connecting the sensor must be mains rated. 

Wiring 

It is important to connect the controller in accordance with the wiring data given in this handbook.  Take 
particular care not to connect AC supplies to the low voltage sensor input or other low level inputs and outputs.  
Only use copper conductors for connections (except thermocouple inputs) and ensure that the wiring of 
installations comply with all local wiring regulations.  For example in the UK use the latest version of the IEE 
wiring regulations, (BS7671).  In the USA use NEC Class 1 wiring methods. 

Power Isolation 

The installation must include a power isolating switch or circuit breaker.  This device should be in close 
proximity to the controller, within easy reach of the operator and marked as the disconnecting device for the 
instrument. 

Earth leakage current 

Due to RFI Filtering there may be an earth leakage current of up to 3.5mA.  This may affect the design of an 
installation of multiple controllers protected by Residual Current Device, (RCD) or Ground Fault Detector, (GFD) 
type circuit breakers. 

Overcurrent protection 

It is recommended that the DC power supply to the system is fused appropriately to protect the cabling to the 
units.  The 2500 provides a fuse on the IOC Terminal Unit to protect the supply from a fault within the 2500. 

Voltage rating 

The maximum continuous voltage applied between any of the following terminals must not exceed 264Vac: 

• relay output to logic, dc or sensor connections; 

• any connection to ground.  

The controller should not be wired to a three phase supply with an unearthed star connection.  Under fault 
conditions such a supply could rise above 264Vac with respect to ground and the product would not be safe. 

Voltage transients across the power supply connections, and between the power supply and ground, must not 
exceed 2.5kV.  Where occasional voltage transients over 2.5kV are expected or measured, the power 
installation to both the instrument supply and load circuits should include a transient limiting device.   

These units will typically include gas discharge tubes and metal oxide varistors that limit and control voltage 
transients on the supply line due to lightning strikes or inductive load switching.  Devices are available in a 
range of energy ratings and should be selected to suit conditions at the installation. 

  

Protective earth 
terminal 
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Conductive pollution 

Electrically conductive pollution must be excluded from the cabinet in which the controller is mounted.  For 
example, carbon dust is a form of electrically conductive pollution. To secure a suitable atmosphere in 
conditions of conductive pollution, fit an air filter to the air intake of the cabinet.  Where condensation is likely, 
for example at low temperatures, include a thermostatically controlled heater in the cabinet. 

Over-temperature protection 

When designing any control system it is essential to consider what will happen if any part of the system should 
fail.  In temperature control applications the primary danger is that the heating will remain constantly on.  Apart 
from spoiling the product, this could damage any process machinery being controlled, or even cause a fire. 

Reasons why the heating might remain constantly on include: 

• the temperature sensor becoming detached from the process; 

• thermocouple wiring becoming short circuit; 

• the controller failing with its heating output constantly on; 

• an external valve or contactor sticking in the heating condition; 

• the controller setpoint set too high. 

Where damage or injury is possible, we recommend fitting a separate over-temperature protection unit, with an 
independent temperature sensor, which will isolate the heating circuit. 

Please note that the alarm relays within the controller will not give protection under all failure conditions. 

Grounding of the temperature sensor shield 

In some installations it is common practice to replace the temperature sensor while the controller is still 
powered up.  Under these conditions, as additional protection against electric shock, we recommend that the 
shield of the temperature sensor is grounded.  Do not rely on grounding through the framework of the 
machine. 

Installation requirements for EMC 

To ensure compliance with the European EMC directive certain installation precautions are necessary as follows: 

• For general guidance refer to Eurotherm Controls EMC Installation Guide, HA025464. 

• When using relay outputs it may be necessary to fit a filter suitable for suppressing the emissions.  The filter 
requirements will depend on the type of load.  For typical applications we recommend Schaffner FN321 or 
FN612. 

Routing of wires 

To minimise the pick-up of electrical noise, the wiring for low voltage dc and particularly the sensor input should 
be routed away from high-current power cables.  Where it is impractical to do this, use shielded cables with the 
shield grounded at both ends. 

Functional Insulation 

This is defined as:  Insulation between conductive parts that is necessary only for the proper functioning of the 
equipment.  This does not necessarily provide protection against electric shock. 

Reinforced Insulation 

This is defined as:  Insulation between conductive parts which provides protection against electric shock.  

Additional EMC Protection on Profibus IOC 

In environments where excessive noise levels are likely, it is recommended that a ferrite clamp is fitted around 
the Profibus cable.  This has the effect of increasing the noise immunity from 2KV to 3.7KV. 
A suitable ferrite clamp is Richo type MSFC -5T. 
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1. Chapter 1   INTRODUCTION 
Thank you for selecting the 2500 DIN Rail Controller and Data Acquisition Unit.  This chapter provides an 
overview of your controller.  
 

1.1. ABOUT THIS HANDBOOK 
This handbook is intended for those who wish to configure and use the 2500 DIN Rail Controller and Data 
Acquisition Unit.   
It may be used in conjunction with the following related handbooks: 

Subject Handbook Name Part Number 

Installation and hardware 
details of the 2500 DIN Rail 
Controller 

2500 Installation and Wiring 
Handbook.   

(Supplied with the instrument) 

HA026178 

Description of configuration 
tool for 2000 series instruments 

iTools User Handbook. 

(Supplied with iTools software) 

HA026179 

EMC and Wiring Practice EMC Installation Guide HA025464 

Serial Communcations  2000 Communications Handbook HA026230 
 

 
In general chapters are presented in the order in which these ‘folders’ appear in iTools.   
 
Chapter 1 provides an overview of the 2500 Unit. 
 
Chapter 2 describes Modbus, Profibus, Devicenet and Ethernet versions of the Input Output Controller (IOC) 
modules. 
 
Chapter 3 describes how the 2500 is configured using “iTools”.  iTools is a software package running on a 
personal computer under Windows 95, 98, 2000, ME, XP or NT(service pack 4 or later).  It provides a ‘view’ into 
the controller and allows configuration, commissioning and if necessary operation.  The general features of the 
iTools package are described in more detail in the User Handbook HA026179.  As iTools is an essential partner 
for the 2500, this engineering manual makes frequent references to it. 
The remaining chapters provide more information about all the functions available in the 2500, including details 
about how to configure each function, what the parameters mean and typical applications.  
Appendix D is a Glossary of terms used in this manual 
 

1.2.  SYMBOLS USED IN THIS MANUAL 

Symbol Meaning 

(xx) Numbers in ( ) are the enumerated values for a parameter  

 Read only 

 Write only 

⋅9 Range set between high and low limits in engineering units 

⋅% Range set between high and low limits in % 

 Time units days, hours, minutes, seconds, ms 

 Hint or useful information 

 

1.2.1. File Paths 
Parameters are located in lists.  Each list is associated with a particular subject such as Alarms, Control, etc. 
The following example shows how a parameter is located in a file path: 
Control → LOOP01 → L01CFG → Ctrl 
Where ‘Ctrl’ is the parameter (Control Type) found in the path ‘Control’ ‘Loop number 1’ ‘Loop number 1 
configuration list’. 
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1.3. STATUS WORDS 
Status Words group together commonly accessed parameters in convenient categories so that they may be 
read as a single transaction.  An example may be alarm states as shown in section 5.10.  The ‘Global Alarm 
Status Word’ from Table 5-7 is reproduced below.  This is a bit map of 16 bits and the value shown in each table 
in this manual is a decimal number.  For example if the value is 31 then the first four bits are set. 
The example below shows how this may be calculated:- 
In Hexadecimal 31 = 1F 

1F 
=  

0001 
1111 

Bits set 

7654 
3210 

Bit area 

This shows that bits 0 to 4 are set 

Bit Value 
(Decimal) 

Set when: 

0 1 Any channel - Sensor break detected 

1 2 Any channel - CJC failed 

2 4 Any channel - Channel not in use 

3 8 Any channel - Analogue output saturated 

4 16 Any channel - Initialising 

5 32 Any channel - Invalid Analogue Cal data 

6 64 Reserved for future use 

7 128 Any channel - Module fault  

8 256 Any Module is missing 

9 512 Any Wrong Module fitted 

10 1024 Any Unrecognised Module fitted 

11 2048 Any Module Comms Error 

12 4096 Reserved for future use 

13 8192 Reserved for future use 

14 16384 Reserved for future use 

15 32768 Reserved for future use 

 
Table 1-1:   Global IO Status Word and Bit Field 

 
 

Value 
(Hex) 

Bit Field 

0 0000 

1 0001 

2 0010 

3 0011 

4 0100 

5 0101 

6 0110 

7 0111 

8 1000 

9 1001 

A 1010 

B 1011 

C 1100 

D 1101 

E 1110 

F 1111 
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1.4. WHAT IS THE 2500? 
The 2500 is a modular system which can provide multi-loop PID control, analogue and digital I/O, signal 
conditioning and computational blocks with a variety of plug-in modules. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-1:   General View of the 2500 DIN Rail Controller and I/O Unit 

 
The base unit (2500B) can be provided in different sizes, with up to 16 I/O modules.  The base can be mounted 
on DIN rail (35mm top-hat), or just bolted to a wall.   
Terminal Units (2500T) clip into the base, providing customer connections to and from the plant devices and 
interconnections between modules and the Input Output Control module (IOC).  Terminal units are specific to 
particular modules as defined in the order code, Appendix B.   
I/O Modules (2500M) clip into the Terminal Units.  These modules are dedicated to specific functions - analogue 
or digital, input or output.  The IOC module (2500E or 2500C) contains the configuration for the system and 
communications support.  Three communications versions are available for Modbus, Profibus or Devicenet.  
The system requires 24Vd.c. at an average of 100mA per module.  A suitable power supply is 2500P available in 
2.5, 5 or 10 amp versions. 
 

1.5. WHAT DOES THE 2500 DO? 
The 2500 system functions around a database core.  In this database all important system numbers and values 
are stored as parameters at specific addresses.  Examples are measured voltages, PVs, status words, channel 
settings, limits, PID loop values.  
This database is updated regularly every 110ms (nominal).  At each update input channel values are recorded 
and output channel signals are set.  All computational blocks - PID loops, Toolkit blocks, user wiring and so on 
are also calculated and updated on each 110ms tick. 
Network communications is implemented as a gateway to the database.  Any network transaction driven by an 
external master effectively reads and writes to database parameters. The only difference is that the network 
updates are asynchronous - the transaction rate is set by the master. 
 
There are two key aspects to the use of the 2500:- 
1. the set-up or configuration of the system to implement the desired control strategy; 
2. the run-time execution of that strategy.  
This handbook concentrates on configuration aspects as being a convenient way to explore the considerable 
number of features available in the 2500 system. 
 
 

Digital 
communications 
ports RS485/422 

Address switch 

Configuration 
port RS232 

2500B Base  

Plant and Process 
Connections 

Optional Fuses 
or Isolator links 

I/O Control Module (IOC) 
Always mounted in the left hand position. 
This view shows the Modbus IOC 

2500M Plug-in I/O Modules 
Can be mounted in any order 
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1.6. THE COMPONENTS OF THE 2500 
The 2500 is normally supplied as a number of separate parts, identified by a unique model code printed on 
labels on the packaging and on each item.  These codes are explained in Appendix B. 
 
The parts can be briefly classified as follows: 
 the Base -      “2500B” 
 the I/O Controller Module -  “2500E” (or the superseded “2500C”) 
 the I/O Modules -    “2500M” 
 the Terminal Units -    “2500T” 
 the 24V Power Supply -   “2500P” mounted separately from the 2500 base 
 Accessories -     “2500A” (e.g. cables and terminators) 
 

The electrical interconnection of these parts is shown in the block diagram below. The Base unit contains a PCB 
linking the modules together - the I/O Bus. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-2:   2500 Block Diagram 

 

1.7. UNPACKING THE INSTRUMENT 
The instrument is despatched in a special pack, designed to give adequate protection during transit.  Should 
the outer box show signs of damage, it should be opened immediately, and the contents examined.  If there is 
evidence of damage, the instrument should not be operated and the local representative contacted for 
instructions.  After the instrument has been removed from its packing, the packing should be examined to 
ensure that all accessories and documentation have been removed.  The packing should then be stored against 
future transport requirements. 
 
 
 
 
 
 
 

Terminal unit 

2500T 

IOC 
module 

2500C or 
2500E 

I/O 
module 1 

2500M 

I/O  

module 2 

2500M 

I/O  

module 3 

2500M 

I/O  

module n 

2500M 

Plant or Machine under control 

Internal I/O bus 

Terminal unit 

2500T 

Terminal unit 

2500T 

Terminal unit 

2500T 

Terminal unit 

2500T 

Modbus or Profibus 
or Devicenet 

communications to 
host PC or Display 

Unit 

∫∫ 

∫∫ 

→ 

→ 
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1.8. MECHANICAL INSTALLATION 
The 2500 base unit is intended to be mounted in an enclosure, or in an environment suitable for IP20 rated 
equipment.  It can be DIN or bulkhead mounted.  When mounted on DIN rail it is locked with the clamps at each 
end.  The unit can be mounted in any orientation, but it is normal to refer to the I/O Bus PCB as the top, as in 
Figure 1-3 below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-3:  The 2500 Base and Terminal Units 

Warning 
The equipment should not be operated without a protective earth conductor connected to one of the 
earth terminals on the base unit.  The earth cable should have at least the current rating of the largest 
power cable used to connect the instrument.  The protective earth cable should be terminated with a 
suitable tinned copper eyelet, retained by one of the screw and washer supplied with the base unit, 
tightened to a torque of 1.2Nm (10.5lbin).  This connection also provides a ground for EMC purposes. 

Dimension B 

2 module 46 mm 

4 module 96 mm 

8 module: 200 mm 

10 module: 249 mm 

12 module 300 mm 

16 module 402 mm 

  

I/O Bus PCB 

Location 
tabs 

Safety Earth 
connection 
(two places) 

DIN rail fixing clips 
DIN rail 

fixing clips 

DIN rail 

B 

180mm 
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1.8.1. DIN Rail Mounting 
For DIN rail mounting, symmetrical, horizontally-mounted 35x7.5 or 35x15 DIN rail to BS EN50022 should be 
used. 

1. Mount the DIN rail, using suitable bolts, ensuring that it makes good electrical contact with the 
enclosure metal work either via the bolts or by means of a suitable earthing cable. 

2. Loosen the screws (‘A’ in Figure 1-3) in the base unit, two or three turns, and allow them, and the 
associated fixing clips to slide to the bottom of the screw slot. 

3. Lower the base unit onto the DIN rail such that the top edge of the rail fits into the slot on the underside 
of the support bar (see Figure 1-3) 

4. Slide the screws ‘A’ and associated clips as far as they will go towards the top of the screw slots, 
ensuring that the top of each fixing clip locates behind the bottom edge of the DIN rail. 

5. Tighten the screws, and check that the base unit is fully secure on the rail. 
 

1.8.2. Panel Mounting 

Warning 
Bolts heads must not exceed 5mm in height, or there will be insufficient isolation clearance between 
the bolt head and the relevant terminal unit(s). 

1. Remove the screws (‘A’ in Figure 1-3) and associated fixing clips. 
2. Holding the base unit horizontally on the panel, mark the position of the two holes on the panel 
3. Drill two suitable holes in the panel and use two suitable bolts (M5 recommended) to secure the base 

unit to the panel, ensuring that good electrical contact with the enclosure metal work is made either via 
the bolts or by means of a suitable earthing cable. 

 

1.8.3. Terminal Unit Installation 
1. Isolate the supply power to the instrument 
2. Insert the tag at the top of the terminal unit printed circuit board into the relevant slot in the Base Unit 

(action ‘B’ in Figure 1-4.) 
3. Press on the bottom of the terminal unit until a ‘click’ confirms that the retention clip has sprung back 

into position to secure the terminal unit (action ‘C’). 
 

Note:  If the Base Unit is not fully populated a blank Terminal Unit (supplied) must be fitted 
immediately to the right of the final module position in order to maintain IP20 rating. 

 

1.8.4. Terminal Unit Removal 
1. Remove any module fitted on the terminal unit (section 1.8.6 below) 
4. If necessary remove all wiring from the terminal unit 
5. Press the retention clip at the bottom of the terminal unit and lift the terminal unit out (action ‘D’). 
 

 
 

Figure 1-4:   Terminal Unit installation/removal 
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1.8.5. To Fit a Module 
 

Note:  Polarising keys prevent modules from being fitted to unsuitable terminal units. 

 
1. Pull the module retaining lever forwards into the unlocked position as shown in Figure 1-5. 
2. Offer the module up to the terminal unit and the backplane, and push home. 
3. Return the retaining lever to the locked position. 
 

1.8.6. Module Removal 
 

1. Pull the module retaining lever forwards into the unlocked position as shown in Figure 1-5. 
2. Disengage the module from the backplane connector and lift the module out of the base unit. 
 

 
 

Figure 1-5:  I/O Module (Side View) 
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1.9. I/O MODULE FUNCTIONS 
The 2500 system provides I/O modules designed to accept wiring directly from common control plant 
transducers , such as thermocouples, transmitters, valve positioners.  The I/O modules provide the basic 
hardware interface.  Software features adapt this interface for different ranges or functions, and add signal 
processing capability.  The following is a summary of the hardware interface capability:- 
 

Analogue input 
modules 
provide:- 

• 150mVd.c. range at high impedance  
• 10Vd.c. range through a medium impedance attenuator 
• 2V high-impedance range is provided for Zirconia probe applications  
• 4-20mA range is supported with appropriate terminal units 
• Linearised 3-Wire resistance measurement  
• Potentiometer input 
• Linearised thermocouple measurement.  The TC terminal units support a cold 

junction temperature sensor for thermocouple applications for automatic CJC 
 

Analogue 
output modules 
support:- 
 

• 4-20mA  
• 0-10Vd.c. ranges, switched by software. 

Digital input 
modules 
accept:- 
 

• Industrial logic levels (24Vd.c.) 
• Line supply (115Va.c. or 230Va.c.),  
• Switch contact inputs.  Debounce and event detect is included. 

Digital output 
modules 
provide:- 
 

• Switched outputs for 24Vd.c. applications at up to 100mA.  
• Channels can be configured for time proportioning on/off and valve position 

algorithms. 

Relay modules 
provide:- 
 

• Contacts outputs for power applications to 2A at 240Va.c. 
• Channels can be configured as digital output modules 
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2. Chapter 2    The IOC Module 
2.1. OVERVIEW  

 

The Input / Output Controller module (IOC) is the central 
processing unit of the 2500 system. 
 
The IOC maintains a database of all system parameters, 
updated on a regular tick interval for consistent control 
loop behaviour.  
Parameters are at fixed published addresses, so any subset 
of parameters can be easily accessed through network 
communications. 
Each parameter has attributes by design - visibility, 
alterability and volatility. This last means that critical 
information (like the configuration) is preserved even after 
power-down. 
 
 

Figure 2-1:   The IOC 

 
All I/O modules are controlled by the IOC as a background task.  The IOC:- 
• verifies I/O module types fitted against the configuration specified 
• initialises and tests modules at start-up and with hot-swap 
• sets the hardware to ranges appropriate against the configuration 
• sets module electrical outputs or reads inputs on a regular tick 
• maintains a set of alarms to track faults and exceptions 
 

Complex strategies can be built up from calculation blocks and tools, operating on the raw input and output 
data connected together with user defined software "wires": 
• Up to 8 PID control blocks provide instant sophisticated control loops 
• "Toolkit Block" functions provide user-wireable software components like timers, totalisers and counters 
• Alarms provide limit control and easy exception handling 
 
The IOC supports several communications interfaces for configuration and large networked systems, SCADA 
packages, T940 and the Visual Supervisor, PLCs and so on: 
• an RS232 interface using an RJ11 connector is used for system configuration 
• Modbus 3-wire or 5-wire communications 
• Profibus DP or Profibus DPv1 communications 
• DeviceNet communications 
The last three each require a dedicated version of the IOC and Terminal Unit; the "Configuration Port" is 
standard on all IOCs. 
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2.2. OPERATING MODES 
The IOC offers several operating modes:-  
 The 'Run' mode provides the normal execution of the I/O and control strategy.  
 The 'Config' mode unlocks system parameters for configuration or re-configuration, while inhibiting the 

output modules.  
 The 'Standby' mode is a transition mode normally inserted by the IOC when changing from one mode to 

another. 
 The 'Fail' mode is drastic, invoked only if the IOC detects a hardware problem 
 

Note:- The IOC contains an applications specific program - the 'control strategy'. Obviously accidental 
change to a strategy could adversely affect the controlled plant, even introducing risk of hazard.  
To avoid risk the IOC 'Config' mode forces I/O module outputs to a electrical low levels.  While it is 
possible to change some parameters in 'Run' mode; any such change must be implemented only with 
the utmost caution.   
Similarly when changing an IOC there is a risk of accident - for example, the new IOC could have an 
inappropriate strategy configured for the specific application.  Before changing one IOC for another 
ensure that the new module contains the correct strategy.   
A ‘Configuration Key’, order code 2500A/CFGKEY, is available which should be plugged into the RJ11 
socket before the IOC is powered up (see also section 2.2.3.).  With this in place the IOC will start up in 
the safer 'Config' mode.  This plug must be removed from the IOC after power-up.  The IOC will stay in 
the 'Config' mode after the plug is removed, and the strategy can be verified in any way appropriate.  
The 'Run' mode can then be set by the network master by writing to the Requested Instrument Mode 
parameter.  
 

2.2.1. Run Mode 
The operating mode or 'Run' mode is the normal machine state.  In 'Run' mode the green indicator LED marked 
"" is illuminated, the 'C' and 'S' LEDs extinguished.. 
Control loops, toolkit blocks, wires, alarms, input and output blocks are all executed and the parameters in the 
database updated.  Appropriate parameters (for example, output channel PVs) can be modified over network 
communications. 
Parameters associated with the design of the strategy are locked; for example, soft wires cannot be modified; 
channel types cannot be changed; calibration values cannot be modified. 
Software versions from 3.26 permit limited on-line reconfiguration of many 'Config' parameters to allow fine-
tuning of a strategy design.  This does not include critical control loop parameters.  This state is protected with a 
special parameter for 'Live Configuration', ‘LveCnf’ in the Operator/System list. 
 

Due care should be taken when changing the value of 'LveCnf'; it should NOT be left enabled. 

 

 

2.2.2. Configuration Mode 
'Configuration' or 'Config' mode is intended for control strategy design, set-up and test.  For this reason this 
mode permits complete alteration of blocks and wires.  Configuration is easily performed from iTools from the 
'Config' port or the Modbus network communications port. When in 'Config' mode the yellow indicator LED 'C' 
is illuminated. 
 

Configuration mode can be entered by:-  
 powering up with the 'Config' lead connected to a PC 
 toggling the iTools access level icon 
 setting the ‘Instrument Mode’ parameter to 2 with iTools 
 any means over the network communications port 
 

If the IOC has been put into configuration mode it will stay in 'config' even through power-cycle until it is 
explicitly set into operating mode. 
 

In 'Config' mode digital outputs are disabled (logic 0 output), analogue outputs drive the level defined by the 
electrical low limit (IOL). 
 

! 

! 
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2.2.3. Configuration Key 
The configuration key ensures that the IOC powers up in configuration mode.  The key is fitted into the 
configuration port of the IOC and has the same effect as powering up the IOC with the config lead connected to 
a PC, see section 2.2.2.   
 
It is recommended that the key is fitted, for example, when a new or spare IOC with unknown configuration 
program is used to replace another IOC in an on line system.   
 
 

 
 
 

Figure 2-2:   Configuration Key Shown Fitted 

 
 
 
 

2.2.4. Standby Mode 
The 'Standby' mode is a transition mode normally invoked by the IOC when changing between Run and Config 
at start-up.  A yellow LED 'S' on the front of the IOC is illuminated in 'Standby' mode. 
 

This mode inhibits changes to parameters and forces output modules to electrical low levels. 
 

This mode would not normally be required by users. 
 

2.2.5. Fail Mode 
'Fail' mode is only entered when the IOC detects a hardware fault during normal operation. This state is 
consequently rare.  The red LED 'X' on the front of the IOC will blink rapidly in the 'Fail' mode. 
 

On software versions V3.30 or V4.00 or higher the user can save the strategy as a clone file; the system can only 
be recovered by forcing a cold-start.  This is a return-to-factory repair. 
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2.3. CONFIGURATION PORT 
The IOC configuration port ('Config' port) is provided on the front face of the IOC.  This RJ11 socket supports 
EIA232 with a fixed 9600 baud rate, no parity, 8 bit data and 1 stop bit for extremely simple and reliable 
connection to a PC.  Any PC based software supporting Modbus can thus communicate with the 2500 system - 
including the iTools package.  A suitable interconnection cable is available, part 
2500A/CABLE/CONFIG/RJ11/(PINDF/3M0. 
 

Pin connections 
RJ11 into IOC 

Pin connections      
9 way D-type to PC 

6  (no connection)  

5  (RX) 3  (TX) 

4  (TX) 2  (RX) 

3  (0V) 5  (0V) 

2  (no connection)  

1  (24V (in))  

(Screen) (Screen) 

 
Table 2-1:   Connections for IOC to PC Link 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-3:   RJ11 Configuration Pin Identification 

 
When the IOC is powered up with a PC connected to the RJ11 configuration port, it will start in the 'Config' 
mode.  The port always uses network address 255, overriding any address switch setting.  When the 'Config' 
lead is in use the Terminal Unit network connections are disabled, whether Profibus, Modbus or DeviceNet. 
A plastic cover is supplied which must be fitted when the IOC is in normal operation. 

RJ11-6 way 

Cable to PC... 

Connectors at the 
back in this view 

 16 

View into socket 

6 

 1

PAC 2500 
Modbus 
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2.4. STATUS INDICATION 
Five LED indicators show the status of an IOC module as follows: 

LED Colour ON ALL OFF 

 
S 
C 

Green 
Yellow 
Yellow 

Normal operation 
Standby (See Note 1) 
Configuration 

Self test failed on 
power up  
 

&C 
both on 

As 
above 

Normal operation with online IO 
reconfiguration enabled 

Self test failed on 
power up 

 

LED Colour ON OFF 

 
 

Yellow IO network or configuration port 
communicating 

 

   

LED Colour ON   (See also Note 1) OFF 

X Red 
 

1. Non-volatile RAM checksum 
failure  

2. Custom linearisation checksum 
failure 

3. I/O network watchdog (if 
configured) 

4. Invalid base size detected 
5. Module missing, faulty or wrong 

type  

Normal operation 

 

  Flashing 

X Red Power on self test failed Refer to section 2.5 
 

Figure 2-4:   IOC Status Indication 
 

 
The DeviceNet health indicator is not shown; this lights red if the network side is unpowered or non-functional. 
Note 1: 
1. Non-volatile RAM checksum failure.   

Identified by the Non-Volatile Memory Failure Flag in Operator → SYSTEM → NVFail.   

2. Custom linearisation checksum failure.   
Identified by Custom Linearisation Failure Flag in Operator → SYSTEM → ClinFl.  
Either condition 1 or 2 above will cause the red LED to flash and the system to go into fail safe mode. 

3. I/O network watchdog.   
Identified by Custom I/O Network Watchdog Flag in Operator → SYSTEM → NWdged and indicates that 
network communication has not occurred for longer than the watchdog duration.  The watchdog may be 
configured to recover automatically.  This will clear the Nwdged flag when communications are restored.  
The flag can be cleared by writing 0 to the IO Network Watchdog Timeout Flag found in Operator → 
SYSTEM → IONwdg. 

4. Invalid base size detected.   
Indicated by any value other than 0, 2, 4, 8, 10, 12 or 16 in the Base Size parameter found in Operator → 
SYSTEM → BaseSz.  This indicates genuine hardware fault as the IOC does not recognise the hardware 
base size code being read from the backplane. 

5. Any IO (channel or module) status bit set except the channel not used bit (bit 2 of the channel status).   
Indicated by the Global IO Status parameter found in Operator → SYSTEM → Iostat.  The Global IO Status is 
an OR of all the module status parameters (found in IO → Module xx → MODxx → ModSta) in the most 
significant byte, and an OR of all the channel status parameters (found in IO → Modulexx → Mxx_Cy → 
ChStat) in the least significant byte. 
To clear this fault all modules and channels should be indicating no fault.  For analogue inputs this may 
require a link on any unused input or configuring them as V to remove any spurious sensor break 
indications.  
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2.5. INITIALISATION AND POWER ON SELF TEST 
The IOC goes through an initialisation sequence when power is applied, and will start in either 'Run' mode or 
'Config' mode.  The tests illuminate the indicators in a specific pattern.  
 
 

 LED 
Test  

Flash ROM RAM 
Test 

Nvol 
Test 

Watch-dog    Test  Nvol 
Check-sum 

Test 

Initial-
isation 

    Full 
Operation (2) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-5:   LED Indication During Start Up 

Power On 

ROM 
Test Pass 

Nvol  
Test Pass 

LED Test RAM  
Test Pass 

Watchdog 
Test Pass 

Nvol Checksums 
Test Pass 

(2) 

Rom Test 
Fail 

RAM Test Fail 

Nvol Test Fail 

Watchdog Test Fail 

‘Flashing' 

LED On 
 

LED Off 
 

Top LED is ON if the 2500 is in operation level 

Centre LED ON if the 2500 is in standby 

Lower LED ON if the 2500 is in configuration mode 

 

C 

  
S 

Note 1 
 

Note 2 
 

Nvol Checksum failure 
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2.6. MODBUS IOC AND TERMINAL UNIT 
The Modbus IOC is identified by the front label and the order code printed on the side label. This IOC must be 
used with the Modbus Terminal Unit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-6:   Modbus IOC Module and Terminal Unit 

The Modbus network connection and the 2500 system power connections are provided by the Terminal Unit; 
the latter with standard screw terminals, the former with RJ45 sockets. 
The network connection is used for connection to an operator interface unit, a PC running iTools or 3rd party 
system, or to link further slave 2500 controllers or other Modbus equipment in a system. 
The IOC can also be configured from the Modbus network if required. 
 
 

2.6.1. Connections to the RJ45 Sockets 
The two RJ45 sockets are parallel connected for network daisy-chaining, with the connections: 
 

RJ45 pin Colour EIA-485 2 wire 4 wire 

1 Orange / 
White 

B D- TX- 

2 Orange A D+ TX+ 

3 Green / White Gnd Gnd Gnd 

4 Blue - - - 

5 Blue / White - - - 

6 Green Gnd Gnd Gnd 

7 Brown / White B - RX- 

8 Brown A - RX+ 

Screen - - - - 

NOTE:  Blue and Blue/White Wires are not used. 
 

CABLE COLOURS MAY CHANGE! 
 

Table 2-2:   RJ45 Modbus Connections 

Plastic covers are supplied which must be fitted when the system is in normal operation. 

! 

* RS422-485 Modbus communications selection 
Fit both links: 
 
1 – 2 for 2 (3) wire Modbus (default) 
2 – 3 for 4 (5) wire Modbus (default) 
 
Note:  Earlier units were fitted with a single link for 
2(3) wire or no link for 4(5) wire. 
 
Fit suitable termination ONLY on the last device in 
the chain. 
The use of the termination plug is recommended 

Address Switch 

Digital Communications 
Ports  
RS485 

24V power supply terminals 

Module connector 

I/O Module 
interconnection bus 

RS485/422 Links * 

1 
2 
3 

Configuration Port (RS232) 

LED Status Indicators 
 

0V +24V 
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2.6.2. The RJ45 Modbus Line Terminator 
All network communications lines must be terminated using appropriate impedance. To provide correct resistor 
values for CAT-5 cable and to match the RJ45 wiring the terminator order code 2500A/TERM/MODBUS/RJ45 
should be used.  This can be plugged into the free socket in the last 2500  base in the chain; it is presumed that 
the other end of the cable (usually at the network master) is likewise terminated. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-7:   Modbus IOC Module and Terminal Unit 

 

2.6.3. The Modbus Address Switch 
The base must be given a unique Modbus address when working in a Modbus network.  The address can be set 
by switch, an 8-way DIP type  mounted on the Terminal Unit.  It allows addresses 1 to 63 to be set in a binary 
code with the right-most six switches, lsb to the right.  The left two switches define parity (on/off, odd or even).  
 
 
 
 
 

 

Figure 2-8:   The Modbus Address Switch 

If the Address switch is set to 0 the IOC will use the software defined address in the parameter 'Addr'.  This can 
be used for base addresses from 64 to 247. 
 

2.6.4. Baud Rate 
Baud rate is set using iTools.  The default is 9600.  The table below shows the rates that are supported in 
different software versions: 
 

 Software version 

Baud rate V1.XX V2.XX V3.26+ 

2400    

4800    

9600    

19,200    

38,400    

 
Table 2-3:   Baud Rates 

 
 
 
 
 

 

MB120 

AN100 Labels 

Moulding 
colour 
Black 

Resistor 
Network 

120Ω 5% 1 

100Ω 5% 

120Ω 5% 8 

8 

1 

P     O    32   16     8      4      2     1 

P      E              ..Address.. 

P Parity On 

P Parity off 

O Odd Parity 

E Even Parity 

Switch Position 

ON 
 
OFF 
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2.7. PROFIBUS IOC AND TERMINAL UNIT  
The Profibus IOC is identified by the front label and the order code printed on the side label. This IOC must be 
used with a Profibus Terminal Unit.  There are two TU options: a standard, a 9-Way D-Type and a dual RJ45 type 
as shown in Figure 2-9.  The latter is similar to the Modbus terminal unit (Figure 2-6), but must not be confused; 
the Modbus unit includes capacitors that could affect high-speed data. 
The IOC may be ordered for Profibus DP or Profibus DPv1. Note that for software versions later than v3.43 (and 
v4.10) DP/DPv1 may be configured within the IOC (see section 6.2.1). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-9:   ProfiBus IOC and Terminal Unit 

RJ45 Communications 
Connectors 

Address Switch 

9-way D-Type 
Communications 
Connector 

24V power supply 
terminals 

Configuration 
Port 
(RS232) 

Module connector 

LED Status 
Indicators 
 

0V +24V 

* Termination Links 
Fit both links: 
1 – 2  to terminate the Profibus network 
2 – 3  no termination 
Fit suitable termination ONLY on the last device in the chain. 
Note:  Earlier units were fitted with a single link.  On these units this link has no function and the system 
should be terminated using the termination plug 
On later units fit either the termination unit or both links in position 1 and 2. 
 
 
 

1 

2 

3 

0V +24V 

* Termination Links 
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2.7.1. Connections to the Network Connectors 
The 9 pin D-Type connector is intended for installations using standard Profibus cables: 
 

Pin No. Signal Name Meaning 
1 Shield Shield (ground) 
2   Not used 
3 RxD/TxD-P Receive/Transmit – Data 'P' 
4   Not used 
5 DGND Data ground 
6 VP      Voltage – Plus 
7   Not used 
8 RxD/TxD-N Receive/Transmit – Data 'N' 
9   Not used 

 

Table 2-4:   Profibus 9-pin D-TypeConnections 

 
The two RJ45 sockets are parallel connected for network daisy-chaining, with the connections: 
 

RJ45 pin Colour Signal 

1 Orange / White Data 'N' 

2 Orange Data 'P' 

3 Green / White Gnd 

4 Blue - 

5 Blue / White - 

6 Green +5V 

7 Brown / White - 

8 Brown - 

 

CABLE COLOURS MAY CHANGE! 

 
Table 2-5:   RJ45 Profibus Connections 

 

2.7.2. The Profibus Address Switch 
The address switch is mounted on the IOC terminal unit.  Addresses from 1 to 127 can be set. 
 
 
 
 
 
 
 

Figure 2-10:   The Profibus Address Switch 

! 

       64   32     16    8      4     2      1 

Profibus   Address 

The Profibus master will set 
the baud rate to cope with 
the slowest slave. 

Switch Position 

ON 
 
OFF 
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2.7.3. Profibus 9 pin Connector Line Termination 
For 9-pin connectors standard Profibus cables should be used.  These cables have special headers on the 9-pin 
D male connector which allow one or two cables to be connected inot them and have a small termination load 
built in with an ON’OFF switch, which is set to ON at the two ends of the links. 
The Profibus standard states that two types of cable, ‘Line A’ and ‘Line B’ may be used.  The termination details 
for these two types of cable are shown below. 
 
 
 
 
 
 
 

Figure 2-11:   The Profibus 9-pin Connector Terminations 

 

2.7.4. The RJ45 Profibus Line Terminator 
The 9-way connector is not provided with terminators; termination is the responsibility of the network designer. 
The RJ45 connector system can be used for local installations for ease of wiring.  This requires special 
termination impedance (nominal 100Ω).  This method of cabling is limited to 16 slaves and must not be directly 
connected to a "standard" Profibus cable. 
The terminator part number 2500A/TERM/PROFIBUS/RJ45 is designed for this application.  Network wiring and 
termination techniques are indicated in chapter 10. 
 
 
 
 
 
 
 
 
 

Figure 2-12:   The Profibus RJ45 Terminator 

390Ω         220Ω       390Ω 

5                    8                3                   6 

Profibus Line A 

390Ω         150Ω       390Ω 

5                    8                3                   6 

Profibus Line B 

 

  PROFI Labels 

Moulding 
colour  
Grey 130Ω 1% 

180Ω 1% 

180Ω 1% 

1 

8 

8 

1 
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2.8. DEVICENET IOC AND TERMINAL UNIT  
The DeviceNet IOC is identified by the front label and the order code printed on the side label. This IOC must 
be used with the DeviceNet Terminal Unit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-13:   DeviceNet IOC and Terminal Unit 

 
 
 
 
 
 

Address Switch 

5-way DeviceNet 
Communications Connector 

24V power supply terminals 

Configuration Port 
(RS232) 

Module connector 

LED Status Indicators 
 

 

1 
2 

3 
4 
5 

0V +24V 
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2.8.1. Connections to the Terminal Unit 
The DeviceNet Connector is selected to comply with the DeviceNet Open Connector specification (5-way, 
5.08mm pitch).  
 

The mating DeviceNet connector (female Open Connector) is supplied to facilitate screw-in user wiring.  The pin 
functions are marked on the TU. 
 

Pin Number Function 

1 V+ 

2 CAN_H 

3 DRAIN 

4 CAN_L 

5 V- 

 
Table 2-6:   5-Way Connector Pin Functions 

2.8.2. DeviceNet Terminators 
The DeviceNet specification states that the bus terminators should not be included as any part of a master or 
slave.  They are not supplied as part of the 2500 DeviceNet termination assembly.  
 

2.8.3. Power 
The DeviceNet bus is powered form the system, the load being around 100mA. 
 

2.8.4. The DeviceNet Address Switch 
The address switch is mounted on the DeviceNet IOC terminal unit.  Addresses from 0 to 63 can be set. The 
leftmost two switches may be used to set the DeviceNet baud rate and also to disable the switches,  allowing 
the baud rate and address to be set by iTools. 
 
 
 
 
 
 
 

Figure 2-14:   DeviceNet Address Switch 

BAUD    32   16     8      4      2     1 

RATE              ..Address.. 

Switch Position 

ON (1) 
 
OFF (0) 

Sw        Baud rate 
0 0       125K 
0 1       250K 
1 0       500K 
1 1       Baud and address set 
             by iTools 
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2.9. ETHERNET IOC AND TERMINAL UNIT  
The Ethernet IOC is identified by the front label and the order code printed on the side label. This IOC must be 
used with the Ethernet Terminal Unit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-15:   Ethernet IOC and Terminal Unit 

 
The Ethernet IOC supports 10BaseT to IEEE802.3 and uses the Modbus TCP protocol. 

 

Address Switch 

24V power supply terminals 

Configuration Port 
(RS232) 

Module connector 

LED Status Indicators 
 

0V +24V 
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2.9.1. Connections to the RJ45 Socket 
The RJ45 socket is connected according to the Ethernet standard. 
 

RJ45 pin Colour Signal 

1 Orange / 
White 

TX+ 

2 Orange TX- 

3 Green / White RX+ 

4 Blue - 

5 Blue / White - 

6 Green RX- 

7 Brown / White - 

8 Brown - 

 

CABLE COLOURS MAY CHANGE! 

 
Table 2-7:   RJ45 Ethernet Connections 

 

2.9.2. The Modbus Address Switch 
The address (Modbus TCP slave i.d.) switch is mounted on the Ethernet IOC terminal unit.  Addresses from 1 to 
63 can be set on the rightmost 6 switches. The leftmost switch may be used to enable DHCP Ethernet 
addressing. 
If all switches are off, the Modbus address and DHCP enable will be determined by the value seen in the iTools 
Operator.COMMS list – see section 6.2. 
 
 
 
 
 
 

Figure 2-16:   Modbus Address Switch 

 

 

 

 

 

 

 

 

 

  

! 

D            32   16     8      4      2     1 

D             Modbus Unit ID 

D   DHCP enabled 
_ 
D   DHCP disabled 
 

Switch Position 

ON 
 
OFF 
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3. Chapter 3    iTools 
3.1. OVERVIEW 
iTools is a Windows based software package providing a user interface into the 2500 system (as well as other 
Eurotherm products). iTools provides tools to configure, commission and monitor any 2500. 
 

iTools implements Modbus RTU communications via any serial port on personal computers under Windows 
95, 98, ME, 2000 or NT version 4. 
 

NOTE:  the minimum specification requirements for the PC depend to some extent on the operating system - 
for further details refer to the iTools "ReadMe" file.  Any modern PC with at least a Pentium-166, 64M of RAM, 
40M of hard disk space free and one serial port free should cope.  This is the minimum specification if running 
Windows NT.  
 

iTools is started in the conventional way either by double clicking the on screen icon or choosing iTools.exe in 
the appropriate folder. 
 

3.2. CONNECTING ANY 2500 TO A PERSONAL COMPUTER 
There are three methods of connecting the 2500 system to a Personal Computer (PC) for configuration.  
 

The simplest connection is through the 'Config' port.  All versions of IOC support this port (see Chapter 2).  The 
'Config' port is RS232 compatible, so can be wired directly to any PC COM port with an appropriate adapter 
cable. 
 

The other connection methods make use of the network communications port. 

The Modbus version IOC requires a converter - RS232 to RS485.   

The Ethernet IOC can be connected directly to the network card in the pc by use of a cross-over cable. 
Alternatively it can be connected to the same network as the pc using a normal cable. 
 

3.2.1. To Connect a Single 2500 Controller to a PC 
Connection of any 2500 to a PC can be made through the RS232 configuration port located on the front of the 
IOC module.  
 

This cable plugs directly into the IOC and a COM port of the PC as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-1:  Connection between IOC and PC using the 'Config' Port 

COM Port 

iTools 

RJ11 Cable Assembly, Ordering Code 

2500A/CABLE/CONFIG/RJ11/9PINDF 

 
 

PC configuration 
station 

Power 
supply 

 

Fit the plastic cover over the 
RJ11 socket when not in use 

With this PSU and cable 
the IOC can configured 
remotely 
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3.2.2. To Connect multiple 2500 Controllers to a PC 
 

Modbus IOC 

A number of Modbus 2500 controllers can be networked together and connected to a network master - iTools.  
As the IOC supports RS485 (either 3-wire or 5-wire) a converter is required at the PC COM port.  The KD485 
RS485/RS232 communications converter is suitable. 
All network components (PC, 2500 and KD485) must be set up as appropriate and compatible for a network - 
each slave with a different address, each working with the same baud rate and parity settings, all components to 
work 5-wire (duplex) or 3-wire. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-2:  Connections for multiple Modbus instruments 

 

 
  

RJ45 Comms Line 
Terminator 

Each base must be set 
to a unique address 

RJ45 Cable Assemblies, Eurotherm Type 

2500A/CABLE/MODBUS/RJ45/RJ45/0M5 

2500A/CABLE/MODBUS/RJ45/RJ45/3M0 

 

iTools 

PC 

Fit suitable 
termination 
resistor on Rx 
side 

 

 

RS485/232 
Converter 
KD485 

RxA RxB TxA TxB 
Com 

RS232 

RS485 
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Ethernet IOC 

If the Ethernet IOC is connected directly to the pc using a cross-over cable, any IP address may be used. 
Alternatively, the Ethernet IOC must be configured for the network by obtaining a compatible fixed IP address 
and Subnet mask or by setting up DHCP – see your Network Administrator.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 3-3:  Connections for multiple Ethernet instruments 

 
In order for iTools to be able to detect the Ethernet IOC, it may be necessary to set up the Modbus TCP ports on 
the EuroMBus server.  To display the server from within iTools, select Options, Advanced, Show Server. 
 
 

Network 
Hub/Switch 

RJ45 Cable Assembly, Eurotherm Type 

2500A/CABLE/MODBUS/RJ45/RJ45/0M5 

2500A/CABLE/MODBUS/RJ45/RJ45/3M0 

 

iTools 

PC 
Each IOC must be set to a 
unique IP address. 
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Within the EuroMBus server select Add, Ports then click on the TCP/IP tab: 

 
 
 
Click Add, or select one of the existing ports and click Edit. 
 

 
For DHCP addressing, your Network Administrator will allocate a Host name for the instrument. This should be 
entered into the Host Name/Address box above. The instrument should be set to DHCP by setting the DIP 
switch – see section 2.9.2. 
 

iTools will now search this IP address when scanning for instruments (see section 3.3) 

Enter a meaningful name in the Name field. 

Enter the IP address in the Host 
Name/Address field.  

Ensure the Enabled box is checked.  

Click OK. 

For fixed addressing, this address must be 
programmed into the Ethernet IOC using 
the configuration cable – see Section 3.2.2. 
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3.3. STARTING iTOOLS - DEVICE DETECTION 
As "network master" iTools must identify any and all devices connected to the network - even if just one 2500 is 
connected through the 'config' port.  On request iTools will automatically search for all devices with unique 
network base addresses. 

 
To initiate the search, press the button: 
 

 

 

A dialogue might ask for a start address.  For a single IOC connected from the 'Config' port leave the start at 
255; for networking multiple systems save time by specifying the lowest address used. 
 

When all connected instruments have been found appropriate icons are a displayed in the Panel window 
(assuming Panel Views has been checked in the View menu): 
 

 
 

Figure 3-4:  2500 icons in the Panel View window 

To save time (in a large network) it is possible to stop iTools scanning by pressing the Stop Scan button once all 
relevant bases have been identified. 
 

To work with any particular base simply click the appropriate icon.  
 

If working with a single IOC through the 'Config' port (and no other ports enabled) the network scan stops 
automatically and the device is automatically selected. 
 

3.4. SETTING ACCESS LEVEL 
The IOC can run in different modes, as discussed in Chapter 2 (section 2.2).  The 'Operating' or 'Run' mode in 
particular limits access to features; the most important of which is that critical loop parameters are secured, to 
prevent accidental changes to an active process.  
The 'Configuration' or 'Config' mode provides full access to parameters for set-up, but limits functions; in 
particular, output channels are limited to OFF (digital outputs) or electrical low (analogue outputs).  Note this 
particularly when testing output channels. 
 

3.4.1. Operating Mode 
For most of its working life the IOC will be in 'Operating' or 'Run' mode, executing the programmed control 
strategy.  In this mode inputs and outputs are active, PID loops and Toolkit Blocks operate and the internal 
database regularly updated.  Any network master can use the communications link to access the database and 
the parameters. 
iTools will indicate that any connected 2500 is in operating mode by displaying the 2500 icon with no additional 
symbols.  On the IOC the top (green) indicator LED marked “” is on. 
 

3.4.2. Configuration Mode 
'Configuration' or 'Config' mode is designed precisely for set-up of any 2500 system.  The 2500 is shipped with 
a collection of useful tools but no strategy.  To configure the 2500 for useful applications the user must define 
the needed I/O modules and "wire" the blocks together to perform the required task.  Sometimes changes are 
made on-site; for this reason, when the 2500 is in configuration mode it is NO LONGER controlling.  Outputs 
drive is effectively disabled. 

When the 2500 is in configuration mode the iTools icon is displayed with a yellow wrench symbol.    On 
the IOC the yellow indicator LED marked “C” is on. 
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3.4.3. Standby Mode. 
'Standby' mode is normally a transient state that the IOC enters while changing modes or when a fault is 
detected.  In Standby mode the IOC is not controlling but is also not in configuration mode.  This mode should 
not be deliberately set by the user.  

When the 2500 is in standby mode the iTools icon is displayed with a yellow hand symbol.    On the IOC 
the yellow indicator LED marked “S” is on. 
 

3.4.4. Changing Mode 
There are several ways to change the IOC run mode. 
 
 To enter 'Config' mode directly from iTools:- 
 

1. Click the “Access” button on the Toolbar, or 

2. Right click on the Instrument View (or the device name in the Device Browser).  From the pop up menu 
select Set Access Level  Configuration, or 

3. From the menu bar, click Device  Set Access Level  Configuration. 
 
When changing from 'Run' to 'Config' mode a warning is displayed on iTools, but no password or security code 
is required. 
 
Alternatively, simply power up the 2500 with iTools and the RJ11 'Config' connector plugged into the IOC 
'Config' socket.  This connection forces the 'Config' mode. 
 
 To enter 'Run' mode from iTools: 
 

1. Click the “Access” button on the Toolbar, or 

2. Right click on the Instrument View (or the device name in the Device Browser).  From the pop up menu 
select Set Access Level  Operator, or 

3. From the menu bar, click Device  Set Access Level  Operator 
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3.5. INSTRUMENT PARAMETERS 
 

In the 2500 system "Parameters" are the numbers and values that represent the state of the machine.  Each 
available parameter has a predefined address in the database.  Parameters in iTools are organised into folders 
which are applicable to a particular subject.  For example, to find a loop alarm setpoint go to Control → 
LOOP(number) → LO(number)ALM in the browser in iTools. 
Parameter values are of just two type: Real Values or Enumerated Values.  The former is altered from a dialogue 
window simply by typing in a new value.  Enumerated values require a selection from predefined options from a 
pull down list.  iTools displays each enumerated item with an integer value in brackets - the enumeration value.  
This is the value that would be used over network communications for reading or writing a new parameter 
value. 
Parameters are given fixed attributes, so may be Read Only or Read/Write.  Read Only parameters are 
displayed in blue and Read/Write parameters are shown in black in the parameter lists.  Only Read/Write values 
can be changed, and some parameters, such as configuration parameters, can only be changed if the access 
level is appropriate.  
iTools also allows irrelevant parameters to be hidden from view, reducing screen clutter. 
Once iTools has detected a 2500 system it is ready to display Parameter Lists for operation, monitoring or 
configuration. 
 

3.5.1. To Display Parameters 
Parameters are collected into related lists.  Controller Parameter Lists may be displayed in several ways: 
 

1. Double click on the required instrument view (or the instrument name in the Device Browser), or 

2. Right click on the instrument view (or the instrument name in the Device Browser) and select Parameter List 
from the pop up window, or 

3. Left click on the required instrument view.  From the Toolbar click Device Views  followed by Parameter 
List. 

 

3.5.2. To Find a Parameter  
 

If it is not known in which list the parameter resides, press the ‘Find’ tab which is located at the at the bottom of 
the browser section. 
You may search on  
 Parameter Names 
 Descriptions 
 Addresses 
 Comments 
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3.5.3. To Change Parameter Values 
The first step is to invoke the parameter edit dialogue.  There are several methods:- 

1. From the Parameter List window double click on the selected parameter; or 

2. From the Parameter List window right click on the selected parameter, and from the pop up menu select 
Edit Parameter Value; or 

3. From the menu bar select Parameter List and from the pop up menu select Edit Parameter Value 
 

A pop up window will appear: 
 
 
 
 
 
 
 
 

Figure 3-5:  Parameter value dialog 

The edit method depends upon parameter type.  If real (as in Figure 3-5 above) then simply type in the new 
value, then set by clicking the "Apply" dialogue button (if you want to use the same dialogue again), or click the 
"OK" button if finished with the dialogue. 
If the parameter offers a list the dialogue looks more like: 
 
 
 
 
 
 
 
 

Figure 3-6:  Enumerated value dialog 

Select the desired value from the pull-down list and click "OK" or "Apply" as before. 
Note that to change the above parameter example over network communications, say to AUTO, write the value 
0 to the parameter address; for manual MAN write 1. 
 

3.5.4. Example:  To Set Baud Rate 
1. From the Device Browser, click Operator → COMMS → Baud (in the right hand window) 

2. Double click this parameter 

3. From the pop up window click "" 

4. Select the required baud rate, and click OK or Apply 
 
The baud rate can only be changed if the 2500 is in Configuration Mode and it is appropriate to the 
Communication protocol 
 

3.5.5. Failure To Write a New Value 
If an attempt to write a new parameter value is unsuccessful the message ‘Value Rejected by Device’ might 
appear.  
This could happen if the controller is not in configuration mode and the parameter selected is a configuration 
parameter. 
Alternatively, an incorrect condition has been requested.  For example, if a module is configured as a Digital 
Input, selecting a parameter associated with any other type (AO, AI or DO) will be rejected. 
Note that there are many situations, particularly in Configuration Mode, where a new value is not formally 
rejected, it is just ignored. 
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3.6. PARAMETER AVAILABILITY AND ALTERABILITY  
A very large number of parameters are pre-defined in the 2500 
system.  
 

The Navigation tree example shown, taken from the iTools 
browser, shows the top list of folders available on a 2500 with 4 
way base.  
 

 iTools can hide folders and parameters that are not relevant to a 
particular set-up.  In this list iTools knows it is a 4 way base and 
has removed the I/O folders for I/O modules 5 to 16.  Note that 
this "list hiding" is delayed at start-up while the IOC 
communicates the parameter values and settings and 
synchronises its data base. 
 

In the same way iTools will hide and expose parameters 
depending on the actual configuration of the 2500 Unit and its 
mode – whether it is in Operating mode, Configuration mode or 
in Standby 
 

The List window will display the list associated with one of these 
folders - simply double-click on the folder to be viewed. 
 
 
 
 
 

Figure 3-7:  Browser view of 2500 folders 

 
 
For example, a double-click on the 
LOOP1 folder (of Figure 3-6) will 
display a list perhaps similar to this: 
Note: from the title bar the identifier 
COM1.ID255-2500-v222.  This 
identifies the device completely 
through the network connection: 
 
 
 
 
 
 
 
 

Figure 3-8:  LOOP1 parameter list 

 COM1 - the port on the PC running iTools that is connected to the 2500 
 ID255 - the Modbus address, in this case via the IOC configuration port 
 2500 - the product code 

V222 - the software version number. 
From the folder line below the title bar the path to the highlighted parameter on the navigation tree is:- 

Control → LOOP01 → L01PID → PB (the PID loop proportional band).  
By default only ‘available’ or relevant parameters appear on a page.  For example, relative cool gain does not 
appear in a heat only controller, and integral time does not appear in an On/Off controller.  
A parameter may be Read Only with the 2500 in operating mode, but Read/Write in Configuration mode.  An 
example is thermocouple linearisation type. 
Parameters coloured in black are Read/Write. 
Parameters coloured in blue are Read Only. 
Parameters in a grey banner are read only and depend upon the setting of another parameter.  For example, 
‘SP Rate Limit Holdback Value’ can only be altered if ‘SP Rate Limit Holdback Type ≠ OFF. 

See Chapter 4 

See Chapter 5 

See Chapter 6 

See Chapter 7 

See Chapter 8 

See Chapters 
9, 10, 11 and 12  

See Chapter 8 

42                                                                                                                                                            Part No HA027115  Issue 5  Feb -14 



2500 Controller  Engineering Handbook 

3.7. SETTING UP AN APPLICATION 
The 2500 can be set up to provide a wide range of application solutions.  To this end it offers I/O channel 
blocks, I/O module blocks, PID loop blocks, timer blocks, counter blocks... and more. 
To create any control strategy the Applications Engineer can connect these blocks together using software 
‘wiring’ in whatever way is needed to provide the required control functions. 

3.7.1. What is a Function Block? 
A function block is a software entity that performs a particular task upon 'input' data to compute 'output' values.  
The actual algorithm may be dependent upon other input settings. 
For example, an input channel is a block - the terminal signal being the 'input', the reported PV the output.  The 
parameter 'Channel Type' will modify the response.  The COUNTER block is a purely computational block, 
producing a count value 'output' from and event 'input'.  Note that there are usually several instances of each 
function block type; for example, there might be eight PID loop blocks. 

3.7.2. Why use Function Blocks? 
Function Blocks are tested building blocks intended to provide general purpose tools to allow speedy 
construction of complex systems.  This methodology reduces problems and speeds up the design cycle while 
retaining the flexibility to produce different applications. 

3.7.3. Function Block Wiring Example 
To make use of function blocks the various inputs and outputs must be interconnected - "wired".  This software 
"wiring" (not to be confused with electrical wiring!) is a method of passing an output parameter value to the 
input parameter of another block. 
Consider the simple task below, to set up a temperature control loop: 
 
 
 
 
 
 
 
 
 

Figure 3-9:  Example of function block wiring 

To implement the temperature control loop a LOOP block is selected - here LOOP01.  To make the loop 
dependant upon temperature the output value (PV) of the AI3 block must be wired to the PV input of the LO01 
PID block. 
Note in this example a temperature measurement device (thermocouple) is wired (literally, in the electrical 
sense) to the Channel 1 terminals of the AI3 Module, which is in the base slot 3. 
To add the loop PV wire use the iTools 'Browse' pane to navigate to LOOP01 and double-click to show the 
parameter list, which might look something like Figure 3-10: 
 
Note that the Process Variable 
(PV) and ‘PVSrc’ parameters 
are not wired by default.  Note 
also the 'Address' column; 
every parameter in the 2500 
has a unique Modbus 
address, and this address is 
used to identify each end of 
the 'wire'.  In the window 
above the Process Value 
‘Source’ has a value  –1, which 
indicates no wire.  
 
It is this parameter that we 
need to alter, defining the 
address of the PV value from 
the AI3. 
 
 

Figure 3-10:  Loop parameter lists 

Plant Wiring 
 Analogue Input Module 

AI3 
 
Module 3  PV 
Channel 1 

LOOP 1 
PID Block 
 
 
SP  OP 
PV 

‘Soft’ Wiring 
 

Part No HA027115  Issue 5  Feb -14                                                                                                                                                            43    



2500 Controller  Engineering Handbook 

We need to identify the AI3 channel output (PV) address; navigate as usual to that list: 
 

 
 

Figure 3-11:  AI3 channel list 
 

We can see the parameter 'Val' is at address 5207.  We could have found this by looking up the published 
Modbus parameter information. 
Reverting to the LOOP list (Figure 3-10), enter the new address (5207) into the PVSrc Value the new parameter 
will look like: 
 

 
 

Figure 3-12:   PID Function Block View with Wiring 
 

To extend this example further, the loop output should be wired to an output channel; the set point wired to a 
fixed value, or to a setpoint controller.  
Complex systems can be constructed in a very short time using the above procedure. 
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3.8. DECLARING I/O MODULES 
Each type of 2500 I/O module is 
identified with a unique code.  The 
IOC regularly scans every base slot 
for module type codes; thus can 
verify any software configuration 
against actual modules fitted.  This 
system also allows for "hot swap" 
of modules in service. 
The iTools I/O module lists show 
two parameters 'ReqID' and 
'ActID'.  The former must be set to 
define the needed module type, 
the latter confirms the type actually 
fitted.  These parameters are found 
in IO → Modulexx → MODxx. 
In the 2500 system EVERY required 
module must be declared and 
identified.  If not declared (or the 
wrong type fitted) the module will 
not function.  Note, the green 
indicator LED on I/O modules only lights if the module is correctly identified and initialised.  If the IOC detects 
any miss-match the red "X" indicator illuminates. 
To set the ‘ReqID’ parameter to match the I/O module navigate to the module block list as shown in the 
example in Figure 3-13: 
 

Figure 3-13:  Selecting a module type 

Double-click the ‘ReqID’ parameter and select the module type from the drop-down list in the usual way.  
 

3.9. THE WIRING EDITOR 
Wiring can become quite complex in a large system.  To help control wiring there is an editor in the Toolkit 
Block components that provides a view of all wiring connections within a 2500 controller.  The editor also 
contains a full list of all the available Wireable Parameters and where they are wired from. 
The Block Wiring Editor in Toolkit Blocks can be opened in a number of ways:- 

1. From the toolbar click next 
to Views  

2. From the View menu 

3. Right click on the icon view or 
the device name in the Device 
Browser  

 

This opens up a Window with 4 
tabbed lists.  The first three tabs 
are for the Toolkit Blocks which 
are covered in Chapter 8.  
The fourth list is the ‘Block Wiring’, 
with all the wireable parameters 
and all their connections within 
the 2500.  It is possible to do all 
the wiring using this editor alone. 
 
 

Figure 3-14:  The wiring editor 

Because there are potentially a very large number of wireable parameters in a 2500 the list is split up into 
sections and a pull down list “Show Parameters” is used for selection.  
 

Wiring can be added as before, by double-clicking or right-clicking on the row required in the ‘Wired From’ 
column.  Wiring can also be made by using Windows drag and drop; for example, taking the 
Control.LOOP01.L01_OP.Ch1OP parameter from the device browser (or from the Parameter List) and dropping 
it on the IO.Module04.M04C1.Val in the Block Wiring page above. 
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4. Chapter 4  Control 
4.1. ABOUT THIS SECTION 
The IOC fitted in the 2500 DIN Rail Controller has a number of options, such as 2, 4 or 8 loops of control and 
Toolkit Blocks depending upon the option ordered.  This section applies to any number of loops.  Toolkit blocks 
are described in Chapter 8.  
The loop type can be configured as: 

Loop Type For further description see section:- 

Single PID 4.4 
Single On/ Off 4.3 
Valve Position (Bounded or Boundless) 4.8.3, 4.8.4 
Cascade pair 4.10 
Override pair 4.11 
Ratio 4.9 

In its simplest form a Control Loop can be represented by the diagram below.   
 
 
 
 
 
 
 
 

Figure 4-1:   A PID Loop 

The loop function block has inputs from a Setpoint Function block and a Process Variable measurement.  
Outputs from the loop function block may be wired to control plant actuators.  Alarm conditions can be added 
to monitor plant conditions.  Auto and Manual Tuning of the loop parameters can be made to suit the 
characteristics of the plant.  This chapter describes these options and how to set them up, all based on LOOP0x, 
where x = 1 to 8. 
Section 4.2 Standard ‘view’ of a loop in iTools 
Section 4.3 Key configuration parameters ‘Loop Type’, ‘Control Type’ 
Section 4.5 Sets of tuning parameters, ‘gain scheduling’ 
Section 4.6 Setpoints and how to select setpoints 
Section 4.8 Outputs, Dual outputs, output demand limit, Heat Cool 
Section 4.9 4.10 4.11 Advanced Loops:- Ratio, Cascade, Override 
Section 4.13 Auto tune 
Section 4.14 Diagnostics 
Section 4.15 Loop Alarms 

 

4.2. LOOP VIEW 
This is the top Parameter List of a Loop in iTools.  In most configurations these parameters are Read Only and 
show how the loop is performing.  The Process Variable would normally be wired to the analogue input 
requiring to be controlled.  Target Setpoint and Auto Manual would be writeable in simple applications. 

 

Figure 4-2:   Loop Overview 

Output Section 4.8 

Auto Tune Section 4.13 
 

Tuning Parameters Section 4.5 
 
 Setpoint Section 4.6 

Process Variable 

Loop Type 
Section 4.3 

Diagnostics Section 4.14 

Alarms Section 4.15 
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4.2.1. Loop Overview Parameters  
These parameters are in the Control → LOOP0x list. 
 

Name Description Range Status 

 PV Process Variable. The input process value to be controlled by the loop.  The current 
value of the variable from the wired source, for example an Analogue Input module 

⋅9  

 PVSrc Process Variable Source.  Modbus address of the parameter wired to the PV.    -1 
indicates NOT wired. 

  

 wSP Working Setpoint.  The Working Setpoint is the current value of the setpoint being 
used by the control loop.  It may come from a number of different sources, such as an 
internal SP, Remote SP or Next Slave Instrument SP (see section 4.6) 

⋅9  

 tSP Target Setpoint.  The Target Setpoint is the value of setpoint at which the control loop 
is aiming.  It may come from a number of different sources, such as an internal SP, 
Remote SP or Next Slave Instrument SP (see section 4.6) 

⋅9  

 T_OP Target Output Power.  The output demand the loop calculates is required before 
external limits are applied. 

⋅%  

 T_OPSrc Process Variable Source.  Modbus address of the parameter wired to the T_OP.    -1 
indicates NOT wired. 

  

 wOP Working Output.  The current value of the output demand signal from the loop.  ⋅%  

 m-A Auto/Manual Select.  If this is not wired this allows the output demand to be set for 
manual or automatic:- 

  

 Auto (0) Automatic The output demand is provided by the control loop 

 mAn (1) Manual The output demand can be set by the operator using the ‘Target Setpoint’ parameter.  When 
changing from Auto to Manual the output demand will remain at the current value until it is raised or 
lowered by the operator.  When changing from Manual to Auto the output demand will assume the previous 
manually set value then change in a controlled manner to the value demanded by the control loop.  This is 
referred to as ‘Bumpless Transfer’. 

 m-Asrc Auto/Manual Select Source.  This allows the Auto/Manual 
select to be wired to a parameter. 

  

 CtSbyAct Control Action in Standby.  The action the Control 
algorithm will take when in Standby mode. 

  

 Suspnd (0) Suspend the loop: 

 Cont (1) Continue running the loop. 

 SbrSt Sensor Break Status Flag.  Either hardware fault from input 
or linearised input PV out of range 

  

 no (0) Sensor working normally 

 YES (1) Sensor in a break condition.  This may be open circuit or high impedance 

 XFb External (or Remote) OP Feedback.  Allows an external 
source of feedback to stop Integral wind-up 

⋅9  

 XFbSrc External Feedback Source.  Modbus address of the 
parameter wired to the ExtFB.    -1 indicates NOT wired. 

  

The following parameters may be hidden if not required for the operation of the instrument.  To reveal uncheck the ‘Hide 
Parameters’ box in ‘Options → Parameter Availability Settings’ 

 o-oOP On Off Control Output.  For ON/OFF control the actual 
output demand is:  

  

 -100 (0) Maximum 'Cool' demand (Full output demand for Direct acting loop)\ 
 0 (1) No output demand 

 +100 (2) Maximum 'Heat' output demand (Full demand for Reverse acting loop) 

 V_POS Valve Position.  Actual position of potentiometer if 
connected or inferred position if no potentiometer fitted 

⋅%  

 SPorig Setpiont Origin.  Defines where the PID Setpoint comes 
from: 

  

 Intern (0) the internal setpoint of the PID block 
 Remote (1) the Remote Setpoint\ 

 Progrm (2) the Programmer Ramp Block 

 WSPHi Maximum value allowed for the working setpoint ⋅9  

 WSPLo Minimum value allowed for the working setpoint ⋅9  
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4.3. LOOP CONFIGURATION 
This is the page used to set up or configure the way in which the loop is designed to operate.  In Configuration 
Mode ALL these parameters are Read/Write, in Operating Mode ALL these parameters are Read ONLY. 
 

 

Figure 4-3:   Loop Configuration 

4.3.1. Key Configuration Parameters. 
These parameters are in the Control → LOOP0x → L0xCFG list. 
The following four configuration parameters must be set to suit the application. 

 LpType Loop Type.  This is first main selection and defines the structure of the loop. 

Single (0) Single Loop Control 

Cascde (1) Cascade Control (See Section 4.10) 

Overid (2) Override Control  (See Section 4.11) 

Ratio (3) Ratio Control       (See Section 4.9) 
 

 Ctrl Control Type.  This is the second main selection and defines the behaviour and outputs of the loop.  A 
control loop may have a single channel output (eg Heat Only) or Dual channel (eg Heat/Cool).  The 
control algorithm may be PID, or a raise/lower Valve Positioning algorithm.  The Valve Position 
algorithm may be configured for use with position feedback from a potentiometer (‘Bounded’ or 
Position Mode control), or without position feedback (‘Boundless’ or Velocity Mode control). 

Single outputs:  Channel 1.   Numbers shown in ( ) are enumerated values 
PID (0) PID control 
OnOff (1) ON/OFF control 
VPU (2) Valve Control - boundless 
VPB (3) Valve control – bounded 

 

Dual outputs:. Channel 1 Channel 2 
PID1&2(4) PID (Heat) PID (Cool) 
PID On(5) PID ON/OFF 
On1&2(6) ON/OFF PID                 see note  
OnVPU(7) ON/OFF Valve Control – boundless see note 
OnVPB(8) ON/OFF Valve control – bounded see note 
VPUOn(9) Valve Control – boundless ON/OFF 
VPBOn(10) Valve control – bounded ON/OFF 
PIDVPU(11) PID Valve Control – boundless Next Phase 
PIDVPB(12) PID Valve control – bounded  Next Phase 
VPU1&2(13) Valve Control – boundless Valve Control – boundless Next Phase 
VPUVPB(14) Valve Control – boundless Valve control – bounded    Next Phase 
VPB1&2(15) Valve control – bounded Valve control – bounded    Next Phase 
VPBVPU(16) Valve control – bounded Valve Control – boundless Next Phase 

Note: Select Direct Control Action (below) and ON/OFF as Channel 2. 

 Act Control Action. This applies to Channel 1, Channel 2 will be the opposite 

rEv (0) Reverse action - the output will increase positively if PV is below SP.  (Eg Heat) 
dir (1) Direct action - the output will increase positively if the PV is above SP. (Eg Cool) 

 rnGH/L Process Value High and Low Limits.    These must reflect the active range of the controlled variable and 
will be used to scale the PID action, for example, to calculate the proportional band in %.  Outside these 
limits the Sensor Break flag will be active 

 

The remaining configuration parameters also affect how the loop is used and are taken in the order listed: 
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4.3.2. Other Loop Configuration Parameters  
Name Description Range Status 

 COOL Cooling Type  This applies to the PID output on Channel 2   

 Lin (0) Linear The control output follows linearly the PID output signal, i.e. 0% PID demand = 0 demand output, 
100% PID demand = 100% demand output. 

 oiL (1) Oil, Water, Fan The control output is characterised to compensate for the non-linear effect of the cooling 
medium - oil, water and blown air.  Typically used in extrusion processes.  H20 (2) 

 FAn (3) 

 ProP (4) Prop  Cooling output is proportional to error 

 titd Integral & Derivative Time Units Usually seconds, but may be changed to minutes or 
hours 

  

 dtyP Derivative Type Derivative on PV defines that derivative action responds to 
changes to PV only 
Derivative on Error defines that derivative action responds to changes to differences 
between SP and PV, better for ramping setpoints 

  

 PwrF Power Feedback Enable If the supply voltage changes the PID output is 
immediately modified to keep the output demand constant.   
Power feedback is generally used in a heating application to compensate for supply 
voltage changes before the effect is seen in the temperature.  For outputs controlling 
contactors or SSRs set power feedback to on.  For outputs controlling analogue 
thyristor units PwrF would normally be set to OFF since the thyristor unit generally 
contains its own local compensation. 

  

 OFF (0) Off  No power feedback 

 on (1) On  Power feedback enabled 

 Fwdt Feedforward Type  Feedforward control is used typically to overcome time 
delays or to compensate for the effect of external influences such as control signals 
from other loops in the process.  This is added directly to the output of the PID 
algorithm, before output limiting and dual output conversions are performed.  Trim 
Limit applied to the PID calculated output is possible when Feedforward is enabled. 

  

 Pdtr Manual/Auto Transfer PD Control Defines the control output behaviour for 
Manual/Auto transfer when there is no integral term: 

  

 no (0) No  Manual to Auto transfer will bump 

 YES (1) Yes  Manual to Auto transfer will be bumpless 

 Sbrt Sensor Break type. On sensor break detection the output demand will revert 
to:- 

  

 Sb.OP (0) Sb.OP to a preset value set by ‘oSbOP’ in ‘L0x_OP’ list 

 HoLd (1) Hold  to its current value 

 FOP Force Manual Output Mode. Force Manual Mode allows you to select how the 
loop behaves on auto/ manual transfer 

  

 no (0) Off Transfer between auto/manual/auto takes place bumplessly 

 trAc (1) Track Transfer from auto to manual, the output reverts to the previous manual value.  Transfer from 
manual to auto takes place bumplessly 

 StEP (2) Step Transfer from auto to manual, the output goes to a pre-set value L01_OP.FOP.  
Transfer from manual to auto takes place bumplessly 

 Pbu Proportional Band Units. Units in which the Proportional band is set   

 EnG (0) Eng in engineering units 

 % (1) % as a percentage of the input range 

 dEcP Decimal Places in Disp/Comms. Defines the resolution of the main PV and Setpoint as 
seen by digital communications 

  

 nnnn (0) No decimal places 

 nnn.n (1) One decimal place ie 123.4 is sent as 1234 

 nn.nn (2) Two decimal places ie 12.34 is sent as 1234 

 WSPRmp Ramp from WSP. When ramping SP is enabled, this parameter determines the 
starting point of the ramp 

  

 no (0) Ramp from PV 

 YES (1) Ramp from WSP 
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4.4.  PID CONTROL 
PID control, also referred to as ‘Three Term Control’, is a technique used to achieve stable straight line control at 
the required setpoint.  The three terms are:  
P Proportional band 
I Integral time 
D Derivative time 
The output from the controller is the sum of the contributions from these three terms.  The combined output is a 
function of the magnitude and duration of the error signal, and the rate of change of the process value.  It is 
possible to set P, PI, PD or PID control. 
 

4.4.1. Proportional Term 
The proportional term delivers an output which is proportional to the size of the error signal.  An example of this 
is shown in Figure 4-4, for a temperature control loop, where the proportional band is 10OC and an error of 3OC 
will produce an output of 30%. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-4:   Proportional Action 

Proportional only controllers will, in general, provide stable straight line control, but with an offset 
corresponding to the point at which the output demand equals the heat loss from the system. 
 

4.4.2. Integral Term 
The integral term removes steady state control offset by ramping the output up or down in proportion to the 
amplitude and duration of the error signal.  The ramp rate (reset rate) is the integral time constant, and must be 
longer than the time constant of the process to avoid oscillations. 

4.4.3. Derivative Term 
The derivative term is proportional to the rate of change of the temperature or process value.  It is used to 
prevent overshoot and undershoot of the setpoint by introducing an anticipatory action.  The derivative term 
has another beneficial effect.  If the process value falls rapidly, due, for example, an oven door being opened 
during operation, and a wide proportional band is set the response of a PI controller can be quite slow.  The 
derivative term modifies the proportional band according to this rate of change having the effect of narrowing 
the proportional band.  Derivative action, therefore, improves the recovery time of a process automatically when 
the process value changes rapidly. 
 

Derivative can be calculated on change of PV or change of Error.  For applications such as furnace control, it is 
common practice to select Derivative on PV to prevent thermal shock caused by a sudden change of output 
following a change in setpoint. 
 

  

Proportional 
band 

3OC error 

Temperature 

Setpoint 

10OC 
Output 

100% 

0% 

30% 
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4.4.4. High and Low Cutback 
While the PID parameters are optimised for steady state control at or near the setpoint, high and low cutback 
parameters are used to reduce overshoot and undershoot for large step changes in the process.  They 
respectively set the number of degrees above and below setpoint at which the controller will start to increase or 
cutback the output demand. 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-5:   High and Low Cutback 

4.4.5. PID Block Diagram 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-6:   PID Block Diagram 
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4.4.6. PID Parameters  
These parameters are in Control → LOOP0x → L0xPID. 
The L0xPID List displays all the current working PID parameter values.  These are all read only (coloured blue) 
and are set either following an Autotune (section 4.13) or adjusted manually (section 4.5.1 ‘PID Sets’).  The PID 
terms have been described in previous pages. 

 
 

Figure 4-7:   PID Parameter List 

Name Description Range Status 

 PB The proportional band value the PID is using now.  Units (Eng, %) are set in Control → 
LOOP0x → LoxCFG → Pbu 

  

 Ti The integral time the PID is using now.  Units (Sec, Min, Hour) are set in Control → 
LOOP0x → L0xCFG → titd 

  

 Td The derivative time the PID is using now.  Units (Sec, Min, Hour) are set in Control → 
LOOP0x → L0xCFG → titd 

  

 rES The Manual reset value the PD controller is using now   

 Hcb The cutback high value the PID is using now     

 Auto (0) Auto The cutback value is set by the PID Block 

 Value The cutback value set manually in Control → LOOP0x → L0xSET → Hcb1 

 Lcb The cutback low value the PID is using now    

 Auto (0) Auto The cutback value is set by the PID Block 

 Value The cutback value set manually in Control → LOOP0x → L0xSET → Lcb1 

 reL The Channel 1 Channel 2 Relative gain value the PID is using now   

 SET Working PID Set. Selects which of the 3 sets of tuning parameters is being used.  
Selection is Manual or by Gain Scheduling (section 4.5.).  Note that Control.LOOP0x → 
L0xSET → nSets must be a value > 1. 

  

 SETSrc Modbus address of parameter value used as the working PID set   

 FF Remote Feedforward Remote input value used as a feedforward.  Feedforward must 
enabled in L01CFG → Feedforward type.   

  

 FFSrc Modbus address of parameter value used as the remote feed forward 

 -1 indicates NOT wired. 

  

 Frz Freeze Control Flag Value  Freeze Control flag may be set to suspend PID calculation 
and all the calculated values remain frozen.  This parameter is wireable 

  

 FrzSrc Modbus address of parameter value used as the freeze control flag   

 LPBrk Loop Break Status Flag.  PID loop detects that the output has remained on a limit and 
PV has not moved by half proportional band for > Loop Break Time 

  

 no (0) No  Loop status is OK 

 YES (1) Yes  Loop status is detected as broken  - open loop 

 Lb_t Loop Break Time  Flag is set when the PID loop detects that the output has 
remained on a limit and the PV has not moved by half the proportional band during the 
Loop Break Time. 

  

 I_Hold Integral Hold Flag Set to suspend the Integral calculation and hold constant the current 
integral contribution to the output value.  This parameter is wireable 
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Name Description Range Status 

 I-HSrc Modbus address of the flag used to hold the Integral value 

 -1 means not wired 

  

 Debump Debump Flag  Set to balance integral to maintain the same output demand.  Flag 
resets itself 

  

 Adc Manual Reset Auto Calc Enable  With Integral Time OFF, setting Adc enables calculation 
of the Manual Reset.  If Adc is not set Manual Reset must be set manually 

  

The following parameters may be hidden if not required for the operation of the instrument.  To reveal uncheck the ‘Hide 
Parameters’ box in ‘Options → Parameter Availability Settings’ 

 FFPb Proportion of feed forward fed directly to the output - Default 100 decreasing value 
increases the effect 

  

 FFtr Fixed offset value added to the feedforward signal   

 FFdv SP and PV feed forward defines range of PID trim contribution. Feedforward is limited 
directly. 

  

 MaxDsp For diagnostic use only   

 MinDsp For diagnostic use only   

 MnPosn For diagnostic use only   

 MxTDTI For diagnostic use only   
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4.5. GAIN SCHEDULING 
Gain scheduling is the automatic transfer of control between one set of PID values and another.  Gain 
scheduling may be used in very non-linear systems where the control process exhibits large changes in 
response time or sensitivity, see Figure 4-8 below.  This may occur, for example, over a wide range of PV, or 
between heating or cooling where the rates of response may be significantly different.  Up to are three sets of 
PID values may be chosen -the number of sets depends on the non-linearity of the system.  Each PID set is 
chosen to operate over a limited (approximately linear) range. 
 

The active set can be selected from:  
1. A digital input 
2. A parameter ‘ Working PID Set’ in the L0xPID list 
3. Or you can transfer automatically in gain scheduling mode.    
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-8:   Gain Scheduling in a Non-linear System 

 

4.5.1. Gain Scheduling Parameters - PID Sets 
These parameters are in the Control → LOOP0x → L0xSET list.  They are not available if Control Type = OnOff 
in Control → LOOP0x → L0xCFG. 

 

Figure 4-9:   PID Parameter Sets 
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The default set up of the loop provides a single set of PID values – all Read/Write.  There are 3 sets of PID values 
available and different strategies to select to change from one PID set to the next.  These two parameters may 
only be changed in configuration level. 
 

Name Description Range Status 

 nSets Number of PID sets to Use. For Gain Scheduling  1, 2, 3  

 PidSch Scheduling Type   

 OFF (0) Off  SET 1 is used all the time 

 SET (1) SET  No strategy, enabled sets may be selected using L0xPID.SET 

 SP (2) SP New set is selected when the Setpoint crosses the value of bound1 and bound2 

 PV (3) PV New set is selected when the PV crosses the value of bound1 and bound2 

 ER (4) ER New set is selected when the Error crosses the value of bound1 and bound2 

 OP (5) OP New set is selected when the Output crosses the value of bound1 and bound2 

 RM (6) RM New set is selected when the Remote Scheduling Input  crosses the value of bound1 and bound2 

 WIRE (7) WIRE  Gain Scheduling is implemented by wiring to the PID terms using XpSrc, TiSrc, TdSrc. 

 RM Remote Scheduling Input. The value used to control the active set when Scheduling 
type is set to RM. 

  

 RMSrc Remote Scheduling Input Source. Modbus address of the parameter supplying the 
value for RM. –1 means it is not wired. 

  

 AnVal The current analogue value selected form AnVal1 to AnVal3   

 bound1 Boundary for change from Gain Scheduling Set 1 to Set 2\nDepends on the 
Scheduling type selected 

  

 bound2 Boundary for change from Gain Scheduling Set 2 to Set 3\nDepends on the 
Scheduling type selected 

  

 XpSrc Proportional Band Source. Modbus address of the parameter supplying the value 
for Prop Band when the Scheduling type is set to WIRE.  –1 means it is not wired. 

  

 TiSrc Integral Time Source. Modbus address of the parameter supplying the value for 
Integral Time when the Scheduling type is set to WIRE.. –1 means it is not wired. 

  

 TdSrc Derivative Time Source. Modbus address of the parameter supplying the value for 
Derivative Time when the Scheduling type is set to WIRE.. –1 means it is not wired. 

  

 
Parameters PB1, Ti1, Td1, rES1, Hcb1, LcB1, rEL1 are the PID parameters for set 1.  They are the same as those 
described in section 4.4.6. and are repeated for sets 2 and 3. 
Parameters OPH1, OPL1 to OPH3, OPL3 are the output limit parameters for each set which are the same as 
those described in section 4.8.2. 
Parameters AnVal1 to 3. are customisable parameters which provide additional flexibility when designing a 
control strategy.  They are available for each set when gain scheduling has been configured and for each loop 
configured.  They can be ‘soft wired’ to perform a specific function relevant to the particular process being 
controlled.  Examples include: Output Power Limit, SP feedforward Trim, etc. 
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4.6. LOOP SETPOINT 
This page is used to configure parameters which define the setpoint to a control loop. 
 

 

Figure 4-10:   Loop Setpoint 

The Working Setpoint is the setpoint used by the control loop and may be derived from a number of different 
sources.  
 

4.6.1. Setpoint Parameters  
These parameters are in the Control → LOOP0x → L0x_SP list. 

Name Description Range Status 

 SSESrc Internal SP Select Source Modbus address of the flag used to select SP1 or SP2     -1 
means it is not wired 

  

 SSEL Internal Setpoint Select.  If this is not wired the setpoint can be selected from:-   

 SP1 (0) Setpoint 1 Internal setpoint 1 

 SP2 (1) Setpoint 2 Internal setpoint 2 

 SP1/2Src Modbus address of the parameter supplying the value of SP1/2   -1 means it is not 
wired 

  

 SP1/2 Current value of SP1/2  Note Control → LOOPnn → Lnn_SP → L-r must not be set.   

 SP_L Minimum value allowed on SP1 ⋅%  

 SP_H Maximum value allowed on SP1 ⋅%  

 SP_2L Minimum value allowed on SP2 ⋅%  

 SP_2H Maximum value allowed on SP2 ⋅%  
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4.6.2. Rate Limit and Holdback Parameters  
These parameters are also in the Control → LOOP0x → L0x_SP list. 
Holdback is used to stop the setpoint ramp when the Process Variable is unable to keep up with the changing 
setpoint.  This is selected by:- 
 

Name Description Range Status 

 SPrr SP Rate Limit.  To set the rate at which the setpoint changes   

 OFF (0) No setpoint rate limit 

 Value Setpoint rate of change is limited to this value 

 SPrSrc Modbus address of the parameter supplying the value of SPrr   -1 means it is not wired   

 Hbty Sets the holdback strategy for setpoint ramps    

 OFF (0) No holdback 

 Lo (1) Setpoint ramp is held back when the PV is below the Setpoint by the Holdback value 

 Hi (2) Setpoint ramp is held back when the PV is above the Setpoint by the Holdback value 

 bAnd (3) Setpoint ramp is held back when the PV is below or above the Setpoint by the Holdback value 

 SRLHb The SP ramp is currently:-   

 OFF (0) ramping 

 HbAc (1) on Hold 

 SRLHd SP Rate Limit Hold.  Stops the SP ramp   

 no (0) enabled 

 YES (1) on Hold 

 SRLAct SP Rate Limit Active Status.     

 no (0) no Setpoint rate limit not active 

 YES (1) Yes Ramping 

 SRLStA SP Rate Limit Complete Flag. SP ramp has   

 no (0) no NOT reached the Target SP 

 YES (1) Yes reached the Target SP 

 SRLDis Disable SP Rate Limit.  Select from:-   

 no (0) no Setpoint rate limit enabled 

 YES (1) Yes Setpoint rate limit disabled 

 Hbkdis Disable Holdback.  Select from:-   

 no (0) no Holdback enabled 

 YES (1) Yes Holdback disabled 

 StkHbk Sticky Holdback Status.  As the above flag could be set and reset very frequently as 
the PV tries to follow the SP, a second output - Sticky Holdback Status - is provided.  
This will remain permanently on if the PV is achieving at least half the rate of the 
setpoint.  This output is used to give a consistent message over communications to 
show that Holdback has very recently been active 
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4.6.3. Remote Setpoint Parameters  
These parameters are also in the Control → LOOP0x → L0x_SP list. 
 

Name Description Range Status 

 rm_SP Remote Setpoint.  A setpoint can be wired from a remote source to replace the local 
setpoint 

  

 rm_Src Remote Setpoint Source.  The source from which the remote setpoint is wired   

 L-r Remote Setpoint Enable. Allows the ‘Remote’ setpoint to replace the Internal setpoint, 
or to act as a trim to the Internal Setpoint. Alternatively the Internal Setpoint can trim 
the Remote Setpoint.  This is selected using the ‘Remote Setpoint Configuration’ in 
the Loop SP Configuration List. 

  

 no (0) no SP1 or SP2 is being used by the PID 

 YES (1) Yes The remote setpoint is being used by the PID 

 L-rSrc Remote Setpoint Enable Source.  The source from which the remote setpoint enable is 
wired 

  

 
 

4.6.4. Control Setpoint – Ramp Parameters 
These parameters are also in the Control → LOOP0x → L0x_SP list. 
They are used to synchronise ramp segments over a number of 2500 controllers, using communications.  
 

Name Description Range Status 

 NwTrSP Next Slave Instrument Target Setpoint.  The next setpoint to be loaded into the Rate 
Limit block 

  

 NwRmRt Next Slave Instrument Ramp Rate.  The next rate limit to be loaded into the Rate Limit 
block 

  

 SISync Trigger New Ramp.  Load the next values into the ramp block   

 no (0) no New Ramp not triggered 

 YES (1) Yes New Ramp triggered 

 

The following parameters may be hidden if not required for the operation of the instrument.  To reveal uncheck the ‘Hide 
Parameters’ box in ‘Options → Parameter Availability Settings’ 

 Loct Local Setpoint Trim.  A fixed ‘offset’ value applied to the working setpoint   

 LocL Local Setpoint Trim Low Limit.  To set a high limit on the setpoint trim value   

 LocH Local Setpoint Trim High Limit.  To set a low limit on the setpoint trim value   

 Hb SP Rate Limit Holdback Value.  Sets the allowed error, in Engineering Units, between 
SP and PV before Holdback is invoked.  Not available if SP Rate Limit Holdback Type = 
OFF.  There is a separate Disable Holdback input 
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4.7. LOOP SETPOINT CONFIGURATION 
These parameters set up or configure the way in which the loop setpoints are designed to operate.   
 

 
 

Figure 4-11:   Loop Setpoint Configuration 
 

4.7.1. Setpoint Function Block 
The schematic diagram below shows how the setpoints are connected and selected and where the setpoint 
limits are applied. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-12:   Setpoint Function Block Schematic 
 

The Remote Setpoint Configuration is in the Setpoint Configuration List (Control → LOOP0x → L0xSPC) and can 
only be changed in Configuration Mode.  The other parameters appear in the Setpoint Parameter List (L0x_SP).  
This list will change depending on the Remote Setpoint Configuration selected.  
The Target setpoint is then fed to a ramp block that applies a Rate Limit to setpoint of the PID. There is a rate 
limit enable/disable input. 
 
 
 
 
 
 
 
 
 
 

Figure 4-13:   Setpoint Rate Limit Schematic 

Rate limit units are selected in Setpoint Configuration List. 
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4.7.2. Setpoint Configuration Parameters  
These parameters are in the Control → LOOP0x → L0xSPC list. 

Name Description Range Status 

 rmTr Remote Tracking. Defines the local setpoint behaviour when changing from Remote 
to Local setpoint.  Read only in Operator Mode. 

  

 OFF (0) Off   Active Local setpoint will remain unchanged 

 trAc (1) Track  Active local setpoint will track the value of the remote setpoint 

 mTr Manual Track.  Defines what the active local setpoint does in Manual Mode.  Read only 
in Operator Mode 

  

 OFF (0) Off   Local setpoint will remain unchanged 

 trAc (1) Track  Local setpoint will track the value of the process variable (servo) 

 rmPU Rate Limit Units. Sets the rate units – Operator or Configuration Modes   

 PSEc (0) Per second 

 Pmin (1) Per Minute 

 PHr (2) Per hour 

 rmt Remote Setpoint Configuration. In remote mode the working setpoint is modified by:-   

 none (0)  

 SP (1) Remote Setpoint   

 Loc.t (2) Remote Setpoint + local trim 

 rmt.t (4) Remote trim + local setpoint 

 PVOnSc WSP to PV On Slave Sync Signal. Used by an external master to servo the working 
setpoint to the process variable 

  

 no (0) No No sync 

 YES (1) Yes Sync WSP to PV 

 StLR Startup Local/Remote Mode. Defines the Setpoint Mode when the controller 
powers up 

  

 NoChang 
(0) 

No Change Setpoint selection remains as it was when the controller powers down 

 Local (1) Local  Controller takes the local Setpoint when it powers up 

 Remote (2) Remote Controller takes the Remote Setpoint when it powers up 

 StWSP Startup WSP Mode. Defines the setpoint strategy when the controller powers up   

 NoChang 
(0) 

No Change   The setpoint remains the same as when the controller was last used 

 GotoPV (1) Goto PV The setpoint takes the same value as the process value 

 Go TSP (2) Goto TSP The setpoint takes the value of the Target setpoint 

 StHld Startup Hold Mode . Defines the HOLD strategy when the controller powers up   

 NoChang 
(0) 

No Change    Hold remains the same as it was when the controller was last used 

 Hold (1) Hold     The controller powers up in HOLD 

 NoHold (2) NoHold         The controller powers up in the normal ramp mode NOT in Hold 
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4.8. CONTROL OUTPUT  
4.8.1. Output Function Block 
This block diagram shows how the parameters and limits are used on the Output of a PID block. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-14:   PID Output Schematic 

4.8.2. Output Parameters  

 

Figure 4-15:   Output Parameters 

These parameters are in the Control → LOOP0x → L0x_OP list. 
 

Name Description Range Status 

 Ch1OP Ch1 Output. The current value of channel 1 output  ⋅%  

 Ch2OP Ch2 Output. The current value of channel 2 output  ⋅%  

 OPLo Low Power Limit. Limits the minimum output demand (0 to 100%) ⋅%  

 OPHi High Power Limit. Limits the maximum output demand (0 to 100%) ⋅%  

 rOL Remote Low Power Limit.  Limits the minimum remote output demand (-100 to 100%) ⋅%  

 rOLSrc Remote Low Power Limit Source.  Low demand limit can be wired to a parameter   

 rOH Remote High Power Limit.  Limits the maximum remote output demand (-100 to 100%) ⋅%  

 rOHSrc Remote High Power Limit Source.  High demand limit can be wired to a parameter   

 ORL Output Rate Limit Enable.  Enables the OPrr value to limit the rate of change of the 
Output. 

  

 OFF (0) Off The Output ramp rate is not limited. 

 on (1) On Enabled.  The Output ramp rate will be limited by the OPrr value. 

 ORLSrc Output Rate Limit Enable Source.  Modbus address of the parameter used as the Output 
Ramp Limit Enable.  –1 means not wired.  
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Name Description Range Status 

 OPrr Output Rate Limit. Sets the rate of change in output demand in seconds   

 OPrSrc Output Rate Limit Source.  Modbus address of the parameter used as the Output Rate 
Limit.  –1 means not wired. 

  

 ont1 Ch1 Output Minimum On Time. Limits the switching rate of a relay or logic output   

 oSbOP Sensor Break Power. Sets the demand output level in % in the event of the controlled 
variable being out of range 

⋅%  

 TkEn Output Track Enable. A feedback signal from the output is used for integral de-
saturation.  This signal may be derived internally or from an external source. 

  

 no (0) No Not enabled.  The default internal OP is used for the integral calculation. 

 YES (1) Yes Enabled.  The feedback signal is forced to a remote output feedback 

 TkESrc Output Track Enable Source. The Output Track Enable Source allows an external 
source of output to stop integral wind up in some applications such as cascade control.  
The integral will calculate a PID output to match the external value when manual to auto 
bumpless transfer is activated. 

  

 TrkIP Track Input. The input value that the Output tracks when 

Control → LOOP0n → L0n_OP → TkEn is set to Track Enable 

Normally a feedback signal from the output used for integral de-saturation. 

  

 TrkSrc Track Input Source. Modbus address of the parameter whose value is used as the 
Track input 

-1 means it is not wired 

  

PFFVal Power Feed Forward. Monitors the demand supply to the controller and adjusts the 
output demand to compensate for changes in the supply.  This parameter shows the 
current value of the power feed forward 

  

PFFSrc Power Feed Forward Source. Provides a wireable source for the power feed forward 
measurement 

  

 
The following parameters may be hidden if not required for the operation of the instrument.  To reveal uncheck the ‘Hide 
Parameters’ box in ‘Options → Parameter Availability Settings’ 

 FOP Forced Output Level  Power level on transferring to Manual if the Forced Output Mode is 
selected in Control → LOOP01 → L01CFG → FOP 

  

 hYS1 Hysteresis 1  Only available if Control Type set to OnOff in Control → LOOP0x → L0xCFG 
list.  Channel 1 On Off Control \n0\tNo hysteresis or gap between output going OFF or 
coming ON\n>0\tGap in engineering units between the output going OFF and coming 
ON 

  

 OFF (0) Auto The cutback value is set by the PID Block 

 Value The hysteresis value is entered manually  

 hYS2 Hysteresis 2   

 OFF (0) Auto The cutback value is set by the PID Block 

 Value The hysteresis value is entered manually  

 ont2 Ch2 Output Minimum On Time. Limits the switching rate of a relay or logic output   

 oSbOP Sensor Break Power  Power applied in ON/OFF control when the sensor is detected as 
broken 

  

 -100 (0) Channel 2 fully ON 

 0 (1) Both Channels OFF 

 100 (2) Channel 1 fully ON 

 TkEn OP Track Enable  The integral is adjusted to make output track the TrkIP parameter in the 
L0x_OP folder 

  

 no (0) No tracking disabled 

 YES (1) Yes Output is made equal to the Track Input 

 TkESrc OP Track Enable Source  Modbus address of the flag used to enable Output Track mode   
-1 means it is not wired 

  

 AbPwrL Absolute Low Power Limit  Internal R/O parameter   
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4.8.3. Valve Control Outputs 
There are two types available Bounded or Boundless Mode.  Bounded requires feedback from a potentiometer 
giving valve position.  Boundless (sometimes known as Velocity or Unbounded mode) does not require position 
feedback.   
 

 
 

Figure 4-16:   Valve output Parameters 

 

4.8.4. Valve Control Parameters  
These parameters are in the Control → LOOP0x → L0xMTR list.  This list only appears if ‘Control Type’ (L0xCFG 
List) is set to a valve position output. 

Name Description Range Status 

tm Valve Travel Time.  Set to the time it takes for the valve to go from fully closed to fully 
open. 

  

Int Valve Inertia Time.   Set this time to the time that the motor carries on moving after 
the signal has ended. 

  

bAct Valve Backlash Time.  Set to compensate for any backlash in linkages   

mPt Minimum Pulse Time. Sets the minimum on time of the device (normally a relay) which 
switches the motor 

  

PotHi Valve Positioner High Limit.  Set to the required output value with the valve at the high 
position. 

⋅%  

PotLo Valve Positioner Low Limit.  Set to the required output value with the valve at the low 
position. 

⋅%  

Sensor break action options are different for Velocity Mode (Boundless) and Position Mode. 

 Vbr Boundless Sensor Break Action.   

 rESt (0) Rest  remain in existing position 

 uP (1) Up  drive valve fully open 

 dwn (2) Down drive valve fully closed 

SbOP Bounded Sensor Break Action.   Set the value (in %) that the valve must move to in the 
event of sensor break. 

  

VP_OP VP Manual Output. Output demand value when in manual.  In manual set to 1 to 
raise or 2 to lower 

 - operates for 1 minimum pulse length 

⋅%  

PPos Pot Position. Indicates the position of the valve from the feedback potentiometer.  ⋅%  

PPoSrc Pot Position Source. Modbus address of the parameter supplying the value of the pot 
position.   

-1 means it is not wired 

  

CalPot Pot Input Calibration Enable.    

 OFF (0) Off Pot calibration disabled. 

 on (1) On Pot calibration enabled. 
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4.9. RATIO CONTROL 
Ratio Control is a technique used to control a process variable at a setpoint which is calculated as a proportion 
of a second (lead) input.  The ratio setpoint determines the proportion of the lead value that is to be used as the 
actual control setpoint.  The ratio setpoint can be applied as either a multiplier or as a divisor to the second 
input. 
A typical application is in gas fired furnaces where in order to achieve efficient combustion, the gas and air flow 
supplied to the burners needs to be maintained at a constant ratio. 

4.9.1. Basic Ratio Control  
Each loop in the 2500 contains a ratio control function block.  Figure 4-17shows a block diagram of a simple 
ratio controller.  The lead PV is multiplied or divided by the ratio setpoint to calculate the desired control 
setpoint.  Prior to the setpoint calculation, the ratio setpoint can be offset by the ratio trim value and must obey 
the overall ratio setpoint operating limits.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-17:   Ratio Control Schematics 

4.9.2. Ratio Parameters  
Ratio control is selected by ‘Loop Type’ = ‘Ratio’.  This parameter is found in Control → LOOP0x → L0xCFG.   

 

 
Figure 4-18:   Ratio Control Parameter List 
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Ratio parameters are found in Control → LOOP0x → L0xRAT 
 

Name Description Range Status 

 SP SP Setpoint generated by the ratio calculation in engineering units ⋅9  

 MRatio Measured Ratio Continuous calculation of the actual measured ratio.  It is calculated 
from the Lead PV and the Process PV. 

⋅9  

 WRatSP Working Ratio SP. The actual Ratio being using by the algorithm after limits and trim. ⋅9  

 RAType Ratio Type  Defines how the ratio is calculated.  Can only be set in configuration 
level. 

  

 Divide (0) Divide Divides the lead PV by the working ratio setpoint 

 Mult (1) Multiply Multiplies the lead PV by the working ratio setpoint 

 RAL Ratio Setpoint Low Limit  Minimum range limit for the ratio setpoint ⋅%  

 RAH Ratio Setpoint High Limit  Maximum range limit for the ratio setpoint ⋅%  

 RatSrc Ratio Setpoint Source. The modbus address of the parameter used for the ratio 
setpoint 

-1 means NOT wired 

  

 Rat_SP Ratio Setpoint Adjustment of the ratio setpoint value.  ⋅%  

 TriSrc Ratio Trim Source.  Modbus address of parameter used for the Ratio Trim SP 

-1 means it is NOT wired 

  

 Trim Ratio Trim Adjustment of the ratio trim value.   ⋅%  

 LeaSrc Lead PV source.  Modbus address of parameter used for the Lead PV 

-1 means it is NOT wired 

  

 LeadPV Lead PV  The measured parameter used to ratio the process variable.  ⋅9  

 REn Ratio Enable Ratio control may be switched off, eg, during commissioning   

 OFF (0) Off Ratio is not used – PID uses the local setpoint only.  The parameter ‘Ratio Valid’ will show YES.   

 on (1) On  Ratio is calculated and used.  The parameter ‘Ratio Valid’ will show no. 

 REnSrc Ratio Enable source.  Modbus address of parameter used for the Ratio Enable. -1 
means it is NOT wired 

  

 RatTrk Ratio Track Mode  Defines the ratio tracking strategy.  Can only be set in configuration 
level. 

  

 OFF (0) OFF Ratio track is disabled 

 on (1) ON whenever ‘Ratio Enable’ is set to ‘Off’ the Ratio SP will track the measured ratio.  This feature allows 
the user to set the Ratio SP according to the current condition of the process. 

 RatVld Ratio Valid.    

 no (0) Ratio is valid or disabled 

 YES (1) Ratio is enabled and no sensor break 
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4.10. CASCADE 
4.10.1. Overview 
Cascade control is classified as an advanced control technique used, for example, to enable processes with long 
time constants to be controlled with the fastest possible response to process disturbances, including setpoint 
changes, whilst still minimising the potential for overshoot.  It is a combination of two PID controllers, where the 
output signal from one (the master) forms the setpoint for the other (the slave).  For cascade control to be 
effective the slave loop should be more responsive than the master. 

4.10.2. Trim Mode 
The 2500 controller uses trim mode cascade control an example of which is shown in Figure 4-19.  The slave 
controls the temperature in a furnace.  The master is measuring the temperature of the workpiece and 
controlling the setpoint of the slave.  In this case the master trims the setpoint of the slave rather than controlling 
it directly.  By limiting the amount of trim the temperature of the furnace will remain within bounds. 
Feedforward allows either the master PV, master SP or a user defined variable (FF_Src) to be fed forward so that 
it directly influences the slave setpoint. 
A typical application for SP feedforward could be in a heat treatment furnace, where it can be used to extend 
the life of heating elements by limiting their maximum operating temperature.   
An application using PV feedforward could be in autoclaves or reactor vessels where it is sometimes required to 
protect the product from excessive temperature gradients (also referred to as Delta T Control).  The effect of this 
is to limit the furnace temperature to a band around the target temperature. 
Feedforward can also be a user defined variable in trim mode in the same way as full scale mode  
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-19:   Cascade Trim Control 

4.10.3. Auto/Manual Operation in Cascade 
Auto/Manual operates on both master and slave loops.  
When the controller is placed in manual the slave working setpoint will track the value of the slave process value 
continually, therefore ensuring bumpless transfer.   
When cascade is deactivated the master loop will monitor the setpoint of the slave loop and provide a smooth 
transition of output demand when the loop moves back to cascade mode.   
 

4.10.4. Cascade Controller Block Diagram 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-20:   Cascade Controller in Trim Mode  

In the ‘L01CFG’ Parameter list ‘Feedforward Type’ must be set to ‘FEEd’ and the ‘Remote Feedforward’ input 
value is displayed in ‘L01PID’. 
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4.10.5. Cascade Parameters  
Cascade control is selected by the LoopType = Cascade .   
 

 

Figure 4-21:   Cascade Control Parameter List 

Cascade parameters are found in Control → LOOP0x → L0xCAS. 
 

Name Description Range Status 

 CasM Cascade Mode. Selected Cascade Mode   

 Full (0) Full scale Cascade mode 

 Full FF (1) Full scale feed forward mode 

 SP.FF (2) Setpoint feed forward mode 

 PV.FF (3) PV feed forward mode 

 TrHi Cascade Feedforward Trim High Limit.  The external analogue input being used as high 
limit for the PID contribution in Feedforward or the Cascade feedforward using remote 
input 

⋅9  

 TrHiSrc Cascade Feedforward Trim High Limit source Modbus address of parameter used as 
the cascade Feed Forward Trim High Limit.  -1 means it is NOT wired 

  

 TrLo Cascade Feedforward Trim Low Limit.  The external analogue input being used as low 
limit for the PID contribution in Feedforward or the Cascade feedforward using remote 
input 

⋅9  

 TrLoSrc Cascade Feedforward Trim Low Limit source Modbus address of parameter used as the 
cascade Feed Forward Trim Low Limit.  -1 means it is NOT wired 

  

 FF_Src Cascade Feedforward Value Source.  Modbus address of parameter used as the 
cascade Feed Forward 

-1 means it is NOT wired 

  

 FF_SP Cascade Feedforward Value.  The external analogue input being used for feedforward 
in the same eng units as PV 

⋅9  

 DisSrc Disable Cascade Source.  Modbus address of flag used to disable cascade. -1 means it 
is NOT wired 

  

 DisCas Disable Cascade.  It is sometimes useful to disable cascade when starting the process.  
This parameter provides a simple way to do this, particularly if it is wired using DisSrc.  
When disabled the auxiliary loop is turned off and the controller returns to single loop 
mode using the local setpoint 

  

 no (0) The cascade loops are both active 

 YES (1) Only the slave loop is active 

 WkFFSP Cascade Working Feedforward Value.  The working feed forward value after trim and 
limit. 

⋅9  

 MFB Master Feedback Value.  Cascade master PID feedback value. ⋅9  
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Name Description Range Status 

The following parameters may be hidden if not required for the operation of the instrument.  To reveal uncheck the ‘Hide 
Parameters’ box in ‘Options → Parameter Availability Settings’ 

 SlvHR High Range of Slave Loop.  Maximum value of the PV of the auxiliary loop ⋅9  

 SlvLR Low Range of Slave Loop.  Minimum value of the PV of the auxiliary loop ⋅9  
 

4.10.5.1. Auxiliary Loop 
Note in the Browser section in Figure 4-21 there are folders for the Auxiliary loop: 
 L1APID  PID parameters 
 L1ASET  PID parameters Sets 
 L01AUX  Loop set up  
 L1A_OP  Loop output set up. 
The master loop has to be configured in a similar manner to the slave loop.  This is done in the same way as the 
main (slave) loop, though there are fewer parameters in each list. 

68                                                                                                                                                            Part No HA027115  Issue 5  Feb -14 



2500 Controller  Engineering Handbook 

4.11. OVERRIDE 
 Overview  
Override Control allows a secondary control loop to override the main control output in order to prevent an 
undesirable operating condition.  The override function can be configured to operate either in minimum, 
maximum or select mode.  
A typical example can be implemented in a heat treatment furnace with one thermocouple attached to the 
workpiece, and another situated close to the heating elements.  Control of the furnace during the heating up 
period is regulated by the override (heating element) temperature controller which provides a safeguard 
against overheating.  Control of the furnace will switch over to the workpiece temperature controller at some 
point when the temperature is near to its target setpoint.  The exact point of switchover is determined 
automatically by the controller, and will be dependent on the selected PID terms.  
 

Simple Override 
Override control is available with analogue, time proportioning and ON/OFF control outputs.  It is not available 
with valve position outputs.  Figure 4-22 shows a simple override control loop.  The main and override 
controller outputs are fed to a low signal selector.  The override controller setpoint is set to a value somewhere 
above the normal operating setpoint, but below any safety interlocks.   
There is only one Auto Manual switch for both loops.  In manual mode the control outputs of both loops track 
the actual output, ensuring bumpless transfer when auto is selected.  The transfer between main and override 
PID control is also bumpless.   
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 4-22:  Override Control Schematic 
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4.11.1. Override Parameters  
Override is configured by setting L0xCFG → Loop Type to Override.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-23:   Override Control Parameter List 

 
Override parameters are found in Control → LOOP0x → L0xOVR. 
 

Name Description Range Status 

 OvrTyp Override Type.  Override Type 

Defines the strategy for Override Control 

  

 MinOP(0) The working output demand is the minimum of the Main and Aux output demands 

 MaxOP(1) The working output demand is the maximum of the Main and Aux output demands 

 Select(2) Select which loop is active using Control → LOOP0x → L0xOVR → ActLP 

 OvrSrc Disable override source.  Modbus address of flag used to disable the override control 

-1 means NOT wired 

  

 OvrDis Disable override.  It is sometimes useful to disable override when starting the process.  
This parameter provides a simple way to do this, particularly if it is wired using OvrSrc.  
When disabled the controller returns to single loop mode using the local setpoint 

  

 no (0) no  Both Main and Auxilliary loops are active 

 YES (1) YES Only the main loop is active 

 ActSrc Active loop source. Modbus address of parameter used to SELECT active loop 

-1 means it is NOT wired 

  

 ActLP Active Loop.  Indicates which loop is currently controlling the process or can be set if 
Control.LOOP0x → L0xOVR → OvrTyp is set to SELECT 

  

 Main (0) The main loop is active 

 Aux (1) The auxiliary loop is active 

 TriSrc Override Loop SP Trim source.  Modbus address of parameter used as the Override SP 
Trim 

-1 means it is NOT wired 

  

 

 Trim Override Loop SP Trim.  SP trim for the Override auxiliary loop ⋅9  
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4.12. TUNING 
In tuning, you match the characteristics of the controller to those of the process being controlled in order to 
obtain good control.  Good control means: 
• Stable, ‘straight-line’ control of the PV at setpoint without fluctuation 
• No overshoot, or undershoot, of the PV setpoint 
• Quick response to deviations from the setpoint caused by external disturbances, thereby rapidly restoring 

the PV to the setpoint value. 

Tuning involves calculating and setting the value of the parameters listed in Control → L0xPID list.  This may be 
done manually or automatically.  The following section describes automatic tuning. 

 

4.13. AUTOMATIC (ONE-SHOT) TUNING 
The ‘one-shot’ tuner works by switching the output on and off to induce an oscillation in the measured value.  
From the amplitude and period of the oscillation, it calculates the tuning parameter values. 
 

If the process cannot tolerate full heating or cooling being applied during tuning, then the levels can be 
restricted by setting the ‘Autotune High Power Limit’ (TnOH) and ‘Autotune Low Power Limit’ (TnOL).  These 
limits are only applied during the autotune process.  However, the measured value must oscillate to some 
degree for the tuner to be able to calculate values. 
Under normal control the output power limits may be set by ‘Low Power Limit’ and ‘High Power Limit’ found in 
Control → L0x_OP list.  If these limits are set to a lower value than the autotune limits, then the autotune high 
and low power limits will be clipped to the output limits as soon as Autotune is run. 
 

A One-shot Tune can be performed at any time, but normally it is performed only once during the initial 
commissioning of the process.  However, if the process under control subsequently becomes unstable (because 
its characteristics have changed), you can re-tune again for the new conditions. 
 

It is best to start tuning with the process at ambient conditions and with the SP close to the normal operating 
level.  This allows the tuner to calculate more accurately the low cutback and high cutback values which restrict 
the amount of overshoot, or undershoot. 
 

4.13.1. Autotune Parameters  
In the 2500 Loops do not have their own individual Autotune.  There is a single tuning block available to be 
used on the loops one at a time.  There is no configuration required. 

 

Figure 4-24:   Auto Tune Parameter List 

Autotune parameters are found in Control → ATUN list. 
 

Name Description Range Status 

 tuning Tuning Active. Set if the tuning block is active. 
Note that there is only 1 tuning block which has to be used to tune the internal loops 
one by one, using Control → ATUN → TnLpNr 

  

 OFF (0) Tuning Inactive 

 on (1) Tuning in progress 

 TnOL Auto tune low power limit.  Set this to limit the minimum output demand level which the 
controller will supply during the tuning process.  If the low output power limit set in the 
output list is higher the autotune low limit will be clipped to this value 

⋅%  
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Name Description Range Status 

 TnOH Auto tune high power limit.  Set this to limit the maximum output demand level which 
the controller will supply during the tuning process.  If the high output power limit set in 
the output list is lower the autotune high limit will be clipped to this value 

⋅%  

 TnStat Tuning State. Reports the state of the individual PID loop tuning   

 OFF (0) Not tuning  

 Noise (1) Monitoring noise 

 Init (2) Initialising 

 Start (3) Start tune at current setpoint 

 Start (4) Start tune at new setpoint 

 NewSP (5) Tune to new setpoint 

 Min (6) Find minimum 

 Max (7) Find maximum 

 Store (8) Store zero time 

 Zero (9) Set output to zero 

 Calc (10) Calculating PID values 

 Abort (11) Tuning aborted 

 DONE (12) Tuning complete 

 CTStat CascadeTuning State.  Reports the state of tuning a cascade loop.  The auxiliary loop is 
tuned first followed by the main 

  

 OFF (0) Not tuning  

 Init (1) Initialising the auxiliary loop 

 Aux PID (2) Tuning the auxiliary loop 

 Wait (3) Wait 

 Wait2 (4) Wait again 

 Init (5) Initialising the main loop 

 PID1 (6) Tuning main PID 

 TnOP Actual output demand that the tuner is requesting ⋅%  

 TnLpNr Tune Loop Number.  Choose the required loop.  Autotune starts when the loop is 
chosen 

  

 OFF (0) Not tuning  

 L01PID(11) Tune loop 1 

 L1APID(12) Tune auxiliary loop 1 

 L1CASC(13) Tune cascade loop 1 

The above three parameters are repeated for as many loops as supplied up to a maximum of eight.  Add ‘10’ to the 
enumerated values shown above for each loop.  For example L02PID has the value (21) and so on.  

 TnPID Tune PID Number.  Reports which loop is being tuned   

 OFF (0) Tuning inactive 

 L01PID (1) Tuning loop 1 

 L1APID (2) Tuning auxiliary loop 1 

The above two parameters are repeated for as many loops as supplied up to a maximum of eight.  The enumerated values 
become (3) and (4) for loop 2 and so on.  

 TnWSP Working SP of Current Tune Stage. Actual SP that the tuner is currently using. ⋅%  

 STime Current Tune Stage Time. The time spent in the current tune stage.   
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4.13.2. Cascade Tuning 
When tuning a cascade loop it is necessary that both master and slave loops are tuned.  It is recommended that 
each loop is tuned independently using the procedure below. 
Because the slave loop is used by the master loop it must be tuned first.   
 

4.13.3. Example:  To Tune a Full Scale Cascade Loop 
 

Step 1.  Configure the loop as cascade full scale as follows:- 
In L0xCNF Set ‘Loop Type’ = Cascade 
In L0xCNF Set ‘Feedforward Type’ = FEEd 
In L0xCAS Set ‘Disable CSD’ = Yes 
In L0x_SP Set ‘Setpoint 1’ = the normal operating setpoint value for the main loop 
In L0x_SP Set ‘Local SP’ = the normal operating setpoint value for the slave loop (when 

cascade is disabled) 
 
Step 2.  Start the controller in Operator Level 
 
Step 3.  Set tune output high and low limits as follows: 
Note:  For the slave tune you may wish to restrict the ability of the tuner to disturb the process.  Tune OH 
should, therefore, be set to a value that will only enable the tune to achieve the local setpoint which you have 
chosen. 
In ATUNE Set ‘TnOL’ to a value which will limit the minimum output demand during tuning.  

This may be 0.0 for a heat only loop. 
Set ‘TnOH’ to a value which will limit the maximum output demand during tuning. 
 

Step 4.  Start tune on the slave loop as follows: 
In ATUNE Set ‘Tune Loop Number’ to L1APID 

 
Step 5.  You may monitor the progress of the tune by viewing the following parameters: 
In ATUNE ‘TnStat’ This indicates which step is being performed 
 ‘TnOP’ The output demand of the autotune.  For a slave loop this will be the same as the 

working output demand. 
 ‘CTStat’ The length of time this particular step has been running.  The tune step will abort 

after two hours 
 

Step 6.  On completion of the slave loop tuning: 
Keep the loop in Cascade Disabled, and allow the slave loop to control the process.  You must allow the slave 
loop to control at its Local SP.  Wait for the master loop to settle to a steady state value.  (Note, it is unlikely 
that the master loop steady state is the same as the slaves). 
When the master PV is at a steady value proceed with tuning the master loop.  (Note, if the master loop has 
not settled satisfactorily you may not be able to tune the master loop at all, since it is necessary to restrict the 
disturbance of the slave when tuning the master. 
 
Step 7.  Tune the master loop  
In ATUNE Set ‘TnOL’ and ‘TnOH’  

The values chosen should be symmetrical and chosen such that the slave stays in control 
(typically + 0.5 * slave proportional band). 
This amount, however, may not be sufficient to disturb the master to achieve a successful tune.  
If the proportional band of the master is in engineering units, the tune hysteresis of the master 
will be +1 engineering unit.  For a temperature loop, therefore, the master must be disturbed 
by at least 1 degree. 
TnOL and TnOH are set in %.  Although it is the master which is being tuned, it is the slave 
working SP which has to be modified in order to achieve a change in the output and hence 
measure a disturbance in the master PV.  Therefore, TnOL and TnOH relate to a percentage of 
the slave range by which the slave working SP will be changed.   
For example, if the slave has a range of –200 to +1372 the slave range is 1572 and TnOL and 
TnOH are 1%, then the slave working setpoint will be modified by + 15.72 degrees. 

In ATUNE Set ‘TnLpNr’ to L0xPID 
In L0xCAS Set ‘DisCas to ‘No’ 

This is to re-enable cascade mode and must be done before the time out period of 1 min 
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Step 8:  Return to control 
The slave and master loops should now be tuned.  Try changing the main setpoint and observe the response.  
If the master PV response is oscillatory then you may not have restricted the disturbance of the slave enough.  
Try decreasing the values of ‘TnOL’ and TnOH’ and retune the master. 

 

To invoke tune select Tune Loop Number to the particular loop that requires to be tuned.  
 

Loop Number Tunes Write Value via Comms 
1 L01PID (Slave) 11 
1 L1APID (Master) 12 
1 L1 Cascade pair 13 
2 L02PID (Slave) 21 
2 L2APID (Master) 22 
2 L2 Cascade pair 23 
3 L03PID (Slave) 31 
Etc Etc etc 

 

Table 4-1:   Tuning via Comms 

Setting Tune Loop Number to 0 (OFF) will discontinue tuning. 
If the sequence of tuning loops one by one is being handled by a supervisory system over communications, 
then the system should monitor the Tuning Active flag and wait for that to reset, or wait until Tune Loop 
Number is reset to 0, before setting Tune Loop Number to the value for the next Loop to be tuned. 
The remaining parameters give diagnostic information about what the tuning block is doing. 
 

Tuning  Cascade Tuning 
OFF OFF 
Noise Init 
Init AuxPID 
Start Wait 
Start Wait2 
NewSP Init 
Min PID1 
Max  
Store  
Zero  
Calc  
DONE  

 

Table 4-2:   Auto Tuning States 
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4.14. LOOP DIAGNOSTICS 

 
Figure 4-25:   Loop Diagnostic Parameter List 

All these parameters are read only and are mostly of use in diagnosing control problems.  

4.14.1. Loop Status Word 
The Loop Status Word (and the equivalent for the Auxiliary Loop) is useful for a supervisory system to read and 
to display loop status. Each of the 16 bits in the word represents a condition. 

Bit Value (Decimal) Bit set 

0 1 Hold 

1 2 Sensor Break 

2 4 SP ramp active 

3 8 Remote SP selected 

4 16 SP servo 

5 32 Debump 

6 64 Loop Break 

7 128 Integral Hold 

8 256 Remote SP fault 

9 512 Direct Action 

10 1024 Track 

11 2048 Power Limit 

12 4096 Autotune 

13 8192 Adaptive tune 

14 16384 Droop Tune 

15 32768 Manual 

 

Table 4-3:   Loop Status Word 

 

4.15. LOOP ALARMS 
Each Loop has 4 alarms which apply to the Loop Process Variable. They may be set to Absolute High, Absolute 
Low, Deviation High, Deviation Low, and Deviation band. One of four alarms, Alarm 4, may also be set as a ‘rate 
of change’ alarm. 
The alarm function blocks have many features.  All the alarms in the 2500 use the same function block and are 
described in detail in Chapter 5. 
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5. Chapter 5    Alarms 
5.1. DEFINITION OF ALARMS AND EVENTS 
Alarms are used to set a flag when a pre-set level has been exceeded (an analogue alarm) or an event has 
occurred (a digital alarm). The flag may be used to switch an output - usually a relay - to provide interlocking of 
the machine or plant or external audio or visual indication of the alarm. Using Toolkit blocks various alarm flags 
may be wired to a single relay output using the OR function.  
Alternatively the Alarms flag may just be read over communications and the 2500 supervisory system will 
annunciate and take the action required.  
Additional alarm options are to make the alarm ‘Blocking’ where a pre-condition has to be met before the alarm 
is enabled, or ‘Latching’ where the alarm must be acknowledged before the flag is cleared. 
Events are just alarms but are generally defined as conditions that occur as part of the normal operation of the 
plant, and are required for information or to start the next phase of the process, etc.  For the purposes of the 
operation of the 2500, alarms and events can be considered the same. 
 

5.2. TYPES OF ANALOGUE ALARM USED IN THE 2500 
This section describes graphically the operation of different types of alarm used in the 2500 controller.  For 
analogue alarms the graphs show measured value plotted against time.  

5.2.1. Absolute High 
 

This alarm (AbSHi) occurs when the Process Variable (PV) exceeds a set high level  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-1:   Absolute High Alarm 

5.2.2. Absolute Low 
 

This alarm (ABSLo) occurs when the Process Variable (PV) exceeds a set low level  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-2:   Absolute Low Alarm 
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5.2.3. Deviation High Alarm 
This alarm (devHi) occurs when the difference between the process variable and the setpoint is positive by 
greater than the alarm setpoint. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-3:   Deviation High Alarm 

5.2.4. Deviation Low Alarm 
This alarm (devLo) occurs when the difference between the process variable and the setpoint is negative by 
greater than the alarm setpoint. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-4:   Deviation Low Alarm 

5.2.5. Deviation Band 
A deviation band alarm (dEvbnd) monitors the process variable and the working setpoint and continuously 
compares the difference against the alarm setpoint.  If the difference is either negative by less than, or positive 
by greater than the alarm setpoint, the alarm state will be active. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5-5:   Deviation Band Alarm 
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5.2.6. Rate Of Change Alarm 
The Process Value falls faster than the alarm setting or rises faster than the alarm setting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-6:   Rate of Change Alarm 

Notes:  
1. The alarm is activated by excessive positive or negative rates of change  
2. An alarm is indicated during the period that the actual rate of change is greater than the set rate of change. 
3. There may be a small delay before the instrument displays an alarm condition since the instrument requires 

several samples.  This delay increases if the set value and actual value are close together 
4. A hysteresis value of, say, 1 unit per second will prevent the alarm from ‘chattering’ if the rate of change 

varies by this amount 
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5.3. TYPES OF DIGITAL ALARM USED IN THE 2500 
This table describes the operation of different types of digital alarm used in the 2500 controller. 
 

ITools List Description 

IstruE Alarm output set when input is TRUE 

ISFALS Alarm output set when input is FALSE 

GoTruE Alarm output set when input changes from FALSE to TRUE 

GoFALS Alarm output set when input changes from TRUE to FALSE 

ChAnGE Alarm output set when input changes state 

 

Table 5-1:   Types of Digital Alarm 

5.4. BLOCKING ALARMS 
A Blocking Alarm only occurs after it has been through a start up phase.  It is typically used to prevent alarms 
from being indicated until the process has settled to its normal working conditions. 
 

5.4.1. Absolute Low With Blocking 
The alarm only occurs after the start up phase when low alarm has first entered a safe state.  The next time a low 
alarm occurs will cause the alarm to become active. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-7:   Absolute Low Blocking Alarm 

5.4.2. Absolute High Alarm With Blocking 
The alarm only occurs after the start up phase when high alarm has first entered a safe state.  The next time a 
high alarm occurs will cause the alarm to become active. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5-8:   Absolute High Blocking Alarm 
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5.4.3. Deviation Band With Blocking 
The alarm only occurs after the start up phase when low deviation alarm has first entered a safe state.  The next 
time an alarm occurs, whether high band or low band will cause the alarm to become active. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5-9:   Deviation Band Blocking Alarm 
 

5.5. LATCHING ALARMS 
The alarm is indicated until it is acknowledged by the user.  Acknowledgement of an alarm is by setting the 
Alarm acknowledge flag via communications or, using wiring, from a digital input. 
To make an alarm latching there are two options, automatic (Auto), or manual (mAn). 
 

1. Automatic Reset. The alarm continues to be active until both the alarm condition is removed AND the alarm 
is acknowledged.  The acknowledgement can occur BEFORE the alarm condition is removed. 

 

2. Manual Reset.  The alarm continues to be active until both the alarm condition is removed AND the alarm is 
acknowledged.  The acknowledgement can only occur AFTER the alarm condition is removed. 

These are shown below for an Absolute High Alarm 
 
 

5.5.1. Latched Alarm (Absolute High) With Automatic Reset 
The alarm is displayed until it is acknowledged 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5-10:   Latched Alarm with Automatic Reset 
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5.5.2. Latched Alarm (Absolute High) With Manual Reset 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5-11:   Latched Alarm with Manual Reset 

5.6. GROUPS & ALARM STATUS WORD 
All the alarms in the 2500 are in groups associated with a PID loop, an I/O channel, or are User defined alarms. 
All the alarm active flags and alarm acknowledged flags are also available within a 16 bit Alarm Status Word 
‘AlmSW’, in the following standard format. 
 

Bit Value (Decimal) Set when:  
0 1 Alarm 1 (or A) active 

Alarms can be acknowledged 
individually or as a group using the 
Group Acknowledge Flag GrpAck.  
 
 
Note: 
Operator → SYSTEM → AckAll 
acknowledges all alarms on the 
base. 
 

1 2 Alarm 1 (or A) acknowledged 
2 4 Alarm 2 (or B) active 
3 8 Alarm 2 (or B) acknowledged 
4 16 Alarm 3 (or C) active 
5 32 Alarm 3 (or C) acknowledged 
6 64 Alarm 4 (or D) active 
7 128 Alarm 4 (or D) acknowledged 
8 256 Alarm E active 
9 512 Alarm E acknowledged 
10 1024 Alarm F active 
11 2048 Alarm F acknowledged 
12 4096 Alarm G active 
13 8192 Alarm G acknowledged 
14 16384 Alarm H active 
15 32768 Alarm H acknowledged 

 

Table 5-2:   Alarm Status Word 

5.7. LOOP ALARMS 
Every PID block in the 2500 includes a group of four alarms.  All alarms use the PID block Process Variable as 
the alarm input and deviation alarms are with respect to the PID block setpoint. 

 
Figure 5-12:  Loop alarms (Configuration mode) 

Acknowledging here will not reset the alarm 
because it is still in an alarm condition 
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The alarm must first clear 
before it can be reset. 
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5.7.1. Alarm Parameters  
These are found in Control → LOOP0x → L0xALM 

Name Description Range Status 

 GrpAck Group Acknowledge.  To acknowledge all alarms associated with this loop.  The action 
which follows depends on the type of latching configured, see section 5.5. 

  

 no (0) No Unacknowledged 

 YES (1) Yes Select to acknowledge 

 AL_1 Alarm 1 Type.  In configuration mode the four alarms may be set to any of the types 
listed below: (See also section 5.2) 

  

 None (0) Alarm not configured 

 AbsLo (1)  Absolute Low 

 AbSHi (2) Absolute High 

 dEvbnd (16) Deviation Band 

 devHi (17) Deviation High 

 devLo (18) Deviation Low 

 rAtE (64) Rate of Change  Alarm 4 only 

 SP_1 Alarm 1 Setpoint.  To set the level at which the alarm operates  ⋅9  

 HY_1 Alarm 1 hysteresis.  Hysteresis is the difference between the point at which the alarm 
switches ON and the point at which it switches OFF. 
It is used to prevent relay chatter. 

⋅9  

 Ih1 Alarm 1 inhibit.  Inhibit prevents the alarm from being indicated.  It can be wired to a 
source (such as a digital input) or if not wired can be set by the operator. 

  

 no (0) No Not inhibited 

 YES (1) Yes Inhibited 

 Ih1Src Alarm 1 inhibit source.  Allows In1 to be wired   

 bLoc_1 Alarm 1 blocking.  In configuration mode the four alarms may be set to blocking, see 
section 5.4. 

  

 no (0) No blocking 

 YES (1) Blocking 

 Ltch_1 Alarm 1 latching.  In configuration mode the four alarms may be set to latching, see 
section 5.5. 

  

 no (0) No latching 

 Auto (1) Automatic reset 

 mAn (2) Manual reset 

 Ack_1 Alarm 1 acknowledge.  To acknowledge alarm 1.  The action which follows depends 
on the type of latching configured, see section 5.5. 

  

 no (0) Unacknowledged 

 YES (1) Acknowledged 

 OP_1 Alarm 1 output state.     

 OFF (0) Alarm 1 off 

 on (1) Alarm 1 on 

 RtUnit Alarm 4 rate units  Alarm 4 only   

 SEc (0) Seconds 

 min (1) Minutes 

 AlmSW Alarm Status Word  See Table 5-2   

The above alarms are repeated for alarms 2 to 4. 
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5.8. USER ALARMS 
The 2500 has four unassigned analogue alarms and four unassigned digital alarms. 

 
 

Figure 5-13:   Analogue User Alarm (Configuration Level) 

 

5.8.1. User Alarm Parameters – Analogue 
These are found in User_Alarms → AN_ALM 
 

Name Description Range Status 

 P1A Alarm 1 Input A Value.  To set the analogue value of alarm 1to input A  ⋅9 

 P1ASrc Alarm 1 Input A Source. Allows P1A to be wired   

 P1B Alarm 1 Input B Value.  To set the analogue value of alarm 1to input A  ⋅9 

 P1BSrc Alarm 1 Input B Source. Allows P1A to be wired   

The remaining parameters are the same as the loop alarms 
Note: 
1. The inputs to the alarm block are unassigned so Input A must be wired to the Value to be tested for the 

alarm condition (PV), and for deviation alarms Input B must be wired to the Value used compare with Value 
A for alarm condition (SP). 

 

5.8.2. User Alarm Parameters – Digital 
The input has to be wired to the Flag to be tested for the alarm condition.  In configuration mode all four alarms 
may be set to any of the digital alarm types listed in section 5.3. 
These are found in User_Alarms → DIGALM 
 

Name Description Range Status 

 P1 Alarm 1 Input Value.  To set the value to alarm 1 input    

 P1Src Alarm 1 Input Source. Allows P1 to be wired   

 AL_1 Alarm 1 Type.  In configuration mode the four alarms may 
be set to any of the types listed below: (See also section 5.2)  

  

 None (83) Alarm not configured 
 IStrue (84)  Alarm output set when input is TRUE 
 ISFALS (85) Alarm output set when input is FALSE 
 Gotrue (86) Alarm output set when input changes from FALSE to TRUE 
 GoFALS (87) Alarm output set when input changes from TRUE to FALSE 
 ChAnGE Alarm output set when input changes state 

The remaining parameters are the same as the loop alarms 
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5.9. I/O ALARMS 
Each I/O module has 8 alarms (designated A to H) which are shared between the channels of the module.  This 
sharing has a default setting but, in configuration mode, individual alarms may be reassigned to other channels. 

 
 

Figure 5-14:   I/O Alarms (Configuration Level) 

5.9.1. I/O Alarm Parameters  
These are found in IO → Module 0x → MOD0x and are essentially the same as Loop Alarms except that there is 
no Group Alarm Acknowledge.  Plus:- 

Name Description Range Status 

 ChnSel Channel select for alarm A.   

 C1 (1) Channel 1 
 C2 (2) Channel 2 
 C3 (3) Channel 3 
 C4 (4) Channel 4 
 C5 (5) Channel 5 
 C6 (6) Channel 6 
 C7 (7) Channel 7 
 C8 (8) Channel 8 

5.9.2. Analogue Modules 
The alarm types are fixed as shown below together with the default channel assignment. 

Alarm Type AI2 Channel AI3 Channel 
A AbsHi 1 1 
B AbsHi 2 2 
C AbsLo 1 1 
D AbsLo 2 2 
E AbsHi 1 3 
F AbsHi 2 4 
G AbsLo 1 3 
H AbsLo 2 4 

 

Table 5-3:   Default Analogue I/O Alarms 

5.9.3. Digital Modules 
The alarm types are not fixed and in configuration mode may be set to any digital alarm type. The default 
channel assignments are shown below. 

Alarm Type DI4 Channel DI8 Channel 
A Any 1 1 
B Any 2 2 
C Any 3 3 
D Any 4 4 
E Any 1 5 
F Any 2 6 
G Any 3 7 
H Any 4 8 

 

Table 5-4:   Default Digital I/O Alarms 
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5.10. INSTRUMENT STATUS ALARMS 
These are self diagnostic alarms provided to simplify fault finding.  Bit masks are provided to allow only selected 
events to be reported in the appropriate alarm output. 
Alarms are reported at the channel level, at the module level and at a system (IOC) level. 
 

5.10.1. Individual Channel Status 
The Status ChStat is reported for every channel on every module and is found in IO → Module0x → M0x_C1 to 
C8. 
 

Bit  Value (Decimal) Bit set when 

Bit 0 1 Sensor break detected 

Bit 1 2 CJC failed 

Bit 2 4 Channel not in use 

Bit 3 8 Analogue output saturated 

Bit 4 16 Initialising 

Bit 5 32 Invalid Analogue Calibration data 

Bit 6 64 Reserved / Analogue input saturated 

Bit 7 128 Module fault (Module Status not zero) 

 

Table 5-5:   Channel Status Bits 

 
An alarm is provided for this status word.  The Status Alarm Output flag is set if any bit in the channel Status is 
set AND the corresponding bit in the Status Alarm Bit Mask is set. 
To use the Alarm the Status Alarm Bit Mask must be set in Configuration Mode. If the bit mask is set to 255 (Bits 
0 to 7 set) then any Channel Status bit will set the alarm output. If the mask is set to 1 (bit 0 set) then only Sensor 
Break detection will set the alarm output. 
As with all alarms it may be configured to be latching or blocking. There is an alarm inhibit and an acknowledge. 
 

5.10.2.    Status of All Channels in a Module  
At the Module level all its channels are reported in the Channel Alarms Status Word. This has the same format 
as standard alarm status words. 
 

Bit Value (Decimal) Set when: 

0 1 Channel 1 Alarm active 

1 2 Channel 1 Alarm acknowledged 

2 4 Channel 2 Alarm active 

3 8 Channel 2 Alarm acknowledged 

4 16 Channel 3 Alarm active 

5 32 Channel 3 Alarm acknowledged 

6 64 Channel 4 Alarm active 

7 128 Channel 4 Alarm acknowledged 

8 256 Channel 5 Alarm active 

9 512 Channel 5 Alarm acknowledged 

10 1024 Channel 6 Alarm active 

11 2048 Channel 6 Alarm acknowledged 

12 4096 Channel 7 Alarm active 

13 8192 Channel 7 Alarm acknowledged 

14 16384 Channel 8 Alarm active 

15 32768 Channel 8 Alarm acknowledged 

 
Table 5-6:   Channel Alarm Status Word 
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5.10.3.   Status of All Channels in a System (IOC) 
Operator → SYSTEM → IOStat is a Global IO Status word that consolidates all the IO status alarms into a single 
word. Bits 0 to 7 are the OR of all the Channel Status bits Table 5-5, bits 8 to 11 the OR of all the Module Status 
bits Table 5-8.  

Bit Value (Decimal) Set when: 
0 1 Any channel Sensor break detected 
1 2 Any channel CJC failed 
2 4 Any channel Channel not in use 
3 8 Any channel Analogue output saturated 
4 16 Any channel Initialising 
5 32 Any channel Invalid Analogue Cal data 
6 64 Reserved /  Analogue input saturated 
7 128 Any channel Module fault  
8 256 Any Module is missing 
9 512 Any Wrong Module fitted 
10 1024 Any Unrecognised Module fitted 
11 2048 Any Module Comms Error 
12 4096 Reserved for future use 
13 8192 Reserved for future use 
14 16384 Reserved for future use 
15 32768 Reserved for future use 

 

Table 5-7:   Global IO Status Word 
 

5.10.4.   Module Status 
Module01 → MOD01 → ModSta is the Module Status for the module fitted in slot one. 

Bit Value  Bit set when 
0 0 Module is OK 
1  1 Module is missing 
2 2 Wrong Module fitted 
3 4 Unrecognised Module fitted 
4 8 Module Comms Error 

 

Table 5-8:   Module Status 

Note that the Summary Word is not an ‘alarm’ word, it reflects the state of the I/O.  
Bit 0 is set if the value of channel 1 is >0.5 for analogue or digital modules. 
Bits 1 to 7 are for channels 2 to 8. See Chapter 7. 
 

5.10.5.   System (IOC) Status 
Operator → SYSTEM → InstSt is the Instrument Status word and provides information about problems with the 
2500 IOC. 

Bit Value Set when: 
0 1 In Config Mode 
1 2 Running Slowly 
3 4 NV ram fail 
4 8 Bad Custom Lin 
5 16 Bad base size 
9 32 I/O network watchdog 
10 64 IO controller cold started 

 

Table 5-9:   Instrument Status Word 
 

An alarm is provided for this status word.  The Instrument Alarm Output flag is set if any bit in the Instrument 
Status is set AND the corresponding bit in the Instrument Alarm Bit Mask is set. 
To use the Alarm the Instrument Alarm Bit Mask must be set in Configuration Mode.  If the bit mask is set to 
2047 (Bits 0 to 10 set) then any Instrument Status bit will set the alarm output.  If the mask is set to 1 (bit 0 set) 
then only ‘in Configuration Level’ will set the alarm output. 
As with all alarms it may be configured to be latching or blocking.  There is an alarm inhibit and an alarm 
acknowledge. 

Note that Bit 2 (value 4) 
will usually be set as 
there is likely to be an 
unused channel. 
 
When IOStat has a value 
4 (or zero) the red LED on 
the 2500 IOC will be off.  
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6. Chapter 6    Operator 
This folder contains a number of system wide and diagnostic parameters. 
 

6.1. LINEARISATION TABLES 
These parameters are found in Operator → Lin Tables and are provided to allow the customised linearisation to 
be checked.  The list is only shown when ‘Options’ → ‘Parameter Availability Settings’ → ‘Hide Parameters and 
Lists when Not Relevant’ is not checked.  They are used for cloning purposes only and under no circumstances 
should any attempt be made to change or enter the value of a parameter in this list. 
 

 
 

Figure 6-1:   Lin Tables 

 

6.2. DIGITAL COMMUNICATIONS  
These parameters set up digital communications 
 

 

 

Figure 6-2:   Modbus Communications Parameters (Configuration Level) 
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6.2.1. Digital Communications Parameters  
These parameters are found in Operator → COMMS.  See also Chapters 9,10, 11 and 12 for further details. 
 

Name Description Range Status 

 Addr Comms Address.  Unit address 

Modbus:-  normally taken from the IOC terminal unit digit switch (see section 2.6.3).  
The digit switch allows addresses of 1 to 63 to be set.  If the address switch is set to 
zero, the ‘Addr’ parameter can be set in software.  This software address is only used if 
unit addresses higher than 63 are required. 

Profibus:-  range 0-127.  Address can be set on the IOC terminal unit digit switch or in 
software using this parameter. 

Devicenet:- range 0-63.  Address can be set on the IOC terminal unit digit switch or in 
software using this parameter. 

Ethernet-Modbus TCP slave id: range 0-63.  Value can be set on the IOC terminal unit 
digit switch or in software using this parameter. 

  

 Baud Comms Baud Rate. Baud rate 

Modbus:-  range 9600 to 19200  see also note 1. 

Profibus:-  the parameter is read only 

Devicenet:-  Rates of 125, 250 or 500 can be set 

Ethernet:- the parameter is not used, so is normally hidden 

  

 Parity Comms Parity.  Parity is available for Modbus, Profibus and Devicenet and must be set 
to suit the master. 

  

 None (0) None.  No parity 

 EvEn (1) Even.  Even parity 

 Odd (2) Odd.    Odd parity 

 Res Comms Resolution.  Modbus only:-  normally set to ‘Full’, giving all the digits available 
including those after the decimal point.  The communications master must know how 
to interpret the number as set in LOOP0x → L0xCFG → dEcP. 

  

 FuLL (0) Full  

 Int (1) Integer.   Setting ‘Res’ to ‘Int’ will only return the integer value. 

 dELy Comms Delay.  Modbus only:  normally set to ‘no’.  It is only required if there is a 
problem, particuarly with comms adaptors.  The delay option leaves 10ms of quiet 
time after each transaction. 

  

 no (0) No delay 

 YES (1) Delay selected in ms (1 –100) 

 FLAGs Comms Special Case Flags. This parameter is for special use only and may be 
changed in all modes, not only in configuration. 

  

The following parameters may be hidden if not required for the operation of the instrument.  To reveal uncheck the ‘Hide 
Parameters’ box in ‘Options → Parameter Availability Settings’ 

 Prot Profibus Protocol. Select the Profibus protocol required.   

 DP (0) DP 

 DPv1 (1) DPv1 

 BaudLo Comms Baud Rate Low Limit   

 BaudHi Comms Baud Rate High Limit   

 AddLo Address Low Limit   

 AddHi Address High Limit   
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The following parameters are only relevant to the Ethernet IOC: 

 IPaddr1 IP Address 1: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is the 
aaa field 

  

 IPaddr2 IP Address 2: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is the 
bbb field 

  

 IPaddr3 IP Address 3: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is the 
ccc field 

  

 IPaddr4 IP Address 4: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is the 
ddd field 

  

 Subnet1 Subnet Mask 1: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is 
the aaa field 

  

 Subnet2 Subnet Mask 2: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is 
the bbb field 

  

 Subnet3 Subnet Mask 3: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is 
the ccc field 

  

 Subnet4 Subnet Mask 4: in the standard Ethernet format, aaa.bbb.ccc.ddd, this is 
the ddd field 

  

 Gateway1 Default Gateway 1: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the aaa field 

  

 Gateway2 Default Gateway 2: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the bbb field 

  

 Gateway3 Default Gateway 3: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the ccc field 

  

 Gateway4 Default Gateway 4: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the ddd field 

  

 PrefMst1 Preferred Master 1: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the aaa field 

  

 PrefMst2 Preferred Master 2: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the bbb field 

  

 PrefMst3 Preferred Master 3: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the ccc field 

  

 PrefMst4 Preferred Master 4: in the standard Ethernet format, aaa.bbb.ccc.ddd, this 
is the ddd field 

  

 MACaddr1 MAC Address 1: in the standard Ethernet format, aa-bb-cc-dd-ee-ff, this is 
the aa-bb fields. 

  

 MACaddr2 MAC Address 2: in the standard Ethernet format, aa-bb-cc-dd-ee-ff, this is 
the cc-dd fields. 

  

 MACaddr3 MAC Address 3: in the standard Ethernet format, aa-bb-cc-dd-ee-ff, this is 
the ee-ff fields. 

  

 DHCPen DHCP Enable:    

 Fixed (0) Fixed.  Fixed IP addressing – DHCP disabled. 

 DHCP (1) DHCP. Dynamic IP addressing – DHCP enabled. 

 NetStat Network Status: for diagnostics purposes   

 IPChanged IP Changed: for diagnostics purposes   

 LocalAddres Local Modbus Address: for diagnostics purposes   
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Note 1:-  The table shows the baud rates supported in different versions:- 
 

Modbus 

Baud Rate Software Version V1 V2 V3 

2400 (3)    

4800 (2)    

9600 (0)    

19,200 (1)    

38,400 (5)    

 

Profibus 

Baud Rate Software Version V1 V2 V3 V4 

Set by the 
master up 
to 12MB 

    

 

Note:-  Version 4 is Profibus only 
 

Devicenet 

Baud Rate Software Version V1 V2 V3 

125K (6)    

250K (7)    

500K (8)    

 

Ethernet 

Baud Rate Software Version V1 V2 V3 

10BaseT    
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6.3. SYSTEM 
These parameters provide information about the system. 
 

6.3.1. System Parameters  
These parameters are found in Operator → SYSTEM. 
 

Name Description Range Status 

 ReqIM Requested Instrument Mode.  The requested mode of the 2500 IOC   

 Operat (0) Operating:  Normal use 

 Stndby(1) Standby:   Input values still work but there are no calculations 

 Config (2) Configuration:  the controller is being set up and is not functioning 

 IM Instrument Operating Mode.  The actual mode of the 2500 IOC   

 Operat (0) Operating:  Normal use 

 Stndby(1) Standby:   Input values still work but there are no calculations 

 Config (2) Configuration:  the controller is being set up and is not functioning 

 II Instrument Identity.  A unique hex number for the 2500 product, displayed as 
decimal as follows:- 

  

 Code 2500E 2500C 

 Modbus 2580 
[9600] 

2500 
[9472] 

 Profibus DP 2581 
[9601] 

2510 
[9488] 

 Profibus DPV1 2582 
[9602]  

2511 
[9489] 

 Devicenet 2583 
[9603]  

N/A 

 Ethernet 2584 
[9604]  

N/A 

 AckAll Global Alarm Acknowledge.  Set to acknowledge all alarms.  It resets itself.   

 no (0) No acknowledge 

 YES (1) Choose ‘Yes’ to acknowledge 

 AckIP Global Alarm Ack Input.  Used to acknowledge all alarms.   

 no (0) No acknowledge (only if not wired) 

 YES (1) Choose ‘Yes’ to acknowledge (only if not wired) 

 AckSrc Global Alarm Ack Input Source.  Modbus address of flag used to acknowledge all 
alarms 

-1 means it is not wired 

Allows all alarms to be acknowledged by wiring to the address of a source 
(configuration level only) 

  

 IOstat Global IO Status.  Summarises all channels of all modules, see section 5.10.3.   

 BaseSz Base Size.  Size of the base as identified by the IOC.   

 IOFail I/O Fail Strategy.  Defines IO behaviour in fault condition   

 Contin (0) Continue – carry on as before 

 EntSby (1) Enter Standby - go into Standby Mode on failure and stay there 

 Stndby (2) Standby - Remain in Standby only whilst fault persists 

 IONwdg I/O Network Watchdog Timeout.  Set time before IO network watchdog is activated 
after failure is detected. 

On loss of Field communications for greater than a pre set time an action can be 
taken, either to go into standby or set the network watchdog flag.  The latter mode is 
intended for use where a failure strategy is defined by the configuration of the IOC.  
This strategy is set by the next parameter ‘NwdAct’. 

A value of 0 disables the watchdog.  Setting to a positive value switches the function 
on. 

h:m:s:ms  
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Name Description Range Status 

 IONrec IO Network Recovery Time   

 NwdAct I/O Network Watchdog Timeout.  Defines the instrument behaviour when the 
network watchdog is activated. 

  

 EntSby (0) Enter Standby.  Go into Standby Mode on failure and stay there 

 Flag (1) Set the network watchdog flag only 

 Nwdged I/O Network Watchdog Flag.  Indicates IO network has failed   

 StStby Startup in Standby.  (Config only) Defines IOC behaviour on powering up   

 no (0) No - Operate normally 

 YES (1) Yes - Remain in Standby Mode 

 STime Sample Time.  Indicates the current sample time the IOC is achieving   

MaxST Maximum Sample Time.  The maximum sample time the IOC has used.  If the IOC is 
failing to achieve the requested sample time this indicates what it can achieve. 

  

ReqST Requested Sample Time. This is normally 110ms (0) but may be increased to 990ms 
(8) in steps of 110ms for bigger systems.   

  

SlowST Running Slower than Requested Flag.  Set if the IOC is failing to achieve the 
requested sample time. 

  

 no (0) IOC is achieving the requested sample time 

 YES (1) IOC is running slower than the requested sample time 

SOrCt Slowed Down Counter.  The number of times the ‘SlowST’ flag has been set.   

ColdSt Cold Start Flag.  Set after a non volatile RAM error has forced a re-initialisation to 
default parameter values. 

  

NVFail Non-Volatile Memory Failure.  The IOC non volatile RAM has failed and it will remain 
in Standby Mode whilst this condition persists. 

  

ClinFl Custom Linearisation Failure.  The IOC has detected failure in a custom linearisation 
curve and it will remain in Standby Mode whilst this condition persists 

  

InstSt Instrument Status.   A status word which combines a number of the above flags. 

See section 5.10.5.  This is used for the Instrument Alarm. 

  

Units Instrument Temperature Units.  (Config mode) sets the temperature units    

 oC (0) Celsius 

 oF (1) Farenheit 

 ok (2) Kelvin 

Mask Instrument Alarm Bit Mask.  (Config mode) set to select which of the ‘InstSt’ bits are 
enabled (not masked) from the Instrument Alarm Status Word ‘AlmSW’.  See section 
5.10.5. 

  

Inhibt Instrument Alarm Inhibit.  To inhibit ‘AlmSW’   

InhSrc Instrument Alarm Inhibit Source.  Modbus address of the parameter used to inhibit 
the instrument alarm 

-1 means it is not wired 

  

Bloc Instrument Alarm Blocking.  (Config mode).  After power up the alarm condition must 
be OK first, before the alarm is allowed to be active.  See section 5.4. 

  

 no (0) No blocking 

 YES (1) Yes – set for blocking alarm operation 

Ltch Instrument Alarm Latching.  (Config Mode) Set to Auto the alarm will latch until the 
condition has cleared and it has been acknowledged.  See section 5.5. 

  

 no (0) No latching 

 Auto (1) Automatic.  The alarm continues to be active until both the alarm condition is removed AND the alarm is 
acknowledged 

 mAn (2) Set to Manual the alarm must clear first, then be acknowledged. 

Ack Instrument Alarm Acknowledge.  See section 5.5.   

 no (0) No acknowledge 
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Name Description Range Status 

 YES (1) Yes – Set to acknowledge alarm 

OP Instrument Alarm Output.  Flag set if ‘AlmSW’ is not zero.   

 OFF (0) No alarm 

 on (1) Alarm flag set 

AlmSW Instrument Alarm Status Word.  Returns the bitwise AND of ‘InstSt’ and the bit mask 
‘Mask’. 

  

The following parameters are used by external masters to control the ramp blocks in the 2500: 

GHd Global SRL Hold Flag.  Holds all ramps   

GHdSrc Global SRL Hold Flag Source.  (Config mode) Modbus address of flag used to hold 
ramps 

-1 means it is not wired 

  

GSSync Trigger All Ramps.  Triggers all ramps to provide a synchronised start.   

 no (0) Do not trigger ramps 

 YES (1) Global trigger active 

ActIM Actual operating mode of the IOC.  Only appears when ‘Options’ → ‘Parameter 
Availability Settings’ not checked 

  

 Operat (0) Operator mode – normal use 

 Stndby (1) Standby mode - I/P values still work but there are no calculations 

 Config (2) Configuration mode - the controller is being set up and is not functioning 

LveCnf Enable IO Config in Operator mode.  Enables changes to parameters and wires in IO 
areas on line. 

Care is needed when changing this value 

  

 no (0) Configuration parameters read only in Operator mode 

 YES (1) Configuration parameters read/write in Operator mode 

IS Instrument Operating State.  Displays the level of operation   

 Operat (0) Operator level 

 Stndby (1) Standby mode - I/P values still work but there are no calculations 

 Config (2) Configuration mode - the controller is being set up and is not functioning 

 LveCnf (3) Live Configuration mode.  Similar to operating mode 

PaChgd Parameter Changed Status Word.  This is a bit mapped field indicating modules 
which have had parameters changed while in ‘LveCnf’.  The parameters are 
detailed in the list below:- 

  

 ALM01 to 16 A to H ALSP_1 to 8 Alarm SP  

 ALM01 to 16 A to H Hy_1 to 8 Alarm hysteresis  

 M01 to 16_C1 to 8 SenS Invert  

 M01 to 16_C1 to 8 VALH Eng val high  

 M01 to 16_C1 to 8 VALL Eng val low  

 M01 to 16_C1 to 8 IOH Electrical high  

 M01 to 16_C1 to 8 IOL Electrical low  

 M01 to 16_C1 to 8 SBDet Sensor break bleed enable  

 M01 to 16_C1 to 8 FltAct Fault action  

 M01 to 16_C1 to 8 LinTyp Linearisation type  

 Bit 0 = module slot 1 ... bit 15 = module slot 16. 

May be used over digital communications 

It is possible to reset the bits to 0 but not set to 1 
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Name Description Range Status 

ApName Application Name This is an 8 character field for the manual entry of a 
configuration name. 

E.g. the name of the clone file currently loaded. 

  

ApVers Application Version.  A 5 digit field for the manual entry of the application version. 

E.g. the clone file version. 

  

TStamp Application Time Stamp.  A 6 digit field to manually store the application 
date/time.. 

  

CustabN1 Custom Table 1 Name.  Name of the custom linearisation table downloaded with 
the linearisation data 

  

CustabN2 Custom Table 2 Name.  Name of the custom linearisation table downloaded with 
the linearisation data 

  

CustabN3 Custom Table 3 Name.  Name of the custom linearisation table downloaded with 
the linearisation data 

  
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6.4. PASSWORD ENTRY 
These parameters allow the user to enter different levels of operation 
 

6.4.1. Password Entry Parameters  
These parameters are found in Operator → PASSWD 
 

Name Description Range Status 

 UserPW User Calibration Password.  The correct value has to be entered to enable User 
Calibration.  See Chapter 13. 

0 -32767  

 RefPW Reference Calibration Password.  The correct value has to be entered to enable 
Reference Calibration.  See Chapter 13. 

0 -32767  

 

6.5. PASSWORD SET UP 
These parameters are in configuration level only and allow the user to set up the passwords for different levels 
of operation. 
 

6.5.1. Password Set Up Parameters  
These parameters are found in Operator → SETPW 
 

Name Description Range Status 

 DefUPW User Calibration Password Configuration..  (Config mode only).  The value used 
for the User Cal password 

0 -32767  

 DefRPW Reference Calibration Password.  (Config mode only).  The value used for the 
Reference Cal password 

0 -32767  

 

6.6. DIAGNOSTICS 
These parameters are used to assess the cycle time that the 2500 unit can achieve.  It is particularly useful for 
2500 units with the 8 PID loops. 
 

6.6.1. Diagnostic Parameters  
These parameters are found in Operator → DIAG 
 

Name Description Range Status 

 Ctime Control Task Duration in Ticks.  This is in ‘ticks’ of 1.83ms (1/60 of 110ms) and is 
the time taken to calculate all the PID loops. 

  

 MaxCT Maximum Control Task Duration.  This is the maximum number of ‘ticks’ used to 
calculate the PID loops.  This can be reset to 0. 

MaxCT should not exceed the number indicated below:- 

Base Size MaxCT ticks 

4  <56 

8  <52 

16  4 

  

 
If ‘MaxCT’ does approach or exceed this number the ‘Operator.SYSTEM → Requested Sample Time’ should be 
increased. 
 
Other diagnostic parameters displayed give the high and low A/D conversion counts for each channel.  These 
are for engineering purposes only. 
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6.7. SYSTEM DESCRIPTIONS 
These parameters provide descriptions of system parameters.  They are found in Operator → DESCR 
 

Name Description Range Status 

 CC Company ID   

 II Product ID   

 VO Instrument Version Number   

 SerialNo Instrument Serial Number   

 PCode1 Feature Pass Code 1. Used to set which features are available: number of loops, user 
calculations. 

  

 PCode2 Feature Pass Code 2. Used to set which features are available: number of loops, user 
calculations. 

  

 FitA Feature Identifier Table Address   

 PidCS Product ID Table Checksum   

 nFID Number of Feature Identifiers   

 F1 Feature1: Indirect Modbus Address   

 F1_1 Address of Read Only Indirection Table   

 F1_2 Address of Read/Write Indirection Table   

 F1_3 Not Used   

 F2 Feature2:  Modbus Word Ordering   

 F2_1 High order word in low reg. addr   

 F2_2 Not Used   

 F2_3 Not Used   

 F3 Feature3: Modbus Function Codes   

 F3_1 FCs 3;4;6;7;8 and 16 supported   

 F3_2 FCs 17-19 NOT supported   

 F3_3 FCs 70 and 71 supported   

 F4 Feature4: Analog Value Formats   

 F4_1 16 bit scaled & IEEE & 32 bit int   

 F4_2 Not Used   

 F4_3 Not Used   

 F5 Feature5: Ethernet Parameters   

 F5_1 Supported Ethernet parameters   

 F5_2 Ethernet Base Address   

 F5_3 Not Used   

 nindRO Read Only Modbus indirect table size   

 nindRW Read/Write Modbus indirect table size   
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7. Chapter 7    I/O MODULES 
7.1. OVERVIEW 
In the 2500 system, I/O Modules perform equipment interface functions to measure or generate raw voltage, 
resistance or current.  Most transducer types can be connected straight into the I/O module via screw terminals. 
Each I/O Module is dedicated to a particular function - analogue or digital, input or output. Channels on a 
module may be set for different functions; for example, channel 2 of an AI2 might be set to work with a Zircionia 
probe, and channel 1 set to a thermocouple range to measure the probe temperature.   
Each channel can be considered as an instance of a design block (see section 3.7), capable of scaling, filtering, 
A-to-D or D-to-A conversions, de-bounce, linearisation, and more - within the reasonable limits of the channel 
type.  Each channel has a set of parameters providing for each feature.  These parameters can be displayed in 
lists and manipulated using iTools. 
The I/O Module itself is also considered a design block, with identity and status parameters. 
 

7.2. I/O BLOCKS 
 
 
 
 
 
 
 
 

Figure 7-1:   For maximum design flexibility all modules are packaged as plug in modules 

 
 
 
Some modules (particularly the analogue input types) are 
supported with different Terminal Units, optimizing performance 
for specific input ranges. 
 
 
 
 
 
 

 

Figure 7-2:   The plant wiring is accommodated by screw terminals in matching terminal units 
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7.3. I/O MODULE INDICATOR LEDS 
All modules support status indicator LED's to reflect I/O terminal status.  
All I/O modules offer a green indicator.  This is illuminated when the module is fitted and powered and when 
the IOC matches the 'ReqID' parameter for that base slot with the actual module type 'ActID'. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-3:   Module Status Indication 

The green status LED should be steady; any flash or blink indicates a system or module hardware problem.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-4:   Analogue I/O Channel Status Indication 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-5:   Digital I/O Channel Status Indication 

Note that the indicators in DI4, DI6 and DI8 modules track the processed data reported to the IOC, not the 
terminal condition.  There could be a slight difference if the channel has a long de-bounce period specified, or 
when using the pulse detect channel type. 

All Analogue I/O modules also support a channel 
status LED for each channel.  These indicators are red 
and show channel status - illuminated if there is a 
channel problem. 

LED ON OFF 

Red Initialising, or I/O overload Normal 
operation 

 Flashing Blinking 

Bad cal data Calibrating 

 

LED ON OFF 

Yellow Digital input Logic 1, input 
voltage high, or contact closed. 

Digital output Logic 1, output 
voltage high, or  (RLY4) contact 

closed.  

Digital input Logic 0, input 
voltage low, or contact open. 

Digital output Logic 0, output 
voltage low, or  (RLY4) contact 

open.  

Note: Digital Output modules must have a 24V power supply connected to the 
terminal unit in order to drive the LEDs. 

 

The Digital I/O modules (including the RLY4) all support an LED associated 
with each channel.  These indicators are yellow and show channel status, lit 
for logic 1 (on). 

LED ON OFF 

* 
Green 

 

Normal 
operation 

Fault Condition 

No power, IOC comms or 
unrecognised module type 
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7.4. CHANNEL ISOLATION 
The 2500 is easy to use because transducers can be directly wired into any appropriate channel at the terminals.  
Such direct connection introduces safety implications, particularly risk of shock hazard.  Electrical isolation 
minimizes such risks even when equipment goes faulty, and particularly when some transducers have to be run 
"live".  
The system designer must also ensure I/O signal integrity, minimizing noise, interference and cross-talk effects.  
Electrical isolation makes it much easier to plan and implement system wiring. 
With these considerations in mind, a very simple isolation strategy is implemented.  There is a barrier separating 
all I/O channels in any I/O module from the rest of the 2500 system. 
The isolation barrier means that a hazardous voltage on any I/O channel cannot introduce a hazard on any 
wiring on another I/O module, or put at risk the rest of the 2500. 
Extending this principle, most 2500 modules - like the AI2, DI6 and so on - provide isolation channel-to-channel.  
This ensures safety and good signal quality on all channels, even running under high common-mode voltage 
conditions. 
Figure 7-6 below shows the principle, using, for example, the AI2 with TC terminal unit  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-6:   AI2 Isolation Barriers 

 
Some I/O modules - like the AI3 - offer channels completely isolated for common-mode rejection, but are 
unlikely to be run at hazardous voltages.  Still others - like DO4 - share one or more common terminals, so the 
individual channels are not isolated at all from each other.  
 
The following sections describe each separate module including the isolation provided for each type.  
 
 

Any installation must pay due regard to safety requirements.  Sensors working at hazardous voltage 
levels must be adequately insulated and wired to appropriately isolated I/O in the 2500 base.  
Wiring on other channels in the same I/O Module could be at risk under fault conditions. 
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7.5. CHANNEL STATUS AND ERRORS 
Any control strategy and configuration of the 2500 must consider wiring and plant faults, errors and exceptions. 
Even simple faults may affect the safe running of the system. 
The 2500 offers several levels of alarms and status indicators to help handle problems.  
Section 5.10 describes the Instrument Status Alarms and how they can be set up.  For I/O modules there is a 
Module Status byte: 

 ModSta Module Status.  A bit field reporting the module status: 
  

 Bit Value 
(decimal) 

Set when 

 0 1 Missing Module 
 1 2 Wrong Module 
 2 4 Unrecognised Module 
 3 8 Module Comms (IOBus) Error 

        See section 7.6.1 for further details. 

 
Each channel also supports a status byte: 

 ChStat Channel Status.  This is a bit mapped field as follows:  
  

 Bit Value 
(decimal) 

Set when  

 0 1 Sensor break detected or value 
outside limits of linearisation table 

 1 2 CJC failed 

 2 4 Channel not in use 

 3 8 Analogue output saturated 

 4 16 Initialising 

 5 32 Invalid Analog input Cal data 

 6 64 Reserved / Analogue Input Saturated 

 7 128 Any Module fault (from ModSta)  

     
See the module sections 7.7.11, 7.8.4, 7.9.12 and 7.10.10  for further details. 
 
These all flag specific error conditions, so can be handled in the control strategy so as to take appropriate 
control action for a safe recovery or shutdown. 
Note that sensor break and input "overload" are treated in the same way.  This may result in unexpected actions 
- overload of mA input may force downscale-drive; "underload" of TC input may result in upscale drive.  Special 
strategies can be applied to hold the "last good" Val parameter, or apply a pre-defined value. 
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7.6. IO MODULE CONFIGURATION CONCEPTS 
The IOC must be configured to recognise each module fitted to the base, and then configured to set up each 
and every I/O channel to work with the connected transducers. 
The configuration methods are illustrated here using iTools, but any method of setting the appropriate Modbus 
parameters will achieve the same. 
The methods for setting the "config" access mode from iTools and setting parameters are described in Chapter 
3, particularly 3.4 and 3.5.  

 
 
In iTools all I/O module lists are found under the folder "IO".  
 
Each module is numbered according to slot position in the base.  
 
Each module folder can be expanded to show  sub-folders for the module block and for 
each channel block.  Each folder contains just the relevant parameter lists. Parameters 
may be visible and alterable according to set design rules depending on context - this 
means that the display changes according to run mode, module type and display 
settings. 
 
In this example the IO folder is expanded to show the IOModules available on a 16 slot 
base. 
 
 
 

 

Figure 7-7:   Browser IO and Module Folders Example 

On start-up iTools takes a short time to read all the system parameters.  While "synchronising"  all folders and 
lists are displayed.  For example, the IO folder will show all 16 module folders, even with smaller bases.  When 
correctly synchronised only the relevant folders are shown. 
The lists illustrated below were obtained from iTools, with both boxes checked in the (Options) Parameter 
Availability settings.  Parameter lists may differ with other settings. 
 

7.6.1. Module Block Parameters 
These parameters are found in IO → Module0x → MOD0x 
 

 
 

Figure 7-8:   Module Block Parameter List 

To declare a module for use, select to the module block list (here MOD04), and set ‘Requested Module Type’ 
(ReqID) to match the needed I/O module (double-click the parameter and select from the list).  
The IOC will interrogate any fitted module and report the type in 'ActID'.  For the module to work these 
parameters must match, as shown in Figure 7-8 above.   
Note that 'ReqID' will not change unless the 2500 is in "config" mode. 
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Module Status Parameters  

Name Description Range Status 

 ModSta Module Status.  A bit field reporting the module status: 

ModSta is 0 if module is OK and working. 

  

 Bit Value (decimal) Set when   

 0 1 Missing Module   

 1 2 Wrong Module   

 2 4 Unrecognised Module   

 3 8 Module Comms (IOBus) Error   
    

 ActID Actual Module Type.  Module type, as found by the IOC.  The list of types is the 
same as the enumerations shown for the Requested Module Type below 

  

 ModVer Module Version.  Module version code (diagnostic aid)   

 ReqID Requested Module Type   

 None (0) No module required in this slot 

 DI4 (1) Digital Input 4 channels (logic) 

 DI8_LG (4) Digital Input 8 channels (logic) 

 DI8_CO (5) Digital Input 8 channels (contact closure) 

 DI6_MV (6) Digital Input 6 channels (ac mains input, 115V rms) 

 DI6_HV (7) Digital Input 6 channels (ac mains input, 230V rms) 

 DO4_EP (16) Digital Output 4 channels (externally powered, 10mA) 

 DO4_24 (17) Digital Output 4 channels (externally powered, 100mA) 

 RLY4 (32) Relay Output 4 channels (2 amp; 3 n/o, 1 change over) 

 AI2 (64) Analogue Input 2 channels (universal; 3 terminal unit options) 

 AI3 (67) Analogue Input 3 channels (4-20mA, with transmitter PSU) 

 AI4 (69) Analogue Input 4 channels (TC, mV, mA terminal unit options) 

 AO2 (80) Analogue Output 2 channels (0-20mA or 0-10V output) 
 

Name Description Range Status 

 AlmSW Summary of alarm status.  This is a bit mapped field as follows:   

 Bit Value (decimal) Set when    

 0 1 Alarm A active   

 1 2 Alarm A acknowledged   

 2 4 Alarm B active   

 3 8 Alarm B acknowledged   

 4 16 Alarm C active   

 5 32 Alarm C acknowledged   

 6 64 Alarm D active   

 7 128 Alarm D acknowledged   

 8 256 Alarm E active   

 9 512 Alarm E acknowledged   
      

Name Description Range Status 
    

 10 1024 Alarm F active   

 11 2048 Alarm F acknowledged   

 12 4096 Alarm G active   

 13 8192 Alarm G acknowledged   

 14 16384 Alarm H active   

 15 32768 Alarm H acknowledged   
    

 ChAlSW Channel Alarm Status Word - Summary of the Channel Status Alarms of all Channels 
in this module. 

The required bits of each Status alarm (IO → Module0x → MNN_Cx → ChStat) must 
be enabled by setting the corresponding bits in the mask, 

(IO → Module0x → MNN_Cx → Mask).  Set mask to 255 to enable all alarms 

The Status alarm must also not be inhibited IO → Module0x → MNN_Cx → Inhibt etc 

  

102                                                                                                                                                            Part No HA027115  Issue 5  Feb -14 



2500 Controller  Engineering Handbook 

 Bit Value (decimal) Set when    

 0 1 Channel 1 alarm active   

 1 2 Channel 1 alarm acknowledged   

 2 4 Channel 2 alarm active   

 3 8 Channel 2 alarm acknowledged   

 4 16 Channel 3 alarm active   

 5 32 Channel 3 alarm acknowledged   

 6 64 Channel 4 alarm active   

 7 128 Channel 4 alarm acknowledged   

 8 256 Channel 5 alarm active   

 9 512 Channel 5 alarm acknowledged   

 10 1024 Channel 6 alarm active   

 11 2048 Channel 6 alarm acknowledged   

 12 4096 Channel 7 alarm active   

 13 8192 Channel 7 alarm acknowledged   

 14 16384 Channel 8 alarm active   

 15 32768 Channel 8 alarm acknowledged   

 

Status Summary Parameters 
 

Name Description Range Status 
    

 Summary Summary Word.  Indicates the state of digital IO channels.  

Initialisation status is given by bits 8 to 15.  The 'initialising' flag is only set during 
power up or if the channel type has been changed.  The flag is fleeting, normally set 
for just one sample period.  

For Digital output modules this word can be written to set or reset outputs. 

 (DI) 

 Bit Value 
(decimal) 

Set when    

 0 1 Channel 1    

 1 2 Channel 2   

 2 4 Channel 3   

 3 8 Channel 4   

 4 16 Channel 5   

 5 32 Channel 6   

 6 64 Channel 7   

 7 128 Channel 8   

 
 
For more information on the alarms, alarm folders and alarm status parameters refer back to chapter 5. 
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7.6.2. Module Channel Parameters 
When the module is identified correctly the I/O channels can be set up. 
 
These parameters are found in IO → Module0x → M0x_Cy 
 

 
 

Figure 7-9:   Channel Parameter List Example 

Figure 7-9 shows an example of a channel parameter list - in this case, for a DO4 module.  
 
All I/O channels have a common set of parameters, but only a relevant sub-set are enabled and visible when 
working with any particular channel type (if iTools is set up appropriately). 
 
The individual parameters are described below in the context of each module type. 
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7.7. ANALOGUE INPUT MODULES 
There are three different analogue input modules - the AI2, the AI3 and the AI4.  These are supported by a 
number of terminal units, each optimised for different input sensors. 
All these modules and channels function the same way and with similar channel parameters, differing only in 
electrical interface options and characteristics. 
Note that some terminal units exclude certain input ranges, and it is possible to configure the AI module to an 
unsupported range.  Care should be taken to ensure that only relevant ranges are configured. 
 

For module specification see Appendix A. 
 

7.7.1. AI2 Isolation Barriers 
Isolation channel-channel: Functional (basic insulation), 264Vac max 

Isolation to system: Reinforced (double insulation), 264Vac max 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-10:   AI2 Isolation Barriers 

 

 

7.7.2. AI2 Analogue Input Equivalent Circuits 
The equivalent circuits below show details of analogue inputs, in particular sensor break circuits. 
 

Thermocouple Input  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-11:   Thermocouple Input 
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3-Wire PRT Input 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-12:   3-Wire PRT Input 

 

4-Wire PRT Input 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Figure 7-13:   4-Wire PRT Input 

 

Pot Input 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-14:   Pot Input 
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Milli-Volt Input  

 
 

 

 
 
 
 
 
 
 
 

Figure 7-15:   mV Input 

 

Volts Input 

 
 
 
 
 
 
 
 

Figure 7-16:   Volts Input 

 

Milli-Amp Input  
 
 
 
 
 
 
 
 
 
 

Figure 7-17:   mA Input 

 

7.7.3. AI2 Terminal Connections 
 

Thermocouple 
The dual TC AI2 Terminal Unit provides 4 screw terminals for channel wiring: 
 

     1+ 1- 2+ 2- 

 

Other AI2 Terminals  
Other AI2 Terminal Unit provides 12 screw terminals for channel wiring: 
 

     H1 B1 H2 B2 
 

    I1 D1 I2 D2 
 

     A1 C1 A2 C2 
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7.7.4. AI3 Isolation Barriers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-18:   AI3 Isolation Barriers 

7.7.5. AI3 mA Input Equivalent Circuit 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-19:   mA Input AI3 

7.7.6. AI3 Terminal Connections 
AI3 Terminal Unit provides 12 screw terminals for channel wiring: 
 

     P1 P2 P3  
 

    C1 C2 C3  
 

     I1 I2 I3  
 

 

7.7.7. AI3 Analogue Input Module Hart Compatibility 
The module does not directly support HART data extraction or injection functions. 
 

The module is compatible with HART systems but with the following notes and provisos: 
• The PSU is specified with a low AC impedance, so permitting normal HART connections (e.g., with master 

connected across the field device (near or far), or across the loop burden). 
• Each channel offers full galvanic isolation, easing wiring and preventing HART signals from becoming 

interfering signals. 
• Power Supply noise and ripple at HART frequencies are at very low amplitude, thus minimising risk of 

interference with HART signals. 
• For HART loops where the main burden resistor is that provided by the AI3, the resistor must be padded with 

an external series resistor, normally by adding 190Ω in series with the C connection.  This can be achieved by 
cutting the track as shown in the diagram above.  The resistor can be wired using the spare terminals and wire-
ended resistors.  Such padding does not affect the specification, except in that the excess input voltage would 
reduce the headroom required to power external devices (as would all HART compliant loops). 
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7.7.8. AI4 Isolation Barriers 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-20:   AI4 Isolation Barriers 

7.7.9. AI4 Analogue Input Equivalent Circuits 
The equivalent circuits below show details of analogue inputs, in particular sensor break circuits. 
 

Thermocouple Input 
 
 
 
 
 
 
 
 
 

Figure 7-21:   Thermocouple Input 

Milli-Volt Input 
 
 
 

 
 
 
 
 
 

Figure 7-22:   mV Input 

Milli-Amp Input 
 
 
 
 
 
 
 
 
 

Figure 7-23:   mA Input 
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7.7.10. AI4 Terminal Connections 
The AI4 Terminal Unit provides 8 screw terminals for channel wiring: 
 

     2+ 2- 4+ 4- 
 

    1+ 1- 3+ 3- 
 
 
 

7.7.11. Analogue Input Parameters 
Channel Type and Enumerations 

Name Description 

 TYPE Channel Type 

 RTD3 (0) PT100 resistance thermometer – 3 wire  

 TC (1) Thermocouple  

 PYRO (2) Optical Pyrometer  

 mV (3) Millivolt  

 mA (I) (4) Milli amp input  

 V (I) (5) Volt input  

 HiZ (6) High impedance (zirconia) input  

 Ohms3 (7) Ohms input – 3 wire  

 HiOhms3 (8) High ohms input – 3 wire  

 Pot (9) Potentiometer input  

 RTD4 (10) PT100 resistance thermometer – 4 wire  

 Ohms4 (11) Ohms input – 4 wire  

 HiOhms4 (12) High ohms input – 4 wire  

 

Analogue Input IO Parameters 

These parameters are found in IO → Module0x → MOD0x and depend on the ‘Channel Type’ selected:  If the 
parameter is greyed out on the PC screen it is not available for the Channel Type configured. 
 

Name Description Range Status 

 LinTyp Linearisation Type.  The linearisation curve applied to convert the measured input to 
engineering units.  Only available when an analogue input has been requested. 

  

 J (0) J type thermocouple   

 K (1) K type thermocouple   

 L (2) L type thermocouple   

 R (3) R type thermocouple   

 B (4) B type thermocouple   

 N (5) N type thermocouple   

 T (6) T type thermocouple   

 S (7) S type thermocouple   

 PL2 (8) Platinel type thermocouple   

 C T/C (9) Custom thermocouple   

 PT100 (10) Pt100 platinum resistance thermometer   

 Linear (11) Linear process input   

 SqRoot (14) Square root    

 Cust 1 (20) Custom curve Name 1   

 Cust 2 (21) Custom curve Name 2   
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Name Description Range Status 

 Cust 3 (22) Custom curve Name 3   

 Val The actual value of the channel in engineering units   

The next four parameters are used to calibrate process type (V/mV/mA inputs).  They are not used for thermocouple, RTD or 
pyrometer inputs.  See section 7.11.3. 

 VALH Engineering Value High. The maximum value allowed for the channel Process Value.  
See also section 7.11.3. 

  

 VALL Engineering Value Low. The minimum value allowed for the channel Process Value.  
See also section 7.11.3. 

  

 IOH Electrical High. The maximum value allowed for the channel Measured Value.  See 
also section 7.11.3. 

  

 IOL Electrical Low. The minimum value allowed for the channel Measured Value.  See 
also section 7.11.3. 

  

 MeasV Electrical Value (V/A/R).  The actual electrical signal value measured at the terminals 
of the channel 

  

 Emiss Emissivity.  To set pyrometer emissivity.  Only applicable to pyrometer inputs   

 CJC_Tp CJC Type.  Cold Junction Compensation may be measured automatically by the 
instrument or use an external reference source.  Only applies to thermocouple 
inputs 

  

 Auto (0) Automatic.  Temperature is measured by a sensor mounted on the terminal unit and is used to 
compensate for the cold junction 

 0C (1) External reference at 0oC 

 45C (2) External reference at 45oC 

 50C (3) External reference at 50oC 

 OFF (4) No CJC 

 CJtemp CJC Temperature.  The actual temperature at the cold junction   

 FltAct Fault Action.  Defines the PV action on input failure   

 UScale (0) Upscale.  PV is driven Upscale. This is the default setting.  

 DScale (1) Downscale.  PV is driven Downscale. 

 SBDet Sensor Break Bleed Enable.  Feeds a tiny current through the sensor so that the 
input drifts upwards when the sensor goes open circuit 

  

 on (0) Default 

 OFF (1) Disabled 

 Lead_R RTD lead resistance.  Only available if RTD or Ohms configured   

 FiltTm Filter Time. The input filter time constant.  Set to a suitable value to reduce the effect of 
a noisy input signal.  Can be set in hours, minutes, seconds or ms  

  

 ChStat Status.  This is a bit mapped field as follows:    
    

 Bit Value 
(decimal) 

Set when    

 0 1 Sensor break detected or value outside limits of linearisation table   

 1 2 CJC failed   

 2 4 Channel not in use   

 3 8 Analogue output saturated   

 4 16 Initialising   

 5 32 Invalid Analog input Cal data   

 6 64 Reserved / Analogue input saturated   

 7 128 Module fault from IO → Module0x → MOD0x → ModSta – an ‘or’ of 
all the bits in the module status word 
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Name Description Range Status 

 UCAL User Calibration Enable.  Allows single offset calibration correction using the ‘Offset’ 
parameter for single point calibration offset or ‘PointL’ with ‘OfsetL’ and ‘PointH’ with 
‘OfsetH’ for 2 point correction  

See also section 7.11.3. 

  

 FAct (0) Channel is using its original factory calibration values 

 USEr (1) Channel calibration is modified by the user 

 PointL User Cal Point Low (Eng).  Input value at which IO → Module0x → M0x_Cy → 
‘OfsetL’ is added to provide the lower point of a two point calibration correction 

Must be enabled using IO → Module0x → M0x_Cy → ‘UCAL’.  See also Chapter 13 
‘Calibration’. 

  

 PointH User Cal Point High (Eng).  Input value at which IO → Module0x → M0x_Cy → 
‘OfsetH’ is added to provide the upper point of a two point calibration correction 

Must be enabled using IO.Module0x → M0x_Cy → ‘UCAL’.  See also Chapter 13 
‘Calibration’. 

  

 OfsetL User Cal Offset Low (Eng).  Offset value added at input value IO → Module’nn’ → 
M’nn’_C’n’ → ‘PointL’ 

to provide the lower point of a two point calibration correction.  See also Chapter 13 
‘Calibration’. 

  

 OfsetH User Cal Offset High (Eng).  Offset value added at input value IO → Module’nn’ → 
M’nn’_C’n’ → ‘PointH’ 

to provide the upper point of a two point calibration correction.  See also Chapter 
13 ‘Calibration’. 

  

 Offset Simple Cal Offset (Eng).  Adds a single offset calibration equally over the whole 
range of the input 

  

 Cal_st Calibration State.  Used to indicate the calibration status of the channel.   

 Done (0) Calibration complete 

 Failed (1) Calibration failed 

 Idle (2) Idle 

 Cal Lo (3) Calibration low 

 Cal Hi (4) Calibration high 

 Restor (5) Restore 

 Sure? (6) Confirm 

 Go (7) Start calibration 

 Abort (8) Calibration aborted 

 Busy (9) Calibration in process 

 Fsave (10) Save 

 Cal TrL AO Calibration Lo Trim (Counts).  Used to adjust the minimum output value of an 
AO2 module 

  

 Cal TrH AO Calibration Hi Trim (Counts).  Used to adjust the maximum output value of an 
AO2 module 

  

 Mask Status Alarm Bit Mask.  Used to select which of the channel status bits ‘ChStat’ 
should be used to set the channel alarm status 

IO → Module’nn’ → MOD’nn’ → ChAlSW 

Set to 255 will allow all alarms to be used. 

  

 Inhibt Status Alarm Inhibit   

 no (0) No.  Inhibits the status alarm 

 YES (1) Yes.  The status alarm is active 

 InhSrc Status Alarm Inhibit Source.  (Config mode) Modbus address of flag used to inhibit 
the status alarm 

-1 means it is not wired 

  

 Bloc Status Alarm Blocking.  See also section 5.4.   

 no (0) No blocking 
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Name Description Range Status 

 YES (1) Yes.  Blocking is active 

 Ltch Status Alarm Latching.  See also section 5.5.   

 no (0) No blocking 

 YES (1) Yes.  Blocking is active 

 Ack Status Alarm Acknowledge.  See also section 5.5.   

 no (0) No acknowledge 

 YES (1) Acknowledge is configured 

 OP Status Alarm Output.    

 OFF (0) No Alarm  

 on (1) Alarm present 

 ClStLL 

 ClStHL 

Calibration State Low and High Limit.  Defines the state of the channel calibration at 
the lower and upper points 

  

 Done (0) Calibration complete 

 Failed (1) Calibration failed 

 Idle (2) Idle 

 Cal Lo (3) Calibration low 

 Cal Hi (4) Calibration high 

 Restor (5) Restore 

 Sure? (6) Confirm 

 Go (7) Start calibration 

 Abort (8) Calibration aborted 

 Busy (9) Calibration in process 

 Fsave (10) Save 

 ChTpLo 

 ChTpHi 

Low and High Limit  for Channel Type.  Defines the lower and upper points based 
on the type of channel in use 

  

 RTD3 (0) PT100 resistance thermometer – 3 wire 

 TC (1) Thermocouple 

 PYRO (2) Optical Pyrometer 

 mV (3) Millivolt 

 mA (I) (4) Milli amp input 

 V (I) (5) Volt input 

 Ohms3 (7) Ohms input – 3 wire 

 HiOhms3 (8) High ohms input – 3 wire 

 Pot (9) Potentiometer input 

 RTD4 (10) PT100 resistance thermometer – 4 wire 

 Ohms4 (11) Ohms input – 4 wire 

 HiOhms4 (12) High ohms input – 4 wire 
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7.8. ANALOGUE OUTPUT MODULE 
There is one Analogue Output Module (AO2) which provides two channels offering either voltage or current 
output drive.  Each channel is independently software settable.  Both channels work the same way, calculating 
the output drive value 'MeasV' from the block parameters and the demanded 'Val' value. 
 

For module specification see Appendix A. 
 

7.8.1. Analogue Output Isolation Barriers 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-24:   AO2 Channel Isolation barriers 

7.8.2. Analogue Output Equivalent Circuits 
 
 
 
 
 
 
 
 

Figure 7-25:   Voltage Output         Current Output 

 

7.8.3. AO Terminal Connections 
 
The AO2 Terminal Unit provides 4 screw terminals for channel wiring: 
 

     1+ 1- 2+ 2- 

No external power source is required, each channel supporting an isolated supply derived from the base 24V. 

1+ 
 
 
 
1- 
 

 
 
 

2500 
I/OBus 

and 
IOC 

mA V 

2+ 
 
 
 
2- 
 

mA V 

<600Ω 

1+ or 2+ 

1- or 2- Internal View Internal View 

1+ or 2+ 

1- or 2- 

>2KΩ (10V output) 
>1KΩ (5V output) 
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7.8.4. Analogue Output Channel Parameters 
These parameters are found in IO → Module0x → MOD0x 
 

AO2 Channel Type and Enumeration 

Name Description Range Status 

 TYPE Channel Type   

 V (O) (30) Volt output 

 mA (O) (31) Milliamp output 

 

AO2 Channel I/O Parameters 

These parameters are found in IO → Module0x → M0x_Cy 
 

Name Description Range Status 

 Val Process Value (in Engineering Units) - controls the output drive.   

 ValSrc Process Value source - Modbus address of the controlling parameter.  Source address 
values of -1 indicate the parameter is not wired. 

  

 VALH Engineering Value High. For TPO only, the maximum control value allowed.   

 VALL Engineering Value Low. For TPO only, the minimum control value allowed.   

 IOH Electrical High. For TPO types only, the maximum output proportion.   

 IOL Electrical Low. For TPO types only, the minimum output proportion.   

 MeasV Electrical Value - the electrical signal value measured at the terminals.   

 FltAct OP Standby Action - behavior when in standby mode   

 DrvDn (2) Electrical output is forced to low limit. 

 DrvUp (3) Electrical output is forced to high limit. 

 Cont (4) Signal is maintained - held if the PV is not wired. If wired to a local PID loop control will be 
maintained. 
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AO2 Status and Alarm Parameters 

These parameters are found in IO → Module0x → M0x_Cy 

Name Description Range Status 

 ChStat Status - a bit mapped field, non-zero on error.   

 Bit Value (dec) Set when    

 0 1 Sensor break detected   

 1 2 CJC failed   

 2 4 Channel not in use   

 3 8 Analogue output saturated   

 4 16 Initialising   

 5 32 Invalid Analog Cal data   

 6 64 Reserved / Analogue Input Saturated   

 7 128 Module fault from IO → Module0x → MOD0x → ModSta   
    

 Mask Status Alarm Bit Mask - selects which bits of 'ChStat' set the channel alarm status 
Set to 255 allows all alarms to be used 

  

 Inhibt Status Alarm Inhibit -   

 no (0) Inhibits the status alarm 
 YES (1) The status alarm is active 

 InhSrc Status Alarm Inhibit Source -  Address of flag to inhibit the status alarm.   

 Bloc Status Alarm Blocking - See also section  5.4.   

 no (0) No blocking. 
 YES (1) Blocking is active. 

 Ltch Status Alarm Latching   

 no (0) No Latching. 
 YES (1) Latching is active 

 Ack Status Alarm Acknowledge   

 no (0) No acknowledge 
 YES (1) Acknowledge is configured 

 OP Status Alarm Output   

 OFF (0) No Alarm  
 on (1) Alarm present 

 

 

Analogue Output 2 Calibration Parameters  

Calibration of the AO Module and associated parameters is described in Chapter 13. 
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7.9. DIGITAL INPUT MODULES 
There are five different digital "input" modules - the DI4, the DI6\115V, the DI6\230V, the DI8\Logic, and the 
DI8\Contact.  These all behave in exactly the same way, with the same channel parameters, but with differences 
in the type and specification of the channel circuits. 

7.9.1. DI4 
The DI4 offers four logic channels for voltage input or for switch contact input.  For the latter a 24V supply is 
required; for logic input the supply must be shorted.  Note that this configuration determines the function for all 
four channels. 
 

7.9.2. DI4 Channel Isolation Barriers  
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-26:   DI4 Channel Isolation Barriers 

7.9.3. DI4 Digital Input Equivalent Circuits 
The following equivalent circuits show the input into the Digital Input Modules.  These may be used for 
determining source conditions. 
 
 
 
 
 
 
 
 
 
 

Figure 7-27:   Quad Digital Input Voltage Source Equivalent Circuit 

 
 
 
 
 
 
 
 
 
 

Figure 7-28:   Quad Digital Input Contact Closure Equivalent Circuit 

7.9.4. DI4 Terminal Connections 
The DI4 Terminal Unit provides 12 screw terminals for channel wiring: 
 

     1 2 3 4 
 

    C C C C 
 

     V+ V+ C C 
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DI1 

DI2 
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C 

C 

Internal View 

V+ 
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C 

1, 2, 3 
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7.9.5. DI6 115V and 230V 
The DI6 modules offer 6 logic input channels designed for direct ac supply. 

 

7.9.6. DI6 Isolation Barriers 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-29:   DI6 Channel Isolation Barriers 

DI6 Equivalent Circuits 
 
 
 
 
 
 
 
 
 

Figure 7-30:   230Vac Digital Input Equivalent Circuit 

 
 
 
 
 
 
 
 
 
 

Figure 7-31:   115Vac Digital Input Equivalent Circuit 

 
 

DI6 Terminal Connections 
The DI6 Terminal Unit provides 12 screw terminals for channel wiring: 
 

     L5 N5 L6 N6 
 

    L3 N3 L4 N4 
 

     L1 N1 L2 N2 
 

1K5Ω 

230Vac 

L1 to L6 

Internal View 
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115Vac 

L1 to L6 
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7.9.7. DI8 Logic 
The DI8 offers 8 logic input channels.  Unlike the DI4, the contact and logic input versions are order options, 
again fixing the channel function for the whole module. 
 

7.9.8. DI8 Logic Input Isolation Barriers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-32:   DI8 Logic Input Isolation Barriers 

 

7.9.9. DI8 Equivalent Circuits 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 7-33:   Octal Digital Input Contact Closure Equivalent Circuit                      Voltage Source Equivalent Circuit 

 
 

7.9.10. DI8 Terminal Connections 
The DI8 Terminal Unit provides 12 screw terminals for channel wiring: 

     1 3 5 7 
 

    IC2 3C4 5C6 7C8 
 

     2 4 6 8 
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7.9.11. DI8 Contact Input 
This version of the DI8 supports switch contact inputs. 
 

The channel configuration is exactly the same as for the logic input version; and the same terminal unit is used. 
 

7.9.12. Digital Input Parameters 
Channel Type and Enumerations 

These parameters are found in IO → Module0x → M0x_Cy 

Name Description Range Status 

 TYPE Channel Type   

 OnOff (I) 
(50) 

On/Off input.  Used for logic or contact inputs which generally switch cleanly. 
The raw input is sampled every tick 

  Update rate = 110ms (once per control cycle) 

  Min pulse width always detected = 110ms 

 Debnce 
(51) 

Debounced.  The input is debounced for the time specified in ‘MinPlsT’ and the debounced state is 
sampled every IOS tick.   
Min pulse width guaranteed to be detected. 

  Update Rate = 110ms (once per control cycle) 

  Debounce time (MinPlsT) limits = 0ms (off) to 2.55s  

  Debounce time (MinPlsT) resolution = 10ms 

  Max pulse width guaranteed filtered 
out 

‘= MinPlsT’ 

  Where ‘MinPlsT’ < 110ms = 110ms 

  Where ‘MinPlsT’  > 110ms = ‘MinPlsT’+10ms 

  Min sampling delay = ‘MinPlsT’ 

  Max sampling delay  = ‘MinPlsT’+120ms  

 Pulse (52) Pulse.  Detects pulses which are longer than the debounce ‘MinPlsT’.  For every edge of a pulse train to be 
detected the cycle time must be more than two IOS ticks. 

  Update Rate = 110ms (once per control cycle) 

  Debounce time (MinPlsT) limits = 0ms (off) to 2.55s  

  Debounce time (MinPlsT) resolution = 10ms 

  Max pulse width guaranteed filtered 
out 

= ‘MinPlsT’ 

  Min pulse width guaranteed to be 
detected 

= ‘MinPlsT’+10ms 

  Min time between pulses = 220ms (two control cycles) 

  Min sampling delay = ‘MinPlsT’ 

  Max sampling delay  = ‘MinPlsT’+120ms 
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Digital Input IO Parameters 

These parameters are found in IO → Module0x → Mox_Cy 
 

Name Description Range Status 

 Val The actual value of the channel in engineering units   

 on (0) On 

 OFF (1) Off 

 SEnS Invert.  Change the polarity of the input signal   

 no (0) Signal is not inverted 

 YES (1) Signal is inverted 

 MnPlsT Minimum Pulse Time.   
For a digital input in debounce mode it defines the time taken for an input signal to reach 
a steady state.  Shorter transients will be ignored. 
For a digital input in pulse mode it should be set to detect the faster leading edges of a 
train of pulses with a minimum resolution of 10mS. 

  

 MeasV Electrical Value (V/A/R).  The actual electrical signal value measured at the terminals of 
the channel 

1 or 
0 

 

 ChStat Status.  This is a bit mapped field as follows:    
    

 Bit Value 
(decimal) 

Set when    

 0 1 Sensor break detected or value outside limits of linearisation table   

 1 2 CJC failed   

 2 4 Channel not in use   

 3 8 Analogue output saturated   

 4 16 Initialising   

 5 32 Invalid Analog input Cal data   

 6 64 Reserved / Analogue Input Saturated   

 7 128 Module fault from IO → Module0x → MOD0x → ModSta – an ‘or’ of 
all the bits in the module status word 

  

 Mask Status Alarm Bit Mask.  Used to select which of the channel status bits ‘ChStat’ should be 
used to set the channel alarm status. 
IO → Module0x → MOD0x → ChAlSW 
Set to 255 will allow all alarms to be used. 

  

 Inhibt Status Alarm Inhibit   

 no (0) No.  Inhibits the status alarm 

 YES (1) Yes.  The status alarm is active 

 InhSrc Status Alarm Inhibit Source.  (Config mode) Modbus address of flag used to inhibit 
the status alarm 
-1 means it is not wired 

  

 Bloc Status Alarm Blocking.  See also section 5.4.   

 no (0) No blocking 

 YES (1) Yes.  Blocking is active 

 Ltch Status Alarm Latching.  See also section 5.5.   

 no (0) No blocking 

 YES (1) Yes.  Blocking is active 

 Ack Status Alarm Acknowledge.  See also section 5.5.   

 no (0) No acknowledge 

 YES (1) Acknowledge is configured 

 OP Status Alarm Output.     

 OFF (0) No Alarm  

 on (1) Alarm present 
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7.10. DIGITAL OUTPUT MODULES 
There are just three different digital "output" modules - the DO4\EP, the DO4\24, and the RLY4 module.  All 
blocks work the same way, with the electrical output 'MeasV' being processed from the demanded 'Val' value.  
All modules offer the same channel parameters, differing only in the type and specification of the channel 
characteristics.  
 

7.10.1. DO4 EP (External Power) 
This module provides four simple logic output channels from current limited switches.  Output power comes 
from a power supply connection at the terminal unit. 

Channel Types: On/Off, TPO, Valve Raise/Lower. 

Output Types: Logic (24Vdc). 
 

7.10.2. DO4 EP Channel Isolation: 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-34:   Isolation Barriers for DO4 Module 
 

7.10.3. Digital Output Equivalent Circuits 
The equivalent circuits below show the output drive from the Quad Digital Output Module for purposes of 
determining the load conditions. 
 
 
 
 
 
 
 
 
 
 
 
Figure 7-35:   Quad Digital Output Current Source Equivalent Circuit (Logic)            Voltage Switch Equivalent Circuit (24V) 
 

7.10.4. DO4 Terminal Connections: 
The DO4 Terminal Unit provides 12 screw terminals for channel wiring: 
 

     1 2 3 4 
 

    C C C C 
 

     V+ V+ C C 
 

Power (nominal 24V) is wired into V+ and C on the lowest row, each duplicated to allow easy daisy-chaining. 
Channel wiring is simply to the appropriate numbered terminal and the C terminal underneath. 
 

7.10.5. DO4 24V 
The 24V version of the DO4 is identical to the EP, but with each channel capable of delivering 100mA. Thermal 
protection provides safe operation even with difficult loads. 
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122                                                                                                                                                            Part No HA027115  Issue 5  Feb -14 



2500 Controller  Engineering Handbook 

7.10.6. Relay Module RLY4 
The RLY4 module "output" contains four power relay contacts capable of working at 2A, 250Vac.  Otherwise, 
module operation is exactly the same as the other logic output modules. 
 

Channel Types: On/Off, TPO, Valve Raise/Lower 

Number of channels: 3 N/O (normally open contact), 1 C/O (changeover contacts) 
 

7.10.7. RLY4 Isolation Barriers 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-36:   Isolation Barriers for RLY4 Module 

 

7.10.8. RLY4 Terminal Connections 
The RLY4 Terminal Unit provides 12 screw terminals for channel wiring: 
 

     1A 2A 3A 4A 
 

    1B 2B 3B 4B 
 

        4C 

 

7.10.9. RLY4 Snubber Circuits 
Each relay is fitted with a ‘snubber’ (22nF + 100Ω) wired across the normally-open (N/O) contacts.  These are to 
prolong contact life particularly when switching inductive loads.  
In ac applications snubbers will pass a small current when the contacts are open - typically 1mA at 110V and 
2mA at 240V.  This current may be sufficient to hold in some relays with low coil current.  The fitted snubbers 
may be removed and alternatives wired to the terminals. 
Use the Terminal Unit Fuses to isolate live terminals if there is a need to "hot swap" the module.  Take particular 
care when using the RLY4 for alarm or safety circuits. 
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7.10.10. Digital Output Channel Parameters 
DO Channel Type and Enumerations 

These parameters are found in IO → Module0x → M0x_Cy 
 

Name Description Range Status 

 TYPE Channel Type   

 OnOff (O) (40) On/Off output 

 TimePr(41) TPO - Time proportioning output 

 VlvRse (42) Valve Raise output 

 (VlvLwr (43)) (Valve Lower output) (Not selectable - automatic on VlvRse) 

 
 On/off may be used for control or for alarms and events and may drive indicator lamps or solenoid valves.  
 TPO is used for control applications with variable pulse width adjusting output power. 
 Valve Position types are also used for control using motorised valve actuators.   
Note that specifying an odd channel type as "Valve Raise" will force the next (even) channel to be "Valve Lower". 

 

DO Channel Control Parameters  

These parameters are found in IO → Module0x → M0x_Cy 
 

Name Description Range Status 

 Val Process Value (in Engineering Units) - controls the output drive ⋅%  

 ValSrc Process Value source - Modbus address of the controlling parameter.  Source address 
values of -1 indicate the parameter is not wired. 

  

 SEnS Invert - In 'OnOff' mode changes the polarity of the output   

 no (0) MeasV sense directly matches Val signal (0 output for Val=0) 

 YES (1) MeasV is inverse of Val signal (1 output for Val=0) 

 MnPlsT Minimum Pulse Time.  For time proportioning output channel types only, defines 
minimum on/off period in seconds.  Both 0 and 1 pulses are constrained 

  

 VALH Engineering Value High.  For time proportioning output only, the maximum control 
value allowed 

⋅9  

 VALL Engineering Value Low.  For time proportioning output only, the minimum control 
value allowed 

⋅9  

 IOH Electrical High.  For time proportioning output types only, the maximum output 
proportion 

⋅9  

 IOL Electrical Low.  For time proportioning output types only, the minimum output 
proportion 

⋅9  

 MeasV Electrical Value - the electrical signal value driven from the terminals   

 FltAct OP Standby Action – behavior in Standby mode   

 DrvDn (2) Electrical output is forced off (logic 0) 

 DrvUp (3) Electrical output is forced on (logic 1) 

 Cont (4) Signal is maintained - held if the PV is not wired.  If wired to a local PID loop control will be 
maintained 
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DO Status and Alarm Parameters 
 

Name Description Range Status 

 Mask Status Alarm Bit Mask – Used to select which of the channel status bits 'ChStat' should 
be used to set the channel alarm status 
IO → Module’nn’ → MOD’nn’ → ChAISW 
Set to 255 will allow all alarms to be used 

  

 Inhibt Status Alarm Inhibit -   

 no (0) Inhibits the status alarm 
 YES (1) The status alarm is active 

 InhSrc Status Alarm Inhibit Source -  Address of flag to inhibit the status alarm   

 Bloc Status Alarm Blocking - See also section 5.4.   

 no (0) No blocking 
 YES (1) Blocking is active 

 Ltch Status Alarm Latching   

 no (0) No Latching. 
 YES (1) Latching is active 

 Ack Status Alarm Acknowledge   

 no (0) No acknowledge 
 YES (1) Acknowledge is configured 

 OP Status Alarm Output   

 OFF (0) No Alarm  
 on (1) Alarm present 
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7.11. CONFIGURATION EXAMPLES 
The following are examples use key configuration parameters to configure different I/O modules. 
 

7.11.1. Thermocouple or RTD Input 
Fit an Analogue Input module into a suitable position on the base, for example AI2 in slot 03. 

In IO → Module03 → 
MOD03 

set ‘ReqID’ = AI2 

In IO → Module03 → 
M03_C1 

set ‘TYPE’ = TC (or RTD).  Note, if the AI module is configured as thermocouple 
input on one channel and, say, mV on the other, then the thermocouple input must 
be on channel 1. 
set ‘LinTyp’ to the type of thermocouple in use, eg type K. 
set ‘CJC_Tp’ = Auto if internal compensation is to be used.  This is the normal 
default case.  Only if an external reference source is used should this parameter be 
changed. 
set ‘FltAct’ = ‘UScale’ (Up scale) to turn off output power in the event of a sensor 
break (or high impedance).  This is the normal default for heating applications. 
‘DScale’ (Down scale).  This is the normal default for cooling applications to turn off 
cooling demand.  
If the input is configured for RTD then ‘CJC_Tp’ is not applicable.  RTD Lead 
Resistance, ‘Lead_R’, reads and compensates for the resistance of the wires 
connecting the RTD sensor to the module. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-37:   Analogue Input For TC (configuration level) 

 

7.11.2. Pyrometer Input 
Using the above example: 

In IO → Module03 → 
M03_C1 

set ‘TYPE’ = ‘PYRO’.  
set ‘LinTyp’ to match the pyrometer curve.  This may be Linear or a custom curve. 
set ‘Emiss’ to an appropriate value for the target surface. 
set ‘FltAct’ as above (note: it is unlikely that a pyrometer will be used in cooling 
applications) 
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7.11.3. Analogue Input: mV, mA, V, ohms 
Using the previous example: 
 

1. In IO → Module03 → M03_C1 a. set ‘TYPE’ = ‘mv’.  
b. set ‘LinTyp’ to match the curve of the transducer in use.   

 
It is now necessary to scale the input to match the displayed reading with the electrical output levels from the 
transducer.  In the example given below an electrical input of 4-20mA corresponds to a scaling of 0.0 to 1000.0 
engineering units. 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-38:   Input Scaling 

Four configuration parameters are used to scale the Electrical Input to the Process Value. 
 
 

 
 
 
 

 

Figure 7-39:   Input Scaling Parameters 

 

2. In IO → Module03 → M03_C1 a. set ‘IOL’ = ‘4.00’.  
b. set ‘IOH’ = ‘20.00’ 
c. set ‘VALL’ = ‘0.00’ 
d. set ‘VALH’ = ‘1000.00’ 

 

Electrical Hi 
(20mA) 

Electrical Input 
Electrical Lo 

(4mA) 

Scale Hi (1000.0) 

Scale Lo (0.0) 

Range 
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7.11.4. Analogue Output 
Fit an Analogue Output module into a suitable position on the base, for example AO2 in slot 04. 
 

1. In IO → Module04 → MOD04  set ‘ReqID to ‘Analogue Output’ (AO2) 

2. In IO → Module04 → M04_C1 (or 2) set ‘Channel Type’ to ‘mA or V 

 
It is now necessary to scale the analogue output to adjust the output value to correspond with the demand from 
the control block output.  In this example the analogue output is 0 to 10V for a PV of 0 to 100% (from the PID 
output). 
 

 
 
 
 
 
 
 
 
 
 

Figure 7-40:   Output Scaling 

 
Four configuration parameters are used to scale the Engineering Input to the Electrical Output: 
 

 
 

Figure 7-41:   Analogue Output Parameters 

 

3. In IO → Module04 → M04_C1 (or 2) a. set ‘IOL’ = ‘0.00’.  
b. set ‘IOH’ = ‘10.00’ 
c. set ‘VALL’ = ‘0.00’ 
d. set ‘VALH’ = ‘100.00’ 

VALH (100%) 
PID Demand 

VALL (0%) 

Electrical High (10V)  IOH 

Electrical 
Output 

Electrical Low (0V)  IOL 
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7.11.5. Digital Input 
Fit a Digital Input module into a suitable position on the base, for example DI8 in slot 01. 
 

1. In Module01 → MOD01 set ‘ReqID to ‘Digital Input’ (DI8) 

2. In IO → Module01 → 
M01_C1 (to 8) 

set ‘Channel Type’ to ‘OnOff (or ‘Debnce’ or ‘Pulse’) 

 

 OnOffI (50) On/ Off Input.  Used for logic or contact inputs which generally switch cleanly. 
The raw input is sampled every IOS tick.  
Update Rate   = 110ms (once per control cycle) 
Min pulse width always detected = 110ms  

 Debnce 
(51) 

Debounced.  The input is debounced for the time specified in ‘MinPlsT’ and the debounced 
state is sampled every IOS tick.   
Update Rate   = 110ms (once per control cycle) 
Debounce time (MinPlsT) limits = 0ms (off) to 2.55s  
Debounce time (MinPlsT) resolution = 10ms  
Max pulse width guaranteed filtered out ‘= MinPlsT’  
Min pulse width guaranteed to be detected.  
Where ‘MinPlsT’ < 110ms   = 110ms 
Where ‘MinPlsT’  > 110ms   = ‘MinPlsT’+10ms   
Min sampling delay   = ‘MinPlsT’   
Max sampling delay    = ‘MinPlsT’+120ms  

 Pulse (52) Pulse.  Detects pulses which are longer than the debounce ‘MinPlsT’.  For every edge of a 
pulse train to be detected the cycle time must be more than two IOS ticks. 
Update Rate   = 110ms (once per control cycle) 
Debounce time (MinPlsT) limits = 0ms (off) to 2.55s  
Debounce time (MinPlsT) resolution = 10ms  
Max pulse width guaranteed filtered out = ‘MinPlsT’  
Min pulse width guaranteed to be detected = ‘MinPlsT’+10ms  
Min time between pulses  = 220ms (two control cycles)  
Min sampling delay   = ‘MinPlsT’  
Max sampling delay   = ‘MinPlsT’+120ms  

 

See also section 7.6.2. ‘Module Channel Parameters’. 
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7.11.6. Digital Outputs 
Fit a Digital Output module into a suitable position on the base, for example DO4 (or RLY4) in slot 02. 
 

In Module02 → MOD02 set ‘ReqID to ‘Digital Output’ DO4 (or RLY4) 

In IO → Module01 → 
M01_C1 (to 4) 

set ‘Channel Type’ to ‘OnOff (or ‘TimePr’ or ‘VlvRse’ or ‘VlVLwr’) 

 

 OnOffO 
(40) 

On/ Off Output.  Used for on/off control, events or alarm outputs.  
The output will switch on and off, following the Process Value input. The output ‘MeasV’ is 
OFF if ‘Val’ is zero, and ON if ‘Val’ is not zero. The sense can be inverted using the Invert 
parameter ‘SenS’, but only in configuration level. 

 TimePr (41) Time proportioning.  Used for control outputs to switch contactors or SSRs   
This takes an analogue input which is converted into an ON time Off time ratio. At 50% 
power the ON and OFF time would be equal. This type is normally used to take a PID heat 
output to drive a (solid state) contactor. The Minimum Pulse Time is the minimum period in 
seconds that the output will be ON when the power goes down towards 0% power, or OFF 
as it rises towards 100%. 
 
This output can be scaled but the default settings of 0 to 100% in giving 0 to 100% out 
would normally be used. 

 VlvRse (42) Valve Raise.  Used for motor valve position output 

 VlvLwr (43) Valve Lower.  Used for motor valve position output 
This pair of outputs has to be configured together.  Making Channel 1 (or 3) Valve Raise will 
automatically configure Channel 2 (or 4) to Valve Lower. 

 
see also section 7.6.2. ‘Module Channel Parameters’. 
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7.11.7. Valve Position Controller 
This example assumes:- 
IO Module 01 is configured for PV input 
IO Module 02 is configured for potentiometer input 
IO Module 03 is configured for relay output 
Loop 01 is configured for bounded valve position control 
The wiring for this is shown below:- 
 
 
 
 
 
 
 
 
 
 
 

Figure 7-42:   Soft Wiring for VP 

Configure Module Types 

Configure Loop 1 for 
Bounded Valve Position 
control 

HOW? Enter configuration level by pressing ‘Access’ in the iTools toolbar 
In the browser select Control ∏ LOOP01 ∏ L01CFG 
In the parameter list select ‘CtrL’ = VPB 

Configure Module02 for 
a potentiometer 
Analogue Input 

HOW? In Configuration level select IO ∏ Module02 ∏ MOD02 
In the parameter list select ‘ReqID’ = AI2 (or AI3 or AI4) 
Select IO ∏ Module02 ∏ M02_C1  
In the parameter list select ‘TYPE’ = Pot 

Configure Module03 for 
valve drive output 

HOW? In Configuration level select IO ∏ Module03∏ MOD03 
In the parameter list select ‘ReqID’ = RLY4 for relay output (or DO4 for digital output) 
Select IO ∏ Module03 ∏ M03_C1  
In the parameter list select ‘TYPE’ = VlvRse 
Select IO ∏ Module03 ∏ M03_C2  
In the parameter list select ‘TYPE’ = VlvLwr 

 

Configure Wiring 

Wire IO Module 01 for PV 
input 

HOW? Enter configuration level by pressing ‘Access’ in the iTools toolbar 
Select the parameter to be wired from ie  
Control ∏ LOOP01 ∏ PVSrc 
Double click in the Wired From column and select the parameter to be wired ie  
IO ∏ Module01 ∏ M01_C1 ∏ Val  
Press OK 

Wire IO Module 02 for 
potentiometer input 

HOW? Select the parameter to be wired from ie 
Control ∏ LOOP01 ∏ L01MTR ∏ PPoSrc 
Double click in the Wired From column and select the parameter to be wired ie  
IO ∏ Module02 ∏ M02_C1 ∏ Val 
Press OK 

Wire IO Module 03 for 
valve raise relay output 

HOW? Select the parameter to be wired from ie  
IO ∏ Module03 ∏ M03_C1∏ ValSrc 
Double click in the Wired From column and select the parameter to be wired ie  
Control ∏ LOOP01 ∏ L01_OP ∏ Ch1OP 
Press OK 

Wire IO Module 03 for 
valve lower relay output 

HOW? Select the parameter to be wired from ie  
IO ∏ Module03 ∏ M03_C2∏ ValSrc 
Double click in the Wired From column and select the parameter to be wired ie  
Control ∏ LOOP01 ∏ L01_OP ∏ Ch1OP 
Press OK 

 

 

Further information on wiring can be obtained from the iTools Handbook Part No HA026179, ‘User 
Wiring’chapter, and in Chapter 3 ‘ITOOLS’ in this handbook. 

M03_C1 
RLY4 

Loop01 

PV OP 

PV 
 

M02_C1 
AI 

Val 
 

IO Module 03 
 Ch1OP 

 
Val 
 

M03_C2 
RLY4 

M01_C1 
AI 

Val 
 

PPos 
 

VvlRse 
 

VvlLow 
IO Module 02 
 

IO Module 01 
 

PV 
input 
 

Pot 
input 
 

SP 
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7.11.8.   To Calibrate a Potentiometer Input 
When using the controller in bounded valve position control mode, it is necessary to calibrate the feedback 
potentiometer to correctly read the position of the valve.  This is carried out using iTools. 
For this example the conditions in example 7.11.7 are assumed:- 
 
To calibrate the potentiometer input:- 
 

Put the loop in manual 
mode 

HOW? Enter operator level.  It is only necessary to do this if the controller is already in 
configuration level by pressing ‘Access’ in the iTools toolbar  
Select Control ∏ LOOP01 

  In the parameter list select ‘m-A’ = mAn 

Drive the valve to 
minimum position 

HOW? In operator level.  
Select Control ∏ LOOP01  

  In the parameter list select ‘T_OP’ = 0 

It is possible that the valve may not close fully.  This might happen if, for example, it has not been calibrated previously for 
the pot in use.  To ensure the valve is fully closed it may be nudged 

First enable Pot Cal HOW? In operator level  
Select Control ∏ LOOP01 ∏ L01MTR 

  In the parameter list select ‘CalPot’ = on. 
In this state the manual closed loop VP control is made open loop  

Nudge the valve to 
minimum position 

HOW? Select Control ∏ LOOP01 ∏ L01MTR 

  In the parameter list select select ‘VP_OP’ = 1 to nudge the valve closed or ‘VP_OP’ = 
2 to nudge the valve open.   

When the valve is fully 
closed set the Pot input 
Low Value to 0% 

HOW? Enter configuration level. 
Select IO ∏ Module02 ∏ M02_C1 
In the parameter list select ‘VALL’ = 0.00.   

In normal operation PPos will read 0.00 when the valve is in this position. 

Now drive the valve fully open by repeating the above sequence 

Set Pot Cal to off HOW? In operator level  
Select Control ∏ LOOP01 ∏ L01MTR 
In the parameter list select ‘CalPot’ = off. 

Drive the valve to 
maximum position 

HOW? Select Control ∏ LOOP01  

  In the parameter list select ‘T_OP’ = 100 

It is possible that the valve may not open fully.  To ensure the valve is fully open it may be nudged 

Enable Pot Cal HOW? In operator level  
Select Control ∏ LOOP01 ∏ L01MTR 

  In the parameter list select ‘CalPot’ = on. 
In this state the manual closed loop VP control is made open loop  

Nudge the valve to 
maximum position 

HOW? Select Control ∏ LOOP01 ∏ L01MTR 

  In the parameter list select select ‘VP_OP’ = 1 to nudge the valve closed or ‘VP_OP’ = 
2 to nudge the valve open.   

When the valve is fully 
open set the Pot input 
Low Value to 100% 

HOW? Enter configuration level. 
Select IO ∏ Module02 ∏ M02_C1 
In the parameter list select ‘VAL.H’ = 100.00.   

 
In normal operation PPos will read100.00 when the valve is in this position. 
 

Set Pot Cal = Off, exit Manual mode and exit configuration level 
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8. Chapter 8    Toolkit Blocks 
8.1. OVERVIEW 
Toolkit blocks are function blocks which can be customised by the user.  They are used to calculate derived 
variables, to perform combinational logic and to trigger events when certain conditions are met.  The constants 
in ‘USRVAL’ may be used as digital flags or analogue parameters.  In the case of digital flags zero is interpreted 
as OFF, any other value is ON. 
 

 

 
 
 
 

Figure 8-1:   Browsing Toolkit Blocks 

 

8.2. ANALOGUE BLOCKS 
Analogue Blocks allow the controller to perform mathematical operations on two input values.  These values can 
be sourced from any available parameter including Analogue Values, User Values and Digital Values.  Each 
input value can be scaled using a multiplying factor or scalar as shown in Figure 8-2. 
The parameters to use, the type of calculation to be performed and the acceptable limits of the calculation are 
determined in Configuration.  
Up to 16 calculations may be performed. 
 
 
 
 
 
 
 
 

Figure 8-2:   Analogue Blocks Schematic 

The scalars and operators and limits may only be changed in configuration mode. 
 

  

Toolkit Blocks are only available if the 2500 IOC is ordered with the Toolkit 
Blocks feature enabled. 
 

Toolkit blocks provided in the 2500 are: 
 

16* or 32 analogue calculation blocks in ‘Analog’ 
 

16* or 32 digital calculation blocks in ‘Digital’ 
 

8* or 16 constants in ‘USRVAL’ 
 

8* Counters, 8* Timers, 8* Totalisers 
 

1 Humidity control block in ‘HUMID1’ 
 

1 Zirconia control block in ‘ZIRC1’ 
 

The ability to wire between blocks in ‘WIRES’ 
 

* earlier versions had less blocks and functions 

Output Value 
 
Fallback Value is used if 
the result of a 
calculation is “bad” 

Analogue input 1 

Analogue input 2 

Analogue 
Operator  

 

Input 1 Scalar 

Input 2 Scalar 

Limits  
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8.2.1. Analogue Operators 
Up to 32 calculations are available.  Operators may only be changed in configuration mode. 
 

Operator Description 

None The selected analogue operator is turned off 

Add The output result is the addition of Input 1 and Input 2 

Sub The output result is the difference Input 1 and Input 2  

where Input 1 > Input 2 

Mul The output result is the multiplication of Input 1 and Input 2 

Div The output result is Input 1 divided by Input 2 

AbsDif The output result is the absolute difference between Input 1 and Input 2 

Max The output result is the maximum of Input 1 and Input 2 

Min The output result is the minimum of Input 1 and Input 2 

HotSwp Input 1 appears at the output provided input 1 is ‘good’.  If input 1 is ‘bad’ then input 2 value will appear at the 
output.  An example of a bad input occurs during a sensor break condition. 

S/Hold Normally input 1 will be an analogue value and input 2 will be digital. 

The output = input 1 when input 2 changes from 0 to 1.  The output will remain at this value until input 2 again 
changes from 0 to 1. 

Input 2 can be an analogue value and must change from 0 to 100% to provide a sample and hold at the 
output. 

Expt The output is the value at input 1 raised to the power of the value at input 2,  i.e. input 1
input 2

 

Sqrt The output result is the square root of Input 1.  Input 2 has no effect. 

Log The output result is the logarithm (base 10) of Input 1.  Input 2 has no effect 

Ln The output result is the logarithm (base e) of Input 1.  Input 2 has no effect 

Exp The output result is the exponential of Input 1, i.e.  e
input1

 Input 2 has no effect 

10^x The output result is 10 raised to the power of Input 1 value i.e. 10
input 1

.   
Input 2 has no effect 

Sel 1 
Up to 
Sel 32 

Logic Operator 1 to 32 is used to control which Analogue Input is switched to the output of the Analogue 
Operator.  If the output from the logic operator is true input 1 is switched through to the output.  If false input 
2 is switched through to the output.  See example below:- 
 
 
 
 
 
 
 
 

 
 
 
 
 
  

This connection is made by 
selecting ‘Sel1’ in AOPR01 Logic input 1 

AOPR01 

The output is ‘An input 1’ when ‘logic 
input 1’ and ‘logic input 2’ are true. 

Logic input 2 

DOPR0 1 Sel 1 
An input 1 

AND 

An input 2 
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8.2.2. Analogue Block Parameters  
These parameters are found in Toolkit Blocks → Analog → AOPR01 to 32 
 

 
 

Figure 8-3:   Analogue Blocks - Parameter List 
 

The schematic view shown above is displayed in the usual parameter list format.  However by invoking the 
Toolkit Block editor (View → Toolkit Blocks on the Menu bar) the same information is available in a more 
graphical format, as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8-4:   Analogue Blocks – Editor 

 
  

 
Set Fall Back and 
Status Break 
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Name Description Range Status 

 Oper Operator.  To define the analogue operator type 
Use the Toolkit block editor for graphical explanation 

  

 For types of operator see section 0. 

 P1_Val Input 1 Value.  The parameter value used for Input 1   

 P1_Src Input 1 Source.  Modbus address of the parameter used for Input 1 
-1 means NOT wired. 

  

 P1_Mul Input 1 Scalar.  Factor applied to Input 1 before calculation   

 P2_Val Input 2 Value.  The parameter value used for Input 2   

 P2_Src Input 2 Source.  Modbus address of the parameter used for Input 2 
-1 means NOT wired. 

  

 P2_Mul Input 2 Scalar.  Factor applied to Input 2 before calculation   

 FallBk Fall Back Value.  The value given by the block if the results of the calculation are invalid 
This option must be enabled by the UseFBk parameter. 

  

 UseFBk Enable Fall Back.  Set to give a safe output value in the event of the result of the 
calculation being invalid. 
Fallback options allow a good result to be indicated when a fault condition occurs on the 
input.  
This feature can be used to break a bad status loop where User wiring has created a loop 
in the configuration.  This feature can be set as an enumeration or graphically as shown in 
Figure 8-3 and Figure 8-4 

  

 C Bad (0) Indicate bad result and clip if outside limits, for other failures use fallback value. 

 F Bad (1) Indicate bad result and always use fallback value. 

 C Good (32) Indicate good result and clip if outside limits, for other failures use fallback value. 

 F Good (33) Indicate good result and always use fallback value. 

 HiLim Output High Limit.  High limit applied to the output   

 LoLim Output Low Limit.  Low limit applied to the output    

 RealCV Output Value.  The output of the Toolkit block after the calculation, fallback and limits   

 CVStat Status.  Set if the calculation itself gives an invalid output   

 Good (0) Status good 

 Bad (1) Status bad 

 

8.2.2.1.  Example – To Add a User Value to Loop 01 Setpoint 2 
This example is included to illustrate the principle of configuring Analogue Blocks using the Toolkit Block editor.  
This example could be used to add a fixed offset to an analogue variable, in this case Setpoint 2. 

1. Under the User Values tab, select a user value, for example ‘Usr1’.  Double click on this and enter a value 
2. Under the Analog Operations tab, click on the Input 1 ellipsis button.  From the small browser window 

select Toolkit Blocks → USRVAL → Usr1.  Press OK or double click on ‘Usr1’. 
3. Click on the Input 2 ellipsis button.  From the small browser window select Control → LOOP01 → L01_SP → 

SP2.  Press OK or double click on ‘SP2’. 
4. Type in the value for the input scalars if required 
5. Select an Operator, in this example ‘Add’ 
6. Limits are applied to the result of the initial calculation.  If the calculation is invalid (eg divide by zero) then 

the ‘Fallback’ value is used.  By checking the ‘Fallback Overrides Limits’ box, if the initial calculation is 
outside the limits, the fallback value will be used. 

 

Notes  
1. Figure 8-3 and Figure 8-4 show this example 
2. Space is left for a comment to describe the purpose of the calculation. 
3. To remove a value from the input, click in the box and press delete or press the ellipsis button and select a 

new parameter from the small browser 
4. The parameter list view can be selected by pressing the Parameter List button 
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8.3. DIGITAL BLOCKS 
Digital Blocks allow the controller to perform combinational logic on two input values.  These values can be 
sourced from any available parameter including Analogue Values, User Values and Digital Values.   
The parameters to use, the type of calculation to be performed, input value inversion and ‘fallback’ value are 
determined in Configuration.  
 

Up to 32 separate calculations can be performed.  
 
 
 
 
 
 
Note: 0 = OFF (or false)    Non 0 = ON (or true) 

 

Figure 8-5:   Digital Block Schematic 

 

8.3.1. Logic Operators 
Up to 16 operations are available.  Operators may only be changed in configuration mode. 
 

Operator Description 

None The selected logic operator is turned off 

AND The output result is ON when both Input 1 and Input 2 are ON 

OR The output result is ON when either Input 1 or Input 2 is ON 

XOR Exclusive OR.  The output result is true when one and only one input is ON.  If both inputs are ON 
the output is OFF. 

Latch The output is ON when input 1 turns ON.  The output remains ON when input 1 turns OFF.  The 
output is reset to OFF by turning input 2 ON. 

= Equal The output result is ON when Input 1 = Input 2  

<> Not Equal The output result is ON when Input 1 ≠ Input 2 

> Greater The output result is ON when Input 1 > Input 2 

< Less than The output result is ON when Input 1 < Input 2 

>= Greater or Equal The output result is ON when Input 1 > Input 2 

<= Less or Equal The output result is ON when Input 1 < Input 2 

 

8.3.2. Parameters for Digital Blocks 
These parameters are found in Toolkit Blocks → Digital → DOPR01 to 32. 
 

 

 

 

 

 

 

 

 

Figure 8-6:   Digital Blocks - Parameter List 

Logic input 1 
Invert? 

Logic input 2 
Invert? 

Output Value 
 
Use Fallback value if 
calculation is “bad” 

Logic 
Operator  
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However by invoking the Toolkit Block editor (View → Toolkit Blocks on the Menu bar) the same information is 
available in a more graphical format as shown in the following view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-7:   Digital Blocks – Editor 

The above views show the result of the configuration example in section 8.3.3. 
 

Name Description Range Status 

 Oper Operator.  Defines the operation of the Digital Toolkit Block 
Use the Toolkit block editor for graphical explanation 
Note that inputs to the blocks may be analogue.  The output is True/False 

  

 For types of operator see section 8.3.1. 

 P1_Val Input 1 Value.  The parameter value used for Input 1   

 P1_Src Input 1 Source.  Modbus address of the parameter used for Input 1 
-1 means NOT wired. 

  

 P2_Val Input 2 Value.  The parameter value used for Input 2   

 P2_Src Input 1 Source.  Modbus address of the parameter used for Input 2 
-1 means NOT wired. 

  

 FallBk  Fallback Value.  The state given by the block if the results of the calculation are invalid   

 F Bad (0) Indicate bad result and return 0 (False) 

 T Bad (1) Indicate bad result and return 1 (True) 

 F Good (32) Indicate good result and return 0 (False) 

 T Good (33) Indicate good result and return 1 (True) 

 InvMsk Invert Inputs Mask.  Setting Bit 0 inverts Input 1 before the computation, 
Setting Bit 1 inverts Input 2 before the computation: 

  

 None (0) Neither input inverted. 

 IP1 (1) Input 1 only inverted 

 IP2 (2) Input 2 only inverted 

 Both (3) Both inputs inverted 

 BoolCV Output Value.  Output of the block True/false   

 CVStat Status.  Set if the logical computation gives an invalid output   

 Good (0) Status good 

 Bad (1) Status bad 
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8.3.3. Example – To Produce a Logic Calculation Block 
This example is included to illustrate the principle of configuring Digital Blocks using the Parameter List. 
The example is a ‘comparator’ which compares the value of two inputs using the < (Less Than <) operator.  The 
first input (input 1) in this example is taken from the output of an analogue input module.  The second input 
(input 2) is an analogue User Value.   
 

This type of application may be used to switch an alarm or event output or used in a decision making situation.  
A logic output is produced if Input 1 is less than input 2.  
 

In this example Input 1 is taken from the channel 1 output of Analogue I/O module ‘M01_C1’ and input 2 is 
taken from a user variable ‘USRVAL.Usr1’. 
 
 
 
 
 
 
 
 
1. In Toolkit Blocks → Digital → DOPR01, set ‘Oper’ to < (8) 
2. In IO → Module01 → M01_C1 press + (or double click M01_C1) to open the list of parameter tags 
3. Drag ‘OP’ tag from M01_C1 to ‘P1_Src’ in the DOPR01 parameter list 
4. In Toolkit Blocks → USRVAL, drag ‘Usr1’ tag to ‘P2_Src’ in the DOPR01 parameter list 
5. Set fallback value to 0 for false or 1 for true 
 
If the Logic Operations editor is opened it will be noticed that the above operations will have been transferred 
to this graphical editor. 
 

DOPR01 

< 

Input 1 

Input 2 

From output of AI module 
M01_C1.OP 

From output of user value 
function block 
(USRVAL.Usr1)  
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8.4. USER VALUES 
A User Value is a variable which can be defined by the user and is available for derived calculations.  They are 
found in Toolkit Blocks → USRVAL. 
They may be used as analogue values or digital where any non zero value is considered ‘True’ 
There are up to 16 user values which may be used as required in any analogue or logic calculations.  To use a 
User value as a digital flag it takes the state OFF when the value is zero and ON when the value is not zero. 
 

 
 

Figure 8-8:   User Values - Parameter List 

Note: 
To set the user value, double click on the user value and enter the new value in the pop up box. 
Alternatively, right click on the user value and select ‘Edit Parameter Value’ from the pop up window. 
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8.5. TIMER BLOCKS 
Timer Blocks allow the controller to use time information as part of the control process.  They can be triggered 
by an event and used to initiate an action.  For example, an action may be delayed following a particular event.  
The Timer Blocks fitted in the 2500 controller are:  
 

Timers Up to eight Timer Blocks each having four modes of operation are explained in section 8.6.  The 
timer type is set in Configuration level.  The timer is activated by an event.  The event is also 
defined in Configuration mode or it may be triggered by a parameter in the list.  Timing 
continues for a set time period.  The output can be ‘wired’ in configuration mode to operate a 
further event, see section 8.9.   

Counters Up to eight Counter Blocks are available.  Each can be configured for Up or Down count. See 
section 8.7. 
The output can be ‘wired’ in configuration mode to operate a further event, see section 8.9. 

Totalisers Up to eight Totaliser Blocks may be configured to provide a running total of a parameter and 
give an output when a pre-set total is reached.  An example might be to totalise the flow 
through a pipe. See section 8.8. 
Totaliser blocks can also be ‘wired’, in Configuration level, to any input parameter.   
The output can also be ‘wired’ in Configuration level to operate an event such as a relay, see 
section 8.9 

 

8.6. TIMER TYPES 
Each timer block can be configured to operate in four different modes.  These modes are explained below 
 

8.6.1. On Pulse Timer Mode (PULSE) 
This timer is used to generate a fixed length pulse from an edge trigger. 
• The output is set to On when the input changes from Off to On. 
• The output remains On until the time has elapsed 
• If the ‘Trigger’ input parameter recurs while the Output is On, the Elapsed Time will reset to zero and the 

Output will remain On 
• The triggered variable will follow the state of the output 
 

The behaviour of the timer under different input conditions is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-9:   On Pulse Timer Under Different Input Conditions 
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8.6.2. Off Delay Timer Mode (DELAY) 
This timer provides a delay between the trigger event and the Timer output.  If a short pulse triggers the Timer, 
then a pulse of one sample time (110ms) will be generated after the delay time. 
 

• The Output is set to Off when the Input changes from Off to On. 
• The Output remains Off until the Time has elapsed. 
• If the Input returns to Off before the time has elapsed, the Timer will continue until the Elapsed Time equals 

the Time.  It will then generate a pulse of one Sample Time duration. 
• Once the Time has elapsed, the Output will be set to On. 
• The Output will remain On until the Input is cleared to Off. 
• The Triggered variable will be set to On by the Input changing from Off to On.  It will remain On until both 

the Time has elapsed and the Output has reset to Off. 
 
The behaviour of the timer under different input conditions is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-10:   Off Delay Timer Under Different Input Conditions 
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8.6.3. One Shot Timer Mode (1 SHOT) 
This timer behaves like a simple oven timer.  
• When the Time is edited to a non-zero value the Output is set to On 
• The Time value is decremented until it reaches zero.  The Output is then cleared to Off 
• The Time value can be edited at any point to increase or decrease the duration of the On time 
• Once set to zero, the Time is not reset to a previous value, it must be edited by the operator to start the next 

On-Time 
• The Input is used to gate the Output.  If the Input is set, the time will count down to zero.  If the Input is 

cleared to Off, then the  Time will hold and the Output will switch Off until the Input is next set.   
Note:  since the Input is a digital wire, it is possible for the operator to NOT wire it, and set the Input value to On 

which permanently enables the timer. 
• The Triggered variable will be set to On as soon as the Time is edited.  It will reset when the Time reaches 

zero. 
 

The behaviour of the timer under different input conditions is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-11:   One Shot Timer 
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8.6.4. Minimum On Timer Mode (CMPRSS) 
This timer has been targeted at guaranteeing that the output remains On for a duration after the input signal has 
been removed.  It may be used, for example, to ensure that a compressor is not cycled excessively. 
 
• The output will be set to On when the Input changes from Off to On. 
• When the Input changes from On to Off, the elapsed time will start incrementing towards the set Time. 
• The Output will remain On until the elapsed time has reached the set Time.  The Output will then switch Off. 
• If the Input signal returns to On while the Output is On, the elapsed time will reset to 0, ready to begin 

incrementing when the Input switches Off. 
• The Triggered variable will be set while the elapsed time is >0.  It will indicate that the timer is counting. 
 
The behaviour of the timer under different input conditions is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-12:   Minimum On Timer Under Different Input Conditions 
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8.6.5. Timer Parameters  
These are found in Toolkit Blocks → Timers → TMR1 to 8. 
 
 
 
 
 
 
 
 
 
 

Figure 8-13:   Timers Parameter List 

 

Name Description Range Status 

 Type Timer Type.  This selects the type of timer from those described in the previous 
sections 

  

 OFF (0) Timer not defined 

 PULSE (1) A single retriggerable pulse timer 

 DELAY (2) Off delay timer 

 1 SHOT (3) One shot timer 

 CMPRSS (4) Compressor or minimum on timer  

 IP_Src Timer Input Wire.  This allows the timer to be started from an external source.  –1 
indicates that no wire is made and the time can be set using the ‘Time’ parameter. 

  

 IP_Val Trigger/Gate Input.  This input triggers the timer to start. 

 OFF (0) Not timing.  Trigger/gate input FALSE 

 on (1) Timing.  Trigger/gate input TRUE 

 Time Timer Time.  Sets the period for which the timer will run  H:M:S:ms  

 Trig Timer Triggered.  The timer trigger will change from on to off depending on the timer 
type 

  

 OFF (0) Not timing.  Trigger/gate output FALSE 

 on (1) Timing.  Trigger/gate output TRUE 

 OP Timer Output.  The output will change from on to off depending on the timer type   

 OFF (0) Timer output FALSE 

 on (1) Timer output TRUE 

 Elapse Timer Elapsed Time.     
 

 

Part No HA027115  Issue 5  Feb -14                                                                                                                                                            145    



2500 Controller  Engineering Handbook 

8.7. COUNTERS 
Up to eight Counter blocks are supported per IOC. 
 

The counter provides a function to count transitions from 'OFF' to 'ON' 
 

The counter can be set to two modes count 'UP' or 'DOWN', it has external wireable enable 'En', a reset 'Rst' 
and a clear overflow flag 'COv'  
 

1. In 'UP' mode, when 'En' is set to one (Yes) the block increments the 'COUNT' from zero to the target 'Tgt'.  
On reaching the target the block will sustain the Ripple Carry output while 'Count = target', on the next 
count it will set the Overflow output 'Ovflow' to 1 (yes) and re set the count to zero 

2. DOWN mode, when 'En' is set to one (Yes) the block decrements the 'COUNT' from the target 'Tgt' to zero.  
On reaching zero the block will sustain the Ripple Carry output while 'Count = zero', on the next count it will 
set the Overflow output 'Ovflow' to 1 (yes) and re set the count to target. 

3. The Overflow output can be cleared by switching the Clear overflow 'COv' from 0 (no) to 1 (yes). 
 

The Total is limited to a maximum count of 2,147,483,647.   
 

A Ripple carry output 'RCarry' allows multiple Counter blocks to be concatenated extending this count if 
required.  See example below: 
 

The nominal quoted resolution for the counter block is nine digits i.e.999999999. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-14:   Counter Block 

 

8.7.1. Counter Parameters  
These are found in Toolkit Blocks → Counters → CTR1 to 8. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-15:   Counters Parameter List 
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Name Description Range Status 

 Dir Direction.  Defines the direction of count in response to clock pulses 
 

The Count is limited to a maximum count of 2,147,483,647. 

  

 Up (0) Count up  In 'UP' mode, when 'En' is TRUE (Yes) the block increments the 'COUNT' from zero to the 
target 'Tgt'.  On reaching the target the block will sustain the Ripple Carry output while 'Count = target'.  
On the next count it will set the Overflow output 'Ovflow' to 1 (yes) and reset the count to zero 

 Down (1) Count down  In 'DOWN' mode, when 'En' is TRUE (Yes) the block decrements the 'COUNT' from the 
target 'Tgt' to zero.  On reaching zero the block will sustain the Ripple Carry output while 'Count = zero'.  
On the next count it will set the  

Overflow output 'Ovflow' to 1 (yes) and re set the count to target. 

 Tgt Target.  Sets the value to which the counter is aiming   

 Count Count.  Current count value   

 Clk Clock.  Clock input:  

A FALSE to TRUE transition on this input will increment/decrement the count for 
Direction = Up/Down respectively. 

  

 ClkSrc Clock Source.  Modbus address of the source from which the Clock is derived. 
 -1 indicates NOT wired 

  

 RCarry Ripple Carry.  Ripple Carry output: 
TRUE during a period determined by Direction: 
Direction = Up: when Count = Target. 
Direction = Down: when Count = 0. 
It will be FALSE otherwise. 

  

 Ovflow Overflow.  Overflow output: 
Becomes TRUE on the count after the ripple carry. 
It will remain TRUE until reset by the ‘Cov’ input.. 

  

 no (0) No overflow 

 YES (1) Overflow active 

 Rst Src Reset Source.  Modbus address of the source from which the Reset is derived. 
-1 indicates NOT wired 

  

 Rst Reset.  Counter reset input. 
Setting this input TRUE will reset/load the count value as follows: 
Direction = Up: count goes to 0 
Direction = Down: count goes to the target value. 
While the reset input is TRUE, the counter will ignore the clock input. 

  

 no (0) Reset input FALSE 

 YES (1) Reset input TRUE 

 COvSrc Clear Overflow Source.  Modbus address of the source from which the Clear Overflow  
input is derived.   -1 indicates NOT wired 

  

 COv Clear Overflow.  Clear Overflow input: 
Setting this input TRUE will cause the Overflow output to become FALSE. 

  

 no (0) Clear overflow input FALSE 

 YES (1) Clear overflow input TRUE 

 EnSrc Enable Source.  Modbus address of the source from which the Enable input is derived.   
-1 indicates NOT wired 

  

 En Enable.  Enable Counter input: 
When TRUE the counter will count the Clock inputs.  
When FALSE, the counter will ignore the Clock input. 

  

 no (0) Clock input is ignored 

 YES (1) Clock inputs are counted 
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8.8. TOTALISERS 
Totalisers are used to measure the total quantity of a measurement integrated over time (e.g. flow, power).  
There is a total of eight totaliser blocks in the 2500 controller.  Outputs from the totaliser blocks are integrated 
values of the inputs.  An alarm state and a pulse output is provided and can be wired to a counter block or 
external electromechanical counter to extend the upper range of totalisation. 
 
In addition to the 'RUN', 'HOLD' and 'RESET' input parameters of a totaliser block, the following are provided: 
 

• a 'LOW THRESHOLD cut-off for the Input signal  
• an alarm set point  
• a Pulse Set point for the Pulse output. 

 
a. In 'RUN' the totaliser will integrate its input and continuously test against an alarm set point.  
b. In 'HOLD' the totaliser and pulse output buffer will stop integrating the input but the block will continue to 

test for alarms. 
c. In 'RESET' the total will be reset to zero and the alarms cleared. 
 

The Total is limited to a maximum of 99999 and minimum of -19999.  This range can be extended by use of the 
pulse output wired to the Counter block. 
 

8.8.1. Totaliser Parameters  
These are found in Toolkit Blocks → Totalisers → TOT1 to 8 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-16:   Totalisers Parameter List 
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Name Description Range Status 

 IP Totaliser Monitored Parameter Value.  Current input value.   99999 
to 

-19999 

 

 IPSrc Totaliser Monitored Parameter Source.  Modbus address of the source from which the 
Monitored Parameter 
is derived.    -1 indicates NOT wired 

  

 Reset Totaliser Reset.  In Reset the totaliser will be zeroed, and alarms will be reset.   

 no (0) Totaliser Reset FALSE 

 YES (1) Totaliser Reset TRUE 

 ResSrc  Totaliser Reset Source.  Modbus address of the source from which Reset is derived. 
-1 indicates NOT wired. 

  

 Run Run.  In Run the totaliser will integrate its input and continuously test against an alarm 
setpoint. 

  

 Reset (0) Totaliser not running 

 Run (1) Totaliser running 

 RunSrc Totaliser Run Source.  Modbus address of the source from which Run is derived. 
-1 indicates NOT wired 

  

 Hld Hold.  In Hold the totaliser will stop integrating its input but will continue to test for alarm 
conditions. 
Note: 
The Run & Hold parameters are designed to be wired to (for example) digital inputs.  
Run must be ‘on’ and Hold must be ‘off’ for the totaliser to operate. 

  

 Cont (0) Totaliser not held 

 Hold (1) Totaliser in hold 

 HldSrc Totaliser Run Source.   Modbus address of the source from which Hold is derived. 
-1 indicates NOT wired 

  

 Total Totaliser Accumulator Output.  The integrated value of the Monitored Parameter   

 AlmSP Totaliser Alarm Setpoint.  Sets the totalised value at which an alarm will occur   

 AlmOP Totaliser Alarm Output.  This is a read only value which indicates the alarm output On or 
Off. 
The totalised value can be a positive number or a negative number.   
If the setpoint is a positive number, the alarm will activate when the total is greater than 
the setpoint.  
If the setpoint is a negative number, the alarm will activate when the total is lower (more 
negative) than the setpoint. 
If the totaliser alarm setpoint is set to 0.0, the alarm will be off.  It will not detect values 
above or below. 
The alarm output is a single state output.  It may be cleared by resetting the totaliser, or 
by changing the alarm setpoint. 

  

 OFF (0) Alarm output off 

 on (1) Alarm output on 

 LowThr Totaliser Low Threshold.  Monitored Parameter low threshold: 
If the absolute value of the input is less than this value, it will be ignored. 
E.g. a LowThr value of 1.0 will cause inputs from -0.9 to +0.9 to be ignored. 

  

 PulsSP Totaliser Pulse Setpoint.  The amount of Total integrated for each PulsOP output.   
E.g. if Monitored Parameter is in m/s then setting PulseSP=10 (m)  
would give one pulse on PulsOP for every 10m integrated. 

  

 PulsOP Totaliser Pulse Output.  Set TRUE for one sample period for every PulseSP integrated.   
Maximum rate of pulses will be 2x sample period.  If the PulseOP cannot keep up with 
the integrated value then pulses will not be lost but will be output at maximum rate until 
caught up. 

  
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8.9. WIRING 
Soft Wiring (sometimes known as User Wiring) refers to the connections which are made in software between 
function blocks.  This section describes the principles of soft wiring.   
In general every function block has at least one input and one output.  Input parameters are used to specify 
where a function block reads its incoming data (the ‘Input Source’).  The input source is usually soft wired to the 
output from a preceding function block.  Output parameters are usually soft wired to the input source of 
subsequent function blocks. 
It is possible to wire from any parameter using its Modbus address.  In practice, however, it is unlikely that you 
will wish to wire from many of the available parameters.  
The function blocks used in this manual are drawn as follows: 
1. Input parameters defined by ‘Src’ on the left of the function block diagram 
2. Typically wired output parameters on the right hand side  
3. Other parameters, which are not normally wired to, are shown as settings  
A parameter which is not wired to can be adjusted through the iTools display provided it is not Read Only (R/O) 
and the correct access level is selected. 
Figure 8-17 shows an example of how a PID function block (Loop 1) might be wired to other function blocks to 
produce a simple single loop controller.  The LOOP01 → ‘PVSrc’ input is soft wired to the output of ‘IO → 
Module01 → M01_C1 → Val’. 
The channel 1 (heat) output from the PID block is soft wired to the input source (‘Wire Src’) of Module 1A, fitted 
as an output module. 
Also in this example, a digital input to the ‘Man Mode Src’, allows the loop to be placed into manual depending 
upon the state of the digital input.  The digital input is DIO1 connected to terminal D1 on the controller. 
 

8.9.1. An Example of Soft Wiring 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8-17:   A Simple Wiring Example of a PID Function Block 
 

8.9.1.1. Implementation 
1. Wire Module 01 Output to Loop 01 PV Input 

a) In IO → Module01 → MOD01  Set ‘ReqID’ to AI2 (or AI3 or AI4) 
b) In IO → Module01 → M01_C1  Press + to open the list of parameter tags 
c) Drag the ‘OP’ tag to ‘PVSrc’ in Control → LOOP01 

 

2. Wire Module 02 Output to Loop 01 Auto/Manual Select Source 
d) In IO → Module02 → MOD02  Set ‘ReqID’ to DI4 (or DI8) 
e) In IO → Module02 → M02_C1  Press + to open the list of parameter tags 
f) Drag the ‘OP’ tag to ‘m-ASrc’ in Control → LOOP01 

 

3. Wire Loop 01 Channel 1Output to the input of Module 03 
g) In Control → LOOP01 → L01_OP Press + to open the list of parameter tags 
h) In Module 03 → M02_C1  Set ‘ReqID’ to DO4 (or RLY4 or AO2) 
i) Drag the ‘Ch1OP’ tag to ‘ValSrc’ in Control → LOOP01 → L01_OP 

 

4. To remove a wire select the ‘Src’ parameter right click Delete Wire 
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8.10. POINT TO POINT WIRING 
The user wiring system in earlier versions (up to V3.07) of the 2500 requires that all variables be ‘wired to’.  This 
requires that each variable that may be ‘wired to’ is allocated an additional Modbus address that contains the 
‘variable source’ if ‘wired to’ and is unused if not. 
All read/write variables can be written over communications.  However, there are many read/write variables that 
are only sometimes wired. 
An indirect 'WIRE' table is provided to facilitate writing to 16 variables not currently provided with a ‘variable 
source’ Modbus register 
As an example if you require wiring to the input scalar in an analogue toolkit block this 'WIRE' block will provide 
connection. 
 

8.10.1. WIRES Parameters  
These are found in Toolkit Blocks → WIRES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-18:   WIRES Parameter List 

Name Description Range Status 

 Src1 Point-to-point Wire Source 
-1 means NOT wired. 

  

 Dst1 Point-to-point Wire Destination. 
-1 means NOT wired. 

  

 Stat1 Wire status   

 OK (0) The wire is operating normally 

 None (1) The wire is not configured.  Either source or destination are set to -1 

 InvSrc (2) The source address cannot be found 

 Inv Dst (3) The destination address cannot be found 

 Fail (4) The value has not been written due to being outside limits, 
not available or not alterable. 

The above parameters are repeated for 16 wires 
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8.11. RELATIVE HUMIDITY  
8.11.1. Overview 
Humidity (or altitude) control uses the traditional Wet/Dry bulb method.  The Humidity toolkit block calculates 
the relative humidity (RH in %) and the Dew Point temperature and allows for compensation of atmospheric 
pressure and psychrometric constant. 
As with any other transducer input, a 2500 analogue input may also be connected to a solid state sensor giving 
RH directly.   
The derived Humidity value may be used for monitoring or may be wired to a PID control block and used to turn 
a refrigeration compressor on and off, operate a bypass valve, and possibly operate two stages of heating 
and/or cooling 
 

8.11.2. Humidity Parameters 
Humidity parameters are found in Control → HUMID1 

 
 

Figure 8-19:   Humidity Parameters (configuration level) 

The Wet and Dry bulb inputs must be wired to the appropriate PT100 analogue inputs. 
 

Name Description Range Status 

 WEt Wet Bulb Temperature value   

 WEtSrc Wet Bulb Temperature Source. Modbus address of the parameter providing the wet 
temperature 
-1 indicates NOT wired. 

  

 Dry Dry Bulb Temperature value   

 DrySrc Dry Bulb Temperature Source. Modbus address of the parameter providing the dry 
temperature 
-1 indicates NOT wired. 

  

 RH Relative Humidity value.  The calculated RH in %   

 DewPnt Wet/Dry Temperature Dew Point. The calculated Dew Point temperature   

 AP Atmospheric Pressure.  The atmospheric pressure used to compensate the RH calculation. 
The default is 1013 mBar 

  

 APSrc Atmospheric Pressure Source.  Modbus address of the parameter being used to provide 
the atmospheric pressure 
-1 indicates NOT wired - i.e. fixed at the default value 

  

 cOrr Wet Bulb Temperature Correction.  Allows an offset to be applied to the wet bulb 
temperature measurement 

  

 PSY_Cn Psychrometric Constant.  Default value 6.66.  May be a constant or may be wired to a 
derived input using ‘PSYSrc’. 

  

 PSYSrc Psychrometric Constant Source.  Modbus address of the parameter being used to provide 
the psychrometric constant 
-1 indicates NOT wired - i.e. fixed at the default value 

  

 Sbrk Sensor Break.  Sensor break status for RH control. 
Logical OR of the Wet and Dry input status' 

  

 no (0) Both sensors within limits 

 YES (1) One or both of the sensors is faulty 
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8.12. ZIRCONIA - CARBON POTENTIAL CONTROL 
8.12.1. Overview 
An available option within the 2500 is the Zirconia function block.  This feature is used to measure carbon 
potential, furnace dew point or oxygen concentration. 
 

8.12.2. Zirconia Probe Parameters  
The key Zirconia configuration parameter is the actual equation used, ‘ZrFn’.  This depends on the type of 
probe, the range and the manufacturer.  Depending on the option selected the Process Variable will be Carbon 
Potential, Dewpoint or Oxygen concentration.  The PV is derived from the probe temperature ‘TmpIP’, the 
probe mV ‘mV’ and, for O2 and Carbon, the local ‘H-CO’ or remote ‘RmH-CO’ gas reference input value.  These 
must be wired to appropriate I/O input channels or derived values. 
 

Zirconia parameters are found in Control → ZIRC1. 
 

 
Figure 8-20:   Zirconia Parameters (configuration level) 

Name Description Range Status 

 ZirPV Zirconia Control Process Value.  The Zirconia PV - the Oxygen or Dew Point value derived 
from the gas reference inputs 

  

 ZiFn Zirconia Probe Equation.     

 MMI (0) MMI - Carbon 

 MMI_DP (1) MMI – Dew Point 

 AACC (10) AACC 

 drAy (11) Drayton 

 ACCU (12) Accucarb 

 SSI (13) SSI 

 mdu (14) MacDhui 

 Oxy (15) Oxygen 

 Log.O (16) Log Oxygen 

 boSH (17) Bosch 

 dw.P (18) Dew Point 

 PmV (19) Probe mV 

 boSC (20) Bosch Carbon 

 BarCol (21) Barber Colman 

 O2_Un Oxygen Exponent. Exponent of the Oxygen units 
eg set to 6 for ppm; set to 2 for % 
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Name Description Range Status 

 H-CO Gas Reference.  Required value which defines the % carbon monoxide in the gas used for 
carburising.  See also section 8.12.4 

  

 RmH-Co Remote Gas Reference.  Remote required value which defines the % carbon monoxide in 
the gas used for carburising.  See also section 8.12.5 

  

 RmHSrc Remote Gas Reference Source .  Modbus address of parameter providing the 
Endothermic Gas correction.  

-1 means that it is not wired and must be set manually. See also section 8.12.5. 

  

 RmGEn Remote Gas Enable.  Set to enable remote gas reference for endothermic correction.  See 
also section 8.12.5. 

  

 Intern (0) Internal.  Use internal gas reference 

 Remote (1) Remote.  Use remote gas reference 

 WkH-CO Working Gas Reference.  The current value of the reference gas.    

 no (0) No gas reference 

 YES (1) Working gas reference value 

 PF Process Factor.  The process factor is used by some probes (MMI) to provide 
compensation for varying degrees of carbon absorption. 
Only shown if ‘Parameter availability settings’ in the ‘View’ menu are not hidden. 

  

 ClnPrb Zirconia Clean Probe IP.  Zirconia Clean Probe IP 
Set to manually initiate a probe clean.  See also section 8.12.7. 

  

 OFF (0) No probe clean.   

 on (1) Probe clean initiated 

 ClnSrc Zirconia Clean Probe IP Source.  Modbus address of the flag used to initiate a probe clean 
-1 indicates NOT wired 

  

 cYct Zirconia Probe Cleaning Interval.  Sets the interval between probe cleaning cycles.  
Default 4 hours. 

h:m:s:
ms 

 

 OFF (0) Zirconia probe cleaning off.  Appears when the value is set to 0. 

 _4h Zirconia Probe Cleaning Interval 

 bot Zirconia Probe Cleaning Time.  The length of time the compressed air is applied to clean 
the probe.  See also section 8.12.7. 

h:m:s:
ms 

 

 bort Maximum recovery time after purging.  The maximum time allowed for the probe to 
recover after cleaning 
Nominally 10 min.  See also section 8.12.7. 

h:m:s:
ms 

 

 bmrt Minimum recovery time after purging.  The minimum time allowed for the probe to 
recover after cleaning 

h:m:s:
ms 

 

 OFF (0) Minimum probe recovery time.  OFF appears when the value is set to 0. 

 _0h Minimum probe recovery time value 

 MinT Zirconia Minimum Calculation Temperature.  Set to the minimum temperature that will be 
allowed for the calculation to take place 

  

 OFFS Zirconia mV Offset.  Applies an offset to the probe reading   

 TOFS Zirconia Temperature Offset.  Sets the temperature offset for the probe   

 t2c Time To Next Cleaning.  Time remaining until the next clean is initiated  h:m:s:
ms 

 

 Prob Zirconia Burn Off State.  Zirconia Burn Off State 
Defines the current state of the probe cleaning. 

  

 idle (0) Cleaning not in progress 

 burn (1) Cleaning in progress 

 rcvy (2) The probe is recovering having just been cleaned 

 boVLV Zirconia Clean Valve Output.  Displays the current state of the cleaning valve.   

 OFF (0) Cleaning not in progress 

 on (1) Cleaning in progress 

 PrbFlt Zirconia Bad Probe.  Set if the probe recovery time exceeds the Maximum recovery time.  
See also section 8.12.7. 

  

 Good (0) Probe clean completed OK 

 Bad (1) Probe due for refurbishment 

 ZirSBr Probe Sensor Break. Set if the probe input is broken   
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Name Description Range Status 

 no (0) Probe OK 

 YES (1) Probe out of limits 

 SootAL Zirconia Probe Sooting Alarm.  Alarm triggered when the atmospheric conditions are 
such that carbon will be deposited as soot on all surfaces inside the furnace.  See also 
section 8.12.6.   

  

 Good (0) Conditions will not cause soot 

 Bad (1) Sooting conditions present 

 mV Zirconia Probe mV IP.  Zirconia probe input -0.1 to 
2.0 

 

 mVSrc Zirconia Probe mV Input Source.  Modbus address of the parameter providing the probe 
input mV 
-1 indicates NOT wired 

  

 TmpIP Zirconia Probe Temperature Input.  The actual temperature of the probe   

 TmpSrc Zirconia Probe Temperature Input Source.  Modbus address of the parameter providing 
the probe temperature 
-1 indicates NOT wired 

  

 PVnVd PV Invalid.  PV invalid   

 no (0) PV valid 

 YES (1) PV invalid 

 PVFrz PV Frozen.  Set whilst the probe is being cleaned or recovering afterwards 
Ensures the control loop is not disturbed by the cleaning 

  

 no (0) PV working normally 

 YES (1) PV Frozen during clean/recover cycle 

 

8.12.3. Temperature Control 
As well as the Carbon control the furnace temperature has to be controlled.  The sensor input of the 
temperature loop may come from the zirconia probe but it is common for a separate thermocouple to be used.  
The temperature PID block will provide a heating output that may will be connected to gas burners or to 
thyristors to control electrical heating elements.  In some applications a cooling output may also be connected 
to a circulation fan or exhaust damper. 
 

8.12.4. Carbon Potential Control 
The zirconia probe generates a millivolt signal based on the ratio of oxygen concentrations on the reference 
side of the probe (outside the furnace) to the amount of oxygen in the furnace. This is set as the Gas Ref/Process 
Factor ‘H-CO’. 
The controller uses the temperature and carbon potential signals to calculate the actual percentage of carbon in 
the furnace ‘ZircPV’.  This second PID loop generally has two outputs.  One output is connected to a valve that 
controls the amount of an enrichment gas supplied to the furnace.  The second output controls the level of 
dilution air. 
Oxygen Units is the ‘O2_Un’ exponent of the oxygen units.  This may be set to correspond to the units used, eg 
set to 6 for PPM; 2 for %, etc. 
 

8.12.5. Endothermic Gas Correction 
A gas analyser may be used to determine the %CO concentration.  If an analogue output is available from the 
analyser, it can be fed into the 2500 Zirconia block to adjust the calculated % carbon reading automatically.  The 
analyser signal should be wired to the Remote Gas Ref/Process Factor ‘RmH-CO’ and the Remote Gas Enable 
‘RmGEn’ set to Enable.  If ‘RmGEn’ is disabled the value can be entered manually in ‘H-CO’. 
 

8.12.6. Sooting Alarm 
In addition to other alarms that may be detected by the controller, zirconia block can trigger an alarm ‘SootAL’ 
when the atmospheric conditions are such that carbon will be deposited as soot on all surfaces inside the 
furnace. 
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8.12.7. Automatic Probe Cleaning 
The 2500 zirconia block has a probe clean and recovery strategy.  A short blast of compressed air is used to 
remove any soot and other particles that may have accumulated on the probe.  The air blast continues for the 
time set in Probe Cleaning time ‘bot’.  Once the cleaning has been completed the time taken for the probe to 
recover is measured.  If the recovery time is longer than the Max recovery time after purging ‘bort’, the probe is 
ageing and replacement or refurbishment is due and the output Zirconia Bad Probe ‘PrbFlt’ is set.  
During the cleaning and recovery cycle, the %C reading is frozen to prevent the carbon PID reacting and 
ensuring continuous furnace operation.  The cleaning cycle can be triggered manually by setting the input 
Zirconia Clean Probe IP ‘ClnPrb’ or it can be programmed to occur automatically at an interval set in Zirconia 
Probe Cleaning Interval ‘cYct’. 
The Zirconia block has various outputs to indicate the status of the block: 
t2c  Time remaining to next cleaning 
PVFrz  set when the PV output is Frozen 
Prob  The probe burn off state set to idle, burn or recovery. 
 

8.13. ORDER IN WHICH CALCULATIONS ARE PERFORMED 
The strategy is executed in the following order:- 
 
1. Point to point wires 
2. Digital calculations 
3. Analogue calculations 
4. Timers 
5. Totalisers 
6. Counters 
7. Humidity 
8. Zirconia 
9. Loops 
10. User alarms 
11. Loop alarms 
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9. Chapter 9    Modbus Communications 
9.1. OVERVIEW 
The 2500 IOC and wiring for digital communications is described in Chapter 3.  
To set up the parameters of the Modbus slave in the 2500 IOC. is described in Chapter 6.2. 
NOTE:- When the configuration port is in use the Modbus network port is disabled. 
 

9.2. MODBUS ADDRESSES 
9.2.1. Offset 
The parameter addresses shown in iTools and in 2500 documentation is the actual register used.  When setting 
up a true Modbus master the address must be increased by 1.  This is not required for Jbus masters. 
 

Parameter Address Modbus Master Address Jbus Master Address 

01000 01001 01000 
 

Table 9-1:   Offset for Modbus 

9.2.2. Parameter Addresses 
All parameter addresses are available in iTools.  They are in the Parameter Lists in the Address column.  To see 
this column ensure that on the Menu Bar under Parameter List → Columns ‘Address’ is ticked.  All the Parameter 
Lists shown in this handbook contain the address column. 
Because there are many addresses within a 2500 and there is potentially a large variety of IOC type, Base size, 
I/O module type, channel setup etc. using iTools is the best way to determine the addresses of the parameters 
that are required in a particular system.  They can be shown in decimal or hexadecimal from the menu bar 
‘Parameter List’ → ‘Address Display’. 
In the case of enumerated values these are listed in preceding chapters of this handbook with the value of the 
enumeration shown in ( ) in the parameter lists.  These can also be seen in iTools for a particular parameter by 
double clicking on the parameter, which opens the parameter value pop up window, then opening the 
enumerated list.   
Take care not to inadvertently change this value in a working system. 
 

9.2.3. Parameter Resolution 
Normal Modbus Comms use a 16 bit word to transfer integer values.  This has no decimal point so the 
magnitude of the number has to be known to the master.  For example if two decimal places are required the 
number 12.34 is set as 1234 and the master has to be set up to divide this by 100.  Each Loop has the option to 
define how many decimal places are included in the word.  See section 4.3.2 and Control → LOOP01 → 
L01CFG → Decimal Places in Disp/Comms. 

Since the value here is limited to 16 bits, the range is limited to +32767 to –32768. If the parameter is outside 
this range a value of –32768 (8000H) will be returned. In order to obtain a true reading in this case, the floating 
point address must be used. 
 

9.2.4. Floating Point 
All Modbus parameters are repeated in the Modbus address space above 32768 (8000hex) in 24 bit IEEE 
floating point format using two adjacent Modbus registers. 
The floating point address of a parameter is its normal address x 2 and + 32768. 
Taking Loop01.PV address as 2 then the floating point address is 2 X 2 + 32768 = 32772 
The format used to transfer IEEE numbers is in Table 9-2 
 

Lower Modbus address Higher Modbus address 

MSB LSB MSB LSB 

Bits 31-24 Bits 23-16 Bits 15-8 Bits 7-0 

Sign & Exponent Fractional Value 

 

Table 9-2:   IEEE Format 

Most Modbus master protocols in SCADA packages will read this directly if the data type is set up as REAL or 
FLOAT. 
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9.3. COMMUNICATIONS BLOCKS 
9.3.1. Block Communications 
Modbus communications is made much more efficient by reading parameters in blocks rather than one by one.  
Actual data rates depend on many factors, but typically at 9600 bits/sec, read one by one, a data rate of about 
30 parameters per second may be achieved.  If blocks of 32 parameters are read at a time the data rate rises to 
a few hundred parameters per second.  This gives a much better update response on a SCADA display, for 
example.  
Parameters that may be required in a particular system are very unlikely to be in a block of contiguous 
addresses that can take advantage of block reading.  To solve this a folder Comms_Blocks has been provided.  
 

9.3.2. Indirection Tables 
Two tables are provided, one for read/write ‘Rw’ and one for read only ‘Ro’ communications.  
The Read Only table would usually be used with Process Variables which are changing continuously and it 
would be block read at a relatively fast rate.   
The Read Write table is for parameters that do not change often, such as setpoints, and could be read at a much 
slower rate.  The actual arrangements would vary depending on the requirements of the whole system. 
The size of the two tables is defined in Operator → DESCR → nIndRO and nIndRW.  The standard size is 127 
parameters each. 
 

9.3.3. Read Write Source Indirection Table 
The ‘Src’ folder allows parameters to be entered into the indirection table. 
 

 
 

Figure 9-1:  Read Write Indirection Table - Block Build 

The parameters may be wired by dragging the parameter tag to the appropriate source parameter shown in the 
above table or by entering the parameter Modbus address in the value column.  For example, parameter 001 
has been wired to Loop01 PV.   
 

9.3.4. Read Write Value Indirection Table 
The ‘Val’ folder provides a convenient way to change the value of the parameter.  This is in addition to changing 
its value in its normal folder.  Note that, in this example, the PV may be changed by writing either to Modbus 
address 16512 or to the actual Control → LOOP01 → PV at address 1. 
 

 
 

Figure 9-2:  Read Write Indirection Table - Value Entry 

9.3.5. Read Only Indirection Table 
These are similar to the ‘Rw’ tables and are also available as ‘Src’ and ‘Val’ tables. 
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10. Chapter 10    Profibus Communications 
10.1. OVERVIEW 
The 2500 IO Controller is available with Profibus DP and Profibus DPv1 communications. The 2500 can thus 
function as a Profibus slave, the network Master having read and write access to IOC database parameters.  The 
2500 will work with any Profibus Master - the Eurotherm T940, the Visual Supervisor and, of course, PC card 
types.  It will work alongside any other slave - and obviously in large systems along with other 2500 bases.  
There are four aspects considered here: the physical wiring of the network, the configuration of the 2500, the 
configuration of the network Master, and the creation and use of  GSD files.  
NOTE:- the Profibus IOC must be configured using iTools.  When the configuration port is in use the Profibus 
network port is disabled. 
 

10.2. PROFIBUS INSTALLATION 
The DP and DPv1 options can be factory fitted, so the order code must include the appropriate field descriptor 
PROFIBUS (for Profibus DP) or PROFI DPv1 (for Profibus DPv1).  Note that this option can be changed in 
configuration mode, see section 6.2.1. 
The matching Terminal Unit must also be ordered.  There are again two styles for different network connectors: 
a standard 9-Way D-Type, or a RJ45 type (not to be confused with the Modbus Terminal Unit, which looks very 
similar).  The latter can only be used for small local systems where the advantage of easier wiring is appreciable.  
See also Chapter 2. 
With the RJ45 version a network can be quickly built up using CATEGORY-5 cable; simply chain together all the 
bases to create a single serial run, all the way through the system up to the Master.  The cable must be 
terminated at both the Master end and at the last slave; if this is a 2500 fit the two links on the terminal unit in 
the high position.  
When connecting to a full Profibus network the D-Type connector must be used, via a short drop to the main 
network cable.  Terminators are not required or supplied for 2500s in such a system.  The pin-out conforms to 
the Profibus standard.  The 5V supply pins are for network bias and termination only; do not load with more 
than 10mA. 
 

10.3. CONFIGURATION OF THE 2500 FOR PROFIBUS 
Each slave on the network must be provided with a unique address, 1 to 127, in no particular sequence.  The 
Terminal Unit switches are used to set this address using binary code, lsb on the right, 1 in the up position 
(furthest from the power connector terminals), and 0 down.  See section 2.7.2. 
There are no software configuration requirements for the 2500. 
 

10.4. A 'GSD' FILE 
The Profibus network Master may be needed to work with many diverse slaves from different manufacturers and 
with different functions.  Furthermore, instruments like the 2500 run thousands of parameters, most of which will 
not be required by the network master for a particular application.   
The user must, therefore, define which parameters are to be available on the Profibus link.  This may be done 
using the Windows configurator which is supplied as standard on the iTools CD.  This configurator creates a 
‘GSD’ file for the slave.  The file <name>.GSD is a text file in predefined standardised format that may be 
imported into any proprietary Profibus master.  The master may then map the selected device parameters into 
the PLC input/output registers, or, in the case of a supervisory (SCADA) package, to a personal computer. 
Note that a GSD file for a particular 2500 may be used for a number of actual 2500 slave devices where the 
same parameter set is required.  These bases will obviously have different unit addresses. 
 

To use any slave the Master has to be set up appropriately in a two-step process: 

1) The new slave has to be declared (using tools provided with the Master); 

2) The GSD file(s) have to be imported and interpreted by the Master. 
 

This is sufficient to establish communications.  However, the Master still has to identify which parameter is which.   
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10.5. TO CREATE A NEW GSD FILE 
Profibus Parameters are defined as Input parameters or as Output parameters.  Input parameters are read every 
Profibus cycle, output parameters are written to every cycle.  This means, for example, that if the Profibus Master 
is writing to setpoint ‘SP1’ then any other attempt to change ‘SP1’ will just be overwritten on the next Profibus 
cycle.  Using ‘Demand Data’ continual writing to Output parameters can be controlled by extra code in the PLC.  
See also the Profibus Handbook Part No. HA026290. 
 

Do This The Display You Should See Additional Notes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2. Set up the editor 
for the 
appropriate slave 
by clicking the 
icon (here, the 
2500). 

 

1. Load the GSD file 
editor from the 
iTools CD and run 
it by double 
clicking the 
desktop icon.   

3. Select the 
appropriate list of 
parameters from the 
drop down list of 
‘folders’  

 
 
 
or 
 
 
 
 

    
Press ‘Delete’ to remove 
the highlighted 
parameter  
 
Press ‘Clear’ to remove 
all parameters in the list 

 

 

4. Highlight the 
parameter to be 
read by the master 
and press the upper 
> button  

5. Highlight the 
parameter to be 
written to the master 
and press the lower > 
button  
 
 
 

 
These folders are in exactly 
the same order as they are 
displayed in iTools. 
 
Check ‘Use Demand Data’ to 
allow continual writing to 
Output parameters 
controlled by the PLC 
 
Check ‘Esuite/DPV1’ when 
using masters capable of 
Profibus DPV1 
communications 
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Continue adding to the Input and Output lists until all the required parameters have been added to the 
appropriate list.  Parameters may be repositioned within a list by using the mouse to drag and drop a parameter 
within its list.  This can be used to make the list more logical. 
A maximum of 117 total input and output parameters is allowed in a Profibus DP slave.  When this limit is 
reached, the configurator will not allow more parameters to be added into either the input or output lists until 
other parameters have been deleted.   
It is advisable not to exceed 32 input and 32 output parameters in total, since some Profibus DP masters are 
unable to deal with more. 
When satisfied with the content a useful comment may be added to the ‘Description’ field at the bottom of the 
window. 
 

10.6. TO SAVE THE GSD FILE 
Once all the Input and Output parameter lists have been assembled as required press the diskette icon ‘Save 
the current GSD file to disc’ or the menu item File/Save and save the file as <name>.GSD. 
An I/O Map may also be displayed or printed for a project folder again using the ‘Display a report of Profibus IO 
Mapping’ icon or from the file menu.  An example is shown below:- 
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10.7. OPERATING AND APPLICATION NOTES 
 The Profibus Master needs the 2500 GSD file in order to establish a communications link.  The configuration of 

the Profibus Master will vary according to the manufacturer.  However, they will follow these basic steps. 
1. A new slave has to be declared and it has to be given a unit ID (base address).  
2. The required GSD file is then imported. 
 
 A single GSD file may be used for a number of actual 2500 systems on the Profibus network if the same 

parameter set is of interest on each.  If not a separate file must be produced for each different 2500. 
 
 Some master devices limit the parameter count to 32 input and 32 output. 
 
 Every parameter in the 2500 is treated as a WORD.  The Master may consider the data as bytes and it is 

necessary to identify which bytes correspond to each parameter.  An example from a configurator is shown 
below. 

 
Tag Name   Address    Datatype 
(* DP Input variables: *) 
VAR_GLOBAL 
    L1_PV                     AT %IW0.2.0!swap : WORD; 
    L1_WSP                     AT %IW0.2.2!swap : WORD; 
    L1_WOP                     AT %IW0.2.4!swap : WORD; 
    L1_ALM                    AT %IW0.2.6!swap : WORD; 
    L2_PV                    AT %IW0.2.8!swap : WORD; 
    L2_WSP                     AT %IW0.2.10!swap : WORD; 
    L2_WOP                    AT %IW0.2.12!swap : WORD; 
    L2_ALM                    AT %IW0.2.14!swap : WORD; 
END_VAR 
 
(* DP Output variables: *) 
VAR_GLOBAL 
    L1_TSP                    AT %QW0.2.0!swap : WORD; 
    L1_ASP                    AT %QW0.2.2!swap : WORD; 
    L2_TSP                    AT %QW0.2.4!swap : WORD; 
    L2_ASP                    AT %QW0.2.6!swap : WORD; 
END_VAR 

 
The PLC Tag name is given during configuration. 
 

Loop 1 PV (tag L1_PV) is Input Word (%IWO).the slave address(2).byte number (0) 
 

The data type is WORD which takes bytes 0 and 1.  The next parameter L1_WSP, therefore, starts at byte 2, and 
so on for the others. 
 

Note that in this case the byte order has to be swapped to be interpreted correctly. 
 

The output variables are handled in the same way. 
 

Note also, that if 32 bits are read on a 16 bit system then a read of 8000Hex (32768dec) is returned. 
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11. Chapter 11   Devicenet Communications 
11.1. OVERVIEW 
The 2500 supports DeviceNet as a “Generic device type, Group 2 only server” with the following specifications: 
• Support I/O messaging of up to 60 analog variables of Input data, and 60 analog variables of Output data. 

Actual I/O sizes can be chosen as required. 
• Choose contents of I/O messages from any variable or value in the main application object, transferring 

only the information needed for an application and saving overall network capacity. 
• Supports Polled I/O, Bit Strobe, Change of State, and Cyclic production. 
• Supports Device Shutdown and Heartbeat messages 
• “Application Variables” object provides direct access to 200 frequently used variables from each device 

type. In 2500 the object can itself be configured to contain specific variables needed for an application. 
• Access to all other values in the instrument provided by a simple ‘Tag Access’ object, giving read or write 

access to blocks of data identified by a tag address. Used for recipe download. 
• Analogue values can be returned either as 16 bit “scaled integer” values, or as 32 bit IEEE single precision 

floats. 
• Operation at all DeviceNet baud rates. (up to 500K baud) 
• maximum of 64 nodes on 100 metres of cable using the CAN physical signalling protocol 

 

11.2. DEFAULT MAPPING 
The 2500's factory default settings provide a “get you started” mapping that should be sufficient for many 
applications.  The following parameters are stored in non-volatile memory in the 2500 IOC.  If no custom 
mapping is made the IOC will load those parameters. 
 

11.3. 2500 DEFAULT PARAMETER MAPPING 
 

Input Parameter Offset 

Process Variable (Loop 1) 0 

Working Setpoint (Loop 1) 2 

Alarm Status (Loop 1) 4 

Process Variable (Loop 2) 6 

Working Setpoint (Loop 2) 8 

Alarm Status (Loop 2) 10 

Process Variable (Loop 3) 12 

Working Setpoint (Loop 3) 14 

Alarm Status (Loop 3) 16 

Process Variable (Loop 4) 18 

Working Setpoint (Loop 4) 20 

Alarm Status (Loop 4) 22 

Process Variable (Loop 5) 24 

Working Setpoint (Loop 5) 26 

Alarm Status (Loop 5) 28 

Process Variable (Loop 6) 30 

Working Setpoint (Loop 6) 32 

Alarm Status (Loop 6) 34 

Process Variable (Loop 7) 36 

Working Setpoint (Loop 7) 38 

Alarm Status (Loop 7) 40 

Process Variable (Loop 8) 42 

Working Setpoint (Loop 8) 44 

Alarm Status (Loop 8) 46 

TOTAL LENGTH 48 

 
 

Output Parameter Offset 

Target Setpoint (Loop 1) 0 

Auto/Manual Select (Loop 1) 2 

Alarm Group Ack (Loop 1) 4 

Target Setpoint (Loop 2) 6 

Auto/Manual Select (Loop 2) 8 

Alarm Group Ack (Loop 2) 10 

Target Setpoint (Loop 3) 12 

Auto/Manual Select (Loop 3) 14 

Alarm Group Ack  (Loop 3) 16 

Target Setpoint (Loop 4) 18 

Auto/Manual Select (Loop 4) 20 

Alarm Group Ack  (Loop 4) 22 

Target Setpoint (Loop 5) 24 

Auto/Manual Select (Loop 5) 26 

Alarm Group Ack  (Loop 5) 28 

Target Setpoint (Loop 6) 30 

Auto/Manual Select (Loop 6) 32 

Alarm Group Ack  (Loop 6) 34 

Target Setpoint (Loop 7) 36 

Auto/Manual Select (Loop 7) 38 

Alarm Group Ack  (Loop 7) 40 

Target Setpoint (Loop 8) 42 

Alarm Group Ack  (Loop 8) 44 

Alarm Status (Loop 8) 46 

TOTAL LENGTH 48 
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11.4. CUSTOM PARAMETER MAPPING 
The DeviceNet interface uses the 2500s standard Modbus indirection table to parameterise its application 
specific Send and Receive tables.  Custom mapping is done with iTools and is stored with the applications clone 
file. 
 

11.4.1. Indirection Tables 
Two tables are provided, one for read/write Rw and one for read only Ro communications. The Read Only table 
would usually be used with Process Variables which are changing continuously and it would be block read at a 
relatively fast rate. The Read Write table is for setpoints that do not change often, and could be read at a much 
slower rate.  The actual arrangements would vary depending on the requirements of the whole system. 
 

11.4.2. Read Write Indirection Table 

 
Figure 11-1:  Read Write Indirection Table 

The parameters may be wired in the usual way See iTools manual for more details.  In the read write table 
Parameter 001 has been wired to Loop01 target setpoint.  
 

11.4.3. Read Only Indirection Table 

 
Figure 11-2:  Read Only Indirection Table 

The parameters may be wired in the usual way.  In the read only table Parameter 001 has been wired to the PV 
of channel 1 of module 3. 
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12. Chapter 12    Ethernet Communications 
12.1. OVERVIEW 
The 2500 I/O Controller  (IOC) supports Ethernet using the Modbus/TCP protocol.  This protocol embeds the 
standard Modbus protocol (see Chapter 9) within an Ethernet TCP layer. 
A master device  (iTools, PLC, SCADA, 6000 series recorders) using the Modbus/TCP protocol is required to 
access the 2500 Ethernet IOC parameters. 
 

12.1.1. Support for other Ethernet utilities 
In addition to the MODBUS TCP protocol, the 2500 IOC supports the standard Ethernet ‘ping’ utility to assist in 
fault finding.  Other interfaces such as http, ftp or telnet are not currently supported. 
 

NOTE 1:-  When the configuration port is in use, the Ethernet network port is disabled for general Modbus/TCP 
traffic.  Support for the ‘ping’ utility is not affected and will still respond. 
 

NOTE 2:-  When changing processors be aware that the MAC address is not the same as the previous MAC 
address and it may take a few minutes to re-establish communications links. 
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12.2. CONFIGURATION OF THE 2500 FOR ETHERNET 
12.2.1. General 
The 2500 IOC Ethernet capability is provided by an interface board installed within the IOC case.  This interface 
board communicates to the IOC internally using a standard Modbus interface at 38400 baud.  The Ethernet port 
is a 10baseT port and can be connected to a hub or switch with Cat5 cable via the standard RJ45 connector.  
Alternatively, an RJ45 cross-over cable may be used to connect direct to a PC 10baseT Network Interface Card. 
As most parameters are saved in the IOC memory, the interface board must retrieve these values before it can 
start communicating on Ethernet.  If the configuration cable is plugged in at power up, this retrieval will not take 
place and the interface board will not communicate over Ethernet.  
The values seen by iTools via the configuration cable in this case will vary according to the instrument set-up: 
1. The MAC address will be returned as 0 in all fields. 
2. If DHCP is configured, the IP address, Subnet mask and Default gateway will contain the values last 

assigned by the DHCP server.  These may change when the configuration cable is removed. 
Changing any of the IP parameters will cause the interface board to reset in order to retrieve the new values. 
Any socket left with no data traffic for 2 minutes will be disconnected and made available for new connections.  
This also applies to the preferred master socket (see section 12.3.5), except it will not be made generally 
available.  Thus the preferred master will either have to send ‘keep alive’ data or periodically re-connect if it 
stops sending data. 
 

Note that the 2500 may not respond if a DHCP server is not available - see section 12.3.7 
 

12.2.2. Setting the Instrument Address 
The 2500 Ethernet IOC uses the Modbus/TCP protocol.  This embeds the normal Modbus protocol within a TCP 
packet for transmission over an Ethernet network.  The Modbus address is included as part of the Modbus/TCP 
protocol, where it is referred to as the ‘Unit ID’ and will need to be set in accordance with the Unit ID Enable 
parameter (12.3.1). 
For normal Modbus (and other protocols) there is only the one address parameter that needs to be set.  For the 
Ethernet instrument however, there are several more: IP address, subnet mask, default gateway and DHCP 
enable.  
Changing any one of these parameters may immediately move the instrument to a new network address.  For 
this reason, it is recommended that such changes are made offline, via the configuration port.  
It is possible to safely make these changes via the Ethernet port since most of the parameters are in a 
contiguous block of addresses.  The exception is the Unit ID – but the DIP switches may set this.  Otherwise, the 
Ethernet parameters may be set by a single block write.  
The format for Ethernet IP addresses is four groups of up to three decimal digits usually represented as: 
aaa.bbb.ccc.ddd.  To enter these values into the 2500 Ethernet IOC, four separate parameters are used for each 
IP address style parameter.  For example, IP address 1 is the ‘aaa’ value, through to IP address 4 for the ‘ddd’ 
value. 
 

12.2.3. DIP Switches 
The following description views the DIP switches from the terminal side.  ‘Off’ (0) is with the switch slider towards 
the terminal, ‘On’ (1) is with the slider away from the terminal. 
The Unit ID Enable parameter decides how these switches are interpreted.  If set to “Instr”, each slave on the 
network must be provided with a unique slave id, 1 to 127.  The Terminal Unit switches may be used to set this 
value using binary code, lsb on the right.  See section 2.6.3. 
The leftmost switch is used to set DHCP enable: ‘off’ selects ‘Fixed’ addressing, ‘on’ selects DHCP.  See section 
12.3.7. 
As normal, if all switches are ‘off’, the values may be set by iTools – otherwise the values are read only. 
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12.3. ETHERNET COMMUNICATIONS PARAMETERS 
The 2500 Ethernet IOC address parameters may be found in the Operator.COMMS list. 
 

 
 

Figure 12-1:   Communications Parameters 

 

12.3.1. Unit Ident Enable 
This parameter controls how the instrument responds to the value in the Modbus TCP Unit Ident field.  The 
following value options are available:- 
0 = ‘Strict’   The instrument will only respond to Unit Ident values of 255 (0xFF).  Ignores values in the Addr – 

Comms address field. 
1 = ‘Loose’  The instrument will respond to ANY Unit Ident value.  Ignores value in Addr – Comms address field. 
2 = ‘Instr’    The instrument will only respond to Unit Ident values that match the Comms Address parameter.  

Uses the value in the Addr – Communications address field.  This field is set by either the DIP 
switches on the terminal unit or by software if the DIP switches are set to zero. 

 

12.3.2. IP Address 
With the DHCP Enable parameter set to ‘Fixed’, the values here become effective.   
Your network administrator will issue you with a value compatible with your network. 
The default IP address ‘out of the box’ is to 192.168.111.222. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 IPadd1 IP address 1 255  

 IPadd2 IP address 2 255  

 IPadd3 IP address 3 255  

 IPadd4 IP address 4 255  

 IP address  000 . 000 . 000 . 000   

 

Part No HA027115  Issue 5  Feb -14                                                                                                                                                            167    



2500 Controller  Engineering Handbook 

12.3.3. Subnet Mask 
This parameter defines which addresses are local to the network.   
Your network administrator will issue you with a value compatible with your network. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 Subnet1 Subnet mask 1 255  

 Subnet2 Subnet mask 2 255  

 Subnet3 Subnet mask 3 255  

 Subnet4 Subnet mask 4 255  

 IP address Subnet mask 000 . 000 . 000 . 000   

 

12.3.4. Default Gateway 
This parameter allows the 2500 Ethernet IOC to access devices that are not on the local network. 
Your network administrator will issue you with a value compatible with your network. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 Gateway 1 Default Gateway 1 255  

 Gateway 2 Default Gateway 2 255  

 Gateway 3 Default Gateway 3 255  

 Gateway 4 Default Gateway 4  255  

 IP address of default 
gateway 

000 . 000 . 000 . 000   

 

12.3.5. Preferred Master - Multiple Connections 
The 2500 Ethernet IOC is capable of providing information to up to four different Modbus/TCP masters 
simultaneously.  Access to the four ‘sockets’ is normally available on a first come first served basis.  Once all 
sockets are in use, further connections will be refused. 
There are situations where a particular master needs guaranteed access to the 2500 IOC at all times. The 
‘preferred master’ IP address can be used to ensure this availability.  When this parameter(s) is configured with 
the appropriate master’s IP address, only three sockets will be generally available, the fourth is reserved for a 
master with the matching IP address. 
Setting the Preferred Master IP address to 0.0.0.0, the default setting, is a special case that disables the function 
and makes all four sockets available for general use.  
Note that if the preferred master attempts to open a second socket while the first socket is connected, it will be 
given access to one of the 3 general sockets – if available.  If no sockets are available, it will be refused 
additional connections. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 PrefMst1 Preferred Master 1 255  

 PrefMst2 Preferred Master 2 255  

 PrefMst3 Preferred Master 3 255  

 PrefMst4 Preferred MAster 4  255  

 IP address Preferred 
Master 

000 . 000 . 000 . 000   
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12.3.6. MAC Address 
Every device designed to connect to the Ethernet is allocated a unique address, the Media Access Control 
(MAC) address.  Every Network Interface Card in every PC and every ‘Internet Enabled’ appliance is allocated its 
unique MAC address.  The 2500 Ethernet IOC is no different. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 MACaddr1 MAC address 1   

 MACaddr2 MAC address 2   

 MACaddr3 MAC address 3   

 MAC address 00-00 – 00-00 – 00-00   
 

The iTools representation of the MAC address is as three 16 bit signed values - MAC address 1 is the most 
significant.  To convert this to the standard notation, each signed value must be converted to two hexadecimal 
bytes to give: 
 

(MACaddr1 MSB) - (MACaddr1 LSB)  
- (MACaddr2 MSB) - (MACaddr2 LSB)  

- (MACaddr3 MSB) - (MACaddr3 LSB) 
 

where ‘-‘ is the standard MAC address separator. 
 

The MAC address must be stored in the device that connects to the Internet - for the 2500 Ethernet IOC; this is 
the interface board.  The MAC address value seen through iTools has to be read from the interface board.  If the 
configuration cable is plugged in at power up, communications to the interface board is inhibited and the MAC 
address parameters seen by iTools will all be 0.  In order to see the correct value(s), the configuration cable 
should be removed for a short period after the power up self-test sequence has completed. 
Note that the MAC address will be available (read only) to iTools via the configuration port (but see section 
12.2.1), regardless of the DHCP setting and will be retrieved before any wait for the DHCP server is invoked. 
 

12.3.7. Dynamic Host Configuration Protocol 
DHCP Enable 

DHCP is a protocol that enables a network server to dynamically allocate the IP address (and other parameters) 
of a client when it connects to the network.  Note:  Other protocols that automatically set the IP address, such as 
BOOTP or Link Local are not supported. 
The DHCP parameter may be set to ‘DHCP’ or ‘Fixed’.  If the parameter is set to fixed see IP address above. 
DHCP at power up: The instrument polls the network for a server to supply these parameters.  Once received, 
they are copied to the IOC and may then be interrogated using iTools via the configuration cable.  Until a valid 
IP address has been received, the IOC parameters will assume a value of 0.0.0.0 – seeing this value may be an 
indication that the DHCP server has not yet supplied any parameters.  
Note that if the DHCP server does not respond (in common with other Ethernet appliances in this situation) the 
2500 will not be accessible via the network. 
An alternate way to view the IP address, assigned by the DHCP server, without using the configuration lead is to 
use the appropriate network tools to interrogate the server.  For example, knowing the instrument MAC address 
(see below) the network command, ‘arp –a’ may provide a cross-reference from the MAC address to the 
assigned IP address. 
Note:  Changing any IP communication parameter will reset the interface board.  With DHCP enabled this will 
trigger a new request to the DHCP network server and may result in new address values being assigned.  When 
viewing the network addresses, it is recommended that no changes be made while reading the DHCP 
assignments via the configuration. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 DHCPen DHCP enable:  Defines if a remote, suitably configured DHCP server, is 
allowed to automatically assign IP address, subnet mask and default gateway. 
See your network administrator to set up this server. 

  

 Fixed (0) Allows manual entry of IP address, subnet mask and default gateway 

 DHCP (1) Allows the DHCP server to set the IP address, the subnet mask and default gateway. 
 

Note that this parameter may be set via the DIP switches (see section 12.2.3) – in which case it is read only here. 

DHCP Leases 
Leases must be issued for less than 24 days.  Notify your network administrator 
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12.4. MODBUS EXCEPTIONS 
The 2500 Ethernet IOC will return all the usual Modbus exceptions with respect to normal transactions. 
There are also two new conditions that will return exceptions. 
• BUSY (6): this will be returned when the configuration cable is plugged in. 
• FAIL (4): this will be returned if the connection from the interface board to the IOC experiences time-outs, 

or crc failures. 
 

12.5. COMMUNICATIONS INDICATORS 
There are two levels of communication indication.  The first dealing with Modbus communications between the 
Ethernet interface board and the IOC the second dealing with  Ethernet communications. 
 

12.5.1. Modbus communications indicator 
The yellow communications status LED on the top of the IOC module will reflect traffic on the IOC Modbus port.  
As such this will see the periodic status exchanges from the interface board (about 2 per second) as well as 
external network traffic.  Note that this status exchange does not start until the power up initialisation is 
complete.  In particular, with DHCP enabled if the server does not respond (or the network is not connected), 
this led will remain off after an initial exchange has completed. 
 

12.5.2. Ethernet communications indicators 
Two LED’s located on the RJ45 network connector that is mounted on the IOC termination unit have following 
uses: 
• The yellow LED indicates receive activity.  It will flash for ALL network activity on the local link – not just traffic 

addressed to the 2500 Ethernet IOC. 
• The green LED indicates transmit activity.  This will only flash when the 2500 Ethernet IOC is replying to 

received requests addressed to the instrument. 
Those parameters are in Operator → COMMS list 
 

Name Description Range Status 

 NetStat1 Ethernet Status: Diagnostic parameter   

 IPChanged IP Parameter Changed: Shows a fleeting (1) while the 
Ethernet interface registers the change in IP 
parameter 

  

 

12.6. NETWORK WATCHDOG 
The Network Watchdog is triggered by external communications traffic that is addressed to the instrument only.  
 
• If the preferred master is configured, only data addressed to the 2500 Ethernet IOC from that IP address 

will reset the watchdog. 
• If the preferred master is not configured, any data addressed to the 2500 Ethernet IOC from the network 

will reset the watchdog. 
 
See section 6.3.1 for further details. 
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13. Chapter 13    Calibration 
13.1. OVERVIEW 
Analogue Input and Output modules are factory calibrated for life on every channel and on every range so as to 
meet quoted specifications.  On occasion there may be good reason to alter this standard behaviour; either to 
compensate for some specific loop or sensor characteristic, or simply to extract maximum accuracy by 
eliminating residual transducer, wiring and measurement errors. 
 
To support such corrections on analogue I/O channels the 2500 offers several levels of "user calibration": 
• Simple Cal Offset correction (input channels); 

• User Calibration, a two-point gain and offset correction (input channels); 

• Reference Calibration, for extremely accurate electrical performance (all channels). 

These are not to be confused with the Factory Calibration, which can always be restored from EEPROM memory 
in the I/O module.  Note that there are other ways to alter channel behaviour - for example, by using the Custom 
Linearisation feature of input channels.  It is also possible to use combinations of all these methods, but the 
simplest solution is always advised. 
 
The Simple Offset is available in any run mode without restriction.  User Calibration can only be changed in 
'Config' mode and with the UserPW set.  Similarly, Reference Calibration requires the password RefPW.  Refer to 
Chapter 6 (OPERATOR) for more information about passwords. 
 
Simple Offset and User Calibration corrections directly alter input channel reported PVs.  The corrections are 
applied after linearisation (important if using TC mode or square-root linearisations).  The full Reference 
Calibration is applied to the electrical interface (MeasV), thus before linearisation (AI modules) or altering the 
actual output (AO modules). 
  
Note that all user-calibrations would require validation and possibly re-calibration if the module (or the 
connected transducer) is changed.  This is not the case with Factory Calibration. 
 

13.2. SIMPLE OFFSET 
Offset correction may be used for any system where there is a systematic measurement or control offset term.  
Less obvious, perhaps, is that an offset may also be sufficient to correct complex errors in any system where the 
input (process monitoring) channel will operate over a very narrow working range.  
 

Simple Offset correction is available on all AI2, AI3 and AI4 channels in both 'Run' mode and 'Config' mode.  No 
password is required.  
 

To carry out offset correction simply change the channel parameter 'Offset', with the required value as a floating 
point number in engineering units.  The value is in the same units as the PV, applied directly and instantly. 
‘Offset’ is found in IO → Module’nn’ → C1 (to 4). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13-1:   Offset directly affects PV 

Uncorrected PV 

Working Range 

Corrected PV 

Simple 
Offset 
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13.2.1. To Perform Offset Calibration  
In iTools navigate to the appropriate channel list, double-click the 'Offset' parameter and enter the correction 
factor: 
 

 
 

Figure 13-2:   Offset parameter  in the IO Channel List  

The IOL, IOH, VALL and VALH limits still apply to the uncorrected channel behaviour; note that the offset of -1.0 
in the above example modifies the PV without problems, despite the VALL limit of 0.000. 
 

13.3. USER CALIBRATION 
Sometimes the simple offset correction is not sufficient for an application - particularly when any compensation 
requires changes through the working range.  If  the "error" (as seen in the PV reported for an input channel) can 
be modelled with a gain term and an offset term we can use the AI2, AI3 and AI4 "user cal" facility to impose a 
straight-line correction. 
This type of correction is defined by two PV offsets, ‘OfsetL’& ‘OfsetH’, applied at two PV points, ‘PointL’ & 
‘PointH’.  This can be shown graphically as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13-3:   Mapping Calculated PV to 'User Cal' PV 

Here the uncorrected PV working range characteristic is shown by the solid line between the working range PV 
values ‘PointL’ and ‘PointH’ (it is best practice to use these extremes for the reference points).  The dotted line 
shows the corrected PV when the shown ‘OfsetL’ (in this example a negative value) and ‘OfsetH’ (here positive) 
have been defined, and UCAL set. 
 

Note that this correction is applied after any linearisation.  This (for example) corrects the temperature reading 
when using a TC range.  
 

The correction is enabled by setting the 'UCAL' parameter to 'USEr (1), normal operation is restored by 
changing UCAL to 'FAct (0)'.  All these parameter should be visible and alterable only when the password 
'UserPW' is set and the 2500 put into 'Config' mode. 

  To find a parameter press the ‘Find’ tab located at the bottom of the browser section in iTools. 

  

Uncompensated PV 

Corrected PV 

OfsetH 

OfsetL 

PointH PointL 
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13.3.1. To Perform User Calibration  
1. Select ‘UserPW’ in Operator → PASSWD.  Enter the password (factory default 12). 

2. Navigate to the appropriate channel list  

3. Double-click the ‘PointL’ parameter and enter the value at which the low offset is to be applied 

4. Double click the ‘OfsetL’ parameter and enter the low offset value 

5. Repeat 3. and 4. to apply a high offset 

6. Set ‘UCAL’ to ‘USER’ 

 
 

Figure 13-4:   'User Cal' Parameter List 

 
 If the correct password has been entered the parameters UCAL, PointL, PointH, OfsetL and OfsetH are 

available as shown by the background changing from grey to white. 

 These parameters default to 0.00000. 

 The parameter values are in engineering units, the same units as the PV.  Corrections are applied 
directly and instantly when 'UCAL' is set to 'USEr (1)'.  

 The IOL, IOH, VALL and VALH limits still apply to the uncorrected channel behaviour.  The simple offset 
parameter is still effective, and is applied AFTER user calibration corrections. 
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13.4. REFERENCE CALIBRATION 
Reference calibration is particularly useful for eliminating residual system errors.  It is another 2-point (straight 
line) method, but rather than altering the PV it directly changes the electrical signal conversion at the terminals.  
This calibration is used for small corrections - for example, to compensate for a known error in a characterised 
thermocouple.  Note that all the calibration points are pre-defined, and large deviations (trying to force large 
corrections) are prohibited. 
 

Partial calibration is quite acceptable.  In the factory the AI2, for example, is calibrated at 16 points.  Most 
applications use a single fixed range, so it would be wasted effort to calibrate anything other than the channel 
and 'Channel Type' used. 
 

Factory Calibration can always be restored - see 13.4.3. below. 
 

It is essential that the calibration procedure follows good practice, using accurate and traceable standards, 
allowing sufficient warm-up and settling times.  Reference Calibration should not be performed if the system 
suffers from external noise interference, PSU problems or large swings in ambient temperature.  Calibration 
cannot compensate for interference noise, non-linearity or temperature effects on the modules. 
 

As any change to calibrated I/O modules (as for a service exchange, for example) will affect performance, it is 
suggested that any system calibrated modules are clearly labelled, particularly where accuracy is critical.  
 

Before calibration you must set the password 'RefPW' in the Operator Password list, and you will need to set 
iTools to show more parameters and list options than usual.  From the 'Options' menu select 'Parameter 
Availability Settings' and get the Parameter Availability dialogue: 
 

 
 

Figure 13-5:   Parameter Availability Settings 

 
Make sure the check-box ‘Parameter Value Selections Restricted...’ is not ticked. 
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13.4.1. Analogue Input Calibration Procedure 
Each module supports several 'Channel Types' - for mA, V, resistance and so on.  Each such channel type can be 
calibrated at two points.  
To perform the calibration at any one point a very accurate known signal (or resistor, for the resistance range) is 
connected to the input terminals.  The 'Calibration State' parameter is then changed to start the calibration 
process; the 2500 samples the connected signal many times. Internal calculations are executed to normalise the 
measured data to match exactly the predefined expected value.  This compensates for internal errors - for 
example, offset, gain, and lead resistance. 
 

The table below identifies the input values required for each module and channel type: 

Module Channel Type LOW Input HIGH Input 

AI2 / AI4 mV(3) 20.000mV 80.000mV 

AI2 V(5) 2.0000V 8.0000V 

AI2 Ohms(7) 200.00Ω 400.00Ω 

AI2 HiOhms(8) 1200.0Ω 4800.0Ω 

AI3 mA(4) 4.000mA 16.000mA 
 

 
Table 13-1:   Analogue Input Calibration Points 

Note: For resistance calibration, connect the reference using 4-wire connection. 
 

 

Note that the AI2 Ohms, HiOhms and V ranges can only be calibrated in a -DC terminal unit. Do NOT try to 
recalibrate channel 1 Ohms range if any channel of the module is to be used for TC applications; any change 
will upset the cold-junction measurement apparatus.  
The AI4 must be calibrated as an AI2. Force the Requested ID parameter to AI2(64): 

 
 

Figure 13-6:   AI4 Working as an AI2 for Calibration 

The AI4 must not be recalibrated on the V, or Ohms 'Channel Types'.  
 

The password 'RefPW' must be set and the 2500 in 'Config' mode. 
 

To calibrate, use iTools to navigate to the channel to be calibrated. 
In iTools set the channel ‘TYPE’, as appropriate.  Connect the reference source ( 

1. Table 13-1, above) to the appropriate channel input. 

2. Set the parameter ‘Calibration State’ Cal_st to 'CalLo (3)'.  Set and make sure the input is at the LOW value 
specified in the table. Change Cal_st to ‘Go (7)’ 

3. Cal_st will change to ‘Busy (9)’ for about 30 seconds, then change to ‘Idle (2)’ or ‘Done (0)’ - that step has 
been completed. 

4. Set Cal_st to 'CalHI (4)'.  Set and make sure the input is the HIGH value (from the table). Change Cal_st to 
‘Go (7)’ 

5. Cal_st will change to ‘Busy (9)’ for about 30 seconds and then change to ‘Idle (2)’ or ‘Done (0)’ - channel 
calibration has been completed. 

6. Finally set ‘Calibration State’ to ‘FSave (10)’.  The calibration constants will be saved and ‘Calibration State’ 
will revert to ‘Idle (2)’. 
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13.4.2. Analogue Output Calibration Procedure 
To calibrate an output channel on any particular range, the user must accurately verify two predefined output 
values.  At each point the user has the option of entering a correction to force the output to the desired value.  
This is an iterative process at each point. 
 

The AO2 supports just two 'Channel Types' with the TYPE parameter: 'mA (O)' (current output) and 'V (O)' 
(voltage output).  The table below identifies the reference points for each channel type. 
 

Channel Type LOW Output HIGH Output 

V(30) 1.000V 9.000V 

mA(31) 2.000mA 18.000mA 

 
Table 13-2:   Analogue Output Calibration Points 

The password 'RefPW' must be set and the 2500 in 'Config' mode, with iTools Parameter Value Selections 
unrestricted to show all parameter options.  
 

  Calibration tip: a calibration step value of 100 should affect the V output by about 35mV, and current 
output by about 75uA.  The step size is affected only slightly by gain tolerances.  If the changes appear to 
be non-linear there may be a hardware problem or a channel loading problem. 

 

With iTools, navigate to the channel to be calibrated; if iTools has been correctly set up the channel list will show 
two extra parameters, 'AO Calibration Lo Trim' and 'AO Calibration Hi Trim'. To calibrate: 
1. Set the channel 'TYPE', as appropriate.  Set the monitor equipment (DVM) on an appropriate range (20mA 

or 10V), and connect to the  relevant channel output terminals. 

2. Set Cal_st to 'CalLo (3)'.  The DVM should display something near the LOW cal value, as described in Table 
13-2, above. 

3. If the output is in error, double-click the 'AO Calibration Lo Trim' parameter and alter the parameter value 
to increase or decrease the output.  See the hint above for step size.  Keep changing 'AO Calibration Lo 
Trim' until the output is correct. 

4. Set 'Calibration State' to 'CalHi(4)'.  

5. If the output disagrees with the value in Table 13-2, double-click the 'AO Calibration Hi Trim' parameter 
and alter the parameter value to increase or decrease the output.  Keep changing the trim value until the 
output is exactly as required.  

6. Finally, set 'Calibration State' to 'FSave(10)'.  The calibration constants will be saved and 'Calibration State' 
will revert to 'Idle(2)'. 

 

13.4.3. Restore Factory Calibration 
Factory calibration may be restored at any time for any individual I/O channel.  The procedure is similar to the 
reference calibration described above.  To perform the restoration the 2500 must be in 'Config' mode, 
Parameter Value Selections must be unrestricted to display all options, and the Reference Calibration Password 
parameter 'RefPW' correctly set.  No other equipment is required. 
Use iTools to navigate to the parameter list of the channel to be restored.  Double-click the parameter 
'Calibration State' (Cal_st) and select 'Restor (5)'.  

 
 

Figure 13-7:   Cal_st list: 'Restor' 

When you "OK" this selection ‘Cal_st’ will then change to 'Done (0)', and after a brief pause return to 'Idle (2)'. 
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14. Appendix A  SPECIFICATION 
 

A1  INSTALLATION CATEGORY AND POLLUTION DEGREE 

This product has been designed to conform to BS EN61010 installation category II and pollution degree 2.  
These are defined as follows: 
INSTALLATION CATEGORY II 
The rated impulse voltage for equipment on nominal 230V ac mains is 2500V. 
POLLUTION DEGREE 2 
Normally, only non-conductive pollution occurs.  Occasionally, however, a temporary conductivity caused by 
condensation shall be expected. 
 

A2  GENERAL SPECIFICATION 

Physical 
Base unit dimensions    0 module:  35mm wide x 180 mm high x 132 mm deep (1.4in x 7.1in x 5.2in) 
       2 module  86mm wide x 180mm high x 132mm deep (3.4in x 7.1in x 5.2in) 
       4 module:  137mm wide x 180mm high x 132mm deep (5.3in x 7.1in x 5.2in) 
       8 module:  239mm wide x 180 mm high x 132 mm deep (10.8in x 7.1in x 5.2in) 
       10 module: 289mm wide x 180mm high x 132mm deep (11.4 in x 7.1 in x 5.2 in) 
       12 module: 340mm wide x 180mm high x 132mm deep (13.4in x 7.1in x 5.2in) 
       16 module: 442mm wide x 180 mm high x 132 mm deep (18.8in x 7.1in x 5.2in) 
Base Unit fixing centres   0 module:  Not applicable 
for panel mounting    2 module:  47mm (1.8in) 
       4 module:  97mm (3.8in) 
       8 module:  198mm (7.8in) 

10 module: 249mm (9.8in) 
12 module: 300mm (11.8in) 

       16 module: 401mm (15.8in) 
 

Weight 
2-way:  No modules - 0.3kg (0.7 lb).  Including all modules - 0.7kg (1.5 lb) max. 
4-way:  No modules – 0.4kg (0.9 lb).  Including all modules - 1.2kg (2.6 lb) max. 
8-way:  No modules - 0.7 kg (1.5 lb).  Including all modules - 2.0 kg (4.4 lb) max. 
10-way:   No modules - 0.8 kg (1.8 lb).  Including all modules - 2.4 kg (5.3 lb) max. 
12-way:   No modules - 1.0 kg (2.2 lb).  Including all modules - 2.8 kg (6.2 lb) max. 
16-way:  No modules - 1.3 kg (2.9 lb).    Including all modules - 3.6 kg (7.9 lb) max. 

Electrical 
Safety earth connections   Earth terminal strip at lower front flange of base unit 
Supply voltage     24V dc (±20%) 
Supply power (max.)    82 Watts (16 module base) 
Surge current (max.)    8 Amps 
Back-up supplies    3.3V ± 5% to source 10µA max. 
 

Environmental  
Temperature  Storage:  -20 to +85°C 
    Operation: 0 to + 55°C 
Humidity  Storage/Operation: 5 to 95% RH (dewpoint 50°C) (See graph) 
Atmosphere     Non-corrosive, non-explosive. 
Altitude (max.)     2000m 
Environmental protection Panel: BS EN60529:IP20 
RFI   EMC emissions:  BS EN61326-1:2006 Class A 
   EMC immunity:  BS EN61326-1 :2006 Industrial locations 
Electrical Safety Specification  BS EN61010-1: 2001 (see section ‘A1’, above); UL61010 
Vibration / shock    To BS EN61131-2 (9 to 150Hz @ 0.5g; 1 octave per minute). 
    Impact withstand BS EN61010 (Corner drop test 100mm) 
Packaging      BS EN61131-2  
     Free fall: BS EN60068-2-32, proc. 1 (five x 1 metre drops for each of six faces). 
Flammability of plastic materials UL746 UL V0 
RoHS compliance    EU; China 
 

Approvals 
       CE; cUL (UL61010); GOST 
 

  

If the supply voltage falls below 19.2V dc 
during start up, the instrument can enter 
a continous cycle of attempted re-starts. 

Maximum RH with dewpoint of 50OC 

Temperature 
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Ethernet Communications 
    Connectors: One RJ45 connector on the Terminal unit 

One RJ11 EIA232 configuration port on the Ethernet IOC module. 
   Network medium: Ethernet Category 5 cables. 
   Protocols:   Modbus-TCP RTU slave. 
     Speed: 10 Mbps. 
   Network Topology: Star connection to a hub. 
   Line length (max):  100 metres, extendable by repeater. 
 Allocation of IP address:  Manual, DHCP. 
    Isolation:  50V dc; 30V ac. (IEEE 802.3) 
 

Modbus Communications 
    Connectors: Parallel pair of RJ45 connectors on the Terminal unit.  
       One RJ11 EIA232 configuration port on the Modbus IOC module 
   Network medium: EIA485, link selectable as 3-wire or 5-wire. 
    Protocols:  MODBUS/JBUS RTU slave. 
    Isolation:  None. 

Profibus Communications 
    Connectors: Parallel pair of RJ45 connectors on the Terminal unit.  
       Or 9-pin D-Type connector on Termianl unit.  This is dependent on Terminal unit supplied. 
       One RJ11 EIA232 configuration port on the Profibus IOC module 

Devicenet Communications 
    Connectors: 5-way Devicenet screw connector on the Terminal unit.  
       One RJ11 EIA232 configuration port on the Devicenet IOC module 
 

A3  IOC SPECIFICATION 

A3.1 TERMINAL UNIT 

Physical 
Dimensions (approx.)  26 mm wide x 125 mm high 
 

Switches – 8 swich segments 
 Modbus:    Switches 1 to 32 Instrument Address, P – Parity On/Off, O – Parity Odd/Even 
 Profibus:    Switches 1 to 64 Instrument Address 
 Devicenet    Switches 1 to 32 Instrument Address, Baud rate set by remaining two segments 
 Ethernet    Switches 1 to 32 Instrument Address, D – DHCP enable/disable 
Links LK1 and LK2    

Modbus    Link pins 1 and 2 for three-wire communications;  link pins 2 and 3 for five-wire  (Figure 2-6) 
 Profibus    Link pins 1 and 2 to terminate the Profibus network; link pins 2 and 3 for no termination (Figure 2-9) 
  

User Connectors 
 Supply power   One x four-way terminal block for supply power.  Supplies separately monitored by the IOC modules. 
   

A3.2  IOC MODULE 

A3.2.1  Hardware 
General 
Dimensions    25 mm wide x 90 mm high x 81mm deep 
 

LED Indicators 
 Green – normal operation 
S Yellow – Standby mode 
C Yellow- Configuration mode 
 

 Yellow – IO network or configuration port communicating 
X Red- failure of non-volatile RAM checksum, Custom linearisation checksum, I/O network watchdog, invalid base 

size detected, module missing, faulty or wrong type, power on self test failed. 

 
Note: sections 2.4 and 2.5 give details of all IOC LEDs  
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A4  I/O MODULE SPECIFICATIONS 

A4.1  AI2 MODULE 

Note: Sensor Break Protection is controlled using an associated AI_UIO block. 

General specification, common to all variants 
Power consumption      2W max. 
Common mode rejection (47 to 63Hz)  >120dB 
Series mode rejection (47 to 63Hz)   >60dB 
Isolation  Channel to channel:   300V RMS or dc (basic insulation). 
     to system:   300V RMS or dc (double insulation). 
Max voltage across any channel    10.3V dc 
 

A4.1.1  Thermocouple input variant 

mV inputs, Thermocouple inputs 
Input range       -150mV to + 150mV 
Input impedance      >100MΩ (sensor break detect circuit ‘Off’) 
Input leakage current     <100nA (sensor break detect circuit ‘Off’) 
Calibration accuracy      ± 0.1% of measured value ± 10µV 
Noise        <28µV p-p with filter off:  <4µV p-p with 1.6s filter (better with longer time constants). 
Resolution        Better than 2µV with 1.6 second filter 
Linearity        Better than 5µV 
Temperature coefficient     <40ppm of reading per °C 
Sensor break protection     Switchable as ‘High’, ‘low’ or ‘Off’.  Sensor current: 125nA 
 

Cold Junction 
    Temperature range:  -10° C to +70° C 
     CJ Rejection:  >30:1 
     CJ accuracy:  ±0.5°C typical (±1.0°C max.) 
     Sensor type  Pt100 RTD, located beneath the input connector 
 

High impedance input (channel two only) 
Input range       0.0V to 1.8V 
Input impedance      >100MΩ (sensor break detect circuit ‘Off’) 
Input leakage current     <100nA (sensor break detect circuit ‘Off’) 
Calibration accuracy      ± 0.1% of measured value ± 20µV 
Noise        <100µV p-p with filter off:  <15µV p-p with 1.6s filter (better with longer time constants). 
Resolution        Better than 7µV with 1.6 second filter 
Linearity        Better than 50µV 
Temperature coefficient     <40ppm of reading per °C 
 

A4.1.2  DC input variant 
mV inputs 
Input range       -150mV to +150mV 
Input impedance      >100MΩ (sensor break detect circuit ‘Off’) 
Input leakage current     <100nA (sensor break detect circuit ‘Off’) 
Calibration accuracy      ± 0.1% of measured value ± 10µV 
Noise        <28µV p-p with filter off:  <4µV p-p with 1.6s filter (better with longer time constants). 
Resolution        Better than 2µV with 1.6 second filter 
Linearity        Better than 5µV 
Temperature coefficient     <40ppm of reading per °C 
Sensor break protection     Switchable as ‘High’, ‘low’ or ‘Off’.  Sensor current: 125nA 
 

High impedance input (channel two only) 
Input range       0.0V to 1.8V 
Input impedance      >100MΩ (sensor break detect circuit ‘Off’) 
Input leakage current     <100nA (sensor break detect circuit ‘Off’) 
Calibration accuracy      ± 0.1% of measured value ± 20µV 
Noise        <100µV p-p with filter off:  <15µV p-p with 1.6s filter (better with longer time constants). 
Resolution        Better than 7µV with 1.6 second filter 
Linearity        Better than 50µV 
Temperature coefficient     <40ppm of reading per °C 
 

Voltage inputs 
Input range       -10.3V to + 10.3V 
Input impedance      303kΩ 
Calibration accuracy      ± 0.1% of measured value ± 2mV 
Noise        <2mV p-p with filter off:  <0.4mV p-p with 1.6s filter (better with longer time constants). 
Resolution        Better than 0.2mV with 1.6 second filter 
Linearity        Better than 0.7mV 
Temperature coefficient     <40ppm of reading per °C 
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A4.1    AI2 MODULE (Cont.) 

A4.1.2  DC INPUTS (CONT.) 

Resistance inputs 
Input range 0Ω to 640Ω (includes support for 2-, 3- or 4-wire RTD connection) 
Calibration accuracy  ± 0.1% of measured value 
Noise <0.05Ω p-p with 1.6s filter (better with longer time constants). 
Resolution  Better than 0.02Ω with 1.6 second filter 
Linearity  Better than 0.05Ω 
Temperature coefficient <30ppm of reading per °C 

High Resistance input 
Input range 0 to 7kΩ 
Calibration accuracy  ± 0.1% of measured value 
Noise <0.5Ω p-p with 1.6s filter (better with longer time constants). 
Resolution  Better than 0.2Ω with 1.6 second filter 
Linearity  Better than 0.1Ω 
Temperature coefficient <30ppm of reading per °C 

Potentiometer inputs 
Input range 0 to 100% rotation 
End-to-end resistance 100Ω (min.) to 7kΩ (max.) 
Calibration accuracy  ± 0.1% of measured value 
Noise <0.01% p-p with 1.6s filter (5kΩ pot.); <0.3% p-p with 1.6s filter (100Ω pot.) 
Resolution  Better than 0.001% with 1.6 second filter and 5kΩ pot. 
Linearity  Better than 0.01% 
Temperature coefficient <20ppm of reading per °C 

A4.1.3 mA input variant 
4 to 20 mA loop inputs 
Input range 
Calibration accuracy  
Noise 
Resolution  
Linearity  
Temperature coefficient  

-25mA to + 25mA with 5Ω burden resistor in terminal unit.  
± 0.25% of measured value plus ±2µA max offset. 
<1µA p-p with 1.6s filter (better with longer time constants) 
Better than 0.5µA with 1.6 second filter 
Better than 1µA. 
<50ppm of reading per °C 

A4.2  AI3 MODULE 

Notes:  
1. The number of AI3 modules must be restricted such that the total, steady-state power consumption for all the 
modules in a base unit does not exceed 24 Watts for the eight module base or 48 Watts for the 16 module base. 
2. Sensor Break Protection is controlled using an associated AI_UIO block. 

General specification 
Power consumption  Current i/p: 2.2W 

Three powered loops: 4W max.  
Common mode rejection (47 to 63 Hz) >120dB  
Series mode rejection (47 to 63 Hz)  >60dB 
Isolation Channel to channel: 50V RMS or dc (basic insulation). 

to system:  300V RMS or dc (double insulation). 

Hart Compliance 
Cutting printed circuit links (one per channel) on the underside of the terminal unit places  250Ω 
resistors in the input circuits within the AI3 module (section 7.7.7.).  

Channel inputs 
Input range -28mA to + 28mA 
Calibration accuracy  ± 0.1% of measured value 
Noise <1µA p-p with 1.6s filter (better with longer time constants) 
Resolution  Better than 0.5µA with 1.6 second filter 
Linearity  Better than 1µA 
Temperature coefficient <50ppm of reading per °C 
Burden resistor  60Ω nominal; 50mA maximum current 
Channel PSU  20V to 25V 

PSU protection:  30mA (nom) current trip, auto resetting. 
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A4.3  AI4 MODULE 

Note: Sensor Break Protection is controlled using an associated AI_UIO block. Channels 1 and 3 support sensor break 
actions ‘Up’, ‘Down’ and ‘None’; channels 2 and 4 support ‘Up’ only. 

General specification (applies to all AI4 variants) 
Power consumption  2W max. 
Common mode rejection (47 to 63 Hz) >120dB  
Series mode rejection (47 to 63 Hz)  >60dB 
Isolation Channel 1 to channel 2: No isolation 

Channel 3 to channel 4:  No isolation 
Ch1 or Ch2 to Ch3 or Ch4: 300V RMS or dc (basic insulation). 
to system:  300V RMS or dc (double isolation). 

Max. voltage across any channel 5V dc 

A4.3.1  Thermocouple input variant 
Thermocouple inputs 
Input range -150mV to + 150mV 
Input impedance >20MΩ (sensor break detect circuit ‘Off’) 
Input leakage current <125nA (sensor break detect circuit ‘Off’) 
Calibration accuracy  ± 0.1% of measured value ± 10µV 
Noise <28µV p-p with filter off; <6µV p-p with 1.6s filter (better with longer time constants). 
Resolution  Better than 2µV with 1.6 second filter 
Linearity  Better than 5µV 
Temperature coefficient <40ppm of reading per °C 
Sensor break protection Fixed pull-up.  Sensor current: 125nA 
Cold Junction 

Temperature range: -10°C to +70°C 
CJ Rejection:  >30:1 
CJ accuracy:  ±0.5°C typical (±1°C maximum) 
Sensor type Pt100 RTD, located beneath the input connector 

A4.3.2  mV input variant 
Thermocouple inputs 
Input range -150mV to + 150mV 
Input impedance >20MΩ (sensor break detect circuit ‘Off’) 
Input leakage current <125nA (sensor break detect circuit ‘Off’) 
Calibration accuracy  ± 0.1% of measured value ± 10µV 
Noise <28µV p-p with filter off; <6µV p-p with 1.6s filter (better with longer time constants). 
Resolution  Better than 2µV with 1.6 second filter 
Linearity  Better than 5µV 
Temperature coefficient <40ppm of reading per °C 

A4.3.3  mA input variant 
Input range 
Calibration accuracy  
Noise 
Resolution  
Linearity  
Temperature coefficient  
Burden Resistor  

-25mA to +25mA 
± 0.25% of measured value plus ±2µA max offset. 
<1µA p-p with 1.6s filter (better with longer time constants) 
Better than 0.5µA with 1.6 second filter 
Better than 1µA. 
<50ppm of reading per °C 
5Ω ± 1% (fitted to terminal unit) 

A4.4  AO2 MODULE 

General specification 
Power consumption  2.2W  max. 
Isolation  Channel to channel: 300V RMS or dc (basic insulation). 

to system:  300V RMS or dc (double insulation). 

Current outputs 
Output range  -0.1 to +20.5mA 
Load limits 0 to 500Ω 
Calibration accuracy Better than ±0.1% of reading 
Linearity  0.03% range (0.7µA) 
Resolution  Better than 1 part in 10000 (1µA typical) 

Voltage outputs 
Output load limits 

-0.1 to 10.1V range:  550Ω min. 
-0.3V to +10.3V range: 1500Ω min. 

Calibration accuracy Better than 0.1% of reading 
Linearity  0.03% range (0.3mV) 
Resolution  Better than 1 part in 10000 (0.5mV typical) 
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A4.5  DI4 MODULE  

Note:  Inputs must be either all logic inputs (link ‘V+’ and ‘C’ terminals together) or all contact inputs (apply 24V supply 
across ‘V+’ and ‘C’ terminals). 

General specification 
Power consumption      0.5W   max. 
Isolation   Channel to channel:  Channels share ‘common’ (‘C’) connections. 
    to system:    300V RMS or dc (double insulation). 
Voltage supply       24±6V dc external supply required for contact inputs. 
Minimum pulse width     10ms, or de-bounce value whichever is longer. 
Debounce time       0ms to 2.55s (as configured by the user). 
Max. voltage across any channel   30V dc. 

Logic inputs (see note above) 
Off (logic 0) voltage      -5V to +5V dc 
On (logic 1) voltage      10.8V to 30V dc 
Input current       2.5mA approx. at 10.5V; 10mA max. at 30V. 

Contact inputs (see note above) 
Off (0) resistance      >7kΩ 
On (1) resistance      <1kΩ 
Wetting current       >8mA. 
Wetting voltage      >9V (12V typical measured open circuit) 
 

A4.6  DI6 MODULE  

Note:   
1. This module is ordered either as a 115V version or as a 230V version.  One type cannot be converted into the 
other. 
2. Each input is fitted with a 470pF capacitor for EMC purposes.  This causes an earth leakage current of 
approximately 0.04 mA at 115Vac 60Hz or 0.08 mA 230Vac 60Hz  

General specification 
Power consumption      0.5W max. 
Detectable pulse width     Three mains cycles 
Isolation   Channel to system:  300V RMS or dc (Double insulation) 
    Channel to channel:  300V RMS or dc (Basic insulation) 
 

A4.6.1  115V ac input variant 
115V inputs 
Off (logic 0) voltage      0 to 35V ac. 
On (logic 1) voltage      95V to 150V ac 
Input current     Maximum:  8mA at 150V RMS 
      Minimum:  2mA 
Max voltage across any channel    150V RMS 
 

A4.6.2  230V ac input variant 
230V inputs 
Off (logic 0) voltage      0 to 70V ac. 
On (logic 1) voltage      180V to 264V ac 
Input current     Maximum:  9mA at 264V RMS 
      Minimum:  2mA. 
Max voltage across any channel    264V RMS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The result of applying RMS voltages 
between 35V and 95V is not defined 

The result of applying RMS voltages 
between 70V and 180V is not defined 

mA 

Off Undefined 

Voltage/current curves for 230V module 

V AC 

On 

V AC 

mA 

Voltage/current curves for 115V module 

Off Undefined 

On 
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A4.7  DI8 MODULE  

Note:  This module is ordered either as a ‘logic’ version or as a ‘contact closure’ version.  One type cannot be 
converted into the other. 

General specification 
Power consumption    Contact i/p: 1.9W max. 
       Logic i/p:  0.6W max. 
Isolation      Ch1 to Ch 2 : Channels share ‘common’ (‘1C2’) connection. 
       Ch3 to Ch 4 : Channels share ‘common’ (‘3C4’) connection. 
       Ch5 to Ch 6 : Channels share ‘common’ (‘5C6’) connection. 
       Ch7 to Ch 8 : Channels share ‘common’ (‘7C8’) connection. 
     Ch1/2 to other channels: 50V RMS or dc (Basic insulation). 
     Ch3/4 to other channels: 50V RMS or dc (Basic insulation). 
     Ch5/6 to other channels: 50V RMS or dc (Basic insulation). 
     Ch7/8 to other channels: 50V RMS or dc (Basic insulation). 
       to system:  300V RMS or dc (Double insulation). 
Minimum pulse width      5ms (Task 1), or 10ms (Task 3), or de-bounce value whichever is longer. 
Debounce time        0ms to 2.55s (as configured by the user). 
Max. voltage across any channel    30V dc 
 

A4.7.1  Logic input variant 
Logic inputs (see note above) 
Off (logic 0) voltage       -5V to +5V dc 
On (logic 1) voltage       10.8V to 30V dc 
Input current        2.5mA approx. at 10.5V; 8mA max. at 30V. 
 

A4.7.2  Contact closure input variant 
Contact inputs (see note above) 
Off (0) resistance       >7kΩ 
On (1) resistance       <1kΩ 
Wetting current        4mA typical 

 

 

A4.8  DO4 

General specification 
Power consumption       0.5W max. 
Isolation    Channel to channel:  Channels share ‘common’ (‘C’) connections. 
       to system:  300V RMS or dc (Double insulation). 

Logic outputs 
Voltage supply (VCS)       24±6Vdc. 
Logic 1 o/p voltage       (Vcs - 3)V for a 5mA load. 
Logic 0 o/p voltage       <1Vdc 
Logic 1 o/p current       8mA per channel (current limited) 
Off state leakage       <0.1mA 

 
Voltage outputs 
Voltage supply (VCS)       12V to 30Vdc. 
Logic 1 o/p voltage       (Vcs - 3)V for a 5mA load. 
Logic 0 o/p voltage       <1Vdc 
Logic 1 o/p current       100mA per channel (current and temperature limited) 

 

 
 
 
  

The result of applying voltages 
between +5V and +10.8V is not 
defined 

The result of applying contact 
resistances between 1kΩ and 7kΩ is 
not defined 
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A4.9  RLY4 MODULE  

Note:  Snubber circuits (22nF+100Ω) are fitted internally to this module.  They may be removed as described in 
Appendix C.  Leakage across the snubber at 240V ac 60Hz = appox. 2mA 

General specification 
Power consumption      1.1W max. 
Isolation   Channel to channel:  300V RMS or dc (Basic insulation). 
    Channel to system:  300V RMS or dc (Double insulation). 
Contact life (resistive load)  240Vac, 2A: >6x105 operations  
      240Vac, 1A: >107 operations  
Contact life (inductive load)  As per derating curves 
Mechanical life       >3x107  operations 

Relay specification 
Contact material      AgCdO 
Maximum current rating     2A at up to 240V ac; 0.5A at 200Vdc, increasing to 2A at 50V dc (resistive)  
Minimum current rating     100mA at 12V  

 
Contact format 
    Channels 1 to 3:  Common and normally open contacts.  (Open circuit with relay not energised) 

Channel 4: Common, normally open and normally closed contacts.  Common and normally closed contacts 
are short circuit with relay not energised 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

F1 = Measured results 
F2 = Typical values 

Life = Resistive life x reduction factor 
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AC inductive load derating curves 

Power factor (cos ϕ) DC Volts 

DC inductive load breaking capacity 
derating curves 
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15. Appendix B   The Ordering Codes 
Base Units 

 Base 
Size 

 Earthing 
System 

 Manuals  

      

2500B 2 3 4 
    

 

2 Base Size  

S02 Single IOC base, 2 module positions  

S04 Single IOC base, 4 module positions  

S08 Single IOC base, 8 module positions  

S10 Single IOC base, 10 module positions  

S12 Single IOC base, 12 module positions  

S16 Single IOC base, 16 module positions  

   

3 Earthing system  

NONE Two earth clamps fitted  

C02 Earthing Clamp for a 2 module base  

C04 Earthing Clamp for a 4 module base  

C08 Earthing Clamp for a 8 module base  

C10 Earthing Clamp for a 10 module base  

C12 Earthing Clamp for a 12 module base  

C16 Earthing Clamp for a 16 module base  

   

4 Manuals  

ENG English Manuals  

FRA French Manuals  

GER German Manuals  

XXX No Manuals  
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IOC 
 

 Redundancy  Function  Comms  Config Key  

       

2500E 2 3 4 5 
     

 

2 Redundancy Features  

S Remote IO acquisition  

 

3 Functions  

ACQIO Remote IO acquisition  

SYSIO Remote IO acquisition (55msec scan)  

UW Toolkit Block + acquisition functions  

4LOOP Four local PID blocks + acquisition  

4LOOPUW Four local PID blocks + Toolkit & acquisition  

8LOOP Eight local PID Blocks + acquisition     

8LOOPUW Eight local PID Blocks + Toolkit & acquisition   

 

4 Communications  

MODBUS Modbus communications  

DEVICENET DeviceNet communications  

PROFIBUS Profibus DP communications  

PBUS DPv1 Eurotherm 'E' Suite communications. (Profibus DPv1)  

ENET MBUS Ethernet Modbus TCP communications  

 

5 Start Up key  

NONE No Start up Key supplied  

CFGKEY RJ11 Start up Key - Forces IOC to Start In configuration  mode after a power 
cycle 
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Modules 

 Module 
Type 

 Voltage 
rating  

DI6 only 

  

     
2500M 2 3 

   

 

2 Module Type  
AI2UNIV Dual channel i- solated universal analogue input module  

AI3 Three channel isolated 4-20mA analogue input module + 3 x isolated 
24v Tx PSU 

 

AI4UNIV Four channel - non isolated T/C, mV, mA input module  

AO2 Dual channel isolated analogue output module mA, volts  

DI424V Dual channel - isolated universal analogue input module  

DI6HVAC Six channel High voltage Logic input  

DI8logic Octal channel - non isolated Digital Input (Logic Inputs only)  

DI8contact Octal channel - non isolated Digital Input (Contact Inputs only)  

DO4LOGIC Quad digital output module Logic output 10mA max  

DO424V Quad digital output module 24d switched output  

RLY4 Dual channel isolated analogue output module mA, volts  

 

3 Power supply – DI424V and DO424V only  

EXTPWR External Power required  

   

3 Voltage rating DI6 only  

230v 230 volt ac. logic input  

115v 115 volt ac. logic input  
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IOC termination units 
 

 Comms  
Protocol 

 Comms  
Connect

or 

 
     

2500T/ 
IOC/S 

4 5 

   

 

4 Communications Protocol  

MODBUS ModBus Communications  

DEVICENET DeviceNet Communications  

PROFIBUS ProfiBus or PbusDPv1 Communications  

ENET MBUS Ethernet / Modbus TCP  

5 Communications Connector Type   

RJ45 RJ45 connector for ProfiBus or ModBus  

9Dtype 9 pin D connector for ProfiBus   

DN Standard DeviceNet screw connector  

EN Standard EtherNet terminal unit  

  

 

Module termination units 
 

 Module 
Type 

 Voltage  Fuse / 
Disconne

ct 

 
      

2500T 2 3 4 
    

 

2 & 3 Termination Type  

AI2 / TC Two channel isolated TC with CJC  

AI2 / DC Two channel isolated mV  

AI3 / UNIV For 3 ch. isolated 4-20mA analogue input module   

AI4 / TC Terminal unit for 4 ch. isolated TC with CJC  

AI4 / mV Terminal unit for 4  ch. isolated mV  

AI4 / mA Terminal unit for 4 ch. isolated mA   

AO2 / UNIV Terminal unit for Dual  Analogue Output   

DI4 / UNIV Terminal unit for Quad Digital Input module  

DI6 / UNIV Terminal unit for 6 ch. mains isolated digital input module  

DI8 / UNIV Terminal unit for 8 ch. digital input module  

DO4 / UNIV Dual channel isolated analogue output module mA, volts  

RLY4 Dual channel isolated analogue output module mA, volts  

 

4 Volts mA option AI2 / DC only  

NONE For PT100,.Hiz inputs  

SHUNT 5 ohm shunt fitted for mA inputs  

 

4 Fuse / Disconnect Type  

NONE Dummy cover fitted  

DCONNECT Disconnects  

 

4 Fuse / Disconnect Type  

NO FUSE Dummy cover fitted  

FUSE2A 4 off 3.15A fuses  

 

188                                                                                                                                                            Part No HA027115  Issue 5  Feb -14 



2500 Controller  Engineering Handbook 

2500A - Accessories items 
 

 Type    CABLE 
only 

 
      

2500A 2 3 4 
    

 

2 Type  

CABLE Communications cable  

CFGPSU 24vdc Power supply for use with configuration lead  

TERM Terminator for end of RS 485 multi-dropped link.  

CFGKEY RJ11 start up key - Forces IOC to start in Configuration 
mode after Power cycle 

 

BLANK Blank Terminal Unit  

   

3 Options with Cable only  

CONFIG Used for configuration of 2500C 
Termination for 2500C is RJ11 
Termination for PC is 9 PIN D RS232 

 

MODBUS Modbus screened cable (Base to base multi-drop 
connection). RJ45 to RJ45 connection 

 

   

3 Options with CFGPSU only  

NONE No mains lead supplied  

UKLEAD UK 5A Mains lead   

   

3 Options with TERM only  

MODBUS Terminator for Modbus link - RJ45 only  

PROFIBUS Terminator for Profibus DP link  - RJ45 only  

   

4,5 & 6 Options with Cable ModBus or ProfiBus only  

RJ45/RJ45/
0M5 

0.5m long  

RJ45/RJ45
3M0 

3.0 metres long  

 
2500P - Power Supplies 
 

 Rating  Manuals  

     

2500P 2 3 
   

        

2 Rating   

1A3 30 watt, 1.3 amp supply  

2A5 60 watt, 2.5 amp supply  

5A0 120 watt, 5.0 amp supply  

10A 240 watt, 10.0 amp supply  

   

3 Manuals  

ENG English Manuals  

FRA French Manuals  

GER German Manuals  

XXX No Manuals  
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Composite Ordering Codes 
 
 Base 

Size 
 Earthing 

System 
 Function  Comms 

Protocol 
 Comms 

Connector 
 Application  

         
2500 2 3 4 5 6 7 

       
 

 I/O Slots - Module and Termination 
fill in 

 Configurati
on Tools 

 

   

8  9 ----------------- 22  23 24 
    

 

1   

2500 Product Code  

   

2 Base size  

S02 2 module positions  

S04 4 module positions  

S08 8 module positions  

S10 10 module positions  

S12 12 module positions  

S16 16 module positions  

   

3 Earthing system  

NONE Two earth clamps fitted  

C02 Earthing Clamp for a 2 module base  

C04 Earthing Clamp for a 4 module base  

C08 Earthing Clamp for a 8 module base  

C10 Earthing Clamp for a 10 module base  

C12 Earthing Clamp for a 12 module base  

C16 Earthing Clamp for a 16 module base  

   

4 Function  

ACQIO Remote IO acquisition  

SYSIO Remote IO acquisition (55msec scan)  

UW Toolkit Block + acquisition functions  

4LOOP Four PID blocks + acquisition  

4LOOPUW Four PID blocks + Toolkit & acquisition  

8LOOP Eight PID Blocks + acquisition   

8LOOPUW Eight PID Blocks + Toolkit & acquisition   

   

5 Communications Protocol  

MODBUS Modbus Communications  

DEVICENET Devicenet Communications  

PROFIBUS Profibus Communications  

PBUS DPv1 Profibus DPv1 Communications  

ENET MBUS Ethernet Modbus TCP communications  

   

6 Communications Connector Type   

RJ45 RJ45 connector for Modbus or Profibus  

9Dtype 9 pin D connector for Profibus   

DN Standard Devicenet screw connector  

EN Ethernet terminal unit   
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7 Application  

NONE No Application loaded  

YYYXXX Pre-configured application loaded  

8 to 23 Module & Terminations  

AI2-TC 2 ch. - isolated universal analogue input module with CJC  

AI2-DC 2 ch. - isolated universal analogue input module For PT100,.Hiz inputs  

AI2-MA 2 ch. - isolated universal analogue input module - 5 ohm shunt fitted for mA inputs  

AI3 3 ch. - isolated 4-20mA analogue input module with 24v Tx PSU  

AI3-DT 3 ch. - isolated 4-20mA analogue input module with 24v Tx PSU - Disconnects  

AI4-TC 4 ch. - non isolated T/C, with CJC  

AI4-MV 4 ch. - non isolated mV input module  

AI4-MA 4 ch. - non isolated mA input module  

   

AO2 2 ch. - isolated analogue output module mA, volts  

AO2-DT 2 ch. - isolated analogue output module mA, volts with Disconnects  

   

DI424 4 ch. - digital input module  

DI424-DT 4 ch. - digital input module with Disconnects  

DI6-230V 6 ch. - 230 volt ac. logic input  

DI6-115V 6 ch. - 115 volt ac. logic input  

DI8L 8 ch. - non isolated Digital Input (Logic Inputs only)  

DI8C 8 ch. - non isolated Digital Input (Contact Inputs only)  

   

DO4L 4 ch. - digital output module Logic output 10mA max  

DO4L-DT 4 ch. - digital output module Logic output 10mA max with Disconnects  

DO424 4 ch. - digital output module 24 volt dc switched output  

DO424-DT 4 ch. - digital output module 24 volt dc switched output  with Disconnects  

RLY4 4 ch. - isolated relay output module  Rated 2A ac  

RLY4-FUSE 4 ch. - isolated relay output module Rated 2A ac, with 4 off 3.15A fuses  

   

BLANK Blank Terminal unit  

NONE No terminal unit or blank fitted  

   

24 Configuration Tools  

NONE CD including  Manuals and latest version of iTools - No iTools product key  

iTools CD including Manuals, iTools & STD  iTools product key and 2500 configuration cable  
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16. Appendix C   To Remove Snubber Circuits From The Relay 
Module 

Each relay is fitted with a ‘snubber’ (22nF + 100Ω) wired across the contacts.  The snubbers are used to prolong 
contact life and to suppress interference particularly when switching inductive loads such as mechanical 
contactors and solenoid valves. 
Snubbers pass a small current typically 1.0mA at 110V 60Hz and 1.7mA at 240V 50Hz, which may be sufficient to 
hold in high impedance loads as, for example, found in some relay coils.   
If this is found to be the case, the snubber can be removed by cutting all or any one of the snubber resistors 
from the printed circuit board. 
 
The procedure below may be followed 
 
1. Remove the rear cover from the module: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure C-1:   Removing the Rear Cover from the Relay Module 

1. Open the module retaining lever 
 
2. Gently ease the rear cover out of the module 

by inserting a small screwdriver in the slots ← 
at the top and bottom of the cover 

 

 
3. Gently ease the rear cover over the module 

retaining catch.  It may be necessary to use the 
screwdriver in positions ↑ to gently lever the 
cover over the catch. 

← 

← 

↑ 

↑ 
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2. Remove the printed circuit board from module case as follows: 
 
1. Invert the module and support it securely on a bench or 

table top 
 
2. Squeeze the sides of the module so that the edge of the 

module bows outwards 
 
3. Very carefully insert a screwdriver into the slot in the edge 

of the module. 
 
Take care that the screwdriver does not slip which may cause 
injury 
 
4. Gently ease the PCB out of module case. 
 
5. Using a suitable pair of wire cutters, snip out and remove 

the 100Ω resistor to remove the required snubber circuit. 
 
 

Figure C-2:   Removing the Case from the Relay Module 

 
3. Remove the snubber resistors 
 
6. Record the removal of the snubber resistor on the side of the module in the place provided.  This will 

provide easy identification of which snubbers have been removed in the event that the module needs to be 
replaced. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure C-3:   Removing Snubbers from the Relay Module PCB 

 
 

  

 

100Ω 

100Ω 

100Ω 

100Ω 

22n 

22n 

22n 

22n 

Relay 1 

Relay 2 

Relay 3 

Relay 4 

To connector block 

R = 100Ω 
C = 22n 

SN4 

SN1 

SN3 
 

SN2 
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17. Appendix D   Glossary of Terms 
Clone/Cloning Cloning allows the configuration and parameter settings from one instrument to be copied to another 

of the same type.  It allows new or spare instruments to be rapidly set up from a standard source. 

Config Short for configuration or configuration mode 

Config Mode A security level in the 2500 in which Configuration Mode Parameters are made alterable 

Configuration 1. The operation and inter-action of the 2500 functional elements 

2. The act of defining the operation and inter-action of the 2500 functional elements by means of 
selecting parameters and adjusting parameter values 

Config Mode 
Parameters 

A subset of the configuration parameters which can only be altered in Config Mode. 

NB c.f. configuration parameters 

Configuration 
Parameter 

A parameter which defines part of the Configuration of the 2500 

NB c.f. config mode parameters 

Configuration Port A comms port intended for configuration of the 2500 

CJC Cold Junction Compensation 

Series 2000 or 240x Eurotherm Controls instrument range.  240x refers particularly to the 2400 range. 

DIN Deutsche Industrie Normand 

EM Electro-magnetic, as in EMC   ~ Compliance 

Enumeration(s) Some parameters offer a list of options, each assigned an arbitrary integer value for discrimination. 

In iTools meaningful enumeration text is displayed, with the enumeration value shown in brackets. 

The enumeration value is the data that would be read or written over any communications link for that 
parameter. 

On/Off control The control output switches on when the setpoint is above process variable and off when the setpoint 
is below 

Hysteresis The difference between the on and off points normally applied to an output relay.  Used to prevent 
relay ‘chatter’. 

I/O Input or Output; general term for the plant interface to the 2500. 

ICP Industrial Control Package.  This is a combination of the T2900 and 2500 DIN rail controller 

IOBase The complete mechanical 2500 assembly - DIN rail mount, base etc. 

IOBus Internal controller to I/O module interface 

IOC Input/output controller (the 2500 central processor module). 

I/O Module A 2500 plug-in module dedicated to plant Input or Output. 

ION Internal low-level input/output network 

Parameter In the 2500 'Parameters' are all the variables associated with blocks, channels, loops and so on, stored 
in a database at specific addresses. 

Parameterised Made accessible as a parameter 

PID Proportional + Integral + Derivative.  Also called three term control 

Program Provide a list of general instructions to define operation 

Programmable Able to be programmed 

PSU Power Supply Unit 

PRT or RTD Abbreviation for Platinum Resistance Thermometer or Resistance Temperature Detector 

SE  Strategy Engine (generic), or specific: the ISE (industrial) and PSE (process) 

Snubber A resistor and capacitor in series, connected across relay contacts, used to prolong contact life and 
reduce interference 

SSR Solid State Relay 

TBD. To be defined 

TC or T/C Abbreviation for thermocouple 

Time proportioning The control output (digital) switches with a variable on to off time 

TU(s) Terminal Units; provide the plant side wiring connections for I/O. 
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18. Index 
Parameter Index – By Mnemonic 

Mnemonic Description Function Block Section 
AbPwrL Absolute Low Power Limit Output 4.8.2 

Ack Instrument Alarm Acknowledge System 6.3.1 

Ack Status Alarm Acknowledge Analogue Input 7.7.8 

Ack Status Alarm Acknowledge Analogue Output 7.8.1 

Ack Status Alarm Acknowledge Digital Input 7.9.5 

Ack Status Alarm Acknowledge Digital output control 7.10.4 

Ack_1 Alarm 1 acknowledge Alarm 5.7.1 

AckAll Global Alarm Acknowledge System 6.3.1 

AckIP Global Alarm Ack Input System 6.3.1 

AckSrc Global Alarm Ack Input Source System 6.3.1 

Act Control Action. Key Configuration 4.3.1 

ActID Actual Module Type Module Block 6.7 

ActIM Actual operating mode of the IOC System 6.3.1 

ActLP Active Loop Override 4.11.2 

ActSrc Active loop source Override 4.11.2 

Adc Manual Reset Auto Calc Enable PID 4.4.6 

AddHi Address High Limit Profibus Digital Communications 6.2.1 

AddLo Address Low Limit Profibus Digital Communications 6.2.1 

Addr Address Digital Communications 6.2.1 

AL_1 Alarm 1 Type Alarm 5.7.1 

AL_1 Alarm 1 Type User Alarm - Digital 5.8.2 

AlmOP Totaliser Alarm Output Totalisers 8.8.1 

AlmSP Totaliser Alarm Setpoint Totalisers 8.8.1 

AlmSW Alarm Status Word Alarm 5.7.1 

AlmSW Instrument Alarm Status Word System 6.3.1 

AlmSW Summary of alarm status Module Block 6.7 

AnVal The current analogue value selected form 
AnVal1 to AnVal3 

Gain Scheduling 4.5.1 

AP Atmospheric Pressure Humidity 8.11.2 

ApName Application Name  System 6.3.1 

APSrc Atmospheric Pressure Source Humidity 8.11.2 

ApVers Application Version System 6.3.1 

bAct Valve Backlash Time Valve Control 4.8.4 

BaseSz Base Size System 6.3.1 

Baud Baud Rate Digital Communications 6.2.1 

BaudHi Comms Baud Rate High Limit Profibus Digital Communications 6.2.1 

BaudLo Comms Baud Rate Low Limit Profibus Digital Communications 6.2.1 

Bloc Instrument Alarm Blocking System 6.3.1 

Bloc Status Alarm Blocking Analogue Input 7.7.8 

Bloc Status Alarm Blocking Digital Input 7.9.5 

Bloc Status Alarm Blocking Digital output control 7.10.4 

Bloc Status Alarm Blocking  Analogue Output 7.8.1 

bLoc_1 Alarm 1 blocking Alarm 5.7.1 

bmrt Minimum recovery time after purging Zirconia 8.12.2 

BoolCV Output Value Digital block 8.3.2 

bort Maximum recovery time after purging Zirconia 8.12.2 

bot Zirconia Probe Cleaning Time Zirconia 8.12.2 

bound1 Boundary change 1/2 Gain Scheduling 4.5.1 

bound2 Boundary change 2/3 Gain Scheduling 4.5.1 

boVLV Zirconia Clean Valve Output Zirconia 8.12.2 

Cal TrH AO Calibration Hi Trim (Counts) Analogue Input 7.7.8 
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Mnemonic Description Function Block Section 
Cal TrL AO Calibration Lo Trim (Counts) Analogue Input 7.7.8 

Cal_st Calibration State Analogue Input 7.7.8 

CalPot Pot Input Calibration Enable Valve Control 4.8.4 

CasM Cascade Mode Cascade 4.10.5 

CC Company ID System Descriptions 6.7 

Ch1OP Ch1 Output. Output 4.8.2 

Ch2OP Ch2 Output. Output 4.8.2 

ChAlSW Channel Alarm Status Word Module Block 6.7 

ChnSel Channel select for alarm A I/O Alarm 5.9.1 

ChStat Status Analogue Output 7.8.1 

ChStat Status Digital Input 7.9.5 

ChStat Status. Analogue Input 7.7.8 

ChTpHi High Limit  for Channel Type Analogue Input 7.7.8 

ChTpLo Low Limit  for Channel Type Analogue Input 7.7.8 

CJC_Tp CJC Type Analogue Input 7.7.8 

CJtemp CJC Temperature Analogue Input 7.7.8 

ClinFl Custom Linearisation Failure System 6.3.1 

Clk Clock Counter 8.7.1 

ClkSrc Clock Source Counter 8.7.1 

ClnPrb Zirconia Clean Probe IP Zirconia 8.12.2 

ClnSrc Zirconia Clean Probe IP Source Zirconia 8.12.2 

ClStHL Calibration State High Limit Analogue Input 7.7.8 

ClStLL Calibration State Low Limit Analogue Input 7.7.8 

ColdSt Cold Start Flag System 6.3.1 

COOL Cooling Type Key Configuration 4.3.2 

cOrr Wet Bulb Temperature Correction Humidity 8.11.2 

Count Count Counter 8.7.1 

COv Clear Overflow Counter 8.7.1 

COvSrc Clear Overflow Source Counter 8.7.1 

Ctime Control Task Duration in Ticks Diagnostics 6.6.1 

Ctrl Control Type Key Configuration 4.3.1 

CtSbyAct Control Action in Standby Loop Overview 4.2.1 

CTStat CascadeTuning State Autotune 4.13.1 

CustabN1 Custom Table 1 Name System 6.3.1 

CustabN2 Custom Table 2 Name System 6.3.1 

CustabN3 Custom Table 3 Name System 6.3.1 

CVStat Status Analogue block 8.2.2 

CVStat Status Digital block 8.3.2 

cYct Zirconia Probe Cleaning Interval Zirconia 8.12.2 

Debnce Debounced Digital Input 7.9.5 

Debnce Debounced Digital Input 7.11.5 

Debump Debump Flag PID 4.4.6 

dEcP Decimal Places in Disp/Comms. Key Configuration 4.3.2 

DefRPW Reference Calibration Password Password set up 6.5.1 

DefUPW User Calibration Password Configuration Password set up 6.5.1 

dELy Delay Digital Communications 6.2.1 

DewPnt Wet/Dry Temperature Dew Point Humidity 8.11.2 

DHCPen MAC Address 4 Ethernat Digital Communications 6.2.1 

Dir Direction Counter 8.7.1 

DisCas Disable Cascade Cascade 4.10.5 

DisSrc Disable Cascade Source Cascade 4.10.5 

Dry Dry Bulb Temperature value Humidity 8.11.2 

DrySrc Dry Bulb Temperature source Humidity 8.11.2 
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Mnemonic Description Function Block Section 
Dst1 point to point wire destination Wires 8.10.1 

dtyP Derivative Type Key Configuration 4.3.2 

Elapse Timer elapsed time Timer 8.6.5 

Emiss Emissivity Analogue Input 7.7.8 

En Enable Counter 8.7.1 

EnSrc Enable Source Counter 8.7.1 

F1 Feature1: Indirect Modbus Address System Descriptions 6.7 

F1_1 Address of Read Only Indirection Table System Descriptions 6.7 

F1_2 Address of Read/Write Indirection Table System Descriptions 6.7 

F1_3 Not Used System Descriptions 6.7 

F2 Feature2:  Modbus Word Ordering System Descriptions 6.7 

F2_1 High order word in low reg. addr System Descriptions 6.7 

F2_2 Not Used System Descriptions 6.7 

F2_3 Not Used System Descriptions 6.7 

F3 Feature3: Modbus Function Codes System Descriptions 6.7 

F3_1 FCs 3;4;6;7;8 and 16 supported System Descriptions 6.7 

F3_2 FCs 17-19 NOT supported System Descriptions 6.7 

F3_3 FCs 70 and 71 supported System Descriptions 6.7 

F4 Feature4: Analog Value Formats System Descriptions 6.7 

F4_1 16 bit scaled & IEEE & 32 bit int System Descriptions 6.7 

F4_2 Not Used System Descriptions 6.7 

F4_3 Not Used System Descriptions 6.7 

F5 Feature5: Ethernet Parameters System Descriptions 6.7 

F5_1 Supported Ethernet parameters System Descriptions 6.7 

F5_2 Ethernet Base Address System Descriptions 6.7 

F5_3 Not Used System Descriptions 6.7 

FallBk Fall Back Value Analogue block 8.2.2 

FallBk Fall Back Value Digital block 8.3.2 

FF Remote Feedforward PID 4.4.6 

FF_SP Cascade Feedforward Value Cascade 4.10.5 

FF_Src Cascade Feedforward Value Source Cascade 4.10.5 

FFdv SP and PV feed forward defines range of 
PID trim contribution 

PID 4.4.6 

FFPb Proportion of feed forward fed directly to 
the output 

PID 4.4.6 

FFSrc Modbus address of parameter used as 
the remote feed forward 

PID 4.4.6 

FFtr Fixed offset value added to the 
feedforward signal 

PID 4.4.6 

FiltTm Filter Time Analogue Input 7.7.8 

FitA Feature Identifier Table Address System Descriptions 6.7 

FLAGs Flags - special case comms Digital Communications 6.2.1 

FltAct Fault Action Analogue Input 7.7.8 

FltAct OP Standby Action Analogue Output 7.8.1 

FltAct OP Standby Action Digital output control 7.10.4 

FOP Force Manual Output Mode. Key Configuration 4.3.2 

FOP Forced Output Level Output 4.8.2 

Frz Freeze Control Flag Value PID 4.4.6 

FrzSrc Modbus address of parameter used as 
the freeze control flag 

PID 4.4.6 

Fwdt Feedforward Type Key Configuration 4.3.2 

Gateway1 Gateway 1 Ethernet Digital Communications 6.2.1 

Gateway2 Gateway 2 Ethernet Digital Communications 6.2.1 

Gateway3 Gateway 3 Ethernet Digital Communications 6.2.1 

Gateway4 Gateway 4 Ethernet Digital Communications 6.2.1 
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Mnemonic Description Function Block Section 
GHd Global SRL Hold Flag System 6.3.1 

GHdSrc Global SRL Hold Flag Source System 6.3.1 

GrpAck Group Acknowledge Alarm 5.7.1 

GSSync Trigger All Ramps System 6.3.1 

Hb SP Rate Limit Holdback Value Remote Setpoint 4.6.1.3 

Hbkdis Holdback Disable  Rate Limit and Holdback 4.6.1.1 

Hbty holdback strategy for setpoint ramps Rate Limit and Holdback 4.6.1.1 

Hcb Cutback high PID 4.4.6 

H-CO Gas Reference Zirconia 8.12.2 

HiLim Output High Limit Analogue block 8.2.2 

Hld Hold Totalisers 8.8.1 

HldSrc Totaliser Hold Source Totalisers 8.8.1 

HY_1 Alarm 1 hysteresis Alarm 5.7.1 

hYS1 Hysteresis 1 Output 4.8.2 

hYS2 Hysteresis 2 Output 4.8.2 

I_Hold Integral Hold Flag PID 4.4.6 

Ih1 Alarm 1 inhibit Alarm 5.7.1 

Ih1Src Alarm 1 inhibit source Alarm 5.7.1 

I-HSrc Modbus address of the flag used to hold 
the Integral value 

PID 4.4.6 

II Instrument Identity System 6.3.1 

II Product ID System Descriptions 6.7 

IM Instrument Operating Mode System 6.3.1 

Inhibt Instrument Alarm Inhibit System 6.3.1 

Inhibt Status Alarm Inhibit Analogue Input 7.7.8 

Inhibt Status Alarm Inhibit Analogue Output 7.8.1 

Inhibt Status Alarm Inhibit Digital Input 7.9.5 

Inhibt Status Alarm Inhibit Digital output control 7.10.4 

InhSrc Instrument Alarm Inhibit Source System 6.3.1 

InhSrc Status Alarm Inhibit Source Analogue Input 7.7.8 

InhSrc Status Alarm Inhibit Source Analogue Output 7.8.1 

InhSrc Status Alarm Inhibit Source Digital Input 7.9.5 

InhSrc Status Alarm Inhibit Source  Digital output control 7.10.4 

InstSt Instrument Status System 6.3.1 

Int Valve Inertia Time Valve Control 4.8.4 

InvMsk Invert Inputs Mask Digital block 8.3.2 

IOFail I/O Fail Strategy System 6.3.1 

IOH Electrical High Analogue Input 7.7.8 

IOH Electrical High Analogue Output 7.8.1 

IOH Electrical High Digital output control 7.10.4 

IOL Electrical Low Analogue Input 7.7.8 

IOL Electrical Low Analogue Output 7.8.1 

IOL Electrical Low Digital output control 7.10.4 

IONrec IO Network Recovery Time System 6.3.1 

IONwdg I/O Network Watchdog Timeout System 6.3.1 

IOstat Global IO Status System 6.3.1 

IP Totaliser Monitored Parameter Value Totalisers 8.8.1 

IP_Src Timer Input Wire Timer 8.6.5 

IP_Val Trigger/Gate Input Timer 8.6.5 

IPaddr1 IP Address 1 Ethernet Digital Communications 6.2.1 

IPaddr2 IP Address 2 Ethernet Digital Communications 6.2.1 

IPaddr3 IP Address 3 Ethernet Digital Communications 6.2.1 

IPaddr4 IP Address 4 Ethernet Digital Communications 6.2.1 

IPChanged IP Changed Ethernet Digital Communications 6.2.1 
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Mnemonic Description Function Block Section 
IPSrc Totaliser Monitored Parameter Value 

Source 
Totalisers 8.8.1 

IS Instrument Operating State System 6.3.1 

Lb_t Loop Break Time PID 4.4.6 

Lcb Cutbacl low PID 4.4.6 

Lead_R RTD lead resistance Analogue Input 7.7.8 

LeadPV Lead PV   Ratio 4.9.2 

LeaSrc Lead PV source Ratio 4.9.2 

LinTyp Linearisation Type Analogue Input 7.7.8 

LocalAddres Local Modbus Address Ethernet Digital Communications 6.2.1 

LocH Local Setpoint Trim High Limit Remote Setpoint 4.6.1.3 

LocL Local Setpoint Trim Low Limit Remote Setpoint 4.6.1.3 

Loct Local Setpoint Trim Remote Setpoint 4.6.1.3 

LoLim Output Low Limit Analogue block 8.2.2 

LowThr Totaliser Low Threshold Totalisers 8.8.1 

LPBrk Loop Break Status Flag PID 4.4.6 

LpType Loop Type Key Configuration 4.3.1 

L-r Remote Setpoint Enable Remote Setpoint 4.6.1.2 

L-rSrc Remote Setpoint Enable Source Remote Setpoint 4.6.1.2 

Ltch Instrument Alarm Latching System 6.3.1 

Ltch Status Alarm Latching Analogue Input 7.7.8 

Ltch Status Alarm Latching Analogue Output 7.8.1 

Ltch Status Alarm Latching Digital Input 7.9.5 

Ltch Status Alarm Latching Digital output control 7.10.4 

Ltch_1 Alarm 1 latching Alarm 5.7.1 

LveCnf Enable IO Config in Operator mode System 6.3.1 

m-A Auto/Manual Select. Loop Overview 4.2.1 

MACaddr1 MAC Address 1 Ethernat Digital Communications 6.2.1 

MACaddr2 MAC Address 2 Ethernat Digital Communications 6.2.1 

MACaddr3 MAC Address 3 Ethernat Digital Communications 6.2.1 

Mask Instrument Alarm Bit Mask System 6.3.1 

Mask Status Alarm Bit Mask Analogue Input 7.7.8 

Mask Status Alarm Bit Mask Analogue Output 7.8.1 

Mask Status Alarm Bit Mask Digital Input 7.9.5 

Mask Status Alarm Bit Mask Digital output control 7.10.4 

m-Asrc Auto/Manual Select Source Loop Overview 4.2.1 

MaxCT Maximum Control Task Duration Diagnostics 6.6.1 

MaxDsp For diagnostic use only PID 4.4.6 

MaxST Maximum Sample Time System 6.3.1 

MeasV Electrical Value Analogue Output 7.8.1 

MeasV Electrical Value Digital output control 7.10.4 

MeasV Electrical Value (V/A/R) Analogue Input 7.7.8 

MeasV Electrical Value (V/A/R) Digital Input 7.9.5 

MFB Master Feedback Value Cascade 4.10.5 

MinDsp For diagnostic use only PID 4.4.6 

MinT Zirconia Minimum Calculation 
Temperature 

Zirconia 8.12.2 

MnPlsT Minimum Pulse Time Digital Input 7.9.5 

MnPlsT Minimum Pulse Time Digital output control 7.10.4 

MnPosn For diagnostic use only PID 4.4.6 

ModVer Module Version Module Block 6.7 

mPt Minimum Pulse Time Valve Control 4.8.4 

MRatio Measured Ratio Ratio 4.9.2 

mTr Manual Track Setpoint Configuration 4.7.2 
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Mnemonic Description Function Block Section 
mV Zirconia Probe mV IP Zirconia 8.12.2 

mVSrc Zirconia Probe mV Input Source Zirconia 8.12.2 

MxTDTI For diagnostic use only PID 4.4.6 

NetStat Network Status Ethernet Digital Communications 6.2.1 

nFID Number of Feature Identifiers System Descriptions 6.7 

nindRO Read Only Modbus indirect table size System Descriptions 6.7 

nindRW Read/Write Modbus indirect table size System Descriptions 6.7 

nSets Number of PID sets to Use Gain Scheduling 4.5.1 

NVFail Non-Volatile Memory Failure System 6.3.1 

NwdAct I/O Network Watchdog Timeout System 6.3.1 

Nwdged I/O Network Watchdog Flag System 6.3.1 

NwRmRt Next Slave Instrument Ramp Rate Remote Setpoint 4.6.1.3 

NwTrSP Next Slave Instrument Target Setpoint Remote Setpoint 4.6.1.3 

O2_Un Oxygen Exponent Zirconia 8.12.2 

OFFS Zirconia mV Offset Zirconia 8.12.2 

Offset Simple Cal Offset (Eng) Analogue Input 7.7.8 

OfsetH User Cal Offset High (Eng) Analogue Input 7.7.8 

OfsetL User Cal Offset Low (Eng) Analogue Input 7.7.8 

On1&2(6) ON/OFF Key Configuration 4.3.1 

OnOff (1) ON/OFF control Key Configuration 4.3.1 

OnOffI On/ Off Input Digital Input 7.11.5 

OnOffO On/ Off Output Digital output control 7.11.6 

ont1 Ch1 Output Minimum On Time Output 4.8.2 

ont2 Ch2 Output Minimum On Time Output 4.8.2 

OnVPB(8) ON/OFF Key Configuration 4.3.1 

OnVPU(7) ON/OFF Key Configuration 4.3.1 

o-oOP On Off Control Output. Loop Overview 4.2.1 

OP Instrument Alarm Output System 6.3.1 

OP Status Alarm Output Analogue Input 7.7.8 

OP Status Alarm Output Analogue Output 7.8.1 

OP Status Alarm Output Digital Input 7.9.5 

OP Status Alarm Output Digital output control 7.10.4 

OP Timer Output Timer 8.6.5 

OP_1 Alarm 1 output state Alarm 5.7.1 

Oper Operator Analogue block 8.2.2 

Oper Operator Digital block 8.3.2 

OPHi High power limit Output 4.8.2 

OPLo Low power limit Output 4.8.2 

OPrr Output Rate Limit Output 4.8.2 

OPrSrc Output Rate Limit Source Output 4.8.2 

ORL Output Rate Limit Enable Output 4.8.2 

ORLSrc Output Rate Limit Enable Source Output 4.8.2 

oSbOP Sensor Break Power Output 4.8.2 

oSbOP Sensor Break Power Output 4.8.2 

Ovflow Overflow Counter 8.7.1 

OvrDis Disable override Override 4.11.2 

OvrSrc Disable override source Override 4.11.2 

OvrTyp Override Type Override 4.11.2 

P1 Alarm 1 Input Value User Alarm - Digital 5.8.2 

P1_Mul Input 1 Scalar Analogue block 8.2.2 

P1_Mul Input 1 Scalar Digital block 8.3.2 

P1_Src Input 1 Source Analogue block 8.2.2 

P1_Src Input 1 Source Digital block 8.3.2 
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P1_Val Input 1 Value Analogue block 8.2.2 

P1_Val Input 1 Value Digital block 8.3.2 

P1A Alarm 1 Input A Value User Alarm - Analogue 5.8.1 

P1ASrc Alarm 1 Input A Source User Alarm - Analogue 5.8.1 

P1B Alarm 1 Input B Value User Alarm - Analogue 5.8.1 

P1BSrc Alarm 1 Input B Source User Alarm - Analogue 5.8.1 

P1Src Alarm 1 Input Source User Alarm - Digital 5.8.2 

P2_Mul Input 2 Scalar Analogue block 8.2.2 

P2_Mul Input 2 Scalar Digital block 8.3.2 

P2_Src Input 2 Source Analogue block 8.2.2 

P2_Src Input 2 Source Digital block 8.3.2 

P2_Val Input 2 Value Analogue block 8.2.2 

P2_Val Input 2 Value Digital block 8.3.2 

PaChgd Parameter Changed Status Word System 6.3.1 

Parity Parity Digital Communications 6.2.1 

PB Proportional Band Units PID 4.4.6 

Pbu Proportional Band Units Key Configuration 4.3.2 

PCode1 Feature Pass Code 1 System Descriptions 6.7 

PCode2 Feature Pass Code 2 System Descriptions 6.7 

Pdtr Manual/Auto Transfer PD Control Key Configuration 4.3.2 

PF Process Factor Zirconia 8.12.2 

PFFSrc Power Feed Forward Source Output 4.8.2 

PFFVal Power Feed Forward Output 4.8.2 

PID (0) PID control Key Configuration 4.3.1 

PID On(5) PID Key Configuration 4.3.1 

PID1&2(4) PID (Heat) Key Configuration 4.3.1 

PidCS Product ID Table Checksum System Descriptions 6.7 

PidSch Scheduling Type Gain Scheduling 4.5.1 

PIDVPB(12) PID Key Configuration 4.3.1 

PIDVPU(11) PID Key Configuration 4.3.1 

PointH User Cal Point High (Eng) Analogue Input 7.7.8 

PointL User Cal Point Low (Eng) Analogue Input 7.7.8 

PotHi Valve Positioner High Limit Valve Control 4.8.4 

PotLo Valve Positioner Low Limit Valve Control 4.8.4 

PPos Pot Position Valve Control 4.8.4 

PPoSrc Pot Position Source Valve Control 4.8.4 

PrbFlt Zirconia Bad Probe Zirconia 8.12.2 

PrefMst1 Preferred Master 1 Ethernet Digital Communications 6.2.1 

PrefMst2 Preferred Master 2 Ethernet Digital Communications 6.2.1 

PrefMst3 Preferred Master 3 Ethernet Digital Communications 6.2.1 

PrefMst4 Preferred Master 4 Ethernet Digital Communications 6.2.1 

Prob Zirconia Burn Off State Zirconia 8.12.2 

Prot Profibus Protocol Digital Communications 6.2.1 

PSY_Cn Psychrometric Constant Humidity 8.11.2 

PSYSrc Psychrometric Constant Source Humidity 8.11.2 

Pulse Pulse Digital Input 7.9.5 

Pulse Pulse Digital Input 7.11.5 

PulsOP Totaliser Pulse Output Totalisers 8.8.1 

PulsSP Totaliser Pulse Setpoint Totalisers 8.8.1 

PV Process Variable. Loop Overview 4.2.1 

PVFrz PV Frozen Zirconia 8.12.2 

PVnVd PV Invalid.   Zirconia 8.12.2 

PVOnSc WSP to PV On Slave Sync Signal Setpoint Configuration 4.7.2 
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PVSrc Process Variable Source Loop Overview 4.2.1 

PwrF Power Feedback Enable Key Configuration 4.3.2 

RAH Ratio Setpoint High Limit Ratio 4.9.2 

RAL Ratio Setpoint Low Limit Ratio 4.9.2 

Rat_SP Ratio Setpoint Ratio 4.9.2 

RatSrc Ratio Setpoint Source Ratio 4.9.2 

RatTrk Ratio Track Mode Ratio 4.9.2 

RatVld Ratio Valid Ratio 4.9.2 

RAType Ratio Type Ratio 4.9.2 

Rcarry Ripple Carry Counter 8.7.1 

RealCV Output Value Analogue block 8.2.2 

RefPW Reference Calibration Password Password Entry 6.4.1 

rel Relative gain Ch1/ch2 PID 4.4.6 

REn Ratio Enable Ratio 4.9.2 

REnSrc Ratio Enable source Ratio 4.9.2 

ReqID Requested Module Type Module Block 6.7 

ReqIM Requested Instrument Mode System 6.3.1 

ReqST Requested Sample Time System 6.3.1 

rES Manual reset PID 4.4.6 

Res Resolution Digital Communications 6.2.1 

Reset Totaliser Reset Totalisers 8.8.1 

ResSrc  Totaliser Reset Source Totalisers 8.8.1 

RH Relative Humidity value Humidity 8.11.2 

RM Remote Scheduling Input Gain Scheduling 4.5.1 

rm_SP Remote Setpoint Remote Setpoint 4.6.1.2 

rm_Src Remote Setpoint Source Remote Setpoint 4.6.1.2 

RmGEn Remote Gas enable Zirconia 8.12.2 

RmH-Co Remote Gas Reference Zirconia 8.12.2 

RmHSrc Remote Gas Reference Source Zirconia 8.12.2 

rmPU Rate Limit Units Setpoint Configuration 4.7.2 

RMSrc Remote Scheduling Input Source Gain Scheduling 4.5.1 

rmt Remote Setpoint Configuration Setpoint Configuration 4.7.2 

rmTr Remote Tracking. Setpoint Configuration 4.7.2 

rnGH/L Process Value High and Low Limits. Key Configuration 4.3.1 

rOH Remote High Power Limit Output 4.8.2 

rOHSrc Remote High Power Limit source Output 4.8.2 

rOL Remote Low Power Limit Output 4.8.2 

rOLSrc Remote Low Power Limit source Output 4.8.2 

Rst Reset Counter 8.7.1 

Rst Src Reset Source Counter 8.7.1 

RtUnit Alarm 4 rate units Alarm 5.7.1 

Run Run Totalisers 8.8.1 

RunSrc Totaliser Run Source Totalisers 8.8.1 

SBDet Sensor Break Bleed Enable Analogue Input 7.7.8 

SbOP Bounded Sensor Break Action Valve Control 4.8.4 

Sbrk Sensor break Humidity 8.11.2 

SbrSt Sensor Break Status Flag Loop Overview 4.2.1 

Sbrt Sensor Break type. Key Configuration 4.3.2 

SEnS Invert Digital Input 7.9.5 

SEnS Invert Digital output control 7.10.4 

SerialNo Instrument Serial Number System Descriptions 6.7 

SET Working PID Set PID 4.4.6 

SETSrc Modbus address of parameter used as 
the working PID set 

PID 4.4.6 
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SISync Trigger New Ramp Remote Setpoint 4.6.1.3 

SlowST Running Slower than Requested Flag System 6.3.1 

SlvHR Slave Loop High Range Cascade 4.10.5 

SlvLR Slave Loop Low Range Cascade 4.10.5 

SootAL Zirconia Probe Sooting Alarm Zirconia 8.12.2 

SOrCt Slowed Down Counter System 6.3.1 

SP Setpoint Ratio 4.9.2 

SP_1 Alarm 1 Setpoint Alarm 5.7.1 

SP_2H Maximum value allowed on SP2 Setpoint 4.6.1 

SP_2L Minimum value allowed on SP2 Setpoint 4.6.1 

SP_H Maximum value allowed on SP1 Setpoint 4.6.1 

SP_L Minimum value allowed on SP1 Setpoint 4.6.1 

SP1/2 Current value of SP1/2 Setpoint 4.6.1 

SP1/2Src Modbus address of the parameter 
supplying the value of SP1/2 

Setpoint 4.6.1 

SPorig Setpiont Origin Loop Overview 4.2.1 

SPrr SP Rate Limit Rate Limit and Holdback 4.6.1.1 

SPrSrc Modbus address of the parameter 
supplying the value of SPrr    

Rate Limit and Holdback 4.6.1.1 

Src1 Point to point wire source Wires 8.10.1 

SRLAct SP Rate Limit Active Status Rate Limit and Holdback 4.6.1.1 

SRLDis SP Rate Limit Disable  Rate Limit and Holdback 4.6.1.1 

SRLHb SP ramp is currently ramping or on hold Rate Limit and Holdback 4.6.1.1 

SRLHd SP Rate Limit Hold Rate Limit and Holdback 4.6.1.1 

SRLStA SP Rate Limit Complete Flag Rate Limit and Holdback 4.6.1.1 

SSEL Internal Setpoint Select Setpoint 4.6.1 

SSESrc Internal SP Select Source Setpoint 4.6.1 

Stat1 Wire Status Wires 8.10.1 

StHld Startup Hold Mode Setpoint Configuration 4.7.2 

STime Current Tune Stage Time Autotune 4.13.1 

STime Sample Time System 6.3.1 

StkHbk Sticky Holdback Status Rate Limit and Holdback 4.6.1.1 

StLR Startup Local/Remote Mode Setpoint Configuration 4.7.2 

StStby Startup in Standby System 6.3.1 

StWSP Startup WSP Mode Setpoint Configuration 4.7.2 

Subnet1 Subnet Mask 1 Ethernet Digital Communications 6.2.1 

Subnet2 Subnet Mask 2 Ethernet Digital Communications 6.2.1 

Subnet3 Subnet Mask 3 Ethernet Digital Communications 6.2.1 

Subnet4 Subnet Mask 4 Ethernet Digital Communications 6.2.1 

Sumary Summary Word Module Block 6.7 

T_OP Target Output Power Loop Overview 4.2.1 

T_OPSrc Process Variable Source Loop Overview 4.2.1 

t2c Time To Next Cleaning Zirconia 8.12.2 

Td Derivative time PID 4.4.6 

TdSrc Derivative Time Source Gain Scheduling 4.5.1 

Tgt Target Counter 8.7.1 

Ti Integral time PID 4.4.6 

Time Timer Time Timer 8.6.5 

TimePr Time proportioning Digital output control 7.11.6 

TiSrc Integral Time Source Gain Scheduling 4.5.1 

titd Integral & Derivative Time Units Key Configuration 4.3.2 

TkEn OP Track Enable Output 4.8.2 

TkEn Output Track Enable Output 4.8.2 

TkESrc OP Track Enable Source Output 4.8.2 
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TkESrc Output Track Enable Source Output 4.8.2 

tm Valve Travel Time Valve Control 4.8.4 

TmpIP Zirconia Probe Temperature Input Zirconia 8.12.2 

TmpSrc Zirconia Probe Temperature Input Source Zirconia 8.12.2 

TnLpNr Tune Loop Number Autotune 4.13.1 

TnOH Auto tune high power limit Autotune 4.13.1 

TnOL Auto tune low power limit Autotune 4.13.1 

TnOP Actual output demand from tuner Autotune 4.13.1 

TnPID Tune PID Number Autotune 4.13.1 

TnStat Tuning State Autotune 4.13.1 

TnWSP Working SP of Current Tune Stage Autotune 4.13.1 

TOFS Zirconia Temperature Offset Zirconia 8.12.2 

Total Totaliser Accumulator Output Totalisers 8.8.1 

TrHi Cascade Feedforward Trim High Limit Cascade 4.10.5 

TrHiSrc Cascade Feedforward Trim High Limit 
source 

Cascade 4.10.5 

Trig Timer Triggered Timer 8.6.5 

Trim Override Loop SP Trim Override 4.11.2 

Trim Ratio Trim Ratio 4.9.2 

TriSrc Override Loop SP Trim source Override 4.11.2 

TriSrc Ratio Trim Source Ratio 4.9.2 

TrkIP Track Input Output 4.8.2 

TrkSrc Track Input Source Output 4.8.2 

TrLo Cascade Feedforward Trim Low Limit Cascade 4.10.5 

TrLoSrc Cascade Feedforward Trim Low Limit 
source 

Cascade 4.10.5 

tSP Target Setpoint. Loop Overview 4.2.1 

TStamp Application Time Stamp System 6.3.1 

tuning Tuning Active Autotune 4.13.1 

TYPE Channel Type Analogue Input 7.7.8 

TYPE Channel Type Analogue Output 7.8.1 

TYPE Channel Type Digital Input 7.9.5 

Type Timer type Timer 8.6.5 

UCAL User Calibration Enable Analogue Input 7.7.8 

Units Instrument Temperature Units System 6.3.1 

UseFBk Enable Fall Back Analogue block 8.2.2 

UserPW User Calibration Password Password Entry 6.4.1 

V_POS Valve Position Loop Overview 4.2.1 

Val Actual value of the channel Analogue Input 7.7.8 

Val Input Channel value Digital Input 7.9.5 

Val Process Value Analogue Output 7.8.1 

Val Process Value Digital output control 7.10.4 

VALH Engineering Value High Analogue Input 7.7.8 

VALH Engineering Value High Analogue Output 7.8.1 

VALH Engineering Value High Digital output control 7.10.4 

VALL Engineering Value Low Analogue Input 7.7.8 

VALL Engineering Value Low Analogue Output 7.8.1 

VALL Engineering Value Low Digital output control 7.10.4 

ValSrc Process Value source Analogue Output 7.8.1 

ValSrc Process Value source Digital output control 7.10.4 

Vbr Boundless Sensor Break Action Valve Control 4.8.4 

VlvLwr Valve Lower Digital output control 7.11.6 

VlvRse Valve Raise Digital output control 7.11.6 

VO Instrument Version Number System Descriptions 6.7 
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VP_OP VP Manual Output Valve Control 4.8.4 

VPB (3) Valve control – bounded Key Configuration 4.3.1 

VPB1&2(15) Valve control – bounded Key Configuration 4.3.1 

VPBOn(10) Valve control – bounded Key Configuration 4.3.1 

VPBVPU(16) Valve control – bounded Key Configuration 4.3.1 

VPU (2) Valve Control - boundless Key Configuration 4.3.1 

VPU1&2(13) Valve Control – boundless Key Configuration 4.3.1 

VPUOn(9) Valve Control – boundless Key Configuration 4.3.1 

VPUVPB(14) Valve Control – boundless Key Configuration 4.3.1 

WEt Wet Bulb Temperature value Humidity 8.11.2 

WEtSrc Wet Bulb Temperature Source Humidity 8.11.2 

WkFFSP Cascade Working Feedforward Value Cascade 4.10.5 

WkH-CO Working Gas Reference Zirconia 8.12.2 

wOP Working Output Loop Overview 4.2.1 

WRatSP Working Ratio SP Ratio 4.9.2 

wSP Working Setpoint. Loop Overview 4.2.1 

WSPHi Maximum value allowed for the working 
setpoint 

Loop Overview 4.2.1 

WSPLo Minimum value allowed for the working 
setpoint 

Loop Overview 4.2.1 

WSPRmp Ramp from WSP Key Configuration 4.3.2 

XFb External (or Remote) OP Feedback. Loop Overview 4.2.1 

XFbSrc External Feedback Source Loop Overview 4.2.1 

XpSrc Proportional Band Source Gain Scheduling 4.5.1 

ZiFn Zirconia Probe Equation Zirconia 8.12.2 

ZirPV Zirconia Control Process Value Zirconia 8.12.2 
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16 bit scaled & IEEE & 32 bit int F4_1 System Descriptions 6.7 

Absolute Low Power Limit AbPwrL Output 4.8.2 

Active Loop ActLP Override 4.11.2 

Active loop source ActSrc Override 4.11.2 

Actual Module Type ActID Module Block 6.7 

Actual operating mode of the IOC ActIM System 6.3.1 

Actual output demand from tuner TnOP Autotune 4.13.1 

Actual value of the channel Val Analogue Input 7.7.8 

Address Addr Digital Communications 6.2.1 

Address High Limit Profibus AddHi Digital Communications 6.2.1 

Address Low Limit Profibus AddLo Digital Communications 6.2.1 

Address of Read Only Indirection Table F1_1 System Descriptions 6.7 

Address of Read/Write Indirection Table F1_2 System Descriptions 6.7 

Alarm 1 acknowledge Ack_1 Alarm 5.7.1 

Alarm 1 blocking bLoc_1 Alarm 5.7.1 

Alarm 1 hysteresis HY_1 Alarm 5.7.1 

Alarm 1 inhibit Ih1 Alarm 5.7.1 

Alarm 1 inhibit source Ih1Src Alarm 5.7.1 

Alarm 1 Input A Source P1ASrc User Alarm - Analogue 5.8.1 

Alarm 1 Input A Value P1A User Alarm - Analogue 5.8.1 

Alarm 1 Input B Source P1BSrc User Alarm - Analogue 5.8.1 

Alarm 1 Input B Value P1B User Alarm - Analogue 5.8.1 

Alarm 1 Input Source P1Src User Alarm - Digital 5.8.2 

Alarm 1 Input Value P1 User Alarm - Digital 5.8.2 

Alarm 1 latching Ltch_1 Alarm 5.7.1 

Alarm 1 output state OP_1 Alarm 5.7.1 

Alarm 1 Setpoint SP_1 Alarm 5.7.1 

Alarm 1 Type AL_1 Alarm 5.7.1 

Alarm 1 Type AL_1 User Alarm - Digital 5.8.2 

Alarm 4 rate units RtUnit Alarm 5.7.1 

Alarm Status Word AlmSW Alarm 5.7.1 

AO Calibration Hi Trim (Counts) Cal TrH Analogue Input 7.7.8 

AO Calibration Lo Trim (Counts) Cal TrL Analogue Input 7.7.8 

Application Name  ApName System 6.3.1 

Application Time Stamp TStamp System 6.3.1 

Application Version ApVers System 6.3.1 

Atmospheric Pressure AP Humidity 8.11.2 

Atmospheric Pressure Source APSrc Humidity 8.11.2 

Auto tune high power limit TnOH Autotune 4.13.1 

Auto tune low power limit TnOL Autotune 4.13.1 

Auto/Manual Select Source m-Asrc Loop Overview 4.2.1 

Auto/Manual Select. m-A Loop Overview 4.2.1 

Base Size BaseSz System 6.3.1 
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Baud Rate Baud Digital Communications 6.2.1 

Boundary change 1/2 bound1 Gain Scheduling 4.5.1 

Boundary change 2/3 bound2 Gain Scheduling 4.5.1 

Bounded Sensor Break Action SbOP Valve Control 4.8.4 

Boundless Sensor Break Action Vbr Valve Control 4.8.4 

Calibration State Cal_st Analogue Input 7.7.8 

Calibration State High Limit ClStHL Analogue Input 7.7.8 

Calibration State Low Limit ClStLL Analogue Input 7.7.8 

Cascade Feedforward Trim High Limit TrHi Cascade 4.10.5 

Cascade Feedforward Trim High Limit source TrHiSrc Cascade 4.10.5 

Cascade Feedforward Trim Low Limit TrLo Cascade 4.10.5 

Cascade Feedforward Trim Low Limit source TrLoSrc Cascade 4.10.5 

Cascade Feedforward Value FF_SP Cascade 4.10.5 

Cascade Feedforward Value Source FF_Src Cascade 4.10.5 

Cascade Mode CasM Cascade 4.10.5 

Cascade Working Feedforward Value WkFFSP Cascade 4.10.5 

CascadeTuning State CTStat Autotune 4.13.1 

Ch1 Output Minimum On Time ont1 Output 4.8.2 

Ch1 Output. Ch1OP Output 4.8.2 

Ch2 Output Minimum On Time ont2 Output 4.8.2 

Ch2 Output. Ch2OP Output 4.8.2 

Channel Alarm Status Word ChAlSW Module Block 6.7 

Channel select for alarm A ChnSel I/O Alarm 5.9.1 

Channel Type TYPE Analogue Input 7.7.8 

Channel Type TYPE Analogue Output 7.8.1 

Channel Type TYPE Digital Input 7.9.5 

CJC Temperature CJtemp Analogue Input 7.7.8 

CJC Type CJC_Tp Analogue Input 7.7.8 

Clear Overflow COv Counter 8.7.1 

Clear Overflow Source COvSrc Counter 8.7.1 

Clock Clk Counter 8.7.1 

Clock Source ClkSrc Counter 8.7.1 

Cold Start Flag ColdSt System 6.3.1 

Comms Baud Rate High Limit Profibus BaudHi Digital Communications 6.2.1 

Comms Baud Rate Low Limit Profibus BaudLo Digital Communications 6.2.1 

Company ID CC System Descriptions 6.7 

Control Action in Standby CtSbyAct Loop Overview 4.2.1 

Control Action. Act Key Configuration 4.3.1 

Control Task Duration in Ticks Ctime Diagnostics 6.6.1 

Control Type Ctrl Key Configuration 4.3.1 

Cooling Type COOL Key Configuration 4.3.2 

Count Count Counter 8.7.1 

Current Tune Stage Time STime Autotune 4.13.1 

Current value of SP1/2 SP1/2 Setpoint 4.6.1 
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Custom Linearisation Failure ClinFl System 6.3.1 

Custom Table 1 Name CustabN1 System 6.3.1 

Custom Table 2 Name CustabN2 System 6.3.1 

Custom Table 3 Name CustabN3 System 6.3.1 

Cutback high Hcb PID 4.4.6 

Cutbacl low Lcb PID 4.4.6 

Debounced Debnce Digital Input 7.9.5 

Debounced Debnce Digital Input 7.11.5 

Debump Flag Debump PID 4.4.6 

Decimal Places in Disp/Comms. dEcP Key Configuration 4.3.2 

Delay dELy Digital Communications 6.2.1 

Derivative time Td PID 4.4.6 

Derivative Time Source TdSrc Gain Scheduling 4.5.1 

Derivative Type dtyP Key Configuration 4.3.2 

Direction Dir Counter 8.7.1 

Disable Cascade DisCas Cascade 4.10.5 

Disable Cascade Source DisSrc Cascade 4.10.5 

Disable override OvrDis Override 4.11.2 

Disable override source OvrSrc Override 4.11.2 

Dry Bulb Temperature source DrySrc Humidity 8.11.2 

Dry Bulb Temperature value Dry Humidity 8.11.2 

Electrical High IOH Analogue Input 7.7.8 

Electrical High IOH Analogue Output 7.8.1 

Electrical High IOH Digital output control 7.10.4 

Electrical Low IOL Analogue Input 7.7.8 

Electrical Low IOL Analogue Output 7.8.1 

Electrical Low IOL Digital output control 7.10.4 

Electrical Value MeasV Analogue Output 7.8.1 

Electrical Value MeasV Digital output control 7.10.4 

Electrical Value (V/A/R) MeasV Analogue Input 7.7.8 

Electrical Value (V/A/R) MeasV Digital Input 7.9.5 

Emissivity Emiss Analogue Input 7.7.8 

Enable En Counter 8.7.1 

Enable Fall Back UseFBk Analogue block 8.2.2 

Enable IO Config in Operator mode LveCnf System 6.3.1 

Enable Source EnSrc Counter 8.7.1 

Engineering Value High VALH Analogue Input 7.7.8 

Engineering Value High VALH Analogue Output 7.8.1 

Engineering Value High VALH Digital output control 7.10.4 

Engineering Value Low VALL Analogue Input 7.7.8 

Engineering Value Low VALL Analogue Output 7.8.1 

Engineering Value Low VALL Digital output control 7.10.4 

Ethernet Base Address F5_2 System Descriptions 6.7 

External (or Remote) OP Feedback. XFb Loop Overview 4.2.1 
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External Feedback Source XFbSrc Loop Overview 4.2.1 

Fall Back Value FallBk Analogue block 8.2.2 

Fall Back Value FallBk Digital block 8.3.2 

Fault Action FltAct Analogue Input 7.7.8 

FCs 17-19 NOT supported F3_2 System Descriptions 6.7 

FCs 3;4;6;7;8 and 16 supported F3_1 System Descriptions 6.7 

FCs 70 and 71 supported F3_3 System Descriptions 6.7 

Feature Identifier Table Address FitA System Descriptions 6.7 

Feature Pass Code 1 PCode1 System Descriptions 6.7 

Feature Pass Code 2 PCode2 System Descriptions 6.7 

Feature1: Indirect Modbus Address F1 System Descriptions 6.7 

Feature2:  Modbus Word Ordering F2 System Descriptions 6.7 

Feature3: Modbus Function Codes F3 System Descriptions 6.7 

Feature4: Analog Value Formats F4 System Descriptions 6.7 

Feature5: Ethernet Parameters F5 System Descriptions 6.7 

Feedforward Type Fwdt Key Configuration 4.3.2 

Filter Time FiltTm Analogue Input 7.7.8 

Fixed offset value added to the feedforward 
signal 

FFtr PID 4.4.6 

Flags - special case comms FLAGs Digital Communications 6.2.1 

For diagnostic use only MaxDsp PID 4.4.6 

For diagnostic use only MinDsp PID 4.4.6 

For diagnostic use only MnPosn PID 4.4.6 

For diagnostic use only MxTDTI PID 4.4.6 

Force Manual Output Mode. FOP Key Configuration 4.3.2 

Forced Output Level FOP Output 4.8.2 

Freeze Control Flag Value Frz PID 4.4.6 

Gas Reference H-CO Zirconia 8.12.2 

Gateway 1 Ethernet Gateway1 Digital Communications 6.2.1 

Gateway 2 Ethernet Gateway2 Digital Communications 6.2.1 

Gateway 3 Ethernet Gateway3 Digital Communications 6.2.1 

Gateway 4 Ethernet Gateway4 Digital Communications 6.2.1 

Global Alarm Ack Input AckIP System 6.3.1 

Global Alarm Ack Input Source AckSrc System 6.3.1 

Global Alarm Acknowledge AckAll System 6.3.1 

Global IO Status IOstat System 6.3.1 

Global SRL Hold Flag GHd System 6.3.1 

Global SRL Hold Flag Source GHdSrc System 6.3.1 

Group Acknowledge GrpAck Alarm 5.7.1 

High Limit  for Channel Type ChTpHi Analogue Input 7.7.8 

High order word in low reg. addr F2_1 System Descriptions 6.7 

High power limit OPHi Output 4.8.2 

Hold Hld Totalisers 8.8.1 

Holdback Disable  Hbkdis Rate Limit and Holdback 4.6.1.1 
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Holdback strategy for setpoint ramps Hbty Rate Limit and Holdback 4.6.1.1 

Hysteresis 1 hYS1 Output 4.8.2 

Hysteresis 2 hYS2 Output 4.8.2 

I/O Fail Strategy IOFail System 6.3.1 

I/O Network Watchdog Flag Nwdged System 6.3.1 

I/O Network Watchdog Timeout IONwdg System 6.3.1 

I/O Network Watchdog Timeout NwdAct System 6.3.1 

Input 1 Scalar P1_Mul Analogue block 8.2.2 

Input 1 Scalar P1_Mul Digital block 8.3.2 

Input 1 Source P1_Src Analogue block 8.2.2 

Input 1 Source P1_Src Digital block 8.3.2 

Input 1 Value P1_Val Analogue block 8.2.2 

Input 1 Value P1_Val Digital block 8.3.2 

Input 2 Scalar P2_Mul Analogue block 8.2.2 

Input 2 Scalar P2_Mul Digital block 8.3.2 

Input 2 Source P2_Src Analogue block 8.2.2 

Input 2 Source P2_Src Digital block 8.3.2 

Input 2 Value P2_Val Analogue block 8.2.2 

Input 2 Value P2_Val Digital block 8.3.2 

Input Channel value Val Digital Input 7.9.5 

Instrument Alarm Acknowledge Ack System 6.3.1 

Instrument Alarm Bit Mask Mask System 6.3.1 

Instrument Alarm Blocking Bloc System 6.3.1 

Instrument Alarm Inhibit Inhibt System 6.3.1 

Instrument Alarm Inhibit Source InhSrc System 6.3.1 

Instrument Alarm Latching Ltch System 6.3.1 

Instrument Alarm Output OP System 6.3.1 

Instrument Alarm Status Word AlmSW System 6.3.1 

Instrument Identity II System 6.3.1 

Instrument Operating Mode IM System 6.3.1 

Instrument Operating State IS System 6.3.1 

Instrument Serial Number SerialNo System Descriptions 6.7 

Instrument Status InstSt System 6.3.1 

Instrument Temperature Units Units System 6.3.1 

Instrument Version Number VO System Descriptions 6.7 

Integral & Derivative Time Units titd Key Configuration 4.3.2 

Integral Hold Flag I_Hold PID 4.4.6 

Integral time Ti PID 4.4.6 

Integral Time Source TiSrc Gain Scheduling 4.5.1 

Internal Setpoint Select SSEL Setpoint 4.6.1 

Internal SP Select Source SSESrc Setpoint 4.6.1 

Invert SEnS Digital Input 7.9.5 

Invert SEnS Digital output control 7.10.4 

Invert Inputs Mask InvMsk Digital block 8.3.2 
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IO Network Recovery Time IONrec System 6.3.1 

IP Address 1 Ethernet IPaddr1 Digital Communications 6.2.1 

IP Address 2 Ethernet IPaddr2 Digital Communications 6.2.1 

IP Address 3 Ethernet IPaddr3 Digital Communications 6.2.1 

IP Address 4 Ethernet IPaddr4 Digital Communications 6.2.1 

IP Changed Ethernet IPChanged Digital Communications 6.2.1 

Lead PV   LeadPV Ratio 4.9.2 

Lead PV source LeaSrc Ratio 4.9.2 

Linearisation Type LinTyp Analogue Input 7.7.8 

Local Modbus Address Ethernet LocalAddres Digital Communications 6.2.1 

Local Setpoint Trim Loct Remote Setpoint 4.6.1.3 

Local Setpoint Trim High Limit LocH Remote Setpoint 4.6.1.3 

Local Setpoint Trim Low Limit LocL Remote Setpoint 4.6.1.3 

Loop Break Status Flag LPBrk PID 4.4.6 

Loop Break Time Lb_t PID 4.4.6 

Loop Type LpType Key Configuration 4.3.1 

Low Limit  for Channel Type ChTpLo Analogue Input 7.7.8 

Low power limit OPLo Output 4.8.2 

MAC Address 1 Ethernat MACaddr1 Digital Communications 6.2.1 

MAC Address 2 Ethernat MACaddr2 Digital Communications 6.2.1 

MAC Address 3 Ethernat MACaddr3 Digital Communications 6.2.1 

MAC Address 4 Ethernat DHCPen Digital Communications 6.2.1 

Manual reset rES PID 4.4.6 

Manual Reset Auto Calc Enable Adc PID 4.4.6 

Manual Track mTr Setpoint Configuration 4.7.2 

Manual/Auto Transfer PD Control Pdtr Key Configuration 4.3.2 

Master Feedback Value MFB Cascade 4.10.5 

Maximum Control Task Duration MaxCT Diagnostics 6.6.1 

Maximum recovery time after purging bort Zirconia 8.12.2 

Maximum Sample Time MaxST System 6.3.1 

Maximum value allowed for the working setpoint WSPHi Loop Overview 4.2.1 

Maximum value allowed on SP1 SP_H Setpoint 4.6.1 

Maximum value allowed on SP2 SP_2H Setpoint 4.6.1 

Measured Ratio MRatio Ratio 4.9.2 

Minimum Pulse Time MnPlsT Digital Input 7.9.5 

Minimum Pulse Time MnPlsT Digital output control 7.10.4 

Minimum Pulse Time mPt Valve Control 4.8.4 

Minimum recovery time after purging bmrt Zirconia 8.12.2 

Minimum value allowed for the working setpoint WSPLo Loop Overview 4.2.1 

Minimum value allowed on SP1 SP_L Setpoint 4.6.1 

Minimum value allowed on SP2 SP_2L Setpoint 4.6.1 

Modbus address of parameter used as the freeze 
control flag 

FrzSrc PID 4.4.6 

Modbus address of parameter used as the 
remote feed forward 

FFSrc PID 4.4.6 
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Modbus address of parameter used as the 
working PID set 

SETSrc PID 4.4.6 

Modbus address of the flag used to hold the 
Integral value 

I-HSrc PID 4.4.6 

Modbus address of the parameter supplying the 
value of SP1/2 

SP1/2Src Setpoint 4.6.1 

Modbus address of the parameter supplying the 
value of SPrr    

SPrSrc Rate Limit and Holdback 4.6.1.1 

Module Version ModVer Module Block 6.7 

Network Status Ethernet NetStat Digital Communications 6.2.1 

Next Slave Instrument Ramp Rate NwRmRt Remote Setpoint 4.6.1.3 

Next Slave Instrument Target Setpoint NwTrSP Remote Setpoint 4.6.1.3 

Non-Volatile Memory Failure NVFail System 6.3.1 

Not Used F1_3 System Descriptions 6.7 

Not Used F2_2 System Descriptions 6.7 

Not Used F2_3 System Descriptions 6.7 

Not Used F4_2 System Descriptions 6.7 

Not Used F4_3 System Descriptions 6.7 

Not Used F5_3 System Descriptions 6.7 

Number of Feature Identifiers nFID System Descriptions 6.7 

Number of PID sets to Use nSets Gain Scheduling 4.5.1 

On Off Control Output. o-oOP Loop Overview 4.2.1 

On/ Off Input OnOffI Digital Input 7.11.5 

On/ Off Output OnOffO Digital output control 7.11.6 

ON/OFF On1&2(6) Key Configuration 4.3.1 

ON/OFF OnVPB(8) Key Configuration 4.3.1 

ON/OFF OnVPU(7) Key Configuration 4.3.1 

ON/OFF control OnOff (1) Key Configuration 4.3.1 

OP Standby Action FltAct Analogue Output 7.8.1 

OP Standby Action FltAct Digital output control 7.10.4 

OP Track Enable TkEn Output 4.8.2 

OP Track Enable Source TkESrc Output 4.8.2 

Operator Oper Analogue block 8.2.2 

Operator Oper Digital block 8.3.2 

Output High Limit HiLim Analogue block 8.2.2 

Output Low Limit LoLim Analogue block 8.2.2 

Output Rate Limit OPrr Output 4.8.2 

Output Rate Limit Enable ORL Output 4.8.2 

Output Rate Limit Enable Source ORLSrc Output 4.8.2 

Output Rate Limit Source OPrSrc Output 4.8.2 

Output Track Enable TkEn Output 4.8.2 

Output Track Enable Source TkESrc Output 4.8.2 

Output Value BoolCV Digital block 8.3.2 

Output Value RealCV Analogue block 8.2.2 

Overflow Ovflow Counter 8.7.1 

Override Loop SP Trim Trim Override 4.11.2 
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Override Loop SP Trim source TriSrc Override 4.11.2 

Override Type OvrTyp Override 4.11.2 

Oxygen Exponent O2_Un Zirconia 8.12.2 

Parameter Changed Status Word PaChgd System 6.3.1 

Parity Parity Digital Communications 6.2.1 

PID PID On(5) Key Configuration 4.3.1 

PID PIDVPB(12) Key Configuration 4.3.1 

PID PIDVPU(11) Key Configuration 4.3.1 

PID (Heat) PID1&2(4) Key Configuration 4.3.1 

PID control PID (0) Key Configuration 4.3.1 

Point to point wire destination Dst1 Wires 8.10.1 

Point to point wire source Src1 Wires 8.10.1 

Pot Input Calibration Enable CalPot Valve Control 4.8.4 

Pot Position PPos Valve Control 4.8.4 

Pot Position Source PPoSrc Valve Control 4.8.4 

Power Feed Forward PFFVal Output 4.8.2 

Power Feed Forward Source PFFSrc Output 4.8.2 

Power Feedback Enable PwrF Key Configuration 4.3.2 

Preferred Master 1 Ethernet PrefMst1 Digital Communications 6.2.1 

Preferred Master 2 Ethernet PrefMst2 Digital Communications 6.2.1 

Preferred Master 3 Ethernet PrefMst3 Digital Communications 6.2.1 

Preferred Master 4 Ethernet PrefMst4 Digital Communications 6.2.1 

Process Factor PF Zirconia 8.12.2 

Process Value Val Analogue Output 7.8.1 

Process Value Val Digital output control 7.10.4 

Process Value High and Low Limits. rnGH/L Key Configuration 4.3.1 

Process Value source ValSrc Analogue Output 7.8.1 

Process Value source ValSrc Digital output control 7.10.4 

Process Variable Source PVSrc Loop Overview 4.2.1 

Process Variable Source T_OPSrc Loop Overview 4.2.1 

Process Variable. PV Loop Overview 4.2.1 

Product ID II System Descriptions 6.7 

Product ID Table Checksum PidCS System Descriptions 6.7 

Profibus Protocol Prot Digital Communications 6.2.1 

Proportion of feed forward fed directly to the 
output 

FFPb PID 4.4.6 

Proportional Band Source XpSrc Gain Scheduling 4.5.1 

Proportional Band Units PB PID 4.4.6 

Proportional Band Units Pbu Key Configuration 4.3.2 

Psychrometric Constant PSY_Cn Humidity 8.11.2 

Psychrometric Constant Source PSYSrc Humidity 8.11.2 

Pulse Pulse Digital Input 7.9.5 

Pulse Pulse Digital Input 7.11.5 

PV Frozen PVFrz Zirconia 8.12.2 
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PV Invalid.   PVnVd Zirconia 8.12.2 

Ramp from WSP WSPRmp Key Configuration 4.3.2 

Rate Limit Units rmPU Setpoint Configuration 4.7.2 

Ratio Enable REn Ratio 4.9.2 

Ratio Enable source REnSrc Ratio 4.9.2 

Ratio Setpoint Rat_SP Ratio 4.9.2 

Ratio Setpoint High Limit RAH Ratio 4.9.2 

Ratio Setpoint Low Limit RAL Ratio 4.9.2 

Ratio Setpoint Source RatSrc Ratio 4.9.2 

Ratio Track Mode RatTrk Ratio 4.9.2 

Ratio Trim Trim Ratio 4.9.2 

Ratio Trim Source TriSrc Ratio 4.9.2 

Ratio Type RAType Ratio 4.9.2 

Ratio Valid RatVld Ratio 4.9.2 

Read Only Modbus indirect table size nindRO System Descriptions 6.7 

Read/Write Modbus indirect table size nindRW System Descriptions 6.7 

Reference Calibration Password DefRPW Password set up 6.5.1 

Reference Calibration Password RefPW Password Entry 6.4.1 

Relative gain Ch1/ch2 rel PID 4.4.6 

Relative Humidity value RH Humidity 8.11.2 

Remote Feedforward FF PID 4.4.6 

Remote Gas enable RmGEn Zirconia 8.12.2 

Remote Gas Reference RmH-Co Zirconia 8.12.2 

Remote Gas Reference Source RmHSrc Zirconia 8.12.2 

Remote High Power Limit rOH Output 4.8.2 

Remote High Power Limit source rOHSrc Output 4.8.2 

Remote Low Power Limit rOL Output 4.8.2 

Remote Low Power Limit source rOLSrc Output 4.8.2 

Remote Scheduling Input RM Gain Scheduling 4.5.1 

Remote Scheduling Input Source RMSrc Gain Scheduling 4.5.1 

Remote Setpoint rm_SP Remote Setpoint 4.6.1.2 

Remote Setpoint Configuration rmt Setpoint Configuration 4.7.2 

Remote Setpoint Enable L-r Remote Setpoint 4.6.1.2 

Remote Setpoint Enable Source L-rSrc Remote Setpoint 4.6.1.2 

Remote Setpoint Source rm_Src Remote Setpoint 4.6.1.2 

Remote Tracking. rmTr Setpoint Configuration 4.7.2 

Requested Instrument Mode ReqIM System 6.3.1 

Requested Module Type ReqID Module Block 6.7 

Requested Sample Time ReqST System 6.3.1 

Reset Rst Counter 8.7.1 

Reset Source Rst Src Counter 8.7.1 

Resolution Res Digital Communications 6.2.1 

Ripple Carry Rcarry Counter 8.7.1 

RTD lead resistance Lead_R Analogue Input 7.7.8 
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Run Run Totalisers 8.8.1 

Running Slower than Requested Flag SlowST System 6.3.1 

Sample Time STime System 6.3.1 

Scheduling Type PidSch Gain Scheduling 4.5.1 

Sensor break Sbrk Humidity 8.11.2 

Sensor Break Bleed Enable SBDet Analogue Input 7.7.8 

Sensor Break Power oSbOP Output 4.8.2 

Sensor Break Power oSbOP Output 4.8.2 

Sensor Break Status Flag SbrSt Loop Overview 4.2.1 

Sensor Break type. Sbrt Key Configuration 4.3.2 

Setpiont Origin SPorig Loop Overview 4.2.1 

Setpoint SP Ratio 4.9.2 

Simple Cal Offset (Eng) Offset Analogue Input 7.7.8 

Slave Loop High Range SlvHR Cascade 4.10.5 

Slave Loop Low Range SlvLR Cascade 4.10.5 

Slowed Down Counter SOrCt System 6.3.1 

SP and PV feed forward defines range of PID trim 
contribution 

FFdv PID 4.4.6 

SP ramp is currently ramping or on hold SRLHb Rate Limit and Holdback 4.6.1.1 

SP Rate Limit SPrr Rate Limit and Holdback 4.6.1.1 

SP Rate Limit Active Status SRLAct Rate Limit and Holdback 4.6.1.1 

SP Rate Limit Complete Flag SRLStA Rate Limit and Holdback 4.6.1.1 

SP Rate Limit Disable  SRLDis Rate Limit and Holdback 4.6.1.1 

SP Rate Limit Hold SRLHd Rate Limit and Holdback 4.6.1.1 

SP Rate Limit Holdback Value Hb Remote Setpoint 4.6.1.3 

Startup Hold Mode StHld Setpoint Configuration 4.7.2 

Startup in Standby StStby System 6.3.1 

Startup Local/Remote Mode StLR Setpoint Configuration 4.7.2 

Startup WSP Mode StWSP Setpoint Configuration 4.7.2 

Status ChStat Analogue Output 7.8.1 

Status ChStat Digital Input 7.9.5 

Status CVStat Analogue block 8.2.2 

Status CVStat Digital block 8.3.2 

Status Alarm Acknowledge Ack Analogue Input 7.7.8 

Status Alarm Acknowledge Ack Analogue Output 7.8.1 

Status Alarm Acknowledge Ack Digital Input 7.9.5 

Status Alarm Acknowledge Ack Digital output control 7.10.4 

Status Alarm Bit Mask Mask Analogue Input 7.7.8 

Status Alarm Bit Mask Mask Analogue Output 7.8.1 

Status Alarm Bit Mask Mask Digital Input 7.9.5 

Status Alarm Bit Mask Mask Digital output control 7.10.4 

Status Alarm Blocking Bloc Analogue Input 7.7.8 

Status Alarm Blocking Bloc Digital Input 7.9.5 

Status Alarm Blocking Bloc Digital output control 7.10.4 
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Status Alarm Blocking  Bloc Analogue Output 7.8.1 

Status Alarm Inhibit Inhibt Analogue Input 7.7.8 

Status Alarm Inhibit Inhibt Analogue Output 7.8.1 

Status Alarm Inhibit Inhibt Digital Input 7.9.5 

Status Alarm Inhibit Inhibt Digital output control 7.10.4 

Status Alarm Inhibit Source InhSrc Analogue Input 7.7.8 

Status Alarm Inhibit Source InhSrc Analogue Output 7.8.1 

Status Alarm Inhibit Source InhSrc Digital Input 7.9.5 

Status Alarm Inhibit Source  InhSrc Digital output control 7.10.4 

Status Alarm Latching Ltch Analogue Input 7.7.8 

Status Alarm Latching Ltch Analogue Output 7.8.1 

Status Alarm Latching Ltch Digital Input 7.9.5 

Status Alarm Latching Ltch Digital output control 7.10.4 

Status Alarm Output OP Analogue Input 7.7.8 

Status Alarm Output OP Analogue Output 7.8.1 

Status Alarm Output OP Digital Input 7.9.5 

Status Alarm Output OP Digital output control 7.10.4 

Status. ChStat Analogue Input 7.7.8 

Sticky Holdback Status StkHbk Rate Limit and Holdback 4.6.1.1 

Subnet Mask 1 Ethernet Subnet1 Digital Communications 6.2.1 

Subnet Mask 2 Ethernet Subnet2 Digital Communications 6.2.1 

Subnet Mask 3 Ethernet Subnet3 Digital Communications 6.2.1 

Subnet Mask 4 Ethernet Subnet4 Digital Communications 6.2.1 

Summary of alarm status AlmSW Module Block 6.7 

Summary Word Sumary Module Block 6.7 

Supported Ethernet parameters F5_1 System Descriptions 6.7 

Target Tgt Counter 8.7.1 

Target Output Power T_OP Loop Overview 4.2.1 

Target Setpoint. tSP Loop Overview 4.2.1 

The current analogue value selected form AnVal1 
to AnVal3 

AnVal Gain Scheduling 4.5.1 

Time proportioning TimePr Digital output control 7.11.6 

Time To Next Cleaning t2c Zirconia 8.12.2 

Timer elapsed time Elapse Timer 8.6.5 

Timer Input Wire IP_Src Timer 8.6.5 

Timer Output OP Timer 8.6.5 

Timer Time Time Timer 8.6.5 

Timer Triggered Trig Timer 8.6.5 

Timer type Type Timer 8.6.5 

Totaliser Accumulator Output Total Totalisers 8.8.1 

Totaliser Alarm Output AlmOP Totalisers 8.8.1 

Totaliser Alarm Setpoint AlmSP Totalisers 8.8.1 

Totaliser Hold Source HldSrc Totalisers 8.8.1 

Totaliser Low Threshold LowThr Totalisers 8.8.1 
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Totaliser Monitored Parameter Value IP Totalisers 8.8.1 

Totaliser Monitored Parameter Value Source IPSrc Totalisers 8.8.1 

Totaliser Pulse Output PulsOP Totalisers 8.8.1 

Totaliser Pulse Setpoint PulsSP Totalisers 8.8.1 

Totaliser Reset Reset Totalisers 8.8.1 

Totaliser Reset Source ResSrc  Totalisers 8.8.1 

Totaliser Run Source RunSrc Totalisers 8.8.1 

Track Input TrkIP Output 4.8.2 

Track Input Source TrkSrc Output 4.8.2 

Trigger All Ramps GSSync System 6.3.1 

Trigger New Ramp SISync Remote Setpoint 4.6.1.3 

Trigger/Gate Input IP_Val Timer 8.6.5 

Tune Loop Number TnLpNr Autotune 4.13.1 

Tune PID Number TnPID Autotune 4.13.1 

Tuning Active tuning Autotune 4.13.1 

Tuning State TnStat Autotune 4.13.1 

User Cal Offset High (Eng) OfsetH Analogue Input 7.7.8 

User Cal Offset Low (Eng) OfsetL Analogue Input 7.7.8 

User Cal Point High (Eng) PointH Analogue Input 7.7.8 

User Cal Point Low (Eng) PointL Analogue Input 7.7.8 

User Calibration Enable UCAL Analogue Input 7.7.8 

User Calibration Password UserPW Password Entry 6.4.1 

User Calibration Password Configuration DefUPW Password set up 6.5.1 

Valve Backlash Time bAct Valve Control 4.8.4 

Valve control – bounded VPB (3) Key Configuration 4.3.1 

Valve control – bounded VPB1&2(15) Key Configuration 4.3.1 

Valve control – bounded VPBOn(10) Key Configuration 4.3.1 

Valve control – bounded VPBVPU(16) Key Configuration 4.3.1 

Valve Control - boundless VPU (2) Key Configuration 4.3.1 

Valve Control – boundless VPU1&2(13) Key Configuration 4.3.1 

Valve Control – boundless VPUOn(9) Key Configuration 4.3.1 

Valve Control – boundless VPUVPB(14) Key Configuration 4.3.1 

Valve Inertia Time Int Valve Control 4.8.4 

Valve Lower VlvLwr Digital output control 7.11.6 

Valve Position V_POS Loop Overview 4.2.1 

Valve Positioner High Limit PotHi Valve Control 4.8.4 

Valve Positioner Low Limit PotLo Valve Control 4.8.4 

Valve Raise VlvRse Digital output control 7.11.6 

Valve Travel Time tm Valve Control 4.8.4 

VP Manual Output VP_OP Valve Control 4.8.4 

Wet Bulb Temperature Correction cOrr Humidity 8.11.2 

Wet Bulb Temperature Source WEtSrc Humidity 8.11.2 

Wet Bulb Temperature value WEt Humidity 8.11.2 

Wet/Dry Temperature Dew Point DewPnt Humidity 8.11.2 
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Wire Status Stat1 Wires 8.10.1 

Working Gas Reference WkH-CO Zirconia 8.12.2 

Working Output wOP Loop Overview 4.2.1 

Working PID Set SET PID 4.4.6 

Working Ratio SP WRatSP Ratio 4.9.2 

Working Setpoint. wSP Loop Overview 4.2.1 

Working SP of Current Tune Stage TnWSP Autotune 4.13.1 

WSP to PV On Slave Sync Signal PVOnSc Setpoint Configuration 4.7.2 

Zirconia Bad Probe PrbFlt Zirconia 8.12.2 

Zirconia Burn Off State Prob Zirconia 8.12.2 

Zirconia Clean Probe IP ClnPrb Zirconia 8.12.2 

Zirconia Clean Probe IP Source ClnSrc Zirconia 8.12.2 

Zirconia Clean Valve Output boVLV Zirconia 8.12.2 

Zirconia Control Process Value ZirPV Zirconia 8.12.2 

Zirconia Minimum Calculation Temperature MinT Zirconia 8.12.2 

Zirconia mV Offset OFFS Zirconia 8.12.2 

Zirconia Probe Cleaning Interval cYct Zirconia 8.12.2 

Zirconia Probe Cleaning Time bot Zirconia 8.12.2 

Zirconia Probe Equation ZiFn Zirconia 8.12.2 

Zirconia Probe mV Input Source mVSrc Zirconia 8.12.2 

Zirconia Probe mV IP mV Zirconia 8.12.2 

Zirconia Probe Sooting Alarm SootAL Zirconia 8.12.2 

Zirconia Probe Temperature Input TmpIP Zirconia 8.12.2 

Zirconia Probe Temperature Input Source TmpSrc Zirconia 8.12.2 

Zirconia Temperature Offset TOFS Zirconia 8.12.2 
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1 
10^x 134 

A 
AbsDif 134 
Add 37, 72, 134, 136 
Address Switch 26, 28, 31, 33 
Analogue    76, 83, 84, 98, 105, 108, 109, 110, 114, 115, 

127, 128, 133, 134, 135, 175, 176 
AND       134 
Autotune 52, 71, 72, 75 

B 
Browser 39, 40, 41, 42, 45, 68, 101 

C 
Carbon 153, 155 
Clean 154, 156 
Cleaning 8, 154, 156 
Configuration mode 20, 42, 93, 141 
Cutback 51 

D 
Derivative 49, 50, 55, 195, 198, 204, 209, 211 
DHCP 33, 36, 37, 89, 166, 167, 169, 170, 177 
Digital    79, 83, 84, 98, 117, 118, 119, 120, 122, 124, 129, 

130, 137 
DIN 11, 13, 15, 16, 46 
Div 134 

E 
Earth 9 
Electromagnetic 8 
Electrostatic 8 
Enumerated Values 40 
Equal 137 
Exp 134 
Expt 134 

F 
Feedforward 49, 52, 53, 66, 67, 73 
Function block 46 
Functional 10, 105 

G 
Greater 137 
Greater or Equal 137 

H 
HART 108 
Hold 49, 52, 57, 60, 75, 93, 134, 149 
HotSwp 134 

I 
Integral 47, 49, 50, 52, 53, 55, 75 
IOC  19, 34, 35, 36 
IP20 9, 15, 16 
Isolation  9, 99, 105, 108, 109, 114, 117, 118, 119, 122, 

123 

K 
Kelvin 92 

L 
Latch 137 
Less or Equal 137 
Less Than 139 
Ln 134 
Log 134, 153 

M 
MAC 89, 165, 166, 169 
Master 66, 73, 159, 160, 162, 168 
Max 72, 74, 120, 129, 134, 156 
Milli-Amp 107, 109 
Milli-Volt 107, 109 
Min 52, 72, 74, 120, 129, 134 
Mul 134, 136 

N 
None 82, 83, 88, 102, 134, 137, 138, 151 
Not Equal 137 

O 
Operating mode 42 
OR 23, 76, 86, 137, 152 
Overcurrent 9 
Over-temperature 10 
Oxygen 153, 155 

P 
Password 95, 174, 176, 197, 203, 205, 215, 218 
PC    22, 34, 35  
Personnel 9 
Polarising keys 17 
Pot 63, 106, 110, 131, 132
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